Dimension 3100 Manual

NanoScope Software Version 5
004-320-000 (standard)
004-320-100 (cleanroom)

Copyright © [2004] Veeco Instruments Inc.
All rights reserved.

Document Revision History: Dimension 3100 Manual

<table>
<thead>
<tr>
<th>Revision</th>
<th>Date</th>
<th>Section(s) Affected</th>
<th>Ref. DCR</th>
<th>Approval</th>
</tr>
</thead>
<tbody>
<tr>
<td>D</td>
<td>03/09/04</td>
<td>All.</td>
<td>N/A</td>
<td>C. Kowalski</td>
</tr>
<tr>
<td>C</td>
<td>05/15/03</td>
<td>Fluid Cell</td>
<td>N/A</td>
<td>L. Burrows</td>
</tr>
<tr>
<td>B</td>
<td>06/01/00</td>
<td>All.</td>
<td>313</td>
<td>A. Varbel</td>
</tr>
<tr>
<td>A</td>
<td>08/25/97</td>
<td>Released.</td>
<td>N/A</td>
<td>M. Leilani</td>
</tr>
</tbody>
</table>
**Notices:** The information in this document is subject to change without notice. NO WARRANTY OF ANY KIND IS MADE WITH REGARD TO THIS MATERIAL, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. No liability is assumed for errors contained herein or for incidental or consequential damages in connection with the furnishing, performance, or use of this material. This document contains proprietary information which is protected by copyright. No part of this document may be photocopied, reproduced, or translated into another language without prior written consent.

**Copyright:** Copyright © 2004 Veeco Instruments Inc. All rights reserved.

**Trademark Acknowledgments:** The following are registered trademarks of Veeco Instruments Inc. All other trademarks are the property of their respective owners.

**Product Names:**
NanoScope®
MultiMode™
Dimension™
BioScope™
Atomic Force Profiler™ (AFP™)
Dektak®

**Software Modes:**
TappingMode™
Tapping™
TappingMode+™
LiftMode™
AutoTune™
TurboScan™
Fast HSG™
PhaseImaging™
DekMap 2™
HyperScan™
StepFinder™
SoftScan™

**Hardware Designs:**
TrakScan™
StiffStage™

**Hardware Options:**
TipX®
Signal Access Module™ and SAM™
Extender™
TipView™
Interleave™
LookAhead™
Quadrex™

**Software Options:**
NanoScript™
Navigator™
FeatureFind™

**Miscellaneous:**
NanoProbe®
# Table of Contents

## Chapter 1  System Overview  1

1.1  System Overview .................................................. 2
  1.1.1  Dimension 3100 SPM Features ................................. 2

1.2  Control Station Overview ............................................ 3
  1.2.1  Input and Display Devices ................................. 3
  1.2.2  Computer .................................................. 4
  1.2.3  NanoScope IIIa Controller .............................. 5
  1.2.4  Dimension 3100 Controller .......................... 6

1.3  Dimension 3100 SPM Overview .................................... 7
  1.3.1  Dimension 3100 Microscope Electronics Box ............. 7
  1.3.2  Optics and Motors Overview .......................... 9
  1.3.3  Stage System .............................................. 9
  1.3.4  Dimension SPM Head ............................... 9
  1.3.5  Cantilever Holder ................................... 13
  1.3.6  Video Zoom Microscope ............................ 14

1.4  Sample Size & Handling ........................................... 15

1.5  Facilities Specifications ........................................... 16

1.6  Applications ..................................................... 16

1.7  Maintenance and Troubleshooting ................................ 16

## Chapter 2  Safety  17

2.1  Safety Requirements ............................................. 19

2.2  Safety Precautions ................................................ 20
  2.2.1  General Operator Safety ............................... 20
  2.2.2  Microscope ............................................. 23
  2.2.3  Sample Safeguards .................................. 26

2.3  Ergonomics .......................................................... 26

2.4  Environmental Conditions ......................................... 27

2.5  Equipment Safety Applications ................................... 27
  2.5.1  Dimension 3100 SPM Facility Requirements ............ 27

2.6  Power-up Sequence (Installation and Service Only) ........... 27
  2.6.1  Pre Power-up Checklist ............................... 28
## Chapter 5  
### Stage System  
5.1 Mounting of Samples  
   5.1.1 Vacuum Chucks  
   5.1.2 Magnetic Pucks  
   5.1.3 Axis Orientation Motorized X-Y Stages  
5.2 Stage Menu Commands  
   5.2.1 Load New Sample  
   5.2.2 Locate Tip  
   5.2.3 Focus Surface  
   5.2.4 Move To (X,Y)  
   5.2.5 Set Reference  
   5.2.6 Programmed Move  
   5.2.7 Initialize  
   5.2.8 SPM Parameters  

## Chapter 6  
### Cantilever Preparation  
6.1 Silicon Cantilever Substrates  
   6.1.1 Wafer Tool Kit  
   6.1.2 Cantilever Preparation  
   6.1.3 Tip Shape of Etched Silicon Probes  
6.2 Silicon Nitride Cantilever Substrates  
   6.2.1 Tip Shape of Silicon Nitride Probes  

## Chapter 7  
### Head, Probe, & Sample Preparation  
7.1 System Information  
   7.1.1 Mouse versus Trackball  
   7.1.2 Motor Interlock  
   7.1.3 Laser Requirements  
7.2 Basic AFM Operation  
   7.2.1 Select the Microscope  
   7.2.2 Select Mode of Operation  
   7.2.3 Prepare the Cantilever Holder  
   7.2.4 Load the Cantilever Holder  
   7.2.5 Remove the Dimension SPM Head  
   7.2.6 Install the Cantilever Holder  
   7.2.7 Replace the Dimension SPM Head  
   7.2.8 Connect the Dimension Head  
   7.2.9 Align Laser  
   7.2.10 Adjust Photodetector  
   7.2.11 Locate Tip  
   7.2.12 Load the Sample  
   7.2.13 Focus Surface  
   7.2.14 Cantilever Tune (TappingMode only)  
   7.2.15 Set Initial Scan Parameters  
   7.2.16 Engage  
   7.2.17 Withdraw
Chapter 8  Contact AFM  119

8.1 Basic Contact Mode AFM Operation  120
  8.1.1 Select the Microscope  120
  8.1.2 Select Mode of Operation  120
  8.1.3 Head, Cantilever and Sample Preparation  120
  8.1.4 Align Laser  120
  8.1.5 Adjust Photodetector  121
  8.1.6 Locate Tip  121
  8.1.7 Focus Surface  121
  8.1.8 Show All Items  122
  8.1.9 Set Initial Scan Parameters  123
  8.1.10 Engage  125

8.2 Advanced Atomic Force Operation  125
  8.2.1 Cantilever Selection  125

8.3 Optimization of Scanning Parameters  127
  8.3.1 Data Type  127
  8.3.2 Gain Settings  128
  8.3.3 Scan Size and Scan Rate  129
  8.3.4 Setpoint  129
  8.3.5 Lowpass Filter  129
  8.3.6 Highpass Filter  129

8.4 Force Calibration Mode  130

Chapter 9  TappingMode AFM  131

9.1 Principles of TappingMode  132

9.2 Basic TappingMode AFM Operation  133
  9.2.1 Select Mode of Operation  133
  9.2.2 Head, Cantilever and Sample Preparation  134
  9.2.3 Align Laser  134
  9.2.4 Adjust Photodetector  134
  9.2.5 Locate Tip  134
  9.2.6 Focus Surface  135
  9.2.7 Cantilever Tune  135
  9.2.8 Show All Items  135
  9.2.9 Set Initial Scan Parameters  140
  9.2.10 Engage  141
  9.2.11 Optimize Scan Parameters  142

9.3 Withdraw the Tip  142

9.4 Advanced TappingMode AFM Operation  143
  9.4.1 Resonating Techniques  143
  9.4.2 Cantilever Oscillation  143
  9.4.3 Decreasing the Cantilever Drive Frequency  145
  9.4.4 Optimization of Scanning Parameters  146
Chapter 10  Fluid Imaging  149

10.1 Basic Principles ................................................. 151
   10.1.1 Acknowledgments ........................................... 151

10.2 Fluid Operation Hardware ...................................... 151
   10.2.1 Fluid Tip Holder ........................................... 151
   10.2.2 Tip Suggestions ........................................... 152
   10.2.3 Rubber Protective Skirt ................................... 153

10.3 Sample Mounting ................................................ 153
   10.3.1 General Notes on Sample Binding ......................... 153
   10.3.2 Larger Samples ............................................ 154
   10.3.3 Smaller Samples ........................................... 154

10.4 Precautions ....................................................... 155
   10.4.1 Spillage Precautions ....................................... 155

10.5 Operating Principles ............................................ 157
   10.5.1 Clean Fluid Cell and Protective Skirt .................... 157
   10.5.2 Select Mode of Operation .................................. 157
   10.5.3 Load the Probe ............................................ 157
   10.5.4 Install the Fluid Tip Holder ............................... 158
   10.5.5 Install the Protective Skirt ............................... 159
   10.5.6 Align Laser ................................................ 159
   10.5.7 False Reflections .......................................... 160
   10.5.8 Load Sample ............................................... 160
   10.5.9 Lower Probe into Fluid .................................... 162
   10.5.10 Readjust Laser Alignment ................................. 162
   10.5.11 Adjust Photodetector ...................................... 162
   10.5.12 Locate Tip ................................................ 163
   10.5.13 Focus Surface ............................................. 163
   10.5.14 Cantilever Tune (TappingMode Only) ................... 165
   10.5.15 Show All Items ............................................ 169
   10.5.16 Set Initial Scan Parameters ............................... 170
   10.5.17 Engage ...................................................... 171
   10.5.18 Adjust Scan Parameters .................................. 171
   10.5.19 Clean Cell and Protective Skirt ......................... 172

10.6 Troubleshooting ................................................ 173
   10.6.1 Cantilever Tune Plot Looks Poor .......................... 173
   10.6.2 Laser Sum Signal Absent or Weak ........................ 173
   10.6.3 Poor Image Quality ........................................ 173
   10.6.4 Unable to Locate Particulate Samples ...................... 174
Chapter 11  Scanning Tunneling Microscopy (STM)  175
11.1  Introduction ................................................. 176
11.1.1  Overview of STM ...................................... 176
11.2  Basic STM Operation ...................................... 177
11.2.1  Imaging Samples ....................................... 177
11.3  STM-Specific Information and Operations ................. 180
11.3.1  STM Hardware ......................................... 181
11.3.2  Fine Points of STM Operation ......................... 182
11.3.3  STM Operating Modes .................................. 182
11.3.4  STM-Specific Menu Parameters ....................... 183
11.4  Spectroscopy with the STM .............................. 187
11.4.1  Operation of STS ....................................... 187
11.5  Troubleshooting Operation of STM ...................... 188
11.5.1  Head and Microscope-Related Problems .............. 188
11.5.2  Head Engages Immediately ......................... 189
11.6  Etching Tungsten Tips ................................... 192
11.6.1  Procedure .............................................. 192

Chapter 12  Lateral Force Mode  195
12.1  Introduction .................................................. 195
12.2  Basic LFM Operation ....................................... 196
12.3  Advanced LFM Operation .................................. 197
12.3.1  Scan Direction ......................................... 197
12.3.2  Tip selection ........................................... 198
12.3.3  Understanding the LFM Signal ......................... 198
12.3.4  Understanding the Color Scale ......................... 199
12.3.5  Using TMR Voltage to Measure Friction .......... 200
12.3.6  Enhancing the LFM Data by Subtracting Two Images 200
12.3.7  Height Artifacts in the Signal ......................... 201

Chapter 13  Force Imaging  203
13.1  Force Plots—An Analogy .................................. 204
13.2  Force Calibration Mode ................................... 206
13.2.1  Example Force Plot ................................... 209
13.3  Force Calibration Control Panels and Menus ........... 212
13.3.1  Main Controls (Ramp Controls) ....................... 213
13.3.2  Main Controls Panel (Display) ......................... 214
13.3.3  Channel 1, 2, 3 Panels ................................ 215
13.3.4  Feedback Controls Panel ............................... 216
13.3.5  Scan Mode Panel (Advanced Mode Only) .......... 217
13.3.6  Menu Bar Commands .................................. 219
13.4  Force Calibration (Contact Mode AFM) .................. 220
13.4.1  Obtaining a Good Force Curve ....................... 220
List of Figures

Chapter 1  System Overview ......................................................... 1
  Figure 1.2a Dimension 3100 Input and Display Equipment ............. 3
  Figure 1.2b Computer (rear view) ........................................... 4
  Figure 1.2c NanoScope IIIa Controller (front view) ..................... 5
  Figure 1.2d Dimension 3100 Controller (front view) .................... 6
  Figure 1.3a D3100 Microscope Electronics Box (rear view) .......... 8
  Figure 1.3b Dimension SPM Head ............................................ 10
  Figure 1.3c Quad Photodetector Arrangement ................................ 11
  Figure 1.3d Dimension Head Scanner ....................................... 12
  Figure 1.3e Standard Cantilever Holder .................................. 13
  Figure 1.3f Fluid Cell Cantilever Holder .................................. 14

Chapter 2  Safety ........................................................................ 17
  Figure 2.1a Safety Symbols Key ................................................ 19
  Figure 2.5a Dimension 3100 SPM Footprint ................................. 27
  Figure 2.8a Log into Windows NT ............................................. 33
  Figure 2.8b Logon Window ...................................................... 34
  Figure 2.8c Select the NanoScope Icon ..................................... 34
  Figure 2.8d Select the Realtime Icon ........................................ 34
  Figure 2.8e Status Panel .......................................................... 35
  Figure 2.9a Laser Explanatory Label ......................................... 36
  Figure 2.9b Laser Warning Label ............................................. 36
  Figure 2.9c Noninterlocked Protective Housing Label .................... 36

Chapter 3  Facilities Requirements ................................................ 37
  Figure 3.1a VT-103-3K with ELCON ......................................... 38
  Figure 3.1b VT-102 ............................................................... 39
  Figure 3.1c IS3K-2 ............................................................... 40
  Figure 3.2a Dimension 3100 SPM Facility Requirements ............... 41
  Figure 3.3a IS3K-2 - Front View ............................................. 42
  Figure 3.3b IS3K-2 - Side View .............................................. 43
List of Figures

Chapter 4 Installation ........................................... 53
Figure 4.3a Hardware for Chuck Securement to Stage .......... 57
Figure 4.3b Secure the Chuck to the Stage .................. 58
Figure 4.3c Dimension 3100 Input and Display Equipment .... 59
Figure 4.4a Computer (rear view) .................................. 61
Figure 4.4b NanoScope IIIa Controller (front view) ........... 63
Figure 4.4c NanoScope IIIa Controller (rear view) ............ 63
Figure 4.4d Dimension 3100 Controller (rear view) .......... 64
Figure 4.4e Dimension 3100 Controller (front view) ....... 65
Figure 4.4f D3100 Microscope Electronics Box (rear view) .. 66
Figure 4.4g Vacuum Power Switch ................................. 67
Figure 4.4h Cable Clamp ........................................... 67

Chapter 5 Stage System ........................................... 69
Figure 5.1a Stage X-Y Axis Orientation ............................. 71
Figure 5.2a Stage Load/Unload Prompt ............................ 72
Figure 5.2b Moving to Tip Position Caution .................... 73
Figure 5.2c Locate Tip Prompt .................................... 74
Figure 5.2d Focus Surface Prompt ................................. 75
Figure 5.2e Move To Prompt ...................................... 76
Figure 5.2f Abort Motion Prompt .................................. 76
Figure 5.2g Set Reference Prompt ................................. 78
Figure 5.2h Defining the X-Axis .................................. 78
Figure 5.2i Resultant Reference Line .................................. 79
Figure 5.2j Programmed Move Prompt ............................ 79
Figure 5.2k Editing or Creating New Program Prompts ......... 80
Figure 5.2l Teach Program Prompt .................................. 80
Figure 5.2m Teach Mode Prompt .................................. 81
Figure 5.2n Initial Focus Prompt .................................. 83
Figure 5.2o Programmed Move Prompt ............................ 83
Figure 5.2p Stage Initialize/Cancel Prompt .......................... 84
Figure 5.2q SPM Move to Lower Limits Prompt .................. 84
Figure 5.2r  Stage Initializing Prompt .............................. 84
Figure 5.2s  Optics Move to End of Travel Prompt .............. 84
Figure 5.2t  Stage Zoom Prompt ................................... 84
Figure 5.2u  Stage Zoom Out Prompt ............................... 85

Chapter 6  Cantilever Preparation ................................. 87
Figure 6.1a  Silicon Cantilever Substrates in Wafer .............. 89
Figure 6.1b  Theoretical Tip Shape of Silicon Probes ............ 90
Figure 6.1c  Silicon Probe Tip Profile Artifact (Front-to-Back) . 91
Figure 6.1d  Silicon Probe Tip Step Profile Artifact (Side-to-Side) 92
Figure 6.1e  Common Silicon Probe Profile (Resultant Scan Artifact) 92
Figure 6.2a  Silicon Nitride Cantilevers in a Wafer .............. 93
Figure 6.2b  Substrate Break-off ................................... 95
Figure 6.2c  Silicon Nitride Cantilevers ......................... 96
Figure 6.2d  Silicon Nitride Cantilevers (profile) ................. 97

Chapter 7  Head, Probe, & Sample Preparation .................. 99
Figure 7.2a  Microscope Select Prompt ............................ 102
Figure 7.2b  Cantilever Holder Stand (top view) ................. 103
Figure 7.2c  Standard AFM Cantilever Holder ................... 104
Figure 7.2d  SPM Head Dovetail and Signal Connector ......... 105
Figure 7.2e  Dimension Head Laser Control Knobs .............. 107
Figure 7.2f  Etched Silicon Tip Laser Alignment ................. 108
Figure 7.2g  Photodetector Adjustment Knobs ................... 109
Figure 7.2h  Silicon Nitride Laser Alignment .................... 110
Figure 7.2i  Vision System Window ............................... 112
Figure 7.2j  Photodetector Mirror Adjustment Knobs .......... 113
Figure 7.2k  Securing Double-sided Tape to the Sample Disk . 114
Figure 7.2l  Securing the Sample ................................. 115
Figure 7.3a  Default SPM Stage Parameters ..................... 118

Chapter 8  Contact AFM ............................................. 119
Figure 8.1a  Select Show All Items ............................... 122
Figure 8.1b  Enable Parameters ................................. 122
Figure 8.1c  Suggested Scan Controls Settings ................. 123
Figure 8.1d  Suggested Other Controls Settings ............... 123
Figure 8.1e  Suggested Feedback Controls Settings ........... 124
Figure 8.1f  Suggested Channel Controls Settings .......... 124
Figure 8.2a  Force Curve ........................................... 126

Chapter 9  TappingMode AFM ....................................... 131
Figure 9.1a  Tapping Cantilever in Free Air ...................... 132
Figure 9.1b  Tapping Cantilever on Sample Surface .......... 133
List of Figures

Chapter 10  Fluid Imaging ............................................. 149
  Figure 10.2a Fluid Tip Holder .................................... 152
  Figure 10.2b Rubber Protective Skirt ............................ 153
  Figure 10.3a Imaging a Sample Covered by a Drop of Fluid .... 154
  Figure 10.5a Tip Holder Installed With Protective Skirt ....... 159
  Figure 10.5b False Reflections from Fluid Tip Holder ......... 160
  Figure 10.5c Typical Cantilever Tune Curve for Silicon Nitride Tip in Fluid 166
  Figure 10.5d Cantilever Tune Control Panels for Main Controls ... 167
  Figure 10.5e Cantilever Tune Frequency Sweep .................. 168
  Figure 10.5f Select Show All Items ............................. 169
  Figure 10.5g Enable Parameters .................................. 169
  Figure 10.5h Suggested Scan Controls Settings during TappingMode .... 170

Chapter 11  Scanning Tunneling Microscopy (STM) ..................... 175
  Figure 11.1a Dimension Tip Holder and Head Connection ....... 177
  Figure 11.3a Typical STM Channel 1 Control Panel Parameters .... 182
  Figure 11.3b Scan Derating Graph ............................... 186

Chapter 12  Lateral Force Mode ......................................... 195
  Figure 12.3a Scan Angle Selection ............................... 197
  Figure 12.3b Example of Frictional Forces on Tip During Scan (Front View) 198
  Figure 12.3c Friction Data ....................................... 199
  Figure 12.3d TMR Data .......................................... 200
  Figure 12.3e Height Artifacts in LFM Data ....................... 201

Chapter 13  Force Imaging ............................................... 203
  Figure 13.1a Comparative Index of Pulling Forces ................. 205
  Figure 13.1b Pulling Forces Graph ............................... 205
  Figure 13.2a Force Calibration Z Waveform ...................... 206
  Figure 13.2b Piezo Travel in Force Calibration Mode ............ 207
List of Figures

Chapter 14 Interleave Scanning .................................................. 247
  Figure 14.2a X-Y Scan Pattern .............................................. 249
  Figure 14.3a LiftMode Profiles .............................................. 250

Chapter 15 Magnetic Force Microscopy ..................................... 255
  Figure 15.1a MFM LiftMode Principles .................................... 256
  Figure 15.1b Extender Electronics Module for NanoScope III, IIIa Controllers 257
  Figure 15.1c Quadrex PhaseImaging Module for NanoScope IIIa Controllers 257
  Figure 15.2a Cantilever Tune for Phase Detection and Frequency Modulation 259
  Figure 15.2b Shift In Phase at Fixed Drive Frequency ................... 260
  Figure 15.2c Cantilever Tune for Amplitude Detection .................. 261
  Figure 15.2d Shift in Amplitude at Fixed Drive Frequency ............. 261
  Figure 15.2e Topographic (left) and Magnetic Force Gradient Image (right) 262
  Figure 15.3a High-resolution Magnetic Force Gradient Image .......... 265
  Figure 15.3b Tip Height and Oscillation Amplitudes (TappingMode & LiftMode) 267
  Figure 15.4a Phase Box .................................................. 268
  Figure 15.5a Microscope Select Dialog Box ............................... 269

Chapter 16 Electric Techniques .................................................. 271
  Figure 16.1a LiftMode Principles ........................................... 273
  Figure 16.1b Extender Electronics Module ................................ 274
List of Figures

Figure 16.2a  Comparison of Attractive and Repulsive Forces 275
Figure 16.2b  Diagram of Extender Electronics Module for EFM 276
Figure 16.2c  Microscope Backplane 277
Figure 16.2d  Toggle Switches on Extender Electronics Module 279
Figure 16.2e  Normal Jumper Configuration 280
Figure 16.2f  Jumper Configuration for Application of Analog 2 Voltage to Tip 281
Figure 16.2g  Jumper Configuration (Application of Analog 2 Voltage to Sample) 282
Figure 16.2h  Jumper Configuration for Applying External Voltage to Tip 283
Figure 16.2i  Jumper Configuration for Applying External Voltage to Sample 284
Figure 16.2j  Normal Jumper Configuration 285
Figure 16.2k  Jumper Configuration for Application of Voltage to Tip 286
Figure 16.2l  Jumper Configuration for Application of Voltage to Sample 287
Figure 16.2m  Jumper Configuration for Applying External Voltage to Tip 288
Figure 16.2n  Jumper Configuration for Applying External Voltage to Sample 289
Figure 16.2o  Phase Detection Cantilever Tune (Extender Electronics Module Installed) 291
Figure 16.2p  Shift In Phase at Fixed Drive Frequency 291
Figure 16.2q  Shift In Amplitude at Fixed Drive Frequency 293
Figure 16.2r  Amplitude Detection Cantilever Tune 294
Figure 16.4a  Simplified Block Diagram of Basic Extender Module in Surface Potential Mode 297
Figure 16.5a  Normal Jumper Configuration with Extender Electronics Module 299
Figure 16.5b  Jumper Configuration for Application of Voltage to Tip 299
Figure 16.5c  Jumper Configuration for Application of Voltage to Sample 300
Figure 16.6a  Toggle Switches on Back of Basic Extender Module 301

Chapter 17

Calibration 305

Figure 17.1a  Scanner Crystal Voltage and Photodiode Voltage 309
Figure 17.1b  Scanner Sensitivity Curve 310
Figure 17.1c  Effect of Nonlinearity and Hysteresis 310
Figure 17.1d  Scanner Voltage and Movement 311
Figure 17.1e  Silicon Calibration Reference 312
Figure 17.2a  0 Degrees Scan Angle 313
Figure 17.3a  Non-Orthogonal and Corrected, Orthogonal Image 314
Figure 17.4a  Fast Scan Linearization: Mag0 317
Figure 17.4b  X Scan Linearization 317
Figure 17.4c  Y Scan Linearization 318
Figure 17.5a  Capture Calibration Prompt 321
Figure 17.5b  Capture Control Prompt 322
Figure 17.5c  Improved Calibration Image 322
Figure 17.6a  X-Y Piezo Calibration Prompt 323
Figure 17.6b  Vertical Calibration Line 324
Figure 17.6c  Calibration Line Distance Prompt 324
<table>
<thead>
<tr>
<th>Chapter 18</th>
<th><strong>Maintenance, Troubleshooting and Warranty</strong></th>
<th>337</th>
</tr>
</thead>
<tbody>
<tr>
<td>Figure 18.1a</td>
<td>Change the Illuminator Bulb</td>
<td>341</td>
</tr>
</tbody>
</table>
List of Figures
Chapter 1  System Overview

The Dimension 3100 Scanning Probe Microscope (SPM) produces high-resolution, three-dimensional images by scanning a sharp tip over the sample surface. The tip is part of a flexible cantilever mounted on one end of a cylindrical piezoelectric tube mounted near the top of the microscope. Voltages applied to the X and Y electrodes on the piezoelectric tube deflect the tube horizontally to produce a precise raster scan over the sample surface. A voltage applied to the Z electrode on the piezo tube controls the vertical height of the tip. A stepper motor coupled to a lead screw translates a slide with the sample attached. A separate motor drive controls the height of the microscope and tip relative to the sample surface.

This manual details facility requirements, installation requirements and procedures, maintenance requirements and procedures, and applications used with the Dimension 3100 Scanning Probe Microscope. This chapter discusses the following:

- **System Overview**: Section 1.1
  - Dimension 3100 SPM Features: Section 1.1.1
- **Control Station Overview**: Section 1.2
  - Input and Display Devices: Section 1.2.1
  - Computer: Section 1.2.2
  - NanoScope IIIa Controller: Section 1.2.3
  - Dimension 3100 Controller: Section 1.2.4
- **Dimension 3100 SPM Overview**: Section 1.3
  - Dimension 3100 Microscope Electronics Box: Section 1.3.1
  - Optics and Motors Overview: Section 1.3.2
  - Stage System: Section 1.3.3
  - Dimension SPM Head: Section 1.3.4
  - Cantilever Holder: Section 1.3.5
  - Video Zoom Microscope: Section 1.3.6
1.1 System Overview

There are two typical configurations of the Dimension 3100 Scanning Probe Microscope (see Chapter 3 for detailed information).

- VT-103-3K with ELCON
- VT-102

The configurations provide options for acoustic and mechanical vibration isolation, as well as various options for positioning control station components. The features outlined below apply to all configurations.

1.1.1 Dimension 3100 SPM Features

**Enhanced Motorized Positioning Stage**

- Inspectable Area 120mm x 100mm
- Resolution: 2µm
- Unidirectional Repeatability: 3µm typical, 10µm maximum
- Bidirectional Repeatability: 4µm for x-axis, 6µm for y-axis typical for point to point motion

**Integrated Dimension 3100 Controller**

The Dimension 3100 controller integrates the illuminator, power supply, and air and vacuum pumps.

**Optical Microscope**

The optical microscope now includes a computer-controlled illuminator for easier optical focusing and zooming.
Video Image Capture Capability

Video image capture capability allows the user to easily incorporate video images into reports and publications.

Computer System

The Dimension 3100 ships with a high quality tower-style Pentium PCI computer system.

1.2 Control Station Overview

The Dimension 3100 SPM control station consists of four components: input and display devices (keyboard, trackball, mouse and monitors), computer, NanoScope controller and Dimension 3100 controller.

1.2.1 Input and Display Devices

Input and display devices include two monitors, a keyboard, mouse, and trackball (see Figure 1.2a). These devices convey information signals to the computer to operate the software and SPM. Depending on the configuration of the system, the input and display devices are located atop the control station table (VT-103-3) or contained within an enclosure (IS3K-3).

CAUTION: The monitors contain a hazardous voltage of 120V.

Figure 1.2a Dimension 3100 Input and Display Equipment
1.2.2 Computer

The computer is the main control unit of the Dimension 3100 SPM system; it supports a 100MB Zip® disc drive, CD-ROM, CDRW, or DVDRW drive and 1.44MB floppy disc drive (see Figure 1.2b). The computer receives data from the input devices, and controls external hardware via the standard ports and the input/output (I/O) bus. The computer isolates the user from direct interaction with the hardware. (See **Dimension 3100 Control Station Connections**: Section 4.4.1 for a complete description of the computer connections).

**Figure 1.2b** Computer (rear view)
1.2.3 NanoScope IIIa Controller

The NanoScope IIIa controller controls the microscope head and scanning. The NanoScope IIIa controller is controlled via a 25-pin D cable connection between the rear of the NanoScope IIIa and the computer (see Figure 1.2c).

The NanoScope IIIa connects to the back of the Dimension 3100 via a 37-pin D cable connection from the front of the controller (see Figure 1.2c).

If you have a Basic or Quadrex Extender, connect it between the NanoScope IIIa controller and the Dimension 3100 microscope.

**Figure 1.2c** NanoScope IIIa Controller (front view)

---

**CAUTION:** The NanoScope controller will overheat if the controller ventilation holes are blocked or if the controller is exposed to heat from an outside source.
1.2.4 Dimension 3100 Controller

The Dimension 3100 controller controls the vacuum and air supply and optics illumination. The Dimension 3100 controller is controlled via a serial cable connection between it and the computer (see Figure 1.2d). The Dimension 3100 controller features gauges on the front panel to indicate vacuum and positive pressures. The Dimension 3100 controller channels positive pressure to the underside of the chuck during X-Y movements, allowing the chuck to glide smoothly over the granite.

**Figure 1.2d** Dimension 3100 Controller (front view)

---

**CAUTION:** Do not turn the Dimension 3100 controller on its side. Turning the controller on its side activates an alarm and turns the vacuum pump off.

**ATTENTION:** Afin d’éviter de sérieux dommages mécaniques, ne tournez pas le boîtier de contrôle sur le côté. Tourner le boîtier sur le côté déclenche une alarme et coupe la pompe à vide.

**VORSICHT:** Um ernsthafe mechanische Beschädigungen zu vermeiden stellen Sie die Dimension Control Box bitte nicht auf die Seite. Dies würde einen Alarm auslösen und die Vakuumpumpe ausschalten.

**CAUTION:** The Dimension controller features a special thermostat that sets off an alarm if the controller overheats (> 40° C). The Dimension controller will overheat if the controller ventilation holes are blocked or if the controller is exposed to heat from an outside source.
The Dimension 3100 controller houses the following components:

**Power Supply**

The power supply is preconfigured at the factory. Verify voltage compatibility before plugging the system into the power source.

**Vacuum and Air Pumps**

The vacuum hose assembly routes vacuum and positive pressure control from the Dimension controller to the stage and chuck.

**Illumination System**

Illumination can be computer or manually controlled. The knob located on the front of the Dimension 3100 controller regulates manual illumination control. For computer control, there is an “illumination” parameter in the Other Controls panel to control brightness. The illuminator control knob must be in the “off” position to allow software control. A fiber optics cable channels light to the Dimension optics.

### 1.3 Dimension 3100 SPM Overview

#### 1.3.1 Dimension 3100 Microscope Electronics Box

The Dimension 3100 Microscope Electronics Box moderates all functions of the microscope, including vacuum and air supply, motor power, optic image signals, microscope control, and stage motor control (see Figure 1.3a). (See Dimension 3100 Microscope External Components Connections: Section 4.4.2 for a complete description of the Electronics Box connections).
Figure 1.3a  D3100 Microscope Electronics Box (rear view)

Note:  Dimension 3100 SPMs equipped with Extender Electronics Module phase attachments utilize a slightly different electronics architecture than standard models. For more information, contact Veeco.

The Dimension 3100 Microscope Electronics Box houses the following components:

Main SPM Circuit Board

This smaller circuit board mounts on a larger board and contains switches to route feedback signals from the head. The photodiode signals combine and amplify in various ways to provide the desired information. The main SPM circuit board also contains the circuits to control the microscope in TappingMode and non-Contact/MFM modes. The RMS detection circuit for the cantilever vibration signal and cantilever oscillation drive circuit are on this board.

Larger SPM Mother Board

This larger circuit board provides local computer control of the SPM electronics, microscope motors and vacuum control.

Two Stepper-motor Drive Board

One stepper-motor drive board operates the Z-stage, focus and zoom motors. The second stepper-motor drive board powers the X-Y stage motors.

Vacuum Power Switch

The vacuum power switch toggles with an ON/OFF control switch for sample vacuum capabilities.
1.3.2 Optics and Motors Overview

The optic system assists you in locating the cantilever and tip relative to the sample. The NanoScope software uses this information to engage the tip on the sample surface at the desired location. The system automatically focuses on most samples by adjusting the SPM height; however, the trackball is available for manual focus control.

The objective mounts on a translational tilt stage. The objective can be translated along the optical axis with a servo motor (focus motor) to adjust the focal point approximately 1.5mm above the cantilever to approximately 3.5mm below. The range of focus below the cantilever allows you to focus on the sample while leaving up to 3.5mm clearance between the tip and sample.

1.3.3 Stage System

The improved Dimension 3100 X-Y stage provides substantially better positioning repeatability (3µm unidirectional and 4-6µm bidirectional) than its predecessor, the Dimension 3000. The stage is more than twice as fast for moving from one location to another. The improved trackball response also makes it easier to locate features of interest for imaging.

The X-Y stage permits micron-scale positioning of samples beneath the tip with a 120mm (X direction) by 100mm (Y direction) travel range. The stage ships with chucks for fully accessible disks up to 8” in diameter.

The Dimension 3100 motorized Z-stage provides accurate, automatic tip engagement and approach. The rigidity of the Z-stage permits low noise and high accuracy imaging. A motorized lead screw drives the Z-stage for coarse approach of the head to the sample. This configuration allows you to image samples of different thicknesses with little difficulty.

1.3.4 Dimension SPM Head

The Dimension SPM head provides accurate imaging of a stationary sample while scanning the integrated detector probe assembly above the sample. The Dimension SPM head allows optical correction of the laser beam path to track the movement of the probe while scanning under the fixed laser beam assembly. The Dimension SPM head is effective in imaging samples too large or heavy to scan by movement of the sample.

Figure 1.3b depicts the optical path of the laser beam inside a Dimension SPM head. The Dimension SPM head places a corrective, tracking lens within the scanner tube to stabilize the laser beam focal point atop the scanning cantilever. This patented technology sharply reduces bowing and attenuation artifacts due to cantilever scanning across the laser beam’s otherwise stationary focal plane.
The Dimension SPM head scans the tip and generates the cantilever deflection or probe feedback signal for the different imaging modes. A quad photodetector detects the beam emitted by the laser diode (1.0 mW max at 670nm) as it reflects off the cantilever. The integrated scanner head consists of the following subassemblies:

**Preamp Board**

The preamp board is located inside the Dimension 3100 SPM microscope head. The preamp board contains a preamplifier circuit for both photodetector signals, a laser diode power supply circuit that regulates the output of the laser, and ±12 volt regulators for the preamp circuit. The voltage regulators include current limiting to protect the circuit. The preamp board is in turn connected to a 21-pin male connector cable plugged into the socket on the front of the stage control electronics box.

**Laser Diode Stage**

A kinematic tilt stage positions the laser beam on the cantilever. The tilt stage consists of the laser diode, collimator, focusing lens, base plate, and the X and Y laser diode adjustment knobs. The X laser diode adjustment knob moves the beam parallel to the major axis of the cantilever substrate. The Y laser diode adjustment knob moves the beam perpendicular to the major axis of the cantilever substrate. The adjustment knobs are described in more detail in Chapter 7.
**Adjustable Detector Mirror**

An adjustable mirror positions the reflected laser spot relative to the four photodetector elements using a kinematic mount and the photodetector mirror adjustment knobs. The photodetector mirror adjustment knobs assist the user in adjusting the position of the mirror to maximize the SUM signal and set the deflection signals.

**Photodetector**

The four elements of the quad photodetector combine to provide different information depending on the operating mode. In all modes the four elements combine to form the SUM signal. The amplified differential signal between the top two elements and the two bottom elements provides a measure of the deflection of the cantilever. This differential signal is used in Contact AFM mode. The differential signal feeds into an RMS converter (or phase module if attached) for TappingMode operation. Similarly, the amplified differential signal between the sum of the two left photodiodes and the sum of the two right photodiodes provides a measure of the torsion in the cantilever and (often used in Lateral Force Microscopy). Figure 1.3c illustrates the arrangement of the photodiode elements in the Dimension 3100 SPM head.

![Quad Photodetector Arrangement](image)

**Beamsplitter and Laser Spot Detector Screen**

The beamsplitter diverts some of the laser light directed towards the photodetector toward the Laser Spot Detector Screen. This screen provides visual indication of the condition of the reflected spot and its orientation relative to the photodetector.

**Scanner Piezo Tube**

Figure 1.3d depicts the electrode configuration used on the scanner piezo tube in the Dimension SPM head. The electrodes are oriented as shown when viewing the Dimension 3100 SPM from the front. With the Scan angle parameter in the control panel set to 0.00, the fast-scan direction is parallel to the front or in the direction of the X-axis.
The end of the scanner allows easy removal of the imaging probe assembly. This permits loading the tip on a separate fixture such that head removal becomes unnecessary.

Table 1.3a  Scanner Piezo Tube Specifications

<table>
<thead>
<tr>
<th>Specification</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Travel (approximate scan size)</td>
<td></td>
</tr>
<tr>
<td>x-axis</td>
<td>90µm</td>
</tr>
<tr>
<td>y-axis</td>
<td>90µm</td>
</tr>
<tr>
<td>z-axis</td>
<td>6µm</td>
</tr>
<tr>
<td>Electronic Resolution</td>
<td>16-bit (all axes)</td>
</tr>
<tr>
<td>Accuracy</td>
<td></td>
</tr>
<tr>
<td>typical</td>
<td>1%</td>
</tr>
<tr>
<td>maximum</td>
<td>2%</td>
</tr>
<tr>
<td>Orthogonality</td>
<td>2 degrees</td>
</tr>
<tr>
<td>Uncorrected Z bow</td>
<td></td>
</tr>
<tr>
<td>90µm scan size</td>
<td>50nm</td>
</tr>
<tr>
<td>10µm scan size</td>
<td>2nm</td>
</tr>
</tbody>
</table>
1.3.5 Cantilever Holder

The cantilever holder is a small printed circuit card or acrylic block that holds the cantilever firmly at the proper angle. The standard cantilever holder is used for operation in air, while a clear glass cantilever holder is used for fluid cell operations. The standard cantilever holder includes the cantilever piezoelectric stack and the electrical contacts to the drive circuits. The fluid cell cantilever holder does not contain a piezoelectric resonator locally. Cantilever holders include gold-plated spring sockets which mate with the gold-plated pins at the end of the scanner. There is also a spring-loaded clip to secure the cantilever probe to the cantilever holder assembly.

You can easily change the cantilever holder on the microscope for different operating modes (see Table 1.3b). The standard cantilever holder shown in Figure 1.3e contains a piezoelectric stack to oscillate the cantilever when operating in TappingMode. The same cantilever holder is used for Contact AFM but no voltage is applied to the piezo stack.

The fluid cell cantilever holder shown in Figure 1.3f provides an optically transparent cover over the back of the cantilever to maintain the optical path of the laser beam constant when the tip is submerged in a fluid medium. If the fluid medium was not covered by the fluid cell, imaging with the tip submerged in fluid would be impossible due to variable surface scattering effects. These effects cause the reflected laser beam to move randomly during imaging, rendering the reflected signal useless for SPM imaging.
Table 1.3b  Cantilever Holder Specifications

<table>
<thead>
<tr>
<th>Holders</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard</td>
<td>Tapping Mode, Contact AFM, MFM</td>
</tr>
<tr>
<td>Optional</td>
<td>STM and Force Modulation</td>
</tr>
<tr>
<td>Fluid Cell</td>
<td>Fluid Contact AFM, Fluid Tapping Mode</td>
</tr>
</tbody>
</table>

Figure 1.3f  Fluid Cell Cantilever Holder

1.3.6  Video Zoom Microscope

The integrated zoom optical microscope features:

- 10x objective (long working distance)
- 2X TV camera tube
- Motorized zoom system
- 410-1845 x magnification range with 13-inch monitor and corresponding field of view of 180—810 µm
- Motorized focus
• Through-the-lens illumination
• Color video camera
• Focus tracking and automated engagement

1.4 Sample Size & Handling

Samples may be up to 8 inches in diameter and 0.5-inch thick using a multipurpose, 8-inch chuck. For samples thicker than 0.5", contact Veeco.

Table 1.4a Sample Specifications

<table>
<thead>
<tr>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max Sample Size</td>
</tr>
<tr>
<td>Wafers and disk media: 8-inch dia. x 0.5&quot; thick.</td>
</tr>
<tr>
<td>Inspectable Area</td>
</tr>
<tr>
<td>100mm x 125mm typical</td>
</tr>
<tr>
<td>Includes interchangeable adapters for centering hard disks and removable wafer locating pins. Vacuum pump included.</td>
</tr>
<tr>
<td>Small Samples</td>
</tr>
<tr>
<td>Magnetic holder available for mounting small samples on mounting pucks (&lt; 15 mm dia. typ.).</td>
</tr>
<tr>
<td>Silicon Wafers</td>
</tr>
<tr>
<td>Silicon-dioxide-coated chuck accommodates 2-inch, 100, 125, 150 and 200 mm wafers.</td>
</tr>
<tr>
<td>Wet Samples</td>
</tr>
<tr>
<td>Optional fluid cell allows immersion of microscope head to max depth of 2 mm.</td>
</tr>
<tr>
<td>Chuck Vacuum</td>
</tr>
<tr>
<td>The chuck vacuum pneumatics secure samples to the chuck using a separate toggle switch at the front of the stage control electronics box.</td>
</tr>
</tbody>
</table>
1.5 Facilities Specifications

Compliance with the requirements and specifications outlined in Chapter 3 is essential before installation and operation of the Dimension 3100 SPM. Chapter 3 details facility site requirements, safety requirements, and configuration options for the Dimension 3100 SPM.

1.6 Applications

Several applications can be applied using the Dimension 3100 SPM. For specific information regarding these applications, please refer to the appropriate chapters in this manual. The following is a list of common applications used with the Dimension 3100 SPM:

- Contact AFM
- Contact AFM in Fluids
- TappingMode
- TappingMode in Fluids
- Lateral Force Mode
- Force Imaging
- Interleave Scanning
- Magnetic Force Imaging
- Electric Techniques
- Calibration

1.7 Maintenance and Troubleshooting

Refer to Chapter 18 for detailed information regarding maintenance and troubleshooting issues for the Dimension 3100 SPM.
This chapter details the safety requirements involved in installation of the Dimension 3100 Scanning Probe Microscope. Specifically, these safety requirements include safety precautions, environmental conditions, and equipment safety applications. Training and compliance with all safety requirements is essential during installation and operation of the Dimension 3100 SPM.

Specifically, this chapter discusses the following areas of information:

- **Safety Requirements**: Section 2.1
- **Safety Precautions**: Section 2.2
  - **General Operator Safety**: Section 2.2.1
  - **Microscope**: Section 2.2.2
  - **Sample Safeguards**: Section 2.2.3
- **Ergonomics**: Section 2.3
- **Environmental Conditions**: Section 2.4
- **Equipment Safety Applications**: Section 2.5
  - **Dimension 3100 SPM Facility Requirements**: Section 2.5.1
- **Power-up Sequence (Installation and Service Only)**: Section 2.6
  - **Pre Power-up Checklist**: Section 2.6.1
  - **Turn on the Dimension 3100 SPM (Service and Installation Only)**: Section 2.6.2
  - **Power-up Checklist (Service and Installation Only)**: Section 2.6.3
- **Power-Up Sequence (Normal Usage)**: Section 2.7
  - **Prepare the System for Power-up (Normal Usage)**: Section 2.7.1
  - **Power-up Checklist (Normal Usage)**: Section 2.7.2
Safety

- **Software Power-up**: Section 2.8
  - Log into Windows NT: Section 2.8.1
  - Log On: Section 2.8.2
  - Start the NanoScope Software: Section 2.8.3
  - Select Realtime: Section 2.8.4
  - Begin Stage Initialization: Section 2.8.5
  - Software Power-up Checklist: Section 2.8.6
- **Hazard Labels**: Section 2.9
  - Laser Warning Labels: Section 2.9.1
### 2.1 Safety Requirements

#### Figure 2.1a  Safety Symbols Key

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Safety Symbol" /></td>
<td>This symbol identifies conditions or practices that could result in damage to the equipment or other property, and in extreme cases, possible personal injury. Ce symbole indique des conditions d'emploi ou des actions pouvant endommager les équipements ou accessoires, et qui, dans les cas extrêmes, peuvent conduire à des dommages corporels. Dieses Symbol beschreibt Zustände oder Handlungen die das Gerät oder andere Gegenstände beschädigen können und in Extremfällen zu Verletzungen führen können.</td>
</tr>
<tr>
<td><img src="image" alt="Safety Symbol" /></td>
<td>This symbol identifies conditions or practices that involve potential electric shock hazard. Ce symbole indique des conditions d'emploi ou des actions comportant un risque de choc électrique. Dieses Symbol beschreibt Zustände oder Handlungen, die einen elektrischen Schock verursachen können.</td>
</tr>
<tr>
<td><img src="image" alt="Safety Symbol" /></td>
<td>This symbol identifies a laser hazard. Exposure could result in eye damage. Ce symbole indique un risque lié à un laser. Une exposition à ce laser peut entraîner des blessures aux yeux. Dieses Symbol bedeutet “Gefährliche Laserstrahlung”. Laserstrahlung kann zu Beschädigung der Augen führen.</td>
</tr>
<tr>
<td><img src="image" alt="Safety Symbol" /></td>
<td>This symbol identifies a thermal hazard. Touching could result in skin burns upon contact. Ce symbole indique un risque lié à de hautes températures. Un contact peut entraîner des brûlures de la peau. Dieses Symbol bedeutet “Heiße Oberfläche”. Berührung kann zu Hautverbrennungen führen.</td>
</tr>
<tr>
<td><img src="image" alt="Safety Symbol" /></td>
<td>This symbol identifies a mechanical crushing hazard. Moving parts can result in serious injury to hands or fingers. Ce symbole indique un risque d'écrasement. Déplacer des pièces de l'appareil peut entraîner des blessures sévères des mains ou des doigts. Dieses Zeichen bedeutet “Quetschungsgefahr durch mechanisch bewegte Teile”. Bewegliche Teile können zu erheblichen Quetschverletzungen von Fingern oder Händen führen.</td>
</tr>
<tr>
<td><img src="image" alt="Safety Symbol" /></td>
<td>This symbol identifies a heavy object. Improper lifting can cause muscle strain or back injury. Ce symbole indique un objet lourd. Soulever cet objet de façon incorrecte peut entraîner des frottements musculaires ou des problèmes de dos. Dieses Symbol identifiziert ein schweres Objekt. Falsches Anheben kann Muskelzerrungen und Rückenverletzungen verursachen.</td>
</tr>
<tr>
<td><img src="image" alt="Safety Symbol" /></td>
<td>This symbol identifies a corrosive material hazard. Corrosive material can cause serious damage to the equipment. Ce symbole indique un risque de la matière corrosive. La matière corrosive peut causer des dommages sérieux au matériel. Dieses Symbol bedeutet “Gefahr durch Korrosive Materialien”. Korrosive Materialien können erhebliche Schäden am Gerät oder anderen Gegenständen verursachen.</td>
</tr>
</tbody>
</table>
2.2 Safety Precautions

Because the Dimension 3100 SPM features independently motorized components, it is crucial that operators become familiar with precautions to avoid injury to themselves and/or damage to samples. This section of the manual should be read by ALL persons working with or around the system.

2.2.1 General Operator Safety

| WARNING: | Service and adjustments should be performed only by qualified personnel who are aware of the hazards involved. |
| AVERTISSEMENT: | Tout entretien ou réparation doit être effectué par des personnes qualifiées et conscientes des dangers qui peuvent y être associés. |
| WARNUNG: | Service- und Einstellarbeiten sollten nur von qualifizierten Personen, die sich der auftretenden Gefahren bewußt sind, durchgeführt werden. |

| WARNING: | Follow company and government safety regulations. Keep unauthorized personnel out of the area when working on equipment. |
| AVERTISSEMENT: | Il est impératif de suivre les prérogatives imposées tant au niveau gouvernemental qu’au niveau des entreprises. Les personnes non autorisées ne peuvent rester près du système lorsque celui-ci fonctionne. |
| WARNUNG: | Befolgen Sie die gesetzlichen Sicherheitsbestimmungen Ihres Landes. Halten Sie nicht autorisierte Personen während des Betriebs vom Gerät fern. |
CAUTION: Please contact Veeco before attempting to move the Dimension 3100 SPM system.

ATTENTION: Il est impératif de contacter Veeco avant de déplacer le Dimension 3100 SPM.

VORSICHT: Bitte kontaktieren Sie Veeco bevor Sie das Dimension 3100 SPM System transportieren.

WARNING: Voltages supplied to and within certain areas of the system are potentially dangerous and can cause injury to personnel. Power-down all components and unplug from power sources before doing any electrical servicing. (Veeco service personnel, only).

AVERTISSEMENT: Les tensions utilisées dans le système sont potentiellement dangeureuses et peuvent blesser les utilisateurs. Avant toute intervention électrique, ne pas oublier de débrancher le système. (Réservé au personnel de Veeco, seulement.)


WARNING: Never alter pneumatics or wiring on the Dimension 3100 SPM.

AVERTISSEMENT: Ne jamais toucher les cables et l'installation pneumatique sur le boîtier accoustique du Dimension 3100.

WARNUNG: Ändern Sie niemals etwas am pneumatischen System oder der Verdrahtung der Schallschutzhube.
WARNING: The Dimension 3100 SPM contains a diode laser with an output of less than 1.0mW at 670nm.

AVERTISSEMENT: Le microscope “Dimension 3100 SPM” est équipé d’une diode laser dont la puissance de sortie est inférieure à 1mW à 670nm.

WARNUNG: Das Dimension 3100 SPM ist mit einem Halbleiterlaser ausgerüstet, dessen Ausgangsleistung kleiner ist als 1.0mW bei 670nm.

WARNING: Do not use acetone to clean the Dimension 3100 SPM.

AVERTISSEMENT: Ne pas utiliser d'acétone pour nettoyer le Dimension 3100 SPM.

WARNUNG: Bitte verwenden sie kein Azeton um das Dimension 3100 SPM zu reinigen.
2.2.2 Microscope

To avoid operator injury and equipment damage, observe the following cautions regarding the Dimension 3100 microscope.

**CAUTION:** If you use the equipment in a manner not specified by the manufacturer, you can impair the protection provided by the instrument.
CAUTION: Stage microscopes feature an automated X-Y stage and Z-axis capable of programmed movement. The movements of all axes are slow, but are capable of exerting high forces. A hand caught in the stage of a Dimension 3100 SPM could be injured severely.

ATTENTION: La platine des microscopes est automatisée dans les directions X, Y et Z, et est programmable. Les mouvements selon ces 3 axes sont lents, but peuvent excercer des forces importantes. La main d’un utilisateur pourrait être sévèrement endommagée si elle se trouvait coincée par cette platine.


WARNING: The internal electronics of the microscope, controllers, and peripheral equipment feature high-voltage components. Because there are no user-serviceable parts, do not attempt system repairs. Disconnect faulty components and ship them to Veeco for repair or replacement.


### WARNING:
Do not attempt repairs on electrical components. If it is necessary to enter the electrical chassis for any reason (e.g., to replace a computer card), power-down the entire system and disconnect it from its power source.

### AVERTISSEMENT:
Ne pas essayer de réparer les parties électroniques. Si il est nécessaire d’accéder au boitier électronique (pour remplacer une carte dans l’ordinateur par exemple), éteindre tout le système et le déconnecter.

### WARNUNG:
Versuchen Sie nicht, elektrische Komponenten selbst zu reparieren. Falls es aus irgend einem Grund notwendig sein sollte, ein Gehäuse mit elektrischen Bauteilen zu öffnen (z.B., um eine Computer-Karte auszutauschen), schalten Sie das gesamte System ab, und trennen Sie es von der Spannungsquelle.

### CAUTION:
Avoid spilling fluids onto the microscope stage or into electrical assemblies, particularly the SPM head. If it is necessary to use fluids, apply only small amounts as needed.

### ATTENTION:
Eviter d’éclabousser la platine du microscope et les assemblages électriques, en particulier la tête du microscope. Si il est nécessaire d’utiliser des liquides, ne les employer qu’en faibles quantités.

### VORSICHT:
2.2.3 Sample Safeguards

| CAUTION: | Do not change samples in the middle of operation. Verify that the stage is clear of tools, objects, and debris at all times. Use alcohol wipes periodically to keep the stage clean of dust. Dispose of wipes in an appropriately labelled solvent-contaminated waste container. |
| ATTENTION: | Ne pas changer d’échantillon en cours d’utilisation. Vérifier que la platine n’est pas encombrée, par des outils par exemple. Employer des tampons d’alcool régulièrement pour dépoissière la platine. |

| CAUTION: | All interlocks are provided to ensure operator and sample safety. **Do not** attempt to bypass interlocks. |
| ATTENTION: | Tous les interlocks sont fournis pour assurer toute sécurité à l’utilisateur. **Ne pas** essayer de ne pas les employer. |

2.3 Ergonomics

The Dimension 3100 SPM design promotes compatibility in the integration of user personnel and equipment within a semiconductor manufacturing environment. Specifically, the ergonomics of the Dimension 3100 SPM design prevent personal injury, equipment damage, and minimizes procedural errors.
2.4 Environmental Conditions

Environmental conditions that may affect the performance of the Dimension 3100 SPM are vibration and noise. See Chapter 3 for detailed condition specifications.

2.5 Equipment Safety Applications

2.5.1 Dimension 3100 SPM Facility Requirements

Figure 2.5a Dimension 3100 SPM Footprint

2.6 Power-up Sequence (Installation and Service Only)

The following section is required only during installation or after servicing and should NOT be used by untrained personnel. For a description of normal power-up procedures, see Section 2.7.
2.6.1 Pre Power-up Checklist

**CAUTION:** You must complete the pre power-up checklist before proceeding with facilities connections and the power-up procedure.

**ATTENTION:** Vous devez effectuer une checklist pour vérifier la mise sous tension avant de mettre en place les connections et commencer la procédure de mise sous tension.

**VORSICHT:** Gehen Sie durch die folgende Checkliste („Pre-Power-up Checklist“), bevor Sie Verbindungen zum Netzanschluß und zu den Versorgungsleitungen herstellen und das System einschalten.

### Pre-Installation

1. Verify that there is a minimum installation space of 10′ (~305 cm) wide x 7.5′ (~230 cm) deep.

   **Note:** Refer to Chapter 3 for facilities requirements specific to the various Dimension 3100 configurations.

2. Verify that AC power (100V, 120V, 220V-240V single phase) is available to the system.

3. Verify the power disconnection device is easily located.

4. Verify that clean dry air is available at 60-100 psi to the vibration isolation table.

5. Verify that vacuum is available at ≥24″ Hg to the system (IS3K-2 acoustic hood only). A vacuum pump is integrated into the Dimension 3100 controller for use with enclosures other than the IS3K-2.

### Module Installation

1. Uncrate the Dimension 3100 SPM system components.

2. Verify all facilities requirements outlined in Chapter 3 are met.

3. Install the Dimension 3100 SPM by completing the following:
   - Set the vibration isolation table or microscope platform in place.
   - Transition the Dimension 3100 SPM to the final operating location.
   - Secure the chuck base and stage.
4. Install the control station by completing the following:
   - Set the table to be used as the control station next to the Dimension 3100 SPM.
   - Place the input and display devices on the user console (monitors [2], mouse, keyboard and trackball).
   - Place the computer and controllers on the control station.

Connections

| CAUTION: | Make sure to power-down all systems at this point to ensure that there is no risk of electrical shock. |
| ATTENTION: | Vérifiez que tous les systèmes ne soient plus sous tension à ce moment, et assurez vous qu’il n’y a pas de risque de choc électrique. |
| VORSICHT: | Überzeugen Sie sich, daß zu diesem Zeitpunkt alle Geräte ausgeschaltet sind, um die Gefahr eines elektrischen Schocks auszuschließen. |

1. Connect the control station extensions.
   - Computer AC power cable to power strip
   - Monitor power cables (2) to power strip
   - Monitor video cable to computer
   - Keyboard to computer
   - Mouse to computer
   - Trackball to computer

2. Connect the Dimension 3100 SPM unit extensions.
   - Serial cable (12’) from computer to Dimension 3100 SPM back panel
   - BNC cable from computer to Dimension 3100 SPM back panel
   - RJ45 LAN cable from computer to host
   - Serial cable (6’) from computer to Dimension 3100 controller
   - 37-pin D cable from NanoScope controller to Dimension 3100 back panel. (the Basic Extender and Quadrex connect between Nanoscope controller and D3100.)
   - Vacuum hose assembly from Dimension 3100 controller to Dimension 3100 SPM back panel
Safety
Power-up Sequence (Installation and Service Only)

______ 25-pin D cable from computer to NanoScope controller
______ NanoScope controller AC power cable to power strip
______ DC power cable from Dimension 3100 controller to Dimension 3100 SPM back panel
______ Fiber optic cable from Dimension 3100 controller to Dimension 3100 SPM objective

Final Installation

CAUTION: The objective, Dimension head, and vacuum sample chuck should be the final equipment installed due to the sensitive nature of these components.

ATTENTION: L’objectif, la tête du Dimension and la platine porte-échantillon devraient être installés en dernier, à cause de leur fragilité.

VORSICHT: Das Objektiv, der Mikroskopkopf und der Vakuumprobenhalter sind empfindliche Komponenten des Dimension SPMs, und sollten als letztes installiert werden.

______ 1. Install the objective.
______ 2. Install the Dimension head.
______ 3. Mount the vacuum sample chuck.

2.6.2 Turn on the Dimension 3100 SPM (Service and Installation Only)

1. Verify that all system components are plugged into AC power with the correct voltage.

2. Verify that all cables are connected properly.

3. Turn on the computer using the push-button switch located on the front of the computer.

4. Turn on the monitors (2) using the push-button switches located on the front of the monitors.

5. Turn on the NanoScope controller using the power switch located on the rear of the NanoScope controller.

6. Turn on the Dimension 3100 controller using the power switch on the rear of the Dimension 3100 controller.
2.6.3 Power-up Checklist (Service and Installation Only)

Power-up (Installation Only)

1. Connect the facilities.
   
   Vacuum (VAC): ≥24”Hg (IS3K acoustic hood only)
   
   Clean dry air (CDA): 60-100psi

2. Verify that all system components are plugged into AC power with the correct voltage.

3. Verify that all cables are connected properly.

4. Verify that the computer, controllers, and monitors turn on simultaneously.

2.7 Power-Up Sequence (Normal Usage)

2.7.1 Prepare the System for Power-up (Normal Usage)

1. Verify that all system components are plugged into AC power with the correct voltage.

2. Verify that all moving parts are free of obstructions.

3. Verify that all cables are connected properly.

4. Turn on the computer using the push-button switch located on the front of the computer.

5. Turn on the monitors (2) using the push-button switches located on the front of the monitors.

6. Turn on the NanoScope controller using the power switch located on the rear of the NanoScope controller.

7. Turn on the Dimension 3100 controller using the power switch on the rear of the Dimension 3100 controller.
2.7.2 Power-up Checklist (Normal Usage)

Power-up (Normal Usage)

1. Verify that all system components are plugged into AC power with the correct voltage.
2. Verify that all moving parts are free of obstructions.
3. Verify that all cables are connected properly.
4. Verify that the computer, controllers, and monitors turn on simultaneously.

2.8 Software Power-up

CAUTION: At this time, all pre power-up and power-up instructions must be completed before continuing.

ATTENTION: A ce moment, toutes les étapes avant la mise en tension et de mise en tension doivent être effectuées avant de continuer.

VORSICHT: An dieser Stelle müssen die „Pre Power-up“ und „Power-up“ Checklisten komplett sein, bevor Sie fortfahren.

2.8.1 Log into Windows NT

1. Press **CTRL-ALT-DELETE** to log into Windows NT (see Figure 2.8a).

   **Note:** The screen begins with the panel split across both screens.

2. Drag the panel to one screen for use (see Figure 2.8a).
2.8.2 Log On

In the Logon Information window, enter the default settings into the User Name and Password fields (see Figure 2.8b).

1. **User Name**: NANOSCOPE

2. **Password**: (Leave blank)

**Note**: If you are unable to log on, verify with the process engineer that the password has not been changed. The system is shipped from the factory with a blank password.
2.8.3 Start the NanoScope Software

Go to the desktop and click on the NanoScope icon or select the D:\SPM\z.exe file to start the NanoScope software (see Figure 2.8c).

2.8.4 Select Realtime

Click the Realtime icon, or select Realtime from the DI menu (see Figure 2.8d). The system automatically initializes for approximately one minute.

The stage may need to be initialized any time the system or one of its components has been powered-down. This allows the stage controller and computer to locate home positions and reset the coordinate system of the stage. If the Focus Surface and Locate Tip icons are grayed out, the stage needs to be initialized.
2.8.5 Begin Stage Initialization

- Select Stage > Initialize.

**Note:** Various axes of motion move to home positions (Zoom, Focus, and Z axes) during initialization. The control screen displays a status panel to guide the user through the initialization process (see Figure 2.8e).

![Figure 2.8e Status Panel](image)

2.8.6 Software Power-up Checklist

_____ 1. Press CTRL-ALT-DELETE.

_____ 2. Log on using your user name and password.

_____ 3. Start the NanoScope software.

_____ 4. Select Realtime.

_____ 5. Begin stage initialization if necessary.

2.9 Hazard Labels

The Dimension 3100 SPM hazard labeling system identifies possible hazard areas. Caution must be taken according to the label warnings when working with associated areas. The following labels appear on the Dimension 3100 SPM:
2.9.1 Laser Warning Labels

Laser Explanatory Label

The Laser Explanatory Label (see Figure 2.9a) indicates that the area to which the label is affixed is affected by a laser. The Laser Explanatory Label is affixed on the Dimension SPM head.

![Figure 2.9a Laser Explanatory Label](image)

Laser Warning Label

The Laser Warning Label (see Figure 2.9b) indicates that the area to which the label is affixed is affected by a laser. The Laser Warning Label is affixed on the Dimension SPM head.

![Figure 2.9b Laser Warning Label](image)

Noninterlocked Protective Housing Label

The Noninterlocked Protective Housing Label (see Figure 2.9c) indicates that the area to which the label is affixed is affected by a laser. The Noninterlocked Protective Housing Label is affixed to the manual access door.

![Figure 2.9c Noninterlocked Protective Housing Label](image)
Chapter 3   Facilities Requirements

This chapter details facility site requirements, safety requirements, and configuration options for the Dimension 3100 Scanning Probe Microscope. Specifically, this chapter details environmental requirements and equipment facilities drawings. Compliance with the following requirements and specifications is essential before beginning installation.

- **Optional Configurations**: Section 3.1
  - VT-103-3K with ELCON: Section 3.1.1
  - VT-102: Section 3.1.2
  - IS3K-2: Section 3.1.3

- **Facilities Requirements**: Section 3.2

- **Acoustic/Vibration Isolation Systems**: Section 3.3
  - IS3K-2 Dimensions, Utilities, and Clearance: Section 3.3.1
  - VT-103-3K Dimensions, Utilities and Clearance: Section 3.3.2
  - VT-102 Dimensions and Utilities: Section 3.3.3
  - Computer/Controller Facility Requirements: Section 3.3.4
  - ELCON Console: Section 3.3.5

- **Facilities Requirements Summary**: Section 3.4

- **Acoustic/Vibration Specifications**: Section 3.5

- **General Facilities Guidelines**: Section 3.6
3.1 Optional Configurations

The following are typical configurations for the Dimension 3100 Scanning Probe Microscope, detailing options for acoustic and mechanical vibration isolation, as well as various options for positioning the control station (computer, control electronics, and accessories). Facilities requirements depend on what type of configuration is used.

3.1.1 VT-103-3K with ELCON

This configuration has two basic elements: the VT-103-3K, which is an integrated air table and acoustic hood for vibration isolation, and the ELCON (electronics console) which is an optional small footprint/compact console (see Figure 3.1a). The VT-103-3K is comprised of an air table, on which the Dimension 3100 microscope rests (not shown) and an acoustic hood which can be raised to access the instrument, and lowered to seal the instrument during operation. The ELCON is a compact control station console used to house the computer and control electronics underneath, and the monitors, mouse and keyboard on top. The VT-103-3K and the ELCON do not require one another and can be used independently.

Figure 3.1a  VT-103-3K with ELCON
3.1.2 VT-102

This configuration consists of two basic elements: the VT-102 which is an air table for vibration isolation, and a typical "table top" version of the control station (computer, control electronics, and accessories). The VT-102 is a compact air table on which the Dimension 3100 microscope rests and does not include an acoustic hood. Figure 3.1b illustrates the "table top" version of the control station in one of many possible configurations used to position the control station elements. This configuration includes the two electronics boxes stacked atop each other on the far right of the table; the tower computer placed next to them on the table top; and the monitors (2), keyboard, and mouse located on the far left. There are many ways to station the equipment, including placing the electronics boxes on the floor or underneath the monitors, or placing computer on the floor, which may save some space and change the facilities requirements.

Figure 3.1b  VT-102
3.1.3 IS3K-2

This configuration is comprised of one basic element, the IS3K-2. The IS3K-2 is an ultra compact/small footprint console containing the control station, the microscope, and an integrated vibration isolation and acoustic enclosure (see Figure 3.1c). This setup consists of the following: two control boxes and a rack mount computer mounted underneath the console and between the table legs. The monitors are flat panel displays and mount on the top of the acoustic hood with adjustable arm attachments. The keyboard and mouse (not shown) sit on the small ledge at the front of the instrument. Finally, the Dimension 3100 microscope (not shown) rests on top of the vibration isolation table inside the IS3K-2 acoustic hood. The entire acoustic hood can raise and lower during installation. For general operation, the microscope is accessed via the small door on the front of the acoustic hood. Although the IS3K-2 is extremely compact (ideal for clean rooms), this configuration has limited working space and may require an extra table for sample preparation and cantilever installation.
3.2 Facilities Requirements

Weight: 150 lbs. for Dimension 3100 SPM assembly only.

**Note:** Vibration and acoustic isolation is strongly recommended (see Section 3.5).
3.3 Acoustic/Vibration Isolation Systems

3.3.1 IS3K-2 Dimensions, Utilities, and Clearance

The IS3K-2 is painted with cardinal paint 6400 series. The system does not outgas. An all stainless version of the IS3K-2 is available as a special order for an additional cost.

An appropriate seat should be used which brings the user’s knees to within 3-4 inches (76-102mm) of the bottom of the keyboard tray.

Figure 3.3a IS3K-2 - Front View
Facilities Requirements
Acoustic/Vibration Isolation Systems

Figure 3.3d  IS3K-2 Leveling Feet Location - Bottom View

Figure 3.3e  IS3K-2 Footprint Requirements - Top View
3.3.2 VT-103-3K Dimensions, Utilities and Clearance

An isolation hood/table is required for acoustic and vibration isolation of the Dimension 3100. The table must be moved to its final location before Veeco personnel can install and train on the SPM.

**Figure 3.3f** VT-103-3K - Front View

**Figure 3.3g** VT-103-3K - Side View with Acoustic Hood Open and Closed
3.3.3 VT-102 Dimensions and Utilities

The vibration isolation table may be supplied in lieu of the VT-103-3K or IS3K-2 for selected applications that do not require acoustic isolation for the desired performance level. The table must be moved to its final location before Veeco personnel can install and train on the SPM.

Figure 3.3i  VT-102 Vibration Isolation Table
3.3.4 Computer/Controller Facility Requirements

The IS3K-2 allows placement of the computer/controller within the framework of the unit. No additional footprint is required.

Customer must supply computer and controller table or order the optional Elcon console for enclosure.

Figure 3.3j  SPM Control Electronics Footprint

Weight: 170 lbs. nominal total; 140 typically on table top.

Note: Dimensions shown for computer and controller equipment are approximate and subject to change without notice.
3.3.5 ELCON Console

The ELCON Console is available as an option for the computer/controller enclosure.

**Figure 3.3k** Optional ELCON Console

Elcon:
- Weight: 400 lbs. (includes all electronics)
- Power: 1,800W; 1 phase; 100V, 120V or 240V
- Min. Door width required: 36"
3.4 Facilities Requirements Summary

If the Dimension 3100 system is used in a clean room with raised floors a pedestal must be provided to support leveling feet on the IS3K-2 or VT-103-3K. House vacuum is optional in all cases. If used, connections should accept a 1/8” or 1/4” male NPT fitting or 170 ID x .250 OD flexible house.

Note: The following summary does not include computer/controller or optional elcon console enclosure requirements.

Table 3.4a Dimension 3100 Facilities Requirements Summary

<table>
<thead>
<tr>
<th>Utility With</th>
<th>Dimension 3100 with VT-103-3K Hood/Table</th>
<th>Dimension 3100 with IS3K-2 Hood/Table</th>
<th>Dimension 3100 with VT-102 Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Electrical</td>
<td>1,800W; single phase; 100V, 120V or 240V duplex outlet; dedicated circuit, 50/60Hz</td>
<td>1,800W; single phase; 100V, 120V or 240V duplex outlet; dedicated circuit, 50/60Hz</td>
<td>1,800W; single phase; 100V, 120V or 240V duplex outlet; dedicated circuit, 50/60Hz</td>
</tr>
<tr>
<td>Disconnect or Shutoff</td>
<td>None required</td>
<td>None required</td>
<td>None required</td>
</tr>
<tr>
<td>Clean Dry Air for Sample Chuck</td>
<td>Supplied with Dimension 3100 by air and vacuum supply module</td>
<td>Supplied with Dimension 3100 by air and vacuum supply module</td>
<td>Supplied with Dimension 3100 by air and vacuum supply module</td>
</tr>
<tr>
<td>Clean Dry Air for Air Table</td>
<td>Requires user supplied air 60-80 PSI, 1 CFM^2</td>
<td>None required</td>
<td>Requires user supplied air 60-80 PSI, 1 CFM^2</td>
</tr>
<tr>
<td>Vacuum for Sample Holdown</td>
<td>Supplied with Dimension 3100 or house vacuum -25in. Hg^2</td>
<td>Supplied with Dimension 3100 (ext. vac. supply module) or house vac. -25 in. Hg^2</td>
<td>Supplied with Dimension 3100 or house vacuum -25in. Hg^2</td>
</tr>
<tr>
<td>Exhaust</td>
<td>None required</td>
<td>None required</td>
<td>None required</td>
</tr>
<tr>
<td>Lan Connection</td>
<td>None required but network support card included</td>
<td>None required but network support card is included</td>
<td>None required but network support card is included</td>
</tr>
<tr>
<td>Approximate Footprints</td>
<td>36” x 33.0”</td>
<td>30.5” x 42.0”</td>
<td>23.0” x 23.0”</td>
</tr>
<tr>
<td>Hood and Table Including SPM</td>
<td>1,100 pounds evenly distributed</td>
<td>1,200 pounds (including computer/controller)</td>
<td>750 pounds evenly distributed</td>
</tr>
<tr>
<td>Min. Door Width</td>
<td>36” minimum</td>
<td>32” minimum</td>
<td>26” minimum</td>
</tr>
</tbody>
</table>
3.5 Acoustic/Vibration Specifications

The following conditions must be met in order to achieve 0.5 angstrom RMS noise specifications:

- Acoustic: Acoustic noise should not exceed 75dBC (Note “C” weighting).
- Vibration: Vibration of the SPM mounting surface should not exceed VC-D in any direction, vertical or horizontal.

Figure 3.5a Vibration Criteria Plot

BBN Criterion A - Probe Test Equipment, 100X Microscopes
BBN Criterion B - 500X Microscopes, Aligners, Steppers to 5um Geometries
BBN Criterion C - 1000X Microscopes, Aligners, Steppers to 1.5um Geometries
BBN Criterion D - Steppers, E-Beams to 0.3um Geometries, CD Inspection Equipment. Most SEMs to 50,000X
BBN Criterion E - Anticipated Adequate for Future Fabrication and Test Equipment for Low Submicron Geometries
3.6 General Facilities Guidelines

The following list contains general facilities recommendations for the Dimension 3100 system:

- For the VT-103-3K and VT-102 vibration isolation systems, you must provide either clean dry air or nitrogen with a pressure capacity of 80psi in order to float the air tables. You must provide the regulator for adjusting the pressure from the source. The source can be either a house air system or a tank.

- Do not mount PA/Paging speakers near the AFM. If a speaker is required use a local volume control instead.

- Keep the telephone ringer on low and install the telephone away from the AFM. Or, turn the telephone ringer off and install a flashing light as a substitute ringer.

- Do not install fluorescent lighting with switching ballasts (also referred to as electronic ballasts). Standard high efficiency ballasts are fine.

- Install baffling in the air ducts to reduce the hissing from the HVAC system or use non-powered HEPA filters. This type of filtering is called Class M7 or 245,000. An in-line fan is installed upstream to provide pressure for the HEPA filter. If installing locally powered HEPA fans, a local on/off switch is needed to turn the fans off while images are captured.

- Add insulation to all walls. If possible, all walls should be hard walls as opposed to temporary walls. Installing insulation in the ceiling helps to damper the acoustic noise from the roof.

- Temperature is standard laboratory setting +/- 2.5° F.

- Humidity is standard laboratory setting +/- 10% RH.

- Power should be in dedicated 115 volt standard duplex outlet (15 amp).

- Clean Dry Air (CDA) is required with a recommended connection of 0.25-inch poly-flow tubing with a range of 0-100 PSI.

- Customer installed house vacuum and vacuum wand is recommended for wafer loading and unloading.

- Customer installed nitrogen is recommended for the blow-off nozzle.
Chapter 4  Installation

This chapter details the installation procedure for the Dimension 3100 Scanning Probe Microscope (SPM) system from receiving to full installation. Specifically, the following topics are discussed in this chapter:

- **Shipping and Receiving:** Section 4.1
  - **Equipment Requirements:** Section 4.1.1
- **Uncrating the System:** Section 4.2
  - **Uncrate the Dimension 3100 SPM System:** Section 4.2.1
- **Installing the Dimension 3100 System:** Section 4.3
  - **Install the Dimension 3100 SPM Unit:** Section 4.3.1
  - **Install the Control Station:** Section 4.3.2
- **Connecting the Dimension 3100 System:** Section 4.4
  - **Dimension 3100 Control Station Connections:** Section 4.4.1
  - **Dimension 3100 Microscope External Components Connections:** Section 4.4.2
- **System Power-up:** Section 4.5

CAUTION:  Installation should be completed by trained Veeco personnel only.  Installation instructions are provided for customer reference only.
4.1 Shipping and Receiving

4.1.1 Equipment Requirements

The following equipment is necessary for successful installation of the Dimension 3100 SPM system. Verify the following is on-hand before beginning installation:

**Equipment Received**

- Dimension 3100 Manual
- Dimension 3100 Controller
- Dimension 3100 Microscope
- Dimension Microscope Head
- Computer
- Hard Drive Back-up on CD
- Mouse, Keyboard and Trackball
- Dimension Accessories Kit
- Cantilever Stand
- Tip Holders (2)
- Wafer Handling Tool Kit
- Calibration Standard
- Vibration Isolation Pad
- Cable Clamp (needed only with VT-103 vibration isolation table)
- Power Strip
- 8” Sample Chuck (option)
- Extender Box (option)
Cables Received

- Controller-to-Dimension 3100 Cable, 37-pin D
- Dimension 3100 DC Power Cable
- Fiber Optic Cable
- Frame Grabber Video Cable (BNC to BNC)
- Power Cords (3)
- Serial Cable, 9-pin D, 12’
- Serial Cable, 9-pin D, 6’ (3)
- Vacuum Hose Assembly
- Applications Module Cable (with NanoScope IV only)
- Closed Loop Preamp Cable (with Closed Loop only)

Tools Received

- 1/2” Wrench (2)
- Small Flat Head Screwdriver
- Phillips Screwdriver
4.2 Uncrating the System

4.2.1 Uncrate the Dimension 3100 SPM System

1. Using scissors, cut and remove the plastic shipping band encircling the Dimension 3100 shipping crate.

2. Lift the cardboard shipping box off of the Dimension 3100 microscope.

3. Unscrew the 2 shipping bolts holding the shipping brackets in place at either side of the Dimension 3100 microscope. Remove the shipping brackets and store with the Dimension 3100 shipping box in the event that the microscope must be shipped for maintenance or repair.

4. Unpack all system components. Each of the items below are shipped in separate boxes:
   - Dimension 3100 Microscope
   - NanoScope Controller (if applicable)
   - Dimension 3100 Controller
   - Computer and Keyboard
   - Dimension Microscope Head
   - Computer and Microscope Accessories (Dimension accessories box)
   - Chuck Base Hardware (packed with Dimension 3100 microscope)

5. Save and store the shipping box for the Dimension microscope head.

   **Note:** If repair or calibration is necessary, the shipping box is crucial for safe return of the head to the factory. It is also convenient to use for long-term storage.

   **CAUTION:** Do not remove the plastic wrap from the microscope’s X-Y stage. Do not remove the microscope head from its shipping box yet. The SPM microscope head must remain in the box until ready for use.
4.3 Installing the Dimension 3100 System

4.3.1 Install the Dimension 3100 SPM Unit

1. Place the vibration isolation table, or the microscope platform, at the desired location.
2. Place the vibration isolation pad on the isolation table.
3. Place the Dimension 3100 microscope in the operating location on the vibration isolation table or other platform.

**CAUTION:** The Dimension 3100 microscope unit exceeds the two-person lift weight limit and should be lifted with a mechanical assist. Use proper lifting technique when removing or replacing the Dimension 3100 microscope. Improper lifting may cause muscle strain or back injury.

4. Carefully remove the plastic wrap from the X-Y stage.
5. Locate the clamps (2), screws (6), and flexure (1) used to secure the chuck base to the granite block (see Figure 4.3a).

**Figure 4.3a** Hardware for Chuck Securement to Stage

6. Carefully slide the chuck base off the X-Y stage.

**Note:** Do not stretch or bend the vacuum lines. Do not remove the vacuum lines from
the chuck base.

7. Wipe down the granite and underside of the chuck base with isopropyl alcohol. Place the
chuck base back onto the granite. Dispose of wipes in an appropriately labelled solvent-contaminated waste container.
8. Align the two sets of three mounting holes on the long edges of the flexure with the three mounting holes of the chuck base and the three mounting holes on the X-Y stage. Align one clamp over each set of three mounting holes (see Figure 4.3b).

9. Secure the chuck base in place on the X-Y stage by screwing the two clamps down onto the flexure and stage, leaving the six screws slightly loose (see Figure 4.3b).

10. Apply moderate pressure to the chuck base to secure the base to the X-Y stage, and tighten the six screws.

11. Locate the vacuum sample chuck shipped in the Dimension accessories box and wipe the top of the chuck base and underside of the sample chuck with isopropyl alcohol. Dispose of wipes in an appropriately labelled solvent-contaminated waste container.

12. Mount the sample chuck on the chuck base.

Figure 4.3b  Secure the Chuck to the Stage
4.3.2 Install the Control Station

1. Set up a table to be used as the control station next to the Dimension 3100 microscope.

   \textbf{Note:} Keep the control station in close proximity to the Dimension 3100 unit without touching the vibration isolation table.

2. Place the following input and display equipment on the control station (see Figure 4.3c):
   - Monitors (2)
   - Keyboard
   - Mouse and Mouse Pad
   - Trackball

   \textit{Figure 4.3c}  Dimension 3100 Input and Display Equipment

3. Place the computer on the side of the input and display devices closest to the Dimension 3100 microscope.

4. Place the NanoScope controller and Dimension 3100 controller next to the computer.

\begin{center}
\begin{tabular}{c}
\textbf{CAUTION:} Do not set the Dimension 3100 controller on its side.\\

\textbf{CAUTION:} Do not set the Dimension 3100 controller on the same table as the Dimension 3100 microscope. Vibrations from the vacuum pump affect imaging performance. You may stack the Dimension 3100 controller atop the NanoScope controller.
\end{tabular}
\end{center}
4.4 Connecting the Dimension 3100 System

CAUTION: Verify that the machine is powered-down and locked-out before attempting to make any connections.

4.4.1 Dimension 3100 Control Station Connections

Connect the Display and Input Devices

1. Connect the monitor power cords (2) to the power strip, but do not initiate power.

2. Connect the (2) monitor video cables to the computer (see #5 in Figure 4.4a and Table 4.4a).

3. Connect the following input devices to the computer (see Figure 4.4a and Table 4.4a):
   - Keyboard (#2)
   - Mouse (#2)
   - Trackball (#3)

   Note: Do not exchange the mouse with the trackball by using your own cable adapters—the trackball’s extra buttons are used to manipulate the stage software.

Connect the Computer

CAUTION: Boards may shift during the course of shipment. Improperly seated boards may cause equipment damage. Remove the computer cover and verify that all the boards are properly seated before powering-up the computer.

Note: Wear an anti-static wristband during this operation to avoid potential damage to the circuit boards.
Connecting the Dimension 3100 System

Figure 4.4a Computer (rear view)

- Port 1
- Video 1
- Video 2
- USB port
- COM 3
- COM 4
- Port 2
- Port 3
- Port 4
- Port 5
**Note:** The computer ships with the network board disabled to avoid error messages for computers not used on a network.

1. To use the computer on a network, select **My Computer > Control > Panel > System > Hardware Profiles > Properties > Network** and click to uncheck the box. Click **OK** twice to exit. Plug in your local network cable and restart the computer.

2. Connect extensions to the Computer. See Table 4.4a and Figure 4.4a for list of extensions, connection information and connection location.

<table>
<thead>
<tr>
<th>Fig Ref</th>
<th>Cable</th>
<th>Part Number</th>
<th>Box</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>AC Power Cable</td>
<td>466-000-004</td>
<td>Power Strip</td>
<td>Computer power</td>
</tr>
<tr>
<td>2</td>
<td>Mouse</td>
<td>n/a</td>
<td>Computer</td>
<td>Input from mouse</td>
</tr>
<tr>
<td>2K</td>
<td>Keyboard</td>
<td>n/a</td>
<td>Computer</td>
<td>Input from keyboard</td>
</tr>
<tr>
<td>3</td>
<td>Trackball</td>
<td>860-000-022</td>
<td>Computer</td>
<td>Input from trackball (COM1)</td>
</tr>
<tr>
<td>4</td>
<td>Serial Cable (12’)</td>
<td>464-000-010</td>
<td>D3100 Back Panel</td>
<td>Motor control for stage (COM2)</td>
</tr>
<tr>
<td>5</td>
<td>Monitor Cables (2)</td>
<td>n/a</td>
<td>Monitors</td>
<td>Video signals</td>
</tr>
<tr>
<td>6</td>
<td>BNC Cable</td>
<td>462-000-002</td>
<td>D3100 Back Panel</td>
<td>Optical image signal from framegrabber</td>
</tr>
<tr>
<td>7</td>
<td>Serial Cable (6’) NanoScope IV only</td>
<td>n/a</td>
<td>NanoScope Controller</td>
<td>Fast Scan (COM4)</td>
</tr>
<tr>
<td>8</td>
<td>Cable, RJ45 LAN</td>
<td>n/a</td>
<td>Host</td>
<td>Network connection</td>
</tr>
<tr>
<td>9</td>
<td>Cable, 25-pin D</td>
<td>464-000-012</td>
<td>NanoScope Controller</td>
<td>Computer to controller electronic interface</td>
</tr>
<tr>
<td>10</td>
<td>Serial Cable (6’)</td>
<td>464-000-024</td>
<td>Dimension Controller</td>
<td>Serial communication w/ Dimension controller (COM3)</td>
</tr>
</tbody>
</table>
Connect the NanoScope Controller

**Note:** The NanoScope III and IIIa are addressed in this manual. For information regarding a NanoScope IV, please refer to your NanoScope IV Controller Manual (004-115-000).

Connect extensions to the NanoScope III (IIIa) Controller. See Table 4.4b, Figure 4.4b, and Figure 4.4c for list of extensions, connection information and connection location.

### Table 4.4b NanoScope III (IIIa) Controller Connections

<table>
<thead>
<tr>
<th>Fig Ref</th>
<th>Cable</th>
<th>Part Number</th>
<th>Box</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Cable, 37-pin D</td>
<td>464-000-002</td>
<td>D3100 Back Panel</td>
<td>Microscope control</td>
</tr>
<tr>
<td>2</td>
<td>AC Power Cable</td>
<td>466-000-004</td>
<td>Power Strip</td>
<td>NanoScope IIIa controller</td>
</tr>
<tr>
<td>3</td>
<td>Cable, 25-pin D</td>
<td>464-000-012</td>
<td>Computer</td>
<td>Computer to controller</td>
</tr>
</tbody>
</table>

**Note:** Be sure to tighten the cable connector locking screws at both ends to prevent accidental removal of the cable while the NanoScope Controller operates.

**Figure 4.4b** NanoScope IIIa Controller (front view)

**Figure 4.4c** NanoScope IIIa Controller (rear view)
Installation
Connecting the Dimension 3100 System

CAUTION: Do not remove or install the cable while the NanoScope IIIa Controller is powered-up or in operation.

Connect the Dimension 3100 Controller

1. Connect extensions to the Dimension 3100 Controller. See Table 4.4c and Figure 4.4d for list of extensions, connection information and connection location.

Note: The Dimension 3100 cables are bundled through the cable clamp provided if the system includes a vibration isolation table. (See section titled Route the VT103 Air Table Cabling at the end of the chapter).

Table 4.4c Dimension 3100 Controller Connections

<table>
<thead>
<tr>
<th>Fig Ref</th>
<th>Cable</th>
<th>Part Number</th>
<th>Box</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>AC Power</td>
<td>466-000-004</td>
<td>Power Strip</td>
<td>Dimension 3100 controller Power</td>
</tr>
<tr>
<td>2</td>
<td>Vacuum Hose Assembly</td>
<td>860-000-012</td>
<td>D3100 Back Panel</td>
<td>Vacuum and air supply</td>
</tr>
<tr>
<td>3</td>
<td>Serial Cable (6')</td>
<td>464-000-024</td>
<td>Computer</td>
<td>Serial communication w/ computer</td>
</tr>
<tr>
<td>4</td>
<td>DC Power Cable</td>
<td>820-000-006</td>
<td>D3100 Back Panel</td>
<td>Motor power</td>
</tr>
<tr>
<td>5</td>
<td>Fiber Optic Cable</td>
<td>443-000-001</td>
<td>D3100 Microscope Optics</td>
<td>Optics illumination</td>
</tr>
</tbody>
</table>

Figure 4.4d Dimension 3100 Controller (rear view)
2. To set illumination, toggle the manual control switch on the front of the Dimension 3100 controller to **ON** for manual control or **OFF** for computer control (see Figure 4.4e).

   **Note:** Each illumination system may vary in intensity. Adjust to preferred levels once the system is operational—for computer adjustment there is an “illumination” parameter on the **Other Controls** panel.

3. Lock the fiber optic cable in place after establishing connection to the Dimension 3100 controller and to the Dimension 3100 microscope optics. Tighten the respective locking screws until they are snug.

4. Remove the temporary cover from the vacuum/air ports.
4.4.2 Dimension 3100 Microscope External Components Connections

Dimension 3100 Microscope Electronics Box Connections

1. Connect the external microscope components to the Electronics Box. See Table 4.4d and Figure 4.4f for list of extensions, connection information and connection location.

<table>
<thead>
<tr>
<th>Fig Ref</th>
<th>Cable Description</th>
<th>Part Number</th>
<th>Box Description</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Vacuum Hose Assembly</td>
<td>860-000-012</td>
<td>Dimension Controller</td>
<td>Vacuum and air supply</td>
</tr>
<tr>
<td>2</td>
<td>DC Power Cable</td>
<td>820-000-002</td>
<td>Dimension Controller</td>
<td>Motor power</td>
</tr>
<tr>
<td>3</td>
<td>BNC Cable</td>
<td>462-000-002</td>
<td>Computer</td>
<td>Optical image signal from framegrabber</td>
</tr>
<tr>
<td>4</td>
<td>Cable, 37-pin D</td>
<td>464-000-002</td>
<td>NanoScope Controller</td>
<td>Microscope control</td>
</tr>
<tr>
<td>5</td>
<td>Application Module Sensor Cable, 15-pin D</td>
<td>465-000-015</td>
<td>Application Module</td>
<td>Application Module control</td>
</tr>
<tr>
<td>6</td>
<td>Serial Cable (12’)</td>
<td>464-000-010</td>
<td>Computer</td>
<td>Motor control for stage</td>
</tr>
<tr>
<td>7</td>
<td>Cable, 14-pin</td>
<td>468-008-100</td>
<td>Closed Loop Preamp</td>
<td>XY Closed Loop Head control</td>
</tr>
</tbody>
</table>

WARNING: Turn NanoScope controller box power off before plugging or unplugging the NanoScope controller cables.

Figure 4.4f D3100 Microscope Electronics Box (rear view)
2. Toggle the vacuum power switch, located on the front of the microscope unit, to OFF (see Figure 4.4g).

![Vacuum Power Switch](image)

**Figure 4.4g** Vacuum Power Switch

**Route the VT103 Air Table Cabling**

![Cable Clamp](image)

**Figure 4.4h** Cable Clamp

1. Route all cables connected to the Dimension 3100 microscope through the slot located in the far right region of the VT103 vibration isolation table.

2. Position the Dimension 3100 microscope in the desired location.

3. Mark the cables with a marker to reference each cable’s position in the cable clamp (see Figure 4.4h).

**Note:** When secured in place, the cable clamp is located underneath the vibration isolation table, near the aforementioned slot (see Step 1).
4. Disconnect all cables from the Dimension 3100 microscope, and remove the cables from the slot.

5. Route cables through the cable clamp and secure the bolts using the supplied allen wrench. Verify that the cables are not pinched in the cable clamp.

6. Re-route cables through the slot and re-connect cables to the Dimension 3100 microscope.

7. Secure the cable clamp by tightening the four bolts underneath the vibration isolation table.

4.5 System Power-up

Prepare the System for Power-up

1. Verify that the power cord is plugged into a grounded power receptacle with the correct voltage.

2. Verify that all cables are connected properly, especially the NanoScope III SPM controller to the Dimension 3100 microscope electronics box.

CAUTION: Cables should not be removed or installed while power is applied to the system. These restrictions do not apply to the small black cable that connects the microscope head to the stage control electronics.

Power-up Sequence

1. Turn on the computer using the push-button switch located on the front of the computer.

2. Turn on the monitors (2) using the push-button switches located on the front of the monitors.

3. Turn on the NanoScope IIIa controller using the power switch located on the rear of the NanoScope IIIa controller.

4. Turn on the Dimension 3100 controller, using the power switch on the rear of the Dimension 3100 controller.
The Dimension 3100 Scanning Probe Microscope (SPM) features a large sample stage capable of positioning large samples such as silicon wafers and computer hard drive media, as well as small samples. The X-Y stage consists of a pair of stacked, perpendicular slides and uses an open loop (unencoded) architecture with stepper motors to drive the stage to user-specified coordinates.

This chapter details procedures for mounting samples and dedicated stage menu software commands. Specifically, this chapter discusses the following:

- **Mounting of Samples**: Section 5.1
  - Vacuum Chucks: Section 5.1.1
  - Magnetic Pucks: Section 5.1.2
  - Axis Orientation—Motorized X-Y Stages: Section 5.1.3
- **Stage Menu Commands**: Section 5.2
  - Load New Sample: Section 5.2.1
  - Locate Tip: Section 5.2.2
  - Focus Surface: Section 5.2.3
  - Move To (X,Y): Section 5.2.4
  - Set Reference: Section 5.2.5
  - Programmed Move: Section 5.2.6
  - Initialize: Section 5.2.7
  - SPM Parameters: Section 5.2.8
5.1 Mounting of Samples

There are two methods widely used for mounting samples: vacuum chucks and magnetic pucks. Regardless of the method used, verify that samples are mounted flat and parallel to the stage. This is especially important for larger samples inspected over more than one site. Grossly tilted samples may require raising the head higher whenever the sample is indexed, increasing cycle time and the risk of probe-sample collision. Similarly, large numbers of identical samples should be mounted the same way whenever possible to allow use of the same settings between samples.

5.1.1 Vacuum Chucks

Stages are equipped with vacuum chucks which are often employed for securing samples.

| CAUTION: | Operators should be cautious when handling larger samples with the vacuum chuck—an 8-inch wafer held using 5 psi vacuum sustains a loading of 250 lbs. |

| CAUTION: | If debris is trapped between the stage and wafer, the wafer may become scratched or broken. Keep the stage clean at all times using isopropyl alcohol. Dispose of wipes in an appropriately labelled solvent-contaminated waste container. When cleaning dust from the stage area, use a vacuum cleaner with a soft brush. DO NOT clean stages using compressed air. |

5.1.2 Magnetic Pucks

Samples may also be secured to the stage using magnetic pucks. This system allows for easy mounting and removal of small samples. For detailed mounting instructions, see Chapter 7.
5.1.3 Axis Orientation—Motorized X-Y Stages

When viewing the Dimension 3100 SPM from the front, stage movements are defined over two axes of motion: X (left-right), and Y (front-back). For X-axis movements, lesser (decreasing) coordinates are located to the left. For Y-axis movements, positive (increasing) coordinates are located toward the rear of the machine, decreasing values are located forward (see Figure 5.1a).

Figure 5.1a  Stage X-Y Axis Orientation

(Front)
5.2 Stage Menu Commands

Important stage menu commands are discussed in detail in the following sections:

- **Load New Sample**: Section 5.2.1
- **Locate Tip**: Section 5.2.2
- **Focus Surface**: Section 5.2.3
- **Move To (X,Y)**: Section 5.2.4
- **Set Reference**: Section 5.2.5
- **Programmed Move**: Section 5.2.6
- **Initialize**: Section 5.2.7
- **SPM Parameters**: Section 5.2.8

5.2.1 Load New Sample

**CAUTION**: Do not move the stage while the microscope is scanning.

Stage software is designed to function between vertical movements of the head. Functions such as **Load New Sample** first lift the head's probe from the sample surface, then index the stage to a preprogrammed location (usually front-center) where samples may be rapidly reloaded.

To load or unload a sample from the stage using the **Load New Sample** function, complete the following:

1. Select **Load New Sample** from the Stage pop-down menu. The screen displays a dialog box (see Figure 5.2a).

**Figure 5.2a** Stage Load/Unload Prompt
2. To load a new sample, click **OK**. The head raises to the Load/Unload height, and the stage indexes to the front-center position.

   **Note:** Verify that the tip is still usable. If the tip has been used for a lengthy period, or if damage is suspected, change the tip now per instructions provided in Chapter 7 of this manual.

3. To release the vacuum chuck’s hold on a sample, use the pneumatic toggle switch located on the upper-right corner of the electronics box. When the vacuum is released, remove the sample.

4. Verify that the stage and vacuum chuck are clean of debris. If debris is present, clean the stage using a lint-free wipe and isopropyl alcohol. Dispose of wipes in an appropriately labelled solvent-contaminated waste container.

5. Place the new sample on the stage.

6. Verify that the sample is centered and seated flat against the chuck’s contact points.

7. Activate the vacuum chuck by toggling the vacuum chuck switch. Select **Stage > Load New Sample** to move the stage back.

### 5.2.2 Locate Tip

When installing new tips, execute the locate tip function before focusing on the sample surface. This function enables the operator to find the probe tip using the optical system. To locate the tip, complete the following:

1. Verify that a tip is installed in the probe tip holder, then select **Stage > Locate Tip** option or use the tool bar icon.

   **Note:** The screen displays a caution indicating that the microscope objective is in motion (see **Figure 5.2b**).

   ![Stage Moving to Tip Position Caution](image)

   **Figure 5.2b** Moving to Tip Position Caution

   **Note:** As the objective moves positions, the tip should begin to come into focus. When the focus position is attained, the screen displays trackball instructions for achieving a focus (see **Figure 5.2c**).
2. Bring the tip into focus by holding down the left trackball button while rolling the trackball.

   **Note:** The tip may be off from center in the field of view, particularly if installing a new type of tip. Zooming out may aid in locating the tip.

3. Rotate the small, metal knobs located on the front of the on-axis viewing assembly to center the tip in the field of view as indicated in the screen prompt.

4. When the tip is in focus and centered in the field of view, click **OK** in the **Locate Tip** prompt.

### 5.2.3 Focus Surface

This function focuses the sample surface. The operator may choose to manually focus on the surface using the trackball or allow the optics to focus automatically by choosing the **Autofocus** feature. When the surface is already partially in focus (or close to it), use the **Autofocus** feature.

To use the **Focus Surface** feature complete the following:

1. Select **Focus Surface** from the **Stage** menu. The screen displays trackball instructions for achieving a focus (see **Figure 5.2d**).
2. Use the left button on the trackball to focus on the surface (which moves the SPM or Z stage up and down).

3. Use the right button on the trackball to zoom out completely when trying to focus on the surface.

4. If the sample is not already under the microscope, use the trackball (with neither the left nor right buttons pressed) to move the X-Y stage until the sample is in position.

5. If the surface is partially in focus, use the Autofocus option to complete the focusing process.

6. To focus on the sample “surface” (normal operation) or the “tip reflection” (for extremely clean samples), change the Focus On parameter accordingly.

   Note: For reflective or semi-reflective samples, the tip reflection is easier to bring into focus than the surface, especially if the sample is very flat or clean.

   CAUTION: When moving the SPM stage up and down, it is possible to crash the tip into the surface. To prevent a crash while focusing on the surface, watch the optical image and tip-to-sample proximity. The sample should be in focus when the tip is 1mm (1000µm) above the surface.

7. For samples which are difficult to bring into focus, move to an edge of the sample, which is easy to find in the optical image, and bring the top of the edge into focus.

8. Move the sample back to the desired X-Y position.

9. Verify that the surface remains in focus.
5.2.4 Move To (X,Y)

This option enables the operator to quickly index the stage to a defined X-Y coordinate. If the origin has not been preset using the Stage > Set Reference panel, the stage automatically defaults to the last origin that was previously used. (All subsequent X-Y moves are done from the origin.)

To move the X-Y stage to a specified X-Y coordinate, complete the following:

1. Verify that the stage origin (position 0, 0) is either:
   - At the default, or,
   - Reset to a new position using the Set Reference panel under the Stage pop-down menu.

2. Select the Move To (x,y) panel under the Stage pop-down menu. The screen presents a panel with four fields (see Figure 5.2e).

   **Note:** The first two fields define absolute moves relative to the currently set origin (0,0). The third and fourth fields define relative moves from the current position.

3. Enter the X and Y coordinates of the desired move to position, then click Move.

4. The stage moves to the new position. Should it become necessary to halt movement, click on the Pause button (see Figure 5.2f).
5. To exit the Move To \((x,y)\) dialog box, click the **Quit** button.

### 5.2.5 Set Reference

The **Set Reference** panel is used to set the origin point on the sample surface to be used for all subsequent Move To and Programmed Move operations. It is important to verify the reference point \((0,0)\) with programmed move sequences, since all moves are relative to the current origin. For example, a program designed to move the stage to the four corners of a square sample when the origin \((0,0)\) is set to the upper-left corner will not probe the same positions if the origin is changed to the lower-right corner. It will avoid confusion to select a standard position as the usual origin reference (e.g., lower-left corner), then reuse the same reference position with all samples.

On samples having a grid-like aspect (e.g., integrated circuits), the reference may be initially defined from a line (two points) rather than a single point. The reference line is defined parallel to some feature on the sample surface (e.g., an electronic trace on an integrated circuit). You may complete this by defining two points: an origin and a second point. Defining the second point compensates for sample rotation. To set a reference on the sample, complete the following:

1. Select the **Focus Surface** function under the **Stage** menu to focus on the sample and move the sample to the desired origin.

2. Select the **Set Reference** option under the **Stage** menu. The screen offers five options to the operator (see Figure 5.2g).
Stage System
Stage Menu Commands

Figure 5.2g  Set Reference Prompt

3. Click Origin in the Set Reference panel; this is the first of two points to be used for defining a reference line on the coordinate grid.

4. Quit the Set Reference menu, and use the Focus Surface option and trackball to either move the stage right or upward as necessary.

Move Stage Right

   a. Move the stage to the right to a second point on the linear feature. (This second point, along with the point of origin, defines the X-axis.)

   b. Quit the Focus Surface option, and return to the Set Reference option under the Stage pop-down menu.

   c. Click on the X Axis option. This establishes the (Y = 0) reference line.

Move Stage Upward

   a. Move the stage upward to a second point on the linear feature. (This second point, along with the point of origin, defines the Y-axis.)

   b. Quit the Focus Surface option, and return to the Set Reference option under the Stage pop-down menu.

   c. Select the Y Axis option. This establishes the (X = 0) reference line.

Note:  Accuracy improves if the two points defining a reference line are located at some distance to each other. For maximum angular accuracy, the two points should be located at opposite sides of the sample (see Figure 5.2h). The left image depicts two closely located points to define the X-axis. The right image depicts a more accurate reference line defined by two, widely spaced points.

Figure 5.2h  Defining the X-Axis
5.2.6 Programmed Move

The Programmed Move function allows the stage to be automatically positioned using a series of memorized positions. These positions are programmed into the controller’s computer, then executed automatically in sequence. This function is particularly useful for statistical quality assurance runs on large numbers of identical samples, and as a basic inspection aid.

To use this option, select the Programmed Move function under the Stage pop-down menu. The screen displays a panel of options (see Figure 5.2j).

![Programmed Move Prompt](image)

The name of the move program currently loaded is displayed in the Program name panel (in the above example, the program is called “move”). Moves are first programmed using the Teach function. Later they may be executed using the Run function.
Teaching a Programmed Move

To program (teach) a series of moves, complete the following:

1. Draw a simple map of the sample, along with each programmed position, before programmed moves are entered. Note the origin point at the time of programming.
   
   **Note:** If reducing cycle time is important, position order should be optimized to reduce stage travel.

2. Click on the Program name option in the Programmed Move panel (see Figure 5.2j) and enter the name to be used.
   
   **Note:** Program names must be eight characters or less and follow DOS protocol.

3. From the Programmed Move panel, click on Teach. The screen prompts with (see Figure 5.2k):

   **Figure 5.2k** Editing or Creating New Program Prompts

   ![Editing existing program or creating new program](<image_url>)

   The program name already exists on the computer.

   Or

   The program name is new (not previously used).

4. Click OK to proceed with programming moves. A new panel displays, featuring the basic teaching commands (see Figure 5.2l).

5. To add a first step, click Add Step to invoke the Teach Mode panel (see Figure 5.2l).

   **Figure 5.2l** Teach Program Prompt

   ![Teach Program prompt](<image_url>)

6. Use the controls to position the stage and sample to the desired location(s) to be programmed into the computer.

   **Note:** These controls are identical to the Focus Surface controls explained in Chapter 5 of this manual.
7. Click on OK in the Teach Mode panel when the stage has moved to a desired position (see Figure 5.2m).

![Figure 5.2m Teach Mode Prompt](image)

8. To add another position, repeat Step 4 - Step 6 until all desired positions have been programmed up to a maximum of 100 steps.

   **Note:** Each time the Teach Program panel is reentered, the Program step increments by another count and automatically assigns a program step number.

9. When all stage positions are entered into the program, click Save in the Teach Program panel, then click Quit. Verify the program is entered and saved under the correct program name.

   **Note:** Save steps before exiting the Teach Program panel; otherwise, programmed steps will be lost.

10. Enter additional programs in the same manner, using a separate program name for each.

### Other Information Regarding the Teach Program Option

To remove a step from the programmed sequence:

1. Go to the Stage pop-down menu to the Programmed Move panel, and select Teach Program.

2. Select Program step from the Teach Program panel.

3. Enter the step number to be removed or drag the mouse to index to the step number. The stage simultaneously moves to the new step position.

4. Select the Remove Step option.

   **Note:** When individual program steps are removed, all subsequent steps are “moved up” by one count.

5. Click Save to save the edited version of program.
To insert a step into an existing program sequence:

6. Go to the Stage pop-down menu to the Programmed Move panel, and select Teach Program.

7. Select Program step in the Teach Program panel.

8. Enter one less than the step number to be added to the sequence, or drag the mouse to index to the desired step number.

   **Note:** For example, to add a new program step #7, while leaving all preexisting steps intact, enter “6” in the Program step panel. The stage simultaneously moves to the preexisting step position #6.

9. Select the Add Step option. The Teach Mode panel appears.

10. Use the trackball to move the stage to the new position to be added.

11. Click Quit to exit the Teach Mode panel. Verify the new position is now added.

   **Note:** When new program steps are added, all preexisting steps beyond the new entry are “moved up” by one count.

12. Click Save to save the edited version of program.

**Origin Points**

Programmed Move positions are memorized relative to the current origin at the time of programming. If the origin has been shifted from its original position since the time of programming, it is necessary to reestablish the original origin point to locate the same positions on the sample. When generating maps of programmed moves, always indicate the origin point.

**Running a Programmed Move**

Once a program sequence has been taught to the computer, you may run the program from the Programmed Move panel. The stage moves to each position in the same order taught, relative to the current origin point. At each program position, the sample is scanned for 1.5 frames, captured, and then indexed to the next position. The system stores captured data from each position is stored on the hard disk; there should be sufficient memory to record 100 frames at 256 samples each.

To run a series of programmed moves, complete the following:

1. Select Stage > Programmed Move.

2. Select the Program name field, and enter the name of the program to be run.
3. Select the Run option. If you are loading and running the program from the beginning, the screen prompts the operator whether to refocus the screen.
   
a. Clicking Yes transfers you to the Focus Surface panel; you may then make focusing adjustments to better view the surface.
   
b. Clicking No initiates the programmed move from step #1.

   **Figure 5.2n**  Initial Focus Prompt

   ![Initial Focus Prompt](image)

   **Note:** If the program was previously run without finishing (aborted), the screen requests whether to begin the program sequence at the aborted step.

4. If you wish to run the entire program from its beginning (step #1); click No. Otherwise, click Yes (see Figure 5.2n).

5. The screen displays the current program step in progress (see Figure 5.2o). To initiate the program sequence from another starting point, use the Teach Program panel to remove any unwanted step(s), and run the program again from the new “step 1” position.

   **Figure 5.2o**  Programmed Move Prompt

   ![Programmed Move Prompt](image)

### 5.2.7 Initialize

The Initialize option allows the system software to locate the top (positive) limit switches on the SPM axis and optics axis stages. If the NanoScope computer determines that it is unsure of the stage position, it will not allow any functions under the Stage menu (except Initialize) to be selected.

To initialize the stage, complete the following:

1. Before beginning initialization, verify that the stage is clear of loose items and debris.

2. Select Stage > Initialize. The dialog box offers two options (see Figure 5.2p).
3. To begin initialization, click **Initialize**. As the stage begins a series of motorized movements, the screen indicates operating status (see Figure 5.2q).

![Stage Initialize/Cancel Prompt](image)

**Note:** The initialization sequence may be aborted at any time by clicking **Pause** (see Figure 5.2r).

![Stage Initializing Prompt](image)

4. The microscope Z-axis moves to the top of its travel. When this is achieved, click **Ok** to continue.

5. The microscope focuses its camera optics to the extent of its travel. When this is achieved, click **Ok** to continue (see Figure 5.2s).

![Optics Move to End of Travel Prompt](image)

6. Next, the camera zoom optics assembly zooms. When the camera zooms in to the limit of its travel, click **Ok** to continue (see Figure 5.2t).

![Stage Zoom Prompt](image)
7. Finally, the camera’s optics zooms out. When the camera zooms out to the limit of its travel, click **Ok** to complete the stage initialization process (see Figure 5.2u). The dialog box removes itself from the screen.

**Figure 5.2u**  Stage Zoom Out Prompt

5.2.8 SPM Parameters

The SPM parameters menu lists the most important Z-axis parameter values for loading/unloading the stage and engaging samples. These values are explained in more detail in Chapter 7.
Chapter 6  Cantilever Preparation

The Dimension 3100 Scanning Probe Microscope comes furnished with etched silicon cantilever substrates for TappingMode AFM and silicon nitride cantilevers for Contact AFM modes. The cantilever probes should be inspected under the microscope when used for the first time to gain a better understanding of how the probes and substrates are connected and separated. The procedure for removing individual substrates from the wafer varies depending on the wafer. It is easier to accomplish this task with the aid of a stereo microscope with 50 – 70x magnification.

This chapter addresses the following:

- **Silicon Cantilever Substrates**: Section 6.1
- **Wafer Tool Kit**: Section 6.1.1
- **Cantilever Preparation**: Section 6.1.2
- **Tip Shape of Etched Silicon Probes**: Section 6.1.3
- **Silicon Nitride Cantilever Substrates**: Section 6.2
- **Tip Shape of Silicon Nitride Probes**: Section 6.2.1
6.1 Silicon Cantilever Substrates

CAUTION: The cantilevers are stored tip-side-up, and the silicon is very brittle. The cantilever will break off of the substrate if contacted.

6.1.1 Wafer Tool Kit

A wafer tool kit for working with silicon cantilever substrates is included with the Dimension 3100 SPM system. The kit contains the following:

- Wafer tweezers
- Flat, substrate tweezers
- Regular tweezers
- Curved, sharp-pointed tweezers
- Flat, L-shaped tweezers

6.1.2 Cantilever Preparation

To prepare the cantilever for imaging:

1. View the wafer with an optical microscope to determine the orientation of the cantilever substrates and to inspect the cantilevers themselves.

   Note: A 10-70X stereo microscope is useful for this task. The cantilevers are tip-side-up when viewed in the wafer holder.

2. Disconnect the substrate from the bulk of the wafer by pressing down gently on the non-cantilever end of the substrate or using sharp-pointed tweezers to carefully break the two substrate supporting arms connecting the substrate to the silicon wafer frame (see Figure 6.1a).

   Note: The supporting arms connecting the substrate to the bulk of the wafer shatter when pressure is applied. It may be convenient to break several substrates from the wafer at one time. Extras may be safely stored in a specially prepared petri dish.

3. At the bottom of the petri dish, place X4-grade, GEL-PAK adhesive strips.

4. Place the substrates, tips facing up, on the adhesive to permit easy removal of the substrates when needed.
Note: Cover the petri dish when not in use.

**Figure 6.1a** Silicon Cantilever Substrates in Wafer

5. Use the curved, sharp-pointed tweezers to remove the cantilever substrate from the wafer container, grasping the sides of the substrate away from the lever and probe tip.

Note: It may be helpful to tip the substrate to one side to help grasp it in the tweezers.

CAUTION: Silicon is extremely brittle. Be very careful to avoid any contact with the probe lever because it will immediately snap off.
6.1.3 Tip Shape of Etched Silicon Probes

Etched silicon probes provide the most consistent tip sharpness of the probes presently available. There are subtleties in general shape that produce different effects from the etched silicon tips when imaging samples with steep walls over steps of 100 nm to several microns in height (see Figure 6.1b).

The present process creates a tip which is symmetric from side-to-side with a 17° half cone angle (see A of Figure 6.1b) and asymmetric from front-to-back, along the length of the lever (see C of Figure 6.1b).

In addition, the substrate mounting angle also affects the interaction of the tip shape with the surface. Along the front edge of the tip, the half angle is nominally 25°, while at the back edge of the tip, the half angle is approximately 10°. Neither of these angles account for the tilt of the substrate. With the mounting angle of the substrate factored in, the front edge of the tip is 35° and the back edge of the tip is zero degrees. From the tip side, the cross-section of the tip near the lever is approximated by an inverted ‘kite’ shape. All of these subtleties arise from the etching process used to make the tip, which employs caustic solutions to perform wet anisotropic etching of the silicon.
To measure sidewall angles, the best orientation of the sample uses the back edge of the tip (that which faces back towards the cantilever substrate) to measure step angles (see Figure 6.1c). Using the back edge, step angles approaching 90 degrees can be measured routinely, depending on the step height.

**CAUTION:** Ensure that the area of measurement offers sufficient clearance so that other faces and edges of the tip and lever do not interfere with the measurement.

This method does not work well in small openings of less than 5 microns where, depending on the depth of the step, other tip edges may contact other faces of the small opening. Wall angle measurements are best measured in open areas for these reasons.
Measurements of line pitch are often best measured using the side-to-side faces of the tip, which exhibits symmetry. Because of the approximate $17^\circ$ half angle of the tip, the line or space measurement is best done at the top of the line for simplification of the measurement artifacts (see Figure 6.1e).

**Figure 6.1d** Silicon Probe Tip Step Profile Artifact (Side-to-Side)

**Figure 6.1d** depicts the resultant effect of the angled back ridge on the step angle measurement for a deeper trench depth. This is tip and topography dependent.

**Figure 6.1e** Common Silicon Probe Profile (Resultant Scan Artifact)

**Figure 6.1e** depicts the resultant effect of the angled back ridge on the step angle measurement for a deeper trench depth. This is tip and topography dependent.
In addition to microscopic scale shape characteristics (see Figure 6.1b - Figure 6.1e), another factor which can affect the wall angle over shorter (nominal 100 nm) step height measurements is the shaped cusp at the end of the tip. The shaped cusp at the end of the tip is formed to increase the sharpness of the tip point to a length of 100 nm from the end of the tip. It is formed in such a manner that the radius of curvature of a silicon tip can be in the range of 5 – 10nm (on a very good tip).

### 6.2 Silicon Nitride Cantilever Substrates

The following procedure details how to remove Silicon Nitride cantilever substrates.

1. Verify that the wafer is oriented with the tips facing upward (gold coated surface down).
2. Inspect the wafer with an optical microscope.

   **Note:** A 10 -70X stereo microscope is useful for becoming familiar with the styles and orientation of the cantilevers on the probe substrate. Included with the AFM microscope is a tool kit containing: wafer tweezers, substrate tweezers, regular tweezers, and a pin-vise.

3. Remove the Pyrex strips by resting the silicon ring on a glass slide or ruler.
4. Apply downward pressure with the tweezers until the strip breaks free from the silicon ring (see Figure 6.2a).

**Figure 6.2a**  Silicon Nitride Cantilevers in a Wafer
5. Place the strip down on a white piece of paper to inspect it under the microscope.

CAUTION: Be careful to avoid pushing strips together as the cantilevers are between the strips. All cantilevers on one side of both strips could break off if the strips are inadvertently pushed together.

CAUTION: Verify that the cantilevers are on the top side of the strip. The cantilevers are on the same side as the reinforcing ring, while the saw-cuts are on the opposite side from the cantilevers. Between each one on the down side of the strip there should be a saw-cut almost through the Pyrex.

6. Handling the strip by its ends, place it on a glass slide (taped down to the edge of a table) with the substrate or spacer piece to be removed hanging over the edge (see Figure 6.2b). The saw cut should be approximately on the edge of the slide.

7. While holding down the next substrate on the strip with the wooden end of a cotton swab, grip the overhanging piece with a pair of wide tweezers and rotate downward until the cantilever substrate breaks off.

8. Repeat this process until as many cantilever substrates as required are removed.
Figure 6.2b  Substrate Break-off

Note: Extra substrates are easily stored in a covered petri dish. The shipped substrates are secured with X0-grade, GEL-PAK™ adhesive strips. The strips are used to permit easy removal of the substrates. If GEL-PAK adhesive strips cannot be found, a simple substitute is the adhesive area from a Post-it note.

Each substrate has two cantilevers on each end of the substrate. Both 100 and 200µm length cantilevers with two different leg widths are provided. When ready to use a cantilever substrate, it may be desirable to remove the unused cantilevers from that substrate, but it is not necessary. For most applications use the 200µm cantilever with the wider legs. For atomic scale images, the 100µm triangular cantilever with the wider legs yields good results.
6.2.1 Tip Shape of Silicon Nitride Probes

Silicon nitride probes provide low cost and durable probes suitable for contact mode imaging. There are some subtleties in general shape that should be understood to gain the best advantage from the silicon nitride tips when imaging samples with steps of 0.1 to several microns in height. The probe tip is approximated by a pyramid formed by intersecting <111> planes in silicon. The approximate shape of the tip is shown in Figure 6.2c along with dimensions and approximate values for spring constants and resonant frequencies.

![Figure 6.2c Silicon Nitride Cantilevers](image)

<table>
<thead>
<tr>
<th>Lever Type</th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>Spring constant (N/m)</th>
<th>Measured Fr (kHz)</th>
</tr>
</thead>
<tbody>
<tr>
<td>100 µm Wide</td>
<td>115</td>
<td>122</td>
<td>21</td>
<td>60</td>
<td>0.58**</td>
<td>40</td>
</tr>
<tr>
<td>200 µm Wide</td>
<td>193</td>
<td>205</td>
<td>36</td>
<td>113</td>
<td>0.12**</td>
<td>12.3-22.1 †</td>
</tr>
<tr>
<td>100 µm Narrow</td>
<td>115</td>
<td>122</td>
<td>15</td>
<td>69</td>
<td>0.38**</td>
<td>-</td>
</tr>
<tr>
<td>200 µm Narrow</td>
<td>193</td>
<td>205</td>
<td>20</td>
<td>150</td>
<td>0.06**</td>
<td>-</td>
</tr>
</tbody>
</table>

Because the Silicon Nitride probe tips have lower aspect ratios than single-crystal etched silicon probes, the steepest measurable step wall angle is appreciably lower. The highest measurable angle using silicon nitride probes is approximately 65° (see Figure 6.2d) using the inner face of the tip (towards the cantilever holder). The steepest measurable angle from side to side (parallel to the edge of the probe's substrate) is approximately 55°. Both of these figures assume that the measurement does not have interference from other edges.
There are two types of silicon nitride cantilever probes available: standard and oxide-sharpened tip processes. The standard devices have the nitride deposited directly into the etched silicon mold pit formed by the intersecting <111> planes, and have points that are slightly rounded with respect to the tips produced using the oxidation sharpening process.

The oxide-sharpened silicon nitride probes have a thermally grown silicon dioxide film deposited in the mold pit used to shape the nitride tip, prior to silicon nitride film deposition. The oxide has two effects: it shapes the inner contours of the pyramidal pit so that a slight cusp forms at the point of the pyramid, and the oxide protects the tip from excessive exposure to a long duration wet silicon etch used to free the cantilevers from the silicon substrate. The result is a noticeably sharper point at the end of the pyramid. Regrettably, along with the increased sharpness of the tip comes a slight increase in double tip effect experienced with the oxide sharpened process.
Chapter 7  Head, Probe, & Sample Preparation

This chapter includes information regarding the Dimension 3100 Scanning Probe Microscope (SPM) setup and operation procedures for Contact Mode and Tapping Mode. Specifically, this chapter details removal and installation of the microscope head, mounting the cantilever, changing the tip, loading and positioning samples, focusing the optics, and general information regarding engaging and withdrawing the tip.

Chapter 9 discusses SPM operation in Tapping Mode in more detail, while Chapter 8 reviews SPM operation in Contact Mode AFM. This chapter contains the following:

- **System Information:** Section 7.1
  - Mouse versus Trackball: Section 7.1.1
  - Motor Interlock: Section 7.1.2
  - Laser Requirements: Section 7.1.3
- **Basic AFM Operation:** Section 7.2
  - Select the Microscope: Section 7.2.1
  - Select Mode of Operation: Section 7.2.2
  - Prepare the Cantilever Holder: Section 7.2.3
  - Load the Cantilever Holder: Section 7.2.4
  - Remove the Dimension SPM Head: Section 7.2.5
  - Install the Cantilever Holder: Section 7.2.6
  - Replace the Dimension SPM Head: Section 7.2.7
  - Connect the Dimension Head: Section 7.2.8
  - Align Laser: Section 7.2.9
  - Adjust Photodetector: Section 7.2.10
  - Locate Tip: Section 7.2.11
7.1 System Information

7.1.1 Mouse versus Trackball

The mouse exclusively operates the NanoScope software with the exception of functions related to direct control of the stage. These commands are only initiated with the trackball. Operator-initiated movement of motors via the Zoom, Focus, Move SPM (Z-stage) and Move XY commands are controlled by the trackball and its buttons. Motor operation is permitted only when the appropriate menu enables movement.

7.1.2 Motor Interlock

SPM stage movement is software interlocked against motion if a valid sum (laser signal) is not present. The sum signal must be between 0.5-9.5 volts, otherwise all commands which try to initiate stage motion will not move the SPM X, Y, or Z stages. However, except for upward Z-stage travel. This interlock reduces the possibility of inadvertently crashing the tip and scanner crystal into the sample or stage, minimizing tip and scanner damage. If during the engage sequence the sum signal changes to a value outside the interlocked limits, the downward motion stops, preventing damage to scanners had the Z-stage continued downward.
7.1.3 Laser Requirements

**CAUTION:** When the Dimension head is plugged into the microscope control electronics, laser light is emitted.

**CAUTION:** The Dimension head features an internal tilt switch to shut power off to the laser whenever it is inverted, however, heed all precautions below.

This instrument uses a semiconductor laser emitting a maximum 1.0mW beam at 670 nm. The light is emitted down the center of the scanner tube and during normal operation reflects back into the system’s optics from the back surface of the cantilever probe.

**WARNING:** During and prior to set up of the laser, it is important to avoid looking directly at the laser beam or at the laser spot. The laser head should never be plugged into the microscope control electronics unless the head is installed in the Z-stage mount. Take care when inserting highly reflective samples on the chuck. Avoid looking at all reflected laser light. Use care to avoid staring into beams that may be reflected from sample surfaces.

**AVERTISSEMENT:** Avant de faire fonctionner le laser, et durant tout le temps pendant lequel il fonctionne, il est impératif de ne pas regarder directement le faisceau du laser ou l’image qu’il refléchit. La sonde laser ne doit jamais être branchés sur l’électronique de contrôle du microscope, tant que la tête de mesure n’est pas installée dans son support. Il est impératif de faire très attention lorsque des échantillons très réfléchissants sont déposés sur la platine. Eviter toute exposition à la lumière laser. Durant l’utilisation, ne pas fixer les faisceaux laser réfléchis par les surfaces d’échantillons.

7.2 Basic AFM Operation

7.2.1 Select the Microscope

1. Set the microscope configuration by selecting the Microscope Select panel from the Di popup menu (see Figure 7.2a).

2. Click OK to close the Microscope > Select dialog box and initiate the Realtime software.

![Microscope Select Prompt]

7.2.2 Select Mode of Operation

1. Select Microscope > Profile.

2. Select the desired mode of operation (Contact Mode, TappingMode, etc.) and click OK.

7.2.3 Prepare the Cantilever Holder

Before loading the substrate onto the cantilever holder, place the cantilever holder on the cantilever holder stand (see Figure 7.2b). The cantilever holder stand is a 2.5-inch diameter black anodized aluminum cylinder that ships with the Dimension 3100 SPM for easy installation of the substrate onto the cantilever holder.

The cantilever holder stand has three stations for different tip holders: 1) standard AFM, 2) fluid imaging AFM and 3) STM. A small, raised block in the center of the gold connector identifies the standard AFM load station.

To prepare the cantilever holder, with the AFM cantilever holder's large spring clip face up, mate the standard AFM cantilever holder sockets to the pins of the AFM cantilever holder stand (see Figure 7.2b).
7.2.4 Load the Cantilever Holder

**Contact Mode AFM**

Silicon nitride substrates are used for SPM operation in Contact Mode AFM. Silicon nitride substrates consist of a cantilever integrated with a sharp tip on the end. For Contact Mode AFM imaging, the cantilever must be soft enough to deflect very small forces and have a high enough resonant frequency to avoid vibrational instabilities.

**Note:** Install silicon nitride substrates face-up so the tip points away from the AFM cantilever holder. This ensures that the cantilever and tip face toward the sample once the cantilever holder is mounted on the head.

To install a silicon nitride substrate on the AFM cantilever holder, complete the following:

1. Using sharp tweezers, grasp the substrate firmly on the sides and lift to free the substrate from the wafer or gel-pack. In the gel-pack boxes the tip ends are pointing upward and do not need to be turned over before being placed in the cantilever holder.

   **Note:** Refer to Chapter 6 for detailed information on how to break out each substrate from the wafer.

2. Many silicon nitride substrates have cantilevers on both ends of the substrate. If this is the case, place the substrate under an optical microscope or magnifier and locate the substrate you want to use.

3. Press down and slide back the spring clip of the standard AFM cantilever holder (see Figure 7.2c).
4. Orient the cantilever intended for imaging away from the cantilever holder, and place the substrate in the AFM cantilever holder groove.

5. Carefully maneuver the substrate until the substrate is flush against the back edge and laying flat in the cantilever holder groove.

6. Press the spring-loaded probe clip down, gently push forward over the substrate, and release the spring clip to hold the substrate in place in the cantilever holder groove.

   **Note:** Always orienting the substrate to one side and the back of the cantilever holder groove will improve repeatability of tip location between runs. This will make aligning the laser onto the cantilever quicker and easier when installing new cantilevers.

**TappingMode**

The procedure for installing TappingMode, single crystal silicon substrates is the essentially the same as the procedure for installing silicon nitride substrates in Contact Mode AFM. However, one difference is that silicon substrates usually have only one cantilever per substrate, which can often be identified without an optical microscope.

   **Note:** Single crystal silicon substrates are installed face-up so the tip points away from the AFM cantilever holder. This ensures that the cantilever and tip face toward the sample once the cantilever holder is mounted on the head.
7.2.5 Remove the Dimension SPM Head

1. Tighten the screw located on the right side of the Dimension SPM head dovetail to release the Dimension SPM head (see Figure 7.2d).

Figure 7.2d  SPM Head Dovetail and Signal Connector

Note: Dovetail engagement actuates with a spring. Failing to engage the spring-loaded dovetail causes a large increase in image noise due to reduced rigidity of the mechanical support of the SPM head.

2. Unplug the connector wire that runs from the SPM head to the Dimension base.

3. Carefully slide the Dimension SPM head up and out of the dovetail groove.

7.2.6 Install the Cantilever Holder

If you are changing cantilevers, we recommend you select Stage > Load new sample before removing the old cantilever. The stage moves to the front of the Dimension base, which becomes useful in laser alignment (refer to Section 7.2.9 for laser alignment). Because the laser sum signal will reach zero once the cantilever is removed, the motor interlock will prevent this is in the future.

CAUTION: When using the Stage > Load New Sample command, be sure there are no objects taller than the height of the cantilever in-between current location of the scanner and the front of the sample chuck. An object in this path could damage the scanner and/or tip.
1. Mate the cantilever holder sockets to the Dimension SPM head pins to install the loaded AFM cantilever holder.

2. Verify the tip points down and away from the head. The end of the cantilever must point in the direction of the optics assembly.

3. Verify the AFM cantilever holder mounts flat against each pin on the end of the head.

### 7.2.7 Replace the Dimension SPM Head

1. Carefully slide the Dimension SPM head down into the dovetail groove of the Z-stage SPM.

2. When sliding the SPM head into the dovetail, make sure that the tip will not touch the sample. If it appears that the tip may touch when the SPM head is fully inserted in the dovetail, raise the Z-stage by selecting Motor > Withdraw several times, or by selecting Stage > Focus Surface and raising the Z-stage upward.

3. Loosen the screw located on the right side of the Dimension SPM head dovetail to lock the head in place (see Figure 7.2d).

### 7.2.8 Connect the Dimension Head

Insert the Dimension SPM head black 21-pin connector plug into the socket just behind the Z-stage located on the stage control electronics box (see Figure 7.2d).

### 7.2.9 Align Laser

**CAUTION:** Turn down the illuminator intensity before proceeding with laser alignment.

For both TappingMode and Contact Mode AFM, the user aligns the laser by moving the laser beam relative to the cantilever while observing the laser spot on the granite surface (a piece of white paper also works well) below the Dimension head. If the laser is not on the cantilever substrate, the laser appears as a bright red spot on the surface below. When the laser is aligned on the cantilever, a shadow appears on the surface below.

Figure 7.2e displays the laser control knobs located on the top of the Dimension head. There is a diagram printed on top of the Dimension head illustrating which direction the laser moves when turning the laser control knobs clockwise.
The X direction runs along the major axis of the substrate (parallel to the length of the cantilever). The right-rear laser control knob, atop the SPM head, controls the laser beam movement along the X direction. The front-left laser knob, atop the SPM head, moves the beam along the Y direction perpendicular to the cantilever and substrate's major axis. In the vision system display, the X direction is right-to-left across the screen, and the Y direction is top-to-bottom.

The procedure for aligning the laser is slightly different between TappingMode and Contact Mode AFM. The sections below detail the procedures for aligning the laser on the cantilever and tips for each mode respectively.

**Etched Silicon Tips (TappingMode)**

In order to place the laser reflection at the end of the cantilever, you must shine a laser beam on either the granite base or a piece of paper.

1. You can view the laser spot several different ways:
   - If a cantilever is being replaced, first select **Stage > Load New Sample** to reflect the laser off the of the granite base while it is locked in the Z-stage dovetail (as discussed in Section 7.1.2).
   - If the cantilever has already been removed, you may need to raise the Z-stage by selecting **Stage > Focus Surface** or **Motor > Withdraw**.
   - You can see the laser spot by removing the SPM head from the dovetail (without unplugging the cable between the SPM head and the Dimension base) and holding the SPM head over the granite or piece of paper.
2. Verify the laser beam is visible on the surface below. If it is not, turn the rear-right laser control knob counter-clockwise until the laser spot appears on the surface below.

3. Turn the rear-right laser control knob clockwise to move the laser in the X positive direction until the laser spot disappears from the surface below. Turn the right-rear laser control knob counter-clockwise until the laser spot just reappears. The laser is now positioned at the edge of the substrate (see Point 1 in Figure 7.2f).

4. Turn the front-left laser control knob clockwise or counter-clockwise to move the laser in the Y direction (parallel to the substrate edge and perpendicular to the cantilever) until the beam crosses the cantilever and a shadow appears over the laser spot on the surface below. The laser is now positioned over the cantilever (see Point 2 in Figure 7.2f).

5. Verify that the laser is deflecting off the cantilever by moving the laser on, over, and off the cantilever by turning the front-left laser control knob less than 1/8 of a turn.

6. Turn the rear-right laser control knob counter-clockwise to move the laser in the X negative direction on the cantilever until the laser crosses the tip-end of the cantilever and falls on the surface below.

7. Move the laser onto the tip-end of the cantilever by reversing the direction of the rear-right laser control knob clockwise until the spot disappears from the surface below (see Point 3 in Figure 7.2f).

8. Verify that a laser spot appears in the Dimension head filter screen. If there is not laser spot, adjust the photodetector mirror using the photodetector adjustment knobs located on the left side of the SPM head (see Figure 7.2g).

**CAUTION:** Use extreme caution when removing the SPM head. Hold the head firmly and do not stress the wire between the SPM head and the Dimension base. Dropping the head will likely result in damage and Veeco factory repair.
**Figure 7.2g** Photodetector Adjustment Knobs

Note: You may now restore the illuminator lamp to increased intensity for improved video image quality.

**Silicon Nitride Tips (Contact Mode AFM)**

In order to place the laser reflection at the end of the cantilever, you must shine a laser beam on either the granite base or a piece of paper.

1. You can view the laser spot several different ways:

   a. If a cantilever is being replaced, first select **Stage > Load New Sample** to reflect the laser off the of the granite base while it is locked in the Z-stage dovetail (as discussed in Section 7.1.2).

   b. If the cantilever has already been removed, you may need to raise the Z-stage by selecting **Stage > Focus Surface** or **Motor > Withdraw**.

   c. You can see the laser spot by removing the SPM head from the dovetail (without unplugging the cable between the SPM head and the Dimension base) and holding the SPM head over the granite or piece of paper.

   **CAUTION:** Use extreme caution when removing the SPM head. Hold the head firmly and do not stress the wire between the SPM head and the Dimension base. Dropping the head will likely result in damage and Veeco factory repair.

2. Verify the laser beam is visible on the surface below. If it is not, turn the rear-right laser control knob counter-clockwise until the laser spot appears on the surface below.
3. Turn the rear-right laser control knob clockwise to move the laser in the X positive direction until the laser spot disappears from the surface below. Turn the right-rear laser control knob counter-clockwise until the laser spot just reappears and stop turning the knob. The laser is now positioned at the edge of the substrate (see Point 1 in Figure 7.2h).

![Figure 7.2h Silicon Nitride Laser Alignment](image)

4. Once the laser is positioned just off the edge of the substrate, use the front-left laser control knob to move in the Y direction (parallel to the edge of the substrate) until the laser crosses a maximum of four legs on the two V-shaped cantilevers (see Point 2 in Figure 7.2h).

**Note:** This occurs when moving in one direction (either up or down from end to end). If the laser is close to the substrate, you should detect four distinct occurrences of the laser spot disappearing and reappearing on the surface below.

5. If the laser is positioned between a pair of legs of one cantilever (laser spot on surface below) turn the rear-right laser control knob counter-clockwise to move the laser left in the X direction until the laser spot disappears on the surface below (see Point 3 in Figure 7.2h).

6. Verify the laser is located on the portion of the cantilever connecting the two lever arms near the tip location by moving the laser on and off the cantilever, repeatedly, with an 1/8 turn of the back-left control knob. Then, place the laser back on the cantilever.

7. Turn the rear-right laser control knob counter-clockwise to move the laser in the X negative direction on the cantilever until the laser crosses the tip-end of the cantilever and falls on the surface below (see Figure 7.2h).

8. Move the laser onto the tip-end of the cantilever by reversing the direction of the rear-right laser control knob clockwise until the spot disappears from the surface below.

9. The laser is now on one of the two cantilevers. To determine which cantilever the laser is on:
Note: During this step do not adjust the back-right laser knob, or you may accidentally return to the original cantilever. Only use the back-right knob when you need to place the laser on the other cantilever.

a. Rotate the back-left laser control knob in either direction until the laser disappears and does not reappear with an 1/8 turn.

b. Use the same back-left laser control knob to rotate the laser the opposite direction, past the original cantilever.

c. Determine which cantilever you are on:
   - If the laser was on the longer cantilever at then beginning of this step, then the laser will not cross any other cantilever legs during this movement.
   - If the laser was on the small cantilever, then the laser will cross the two longer cantilever legs.

d. Select the cantilever for imaging by returning to the original cantilever, or locate the other end of this cantilever.

10. Verify that a laser spot appears in the Dimension head filter screen. If there is not laser spot, adjust the photodetector mirror using the photodetector adjustment knobs located on the left side of the SPM head.

7.2.10 Adjust Photodetector

1. Now that the laser is aligned on the cantilever, verify there is a spot visible on the Dimension head filter screen.

2. Verify there is an appropriate laser sum signal displayed on the image monitor (see Figure 7.2i). Typical laser sum values:
   - Contact Mode AFM: 4 - 6V
   - Tapping Mode: 1.5 - 2.5V

Note: If the laser sum signal is low, either the laser is not aligned or the photodetector knob needs adjusting (described in Step 3).
3. Center the laser detector signal using the photodetector adjustment knobs (see Figure 7.2i) located on the left side of the Dimension head. The image monitor displays the laser signal values and a schematic of the detector quadrants labeled **Detector**. The position of the laser is denoted by a red dot on the detector schematic (see Figure 7.2i).

- The Vertical Deflection signal is the difference between the top and bottom photodetectors. For TappingMode, adjust this signal to 0. For Contact Mode, adjust this signal to -2 (see Figure 7.2j).

**Note:** In TappingMode, the **RMS Ampl** is an AC signal and does not have any real magnitude until the cantilever tune has been completed.

**Note:** When the laser is positioned in the center of the detector schematic, the laser is also in the center of the screen on the front of the head. If the laser is severely out of alignment, it may help to first center the laser on the screen on the head using the photodetector adjustment knobs, then use the detector schematic on the image monitor to finish positioning the laser.
7.2.11 Locate Tip

For initial start-up where the Z-stage and optics have been almost fully retracted (such as when you performed Stage > Load New Sample), use the Focus Surface command to move the tip closer to the surface. It is easier to focus on the tip with more light reflecting from the surface into the optics.

To locate the tip, complete the following steps:

1. Initiate the Locate Tip command in the Stage menu by clicking on Locate Tip.
   
   **Note:** This command locates the tip position (Z height) using optical focal distance measurements. When this step completes, the computer records the tip position in memory.

2. Zoom out as far as possible using the trackball or Zoom Out button. This helps you locate the cantilever in optical field of view.

3. Once you find the tip, use the optic adjustment knobs (lower-left corner of the zoom optics assembly) to align the optical microscope lens so the tip is centered in the video display window.

4. Focus on the cantilever using the trackball. You can zoom in using the Zoom button on the trackball.

5. Quit the Locate Tip sequence by pressing ENTER on the keyboard or clicking OK at the bottom of the Locate Tip dialog box.
7.2.12 Load the Sample

If it is your first time operating the microscope, we recommend that you first image the calibration sample (a 10µm-pitch grid of 200nm step height) provided with the instrument.

Small Sample Preparation

Place the calibration sample or other small sample on one of the 1.5cm diameter metal disks used for sample mounting. The Dimension 3100 SPM ships with several steel sample disks that you may attach to a magnetic sample holder located in the Dimension Chuck Spare Parts Kit. Also provided with the instrument are red and white colored double-sided adhesive patches, or “sticky tabs,” designed to hold the sample chip to the disk.

1. Peel off a sticky tab from the provided sheet, and place it on the steel small sample puck (see Figure 7.2k).

2. Peel off the red-and-white paper to leave a patch of the two-sided adhesive on the steel sample disk holding the sample chip to the disk.

3. Using tweezers, place the small sample to be imaged firmly on the adhesive (see Figure 7.2l).
   
   **Note:** Alternatively, you may glue a small sample down to the sample puck using cyanoacrylate glue (super glue).

4. Place the small sample disk on the magnetic small sample holder.
   
   **Note:** The small sample holder provided with the Dimension 3100 is not optimal for imaging soft magnetic materials due to the magnetic hold-down properties. If magnetic imaging is intended, use the vacuum chuck.

   **Note:** For small samples with flat backs or samples mounted on metal discs, use the vacuum chuck.

**Figure 7.2k**  Securing Double-sided Tape to the Sample Disk
5. Secure the sample atop the stage.

**Figure 7.21** Securing the Sample

---

**Large Sample Preparation**

You may place large, flat samples directly on the vacuum chuck which are held down using vacuum. To engage the vacuum, use the toggle switch labeled **Vacuum** on the front of the black SPM electronics box. The stage has five holes available for holding samples: the center hole, three holes with machined rings for holding wafers and discs, and an isolated hole near the edge of the chuck for small samples. Remove the screw from the hole you will use, and block all unused holes with screws.

**7.2.13 Focus Surface**

1. Select the **Focus Surface** option under the **Stage** pop-down menu, or click on the **Focus Surface** icon.

2. Focus on the sample surface by rolling the trackball up or down while pressing the bottom-left button. This adjustment raises or lowers the vertical engage stage on which the SPM and optics are mounted.

3. To move long distances hold both left trackball buttons down simultaneously and roll the trackball with high speed to lock the peak speed of motion. Release these two buttons to stop the motors. Be careful when performing this in the downward direction.

**CAUTION:** Since the command **Focus Surface** moves the scanner vertically, be careful when making this adjustment to ensure that the tip does not hit the sample surface.
7.2.14 Cantilever Tune (TappingMode only)

1. Select Cantilever Tune from the View > Sweep pop-down menu, or click on the Cantilever Tune icon.

2. For Auto Tune Controls, verify the following:
   - Start Frequency is set to 100 kHz
   - End Frequency is set to 500kHz.
   - Target Amplitude is set to 2V.

3. Click on AUTO TUNE.

4. When the procedure ends, click on QUIT to exit the function.

7.2.15 Set Initial Scan Parameters

1. In the Scan Controls panel, set the following:
   - Initial Scan Size is set to 1µm (or desired scan size). Veeco recommends you always initially engage with small scan sizes.
   - X and Y Offsets are set to 0.
   - Scan Angle is set to 0.

2. In TappingMode, under the Feedback Controls panel, set the following:
   - Integral Gain is set to 0.4.
   - Proportional Gain is set to 0.8.
   - Scan Rate is set to 1Hz.

3. In Contact Mode AFM, under the Feedback Controls panel, set the following:
   - Setpoint is set to 0V.
   - Integral Gain is set to 2.0.
   - Proportional Gain is set to 3.0.
   - Scan Rate is set to 1Hz.
7.2.16 Engage

- Select Motor > Engage, or click the Engage icon.
- Once engaged, refer to the appropriate chapter in this manual for further instructions for the mode you are using (e.g. Contact AFM: Chapter 8, TappingMode AFM: Chapter 9, etc.)

7.2.17 Withdraw

When imaging is complete, withdraw the tip by selecting Motor > Withdraw, or click the Withdraw icon. This typically raises the tip 1mm above the sample.

Although the 1mm withdraw distance provides enough clearance to loosen the dovetail and remove the AFM head, if further distance is desired perform one of the following:

- Select Stage > Focus Surface to raise the Z-stage with the trackball.
- Execute Withdraw multiple times.
- Select Stage > Load New Sample.

Note: It is impossible to move the Dimension head if the laser sum signal is too low.

7.3 Advanced AFM Operation

7.3.1 Stage Parameters

The system ships with the following default stage parameters (see Figure 7.3a). Once you have become familiar with using the system, you may want to adjust the stage parameters to speed up the engage sequence.

1. To access the stage parameters panel, select SPM Parameters from the Stage pop-down menu.

2. For initial set-up, use the following values. When done, click OK to close the SPM Parameters window.
Definitions of Stage > SPM Parameters fields are as follows:

**Sample Clearance**

Defines the height of the probe tip over the sample prior to Engage (set up by performing the Locate Tip and Focus Surface routines). You may change the sample clearance parameter once you are experienced with the system. The default parameter is 1000µm. This parameter also sets the distance that the tip is raised above the sample each time Withdraw is executed.

**SPM Safety**

Defines the height of the probe tip over the sample where the fast approach changes over to the slow approach. The default parameter is 100µm. You may reduce to 50-75µm once you are experienced with the system. Reducing this number speeds up the approach sequence, but it increases the risk of the tip reaching the surface during the fast engage if the Locate Tip and Focus Surface focal points are not properly set. If this happens, the tip has “crashed” and may need replacing.

**SPM Engage Step**

Defines the step size of the Z-stage during engage. The default parameter is 1µm. Increasing this increases the speed of the approach.

<table>
<thead>
<tr>
<th>SPM Parameters</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample clearance:</td>
<td>1000.0 µm</td>
</tr>
<tr>
<td>SPM safety:</td>
<td>100 µm</td>
</tr>
<tr>
<td>SPM engage step:</td>
<td>1.00 µm</td>
</tr>
<tr>
<td>Load/Unload height:</td>
<td>3000 µm</td>
</tr>
</tbody>
</table>

**CAUTION:** Do not change this parameter by more than 0.5-1 µm because the step size must be some modest fraction of the total Z range of the scanner (i.e. 6-7µm).

**Load/Unload Height**

This parameter defines how high the tip moves above the sample when Stage > Load New Sample is executed. After the Z-stage is raised, the sample stage moves as far forward in the Y direction (towards you) as possible.
Chapter 8  Contact AFM

This chapter covers procedures for operating the Dimension 3100 Scanning Probe Microscope (SPM) in Contact Mode AFM. It is assumed that the operator has previously prepared a Contact Mode tip and aligned the laser per instructions provided in Chapter 7 of this manual. Specific information regarding tip preparation is also provided in Chapter 6.

- **Basic Contact Mode AFM Operation**: Section 8.1
  - **Select the Microscope**: Section 8.1.1
  - **Select Mode of Operation**: Section 8.1.2
  - **Head, Cantilever and Sample Preparation**: Section 8.1.3
  - **Align Laser**: Section 8.1.4
  - **Adjust Photodetector**: Section 8.1.5
  - **Locate Tip**: Section 8.1.6
  - **Focus Surface**: Section 8.1.7
  - **Show All Items**: Section 8.1.8
  - **Set Initial Scan Parameters**: Section 8.1.9
  - **Engage**: Section 8.1.10

- **Advanced Atomic Force Operation**: Section 8.2
  - **Cantilever Selection**: Section 8.2.1
  - **Optimization of Scanning Parameters**: Section 8.3
    - **Data Type**: Section 8.3.1
    - **Gain Settings**: Section 8.3.2
    - **Scan Size and Scan Rate**: Section 8.3.3
    - **Setpoint**: Section 8.3.4
8.1 Basic Contact Mode AFM Operation

The following is a general outline of basic operational procedures involved in Contact Mode AFM. For more detailed instructions, refer to Chapter 7 of this manual.

8.1.1 Select the Microscope

1. Set the microscope head configuration by selecting Di > Microscope Select.
2. Click OK to close the Microscope Select dialog box. When enabled, the selected buttons are black.

8.1.2 Select Mode of Operation

1. Select Microscope > Profile.
2. Select Contact Mode as the mode of operation.

8.1.3 Head, Cantilever and Sample Preparation

1. Install a silicon nitride tip onto an AFM cantilever holder (see Chapter 7).
2. Load the cantilever holder with installed tip onto the scanner tube of the Dimension SPM head.

8.1.4 Align Laser

1. Align the laser using the laser control knobs.
2. Verify the laser beam is positioned on the back of the cantilever, with a spot visible in the Dimension head filter screen and a sum signal of 4-6V.
8.1.5 Adjust Photodetector

1. Adjust the photodetector so that the red dot moves toward the center of the Dimension head filter screen using the two photodetector adjustment knobs located on the side of the Dimension head.

2. Verify that the red dot is centered and elliptical in shape in the Dimension head filter screen.

3. Set the Vertical Deflection to -2V.

8.1.6 Locate Tip

1. Select Stage > Locate Tip or click on the Locate Tip icon.

2. Center the tip end of the cantilever under the cross hairs using the two optics adjustment knobs located left of the optical microscope objective.

3. Use the trackball with the bottom left button depressed to focus on the tip end of the cantilever.

8.1.7 Focus Surface

1. Select Stage > Focus Surface or click on the Focus Surface icon.

2. Focus on the sample surface using the trackball with the bottom-left button depressed.
8.1.8 Show All Items

Before changing any parameters, you should display all of the available parameters. If you cannot view a parameter in a panel, you might need to enable this parameter.

1. Click the “minus box” in the upper left corner of the panel, and click **Show all items**.

![Figure 8.1a](image1.png)

**Figure 8.1a** Select Show All Items

2. Ensure there is a “X” in the check box to the left of all parameters.

**Note:** Those parameters without a X will not display in normal Realtime mode.

![Figure 8.1b](image2.png)

**Figure 8.1b** Enable Parameters

3. Click the “minus box” in the upper left corner of the panel, and click **Show all items**.

The panel will once again appear in normal Realtime mode.
8.1.9 Set Initial Scan Parameters

Scan Controls Panel

In the Scan Controls panel, set the following initial scan parameters (see Figure 8.1c).

1. Set the Scan Rate to 2 Hz.
2. Set the Scan Size to 1µm.
3. Set the Scan Angle to 0.
4. Set X and Y Offsets to 0.

![Figure 8.1c Suggested Scan Controls Settings](image)

Other Controls Panel

Keep the Z limit at its maximum value.

![Figure 8.1d Suggested Other Controls Settings](image)
Feedback Controls Panel

1. Set the **Integral gain** to 2.0 and the **Proportional gain** to 4.0 (see Figure 8.1e).

2. Set the **Deflection Setpoint** to 0V.

![Feedback Controls Panel](image)

**Figure 8.1e**  Suggested Feedback Controls Settings

Channel Panels 1 and 2

1. In the **Channel 1** panel, set **Data type** to **Height** (see Figure 8.1f).

2. Set **Data scale** to a reasonable value for the sample.

   **Note:** For example, for a 200nm step height calibration sample, a reasonable Data scale setting is 300nm initially.

3. Set **Line direction** to either **Trace** or **Retrace**.

4. On the **Channel 2** panel, verify **Data type** is set to **Off** to disable the panel.

![Channel Panels 1 and 2](image)

**Figure 8.1f**  Suggested Channel Controls Settings
8.1.10 Engage


2. To move to another area of the sample, execute a Withdraw command to avoid damaging the tip and scanner.

3. Move the stage using the trackball to the next area of interest on the sample.

4. Select Motor > Engage.

Note: After the tip engages, adjust the control panel values to provide the desired scan parameters.

8.2 Advanced Atomic Force Operation

Although a great deal can be accomplished with basic knowledge of AFM operation, there is far more to operating the AFM.

Cantilever selection is critical and becomes more important as tip and cantilever technology continues to develop. A clear understanding of the parameters in the Realtime control panel allows the user to tune the microscope to accommodate a wide variety of samples. This section provides more detailed information on the operation of the Dimension microscope in Contact Mode AFM.

8.2.1 Cantilever Selection

Two basic cantilever styles are available for Contact Mode AFM. Traditional triangular silicon nitride cantilevers have been used successfully for years. They are robust and relatively inexpensive. Etched silicon cantilevers with integral tips provide another scanning option. They have a higher aspect ratio and smaller end radius than the silicon nitride cantilevers (Model ESP).

Note: There are a wide variety of tips available for Contact Mode AFM. Check the tip buying guide on the Veeco website (www.veeco.com) for more information.

Silicon Nitride Cantilevers

Silicon nitride cantilevers for the Dimension 3100 SPM are available in two process variations: standard and sharpened. Sharpened silicon nitride cantilevers (Model DNPS) are almost identical in appearance to the standard silicon nitride cantilevers, but have a slightly sharper end at the very tip. Sharpened silicon nitride cantilevers are available by mail order through www.veeco.com.

Each silicon nitride cantilever substrate includes four cantilever tips with different size and spring-constants. Two of the cantilevers on each substrate measure 115µm from the substrate to the apex of the triangular cantilever (referred to as 100µm cantilevers) while the remaining two cantilevers measure 193µm from the substrate to the apex of the triangular cantilever (referred to as 200µm cantilevers). Both cantilever lengths are available with wide legs and narrow legs; however,
thickness of both cantilevers are equal. The calculated spring-constant for each of the cantilever configurations is listed below in Table 8.2a. These values are approximations and significant variability occurs. The tabulated values are used to approximate contact force unless more accurate values are measured by the user.

Table 8.2a Cantilever Spring Constants

<table>
<thead>
<tr>
<th>Cantilever Type</th>
<th>k (N/m) Narrow Legs</th>
<th>k (N/m) Wide Legs</th>
</tr>
</thead>
<tbody>
<tr>
<td>100µm (triangular)</td>
<td>0.38</td>
<td>0.58</td>
</tr>
<tr>
<td>200µm (triangular)</td>
<td>0.06</td>
<td>0.12</td>
</tr>
</tbody>
</table>

The 100µm wide-legged cantilever are used on most samples. If the image degrades rapidly because the tip damages the sample surface, switch to a cantilever with a lower spring-constant. Cantilevers with smaller spring-constants are used on softer samples which are destroyed by imaging with high-contact forces.

**Etched Silicon Tips**

Etched silicon tips have a higher aspect ratio and smaller end radius than the silicon nitride cantilevers. Because they are sharper, etched silicon tips provide better resolution and have less applied capillary forces. Most samples in air are covered by a thin layer of water and other condensed contaminants. These contaminants often form a capillary bridge between the tip and sample, generating large adhesive forces, also referred to as capillary forces (see Figure 8.2a). For more force curve information, see Chapter 13.

**Figure 8.2a Force Curve**
8.3 Optimization of Scanning Parameters

Careful selection of scan parameters is important in the successful application of Contact Mode AFM. In most cases, optimal parameter selection depends on the sample. It is beneficial to experiment with a range of values within each parameter, however, please review discussions of the scan parameters in the Realtime control panels in the Command Reference Manual before making bold changes. The following section analyzes the effects of the most important parameters.

8.3.1 Data Type

Data type is the first parameter set because the settings of other parameters depend on it. The Data type parameter in the Channel control panels selects the type of data collected by the system. Height data corresponds to the change in piezo height needed to keep the cantilever deflection constant. Deflection data comes from the differential signal off of the top and bottom photodiode segments relative to the Deflection Setpoint.

The scan parameters required to collect accurate height data are different from the optimal parameters for deflection data. To collect height data, the feedback gains must be high so that the tip tracks the sample surface with minimal cantilever deflection. The position of the piezo during the scan reflects the height of the sample. To collect accurate topographical data, set the Data type parameter to Height. Topographical Deflection data is only reasonable on very smooth, flat samples. Topographical Deflection data is used infrequently and only for high resolution work.
Collect **Deflection** data with low feedback gains to ensure the piezo remains at a constant position relative to the sample. In this case, the tip and cantilever are deflected by the features on the sample surface. The output fluctuations in the cantilever deflection voltage from the top and bottom photodiode segments are recorded as a measure of the variation in the sample surface. **Deflection** data is not automatically calibrated in units of distance. You must measure the sensitivity using the procedures discussed in Chapter 13.

**Deflection** data collected with high feedback gains essentially equals the derivative of the height. This is commonly referred to as the error-signal. The error-signal provides a sensitive edge-detection technique and can be very helpful in visualizing fine details in topography that are difficult to see in regular height data. Using two channels, you must capture both height and deflection data simultaneously. **Deflection** (error-signal) data alone does not yield quantitative height information.

### 8.3.2 Gain Settings

The **Integral**, **Proportional**, and **LookAhead** gains in the **Feedback Controls** panel determine the feedback on the piezo height. The feedback loop keeps the deflection signal constant by adjusting the height of the piezo tube. If the gains are high, as they should be for **Height** data, the piezo height changes to keep the cantilever deflection nearly constant. If the gains are low, as they should be for topographical **Deflection** data, the cantilever deflects from its nominal position as it encounters features in the sample.

In general, set the gain settings as follows:

1. Set the **Integral** and **Proportional** gains to 2-3 to start scanning.

2. To optimize the gains for **Height** data, increase the **Integral gain** until the piezo begins to oscillate, then eliminate the oscillations by reducing the gain with 2-3 clicks of the left arrow key.

3. Repeat the process for the **Proportional gain**.

   **Note:** Piezo oscillations typically cause high frequency wavy lines in the Realtime image. Piezo oscillations are more easily observed in **View > Scope Mode**.

4. For **Deflection** data, engage the microscope with the gains high, then lower them as much as possible without losing contact with the sample once the system begins scanning.

5. Set the **LookAhead gain** to 0.7 initially for samples with step-like features oriented perpendicular to the fast scan direction. Otherwise, it should be left at 0.00.

   **Note:** The **LookAhead gain** includes information from the previous scan line to determine the current gain setting.
8.3.3 Scan Size and Scan Rate

In general, decrease the Scan rate as the Scan size increases. Use scan rates of 1.5 - 2.5 Hz for large scans on samples with tall features. High scan rates help reduce drift, but use high scan rates only on flat samples with small scan sizes. When first using the system, vary the scan rate enough to observe a change in the image quality.

8.3.4 Setpoint

The Setpoint parameter defines the desired voltage (and, therefore, the desired deflection or force of the cantilever) for the feedback loop. The setpoint voltage constantly compares to the present vertical deflection signal of the photodiode to calculate the desired change in the piezo position. When the gain values are high, and when the Data type is set to Height, the Z piezo position changes to keep the photodiode output signal close to the Setpoint; therefore, the cantilever deflection remains nearly constant.

Adjust the Setpoint to increase or decrease the cantilever deflection and, therefore, the contact force of the tip on the sample. The Force Calibration command in the Realtime > View menu allows you to adjust the setpoint while viewing a graph of the tip position versus the deflection voltage. Using this procedure, described in detail in Chapter 13, minimizes the contact force of the tip on the sample. This is especially important on soft materials such as biological samples.

8.3.5 Lowpass Filter

The Lowpass filter invokes a digital, one-pole, lowpass filter to remove high-frequency noise from Realtime data. The filter operates on the collected digital data regardless of the scan direction. Settings for this item range from Off through 9. Off implies no lowpass filtering of the data, while settings of 1 through 9, successively, lower the cut-off frequency of the filter applied to the data stream. The standard setting is Off.

8.3.6 Highpass Filter

The Highpass filter parameter invokes a digital, two-pole, highpass filter to remove low frequency effects such as ripples caused by torsional forces on the cantilever when the scan reverses direction. As with the Lowpass filter, the Highpass filter also operates on the digital data stream regardless of scan direction. This parameter can be Off or set from 1 through 9. Settings of 1 through 9, successively, lower the cut-off frequency of the filter applied to the data stream. Note that in removing low frequency information from the image, the Highpass filter distorts the height information in the image. As a result, this filter must be Off when accurate height information is desired. The Highpass filter is typically used only for atomic images.
8.4 Force Calibration Mode

The Force Calibration command in the View > Force Mode > Calibration menu allows you to check the interaction between the cantilever and the sample surface. For detailed information regarding Force Calibration, see Chapter 13.
Chapter 9  TappingMode AFM

This chapter details procedures for operating the Dimension 3100 SPM in TappingMode in air. For information regarding TappingMode in fluids, see Chapter 10. For information regarding loading a TappingMode tip and aligning the SPM laser see Chapter 7 of this manual. Additional information regarding cantilever preparation is provided in Chapter 6.

This chapter addresses the following:

- **Principles of TappingMode**: Section 9.1
- **Basic TappingMode AFM Operation**: Section 9.2
  - **Select Mode of Operation**: Section 9.2.1
  - **Head, Cantilever and Sample Preparation**: Section 9.2.2
  - **Align Laser**: Section 9.2.3
  - **Adjust Photodetector**: Section 9.2.4
  - **Locate Tip**: Section 9.2.5
  - **Focus Surface**: Section 9.2.6
  - **Cantilever Tune**: Section 9.2.7
  - **Show All Items**: Section 9.2.8
  - **Set Initial Scan Parameters**: Section 9.2.9
  - **Engage**: Section 9.2.10
  - **Optimize Scan Parameters**: Section 9.2.11
- **Withdraw the Tip**: Section 9.3
- **Advanced TappingMode AFM Operation**: Section 9.4
  - **Resonating Techniques**: Section 9.4.1
  - **Cantilever Oscillation**: Section 9.4.2
9.1 Principles of TappingMode

Figure 9.1a depicts a cantilever oscillating in free air at its resonant frequency. A piezo stack excites the cantilever substrate vertically, causing the cantilever to move up and down. As the cantilever moves vertically, the reflected laser beam, or “return signal,” deflects in a regular pattern over a photodiode array, generating a sinusoidal, electronic signal.
Figure 9.1b represents the same cantilever at the sample surface. Although the piezo stack continues to excite the cantilever substrate with the same energy, the tip deflects in its encounter with the surface. The reflected laser beam reveals information about the vertical height of the sample surface and characteristics of the sample material itself. These material characteristics include elasticity, magnetism, and presence of electrical forces.

![Tapping Cantilever on Sample Surface](image)

**Figure 9.1b**  Tapping Cantilever on Sample Surface

Note: Deflection of the cantilever and return signal are exaggerated in the figure for illustrative purposes.

### 9.2 Basic TappingMode AFM Operation

The following is a general outline of basic operational procedures involved in TappingMode AFM. For more detailed instructions, refer to Chapter 7 of this manual.

#### 9.2.1 Select Mode of Operation

- Select **Microscope > Profile**.
- Select **TappingMode** as the mode of operation.
9.2.2 Head, Cantilever and Sample Preparation

- Install an etched single crystal silicon tip onto an AFM cantilever holder (see Chapter 7).
- Load the cantilever holder with installed tip onto the scanner tube of the Dimension SPM head.

9.2.3 Align Laser

- Align the laser using the laser control knobs (see Align Laser: Section 9.2.3 for more detailed instructions).
- Verify the laser beam is positioned on the back of the cantilever, with a spot visible in the Dimension head filter screen and a sum signal of at least 1V.

9.2.4 Adjust Photodetector

1. Adjust the photodetector so that the red dot moves toward the center of the Dimension head filter screen using the two photodetector adjustment knobs located on the left side of the Dimension head.
2. Verify that the red dot is centered and elliptical in shape in the Dimension head filter screen.
3. Set the Vertical Deflection to 0V.

9.2.5 Locate Tip

1. Select Stage > Locate Tip or click the Locate Tip icon.
2. Center the tip end of the cantilever under the crosshairs using the two optics adjustment knobs located left of the optical microscope objective.
3. Use the trackball with the bottom left button depressed to focus on the tip end of the cantilever.

Note: You may need to adjust the illumination and zoom to clearly see the probe.
9.2.6 Focus Surface

**CAUTION:** Use caution when focussing on the sample surface. Moving the head too quickly while focussing can cause the tip to crash, which may damage the tip and/or sample.

1. Select **Stage > Focus Surface** or click the **Focus Surface** icon.

2. In the **Focus On** box, select **Choose either surface** or **Tip reflection**. If the sample is very flat or reflective, choose **Tip reflection**.

3. Focus on the sample surface using the trackball with the bottom left button depressed.

   **Note:** You may need to adjust the illumination and zoom to clearly see the probe.

9.2.7 Cantilever Tune

This section describes the steps required to find the resonance peak of the cantilever and adjust the oscillation voltage so the cantilever vibrates at an appropriate amplitude. A range of oscillation frequencies are applied to the cantilever to determine the frequency which produces the largest response (the resonant frequency). In most instances, the resonant peak has a sharp Gaussian distribution but at times the peak can be ragged. The system tolerates some deviation in the shape of the peak.

- Select **View > Sweep > Cantilever Tune**, or click on the **Cantilever Tune** icon. The initial **Cantilever Tune** panel appears with the **Frequency Sweep** (a plot of cantilever response as a function of applied oscillation frequency) on the display monitor.

- Choose either the manual or automatic tuning method (see Automatic Tuning and Manual Cantilever Tuning).
Automatic Tuning

For most purposes, the Auto Tune function will suffice.

- Verify the starting parameters. The nominal resonant frequency of a probe can be found on the probe box label. Ensure the start and end frequencies correlate with this value.
- Click Auto Tune. The computer and controller begin automatic tuning (see Figure 9.2a).

![Figure 9.2a Auto Tune Control Panel](image)

Manual Cantilever Tuning

With Force Modulation or Fluid Tapping applications, it may be useful to tune the cantilever manually.

Note: More than one type of cantilever exists. Cantilevers can have different dimensions and different resonant frequencies. Certain parameter values, particularly the center frequency and the sweep width used in the following example, apply to a particular cantilever type. In the following example, nominal parameter values will vary depending on the actual cantilever used.

1. In the Cantilever Tune panel, set the Drive frequency parameter to a value near the center of the resonant frequencies range specified for the wafer. For example, if the frequency range is specified as 240—420 KHz, select a drive frequency of 330 KHz.
2. Set the Drive amplitude to 200 mV.
3. Set the Sweep Width to the same value as the Center Frequency.
4. The Sweep Width must be large enough to cover the frequency range specified for the wafer.
5. Zero the Setpoint.
6. Set the Amplitude limit to 2.5V.
7. Center the peak on the frequency sweep plot shown on the display monitor using the Zoom In and Offset commands after identifying the maximum amplitude peak with the lowest frequency in the frequency response plot.
**Note:** The Offset command sets the center frequency equal to the cursor position to shift the plot. The Zoom In command decreases the sweep width and shifts the center frequency value to stretch the plot.

8. Increase the **Setpoint** until the peak appears.

9. Continue to **Zoom In** and center the peak until the peak coincides with the vertical center line within **10 Hz**. The value displayed for center frequency is now used as the resonant frequency of the cantilever.

**Note:** The system works well in TappingMode if the center frequency is at, or below, the peak in the resonance plot. The center frequency can decrease to the point where the oscillation amplitude reaches 90 percent of the maximum value. Operate at a frequency lower than the resonant frequency to avoid shifting the resonant frequency upon approach of the tip to the surface (see **Figure 9.2c**).

**Figure 9.2b** Cantilever Tune Control Panels for Main Controls

<table>
<thead>
<tr>
<th>Graph Controls</th>
<th>Main Controls</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sweep width: 3.00000 kHz</td>
<td>Amplitude setpoint: 1.000 V</td>
</tr>
<tr>
<td>Drive frequency: 10.0000 kHz</td>
<td>Amplitude limit: 2.500 V</td>
</tr>
<tr>
<td>Sweep sample count: 256</td>
<td>Drive phase: 0 °</td>
</tr>
<tr>
<td>pause between steps: 1500 μs</td>
<td>Drive amplitude: 200.0 mV</td>
</tr>
</tbody>
</table>

10. Specify the **RMS amplitude** after tuning the cantilever to its resonant frequency. The desired operating amplitude depends on the sample and other scanning conditions.
11. Click **OK**. The parameters set in the **Cantilever Tune** control panel appear in the **Realtime** control panel.

12. Click on **CANCEL** to exit the **Cantilever Tune** command and leave the parameters unchanged.
### 9.2.8 Show All Items

Before changing any parameters, you should display all of the available parameters. If you cannot view a parameter in a panel, you might need to enable this parameter.

1. Click the “minus box” in the upper left corner of the panel, and click **Show all items**.

   ![Figure 9.2d Select Show All Items](image)

   **Figure 9.2d** Select Show All Items

   a. Click here
   b. Select this

2. Ensure there is a “X” in the check box to the left of all parameters.

   **Note:** Those parameters without a X will not display in normal Realtime mode.

   ![Figure 9.2e Enable Parameters](image)

   **Figure 9.2e** Enable Parameters

3. Click the “minus box” in the upper left corner of the panel, and click **Show all items**. The panel will once again appear in normal Realtime mode.
9.2.9 Set Initial Scan Parameters

Scan Controls Panel

In the Scan Controls panel, set the following initial scan parameters (see Figure 9.2f).

1. Set the Scan Rate to 2 Hz.
2. Set the Scan Size to 1µm.
3. Set the Scan Angle to 0.
4. Set X and Y Offsets to 0.

![Figure 9.2f Suggested Scan Controls Settings](image)

Other Controls Panel

Verify the Z Limit is at the maximum value.

![Figure 9.2g Suggested Other Controls Settings](image)
Feedback Controls Panel

- Set the **Integral gain** to 0.5 and the **Proportional gain** to 0.7 (see Figure 9.2h).
- Set the **Look Ahead gain** to zero.

**Figure 9.2h**  Suggested Feedback Controls Settings

<table>
<thead>
<tr>
<th>Feedback Controls</th>
</tr>
</thead>
<tbody>
<tr>
<td>SPM feedback:</td>
</tr>
<tr>
<td>Z modulation:</td>
</tr>
<tr>
<td>Integral gain:</td>
</tr>
<tr>
<td>Proportional gain:</td>
</tr>
<tr>
<td>Amplitude setpoint:</td>
</tr>
<tr>
<td>Drive frequency:</td>
</tr>
<tr>
<td>Drive amplitude:</td>
</tr>
<tr>
<td>Analog 2:</td>
</tr>
</tbody>
</table>

**Note:** The **Drive frequency** and **Drive amplitude** values were determined during the Cantilever Tune procedure. It is not necessary to enter a value for the **Amplitude setpoint**; this will be determined automatically during the engage process.

### 9.2.10 Engage

1. Select **Motor > Engage**. A pre-engage check begins, followed by Z-stage motor motion.

2. To move to another area of the sample, execute a **Withdraw** command to avoid damaging the tip and scanner.

3. Move the stage using the trackball to the next area of interest on the sample.

4. Select **Motor > Engage**.

   **Note:** After the tip engages, adjust the control panel values to provide the desired scan parameters. Refer to Section 9.4.4 for scan parameter optimization.

5. After engaging, it may be necessary to recheck the Cantilever Tune parameters. Select **View > Sweep > Cantilever Tune**. In the **Tip Offset** box, enter **200nm** and click **OK**. Adjust the **Drive frequency** if necessary.
9.2.11 Optimize Scan Parameters

The procedure to optimize the scan parameters is similar to that of Contact Mode.

1. In the Scan Controls panel, set Slow scan axis to Disabled.
2. Select View > Scope Mode.
3. Observe the agreement between the trace and retrace lines. Adjust the Scan rate, Gains, and Amplitude setpoint to bring these two lines in to coincidence. A more detailed discussion of these parameters can be found in Section 9.4.

9.3 Withdraw the Tip

1. Select Withdraw from the Motor menu. The SPM stops scanning, and ascends to the sample clearance height defined in the SPM Parameters menu.
2. Select the Stage > Load New Sample option to replace or move the sample.
3. Use the Focus Surface command to move the SPM up if you desire more clearance between the tip and sample.

CAUTION: Never withdraw samples without verifying that the tip has adequate clearance during the entire sample removal sequence.
9.4 **Advanced TappingMode AFM Operation**

This section discusses the more subtle aspects involved in operating the Dimension 3100 in TappingMode.

### 9.4.1 Resonating Techniques

Without a thorough understanding of principles associated with cantilever resonating techniques, you may generate distorted data. Understanding the *Cantilever Tune* process and the effects of real-time scan parameters is critical for effective operation of the microscope. It is also important to understand similarities and differences between *Force Calibration Mode in Contact AFM* and *Force Calibration Mode in TappingMode* (see Chapter 13).

### 9.4.2 Cantilever Oscillation

The response of the cantilever to inputs plays an important role in the operation of the Dimension 3100 SPM while in TappingMode. There is an important trade-off between the response time of the cantilever and the force applied to the sample. The cantilever does not respond instantly to perturbations in oscillation amplitude. The cantilever drive system pumps energy gradually into the cantilever oscillation. Figure 9.4a illustrates a typical response curve of the cantilever amplitude as a function of time. To demonstrate the conflicting requirements, the performance of the system is analyzed at two operating points.

**Figure 9.4a** Cantilever Response Curve

At Setpoint 1 the operating point is only slightly lower than the free oscillation amplitude. This has the advantage of dissipating very little energy to the sample surface. The disadvantage is that the system takes longer to recover from a given perturbation in the amplitude. Consider the situation where the tip travels off a step with a height of $\Delta x$. At Setpoint 1 it takes longer for the amplitude of the cantilever oscillation to increase; therefore, the feedback system is slow in responding to the error created by going off of the step. At operating Setpoint 2 the cantilever amplitude builds up...
more rapidly. The feedback system senses the error caused by going off of the step and responds more rapidly. Unfortunately, more energy transfers to the sample surface while scanning at this operating point.

The nature of the sample influences the decision between response time and contact force. For example, harder samples can withstand higher contact forces, so the response time improves by lowering the **Setpoint amplitude**. Soft samples that are relatively flat should run with higher **Setpoint** values to reduce the energy imparted to the sample. In general, the solution to the problem is to decrease the scan rate and increase the feedback gains. In some situations, the feedback gains cannot increase without causing piezo oscillations; in such cases there is no choice but to reduce the scan rate.

Inadequate response time typically occurs when the tip encounters a low point in the sample. The amplitude of the cantilever oscillation decreases very quickly when taller portions of the sample are encountered. As a result, the system response is markedly different depending on whether the tip is climbing or descending a feature in the sample. For this reason, **Scope Mode** is very useful when setting scan parameters. As the tip descends, features are evaluated by comparing the **Trace** and **Retrace** in **Scope Mode**. Figure 9.4b illustrates the effects of poorly selected scan parameters on a calibration standard that includes a series of sharp-walled pits. Regardless of the scan direction, the tip does not track the wall of the pit when the tip encounters a pit. However, it does track the surface closely when moving out of the pit.

**Figure 9.4b**  Scope Trace with High Scan Rate

![Scope Trace with High Scan Rate](image)

Figure 9.4c depicts the same sample with a slight increase in the **Integral gain** and a twofold decrease in the **Scan rate**. The tip now tracks the surface when it descends into the pit as well as when it exits. The **Trace** and **Retrace** lines now coincide closely.
9.4.3 Decreasing the Cantilever Drive Frequency

The Drive frequency selected to oscillate the cantilever plays an important role in the performance of the microscope while in TappingMode. As a first step it is important to determine the resonant frequency of the cantilever, but the Drive frequency could be further tuned to improve scanning performance.

The microscope produces better data in TappingMode when the Drive frequency is set lower than the resonant peak of the cantilever. The Drive frequency is set such that it coincides with a 1-10 percent decrease in the oscillation amplitude by setting Peak offset in the Auto Tune controls to the desired percent. Figure 9.4d shows a suggested operating region. This is a suggestion based on our observations; users are encouraged to experiment with the microscope and decide what produces the best results.
9.4.4 Optimization of Scanning Parameters

The user is encouraged to review Section 8.3 which discusses parameter optimization for Contact AFM.

9.4.5 Data Type

Data type is the first parameter to set because the values of other parameters depend on it. The Data type parameter in the Channel 1, Channel 2 and Channel 3 panels selects the type of data collected by the system. Height data corresponds to the change in piezo height needed to keep the amplitude of the cantilever constant. Amplitude data measures the change in amplitude relative to the amplitude setpoint.

The scan parameters required to collect good Height data are different than the optimal parameters for Amplitude data. To collect Height data while tracking the sample surface with minimal change in the tip’s oscillation amplitude, the feedback gains must be high.

Amplitude data collected with high feedback gains is the derivative of the height. Amplitude mode provides a sensitive edge detection technique. With the dual screen mode it is possible to capture both Height and Amplitude data simultaneously.

9.4.6 Gain Settings

The Integral and Proportional gains on the Feedback Controls panel must be high enough to force the feedback system to track the sample surface. When scanning in TappingMode, set the Integral and Proportional gains to lower values than those values used in Contact mode. The Proportional gain can usually be set 30%-100% higher than the Integral gain. To optimize the gains, increase the Integral gain until the piezo begins to oscillate (feedback oscillation usually occurs with Integral gains of 1-2), then eliminate the oscillations by reducing the gain with two or three clicks of the left arrow key. Repeat the process for the Proportional gain.

9.4.7 Scan Size, Scan Rate, and Setpoint

The Scan size, Scan rate, and Setpoint values effect data output differently. As in Contact mode, decrease the Scan rate as the Scan size is increased. Use Scan rates of 0.5-1.0 Hz for large scans on samples with tall features. High scan rates help reduce drift, but only use them on flat samples with small scan sizes.
The **Setpoint** parameter defines the desired voltage for the feedback loop. The **Setpoint** voltage is constantly compared to the present **RMS amplitude** voltage to calculate the desired change in the piezo position. When the gain values are high, as they should be when the **Data type** is set to **Height**, the Z piezo position changes to keep the amplitude voltage close to the **Setpoint**; therefore, the oscillation amplitude remains nearly constant.

As discussed above, changing the **Setpoint** alters the response of the cantilever oscillation and changes the amount of force applied to the sample surface.

The force applied by the tip on the sample increases as the setpoint is decreased. To minimize the force on the sample:

- Increase the setpoint using the right arrow key on the computer keyboard until the tip is no longer interacting with the surface. This can be observed by monitoring the trace and retrace lines in **View > Scope Mode**, and by monitoring the **Z Center Position** display in the Image Monitor. When the tip is no longer interacting with the surface, the Z Center Position will move to the retracted limit.

- Slowly decrease the setpoint using the left arrow key on the keyboard until features appear in the trace and retrace lines in **View > Scope Mode**.

The setpoint can also be adjusted by using **View > Force Mode > Calibrate**. Force calibration mode is used to compare the amplitude of the cantilever oscillation on the surface to the free-air amplitude. Other uses of Force Calibration include characterizing the forces on the cantilever tip, diagnosing the performance, and calibrating the RMS amplitude voltage as a function of the oscillation amplitude of the cantilever. The use of Force Calibration is described in Chapter 13.

### 9.4.8 Surface Tune

It is often desirable to check the cantilever tune after engaging. You will notice that the **Cantilever Tune** icon is grayed out when the tip is engaged. However, you can still access the **Cantilever Tune** panel by selecting **View > Sweep > Cantilever Tune**.

A warning appears indicating that cantilever tuning while engaged can result in damage to the tip or sample. This warning prompts you to enter a **Tip offset**. This is the distance above the sample that the tip will be raised before displaying the tuning spectrum. Use a minimum **Tip offset** of 100-200nm.

Observe the plot of amplitude vs. driving frequency to see if the cantilever tuning curve shifted during the engagement. The drive frequency can be adjusted to compensate for such a shift by using the **Offset** command located above the **Cantilever Tune** plot. The phrase response curve can be adjusted as well.
9.5 Troubleshooting

9.5.1 Frequency Response Plot

If a peak in the frequency response plot does not appear, perform the following steps:

1. Increase **Sweep width** to the maximum value.

2. Increase the **Drive amplitude** in intervals of 200-300mV until you have reached 2-3V.

3. If the peak still has not appeared, then increase the **Sweep width** by first increasing the **Center Frequency**, then maximizing the **Sweep width**. If there is still no peak on the response plot, check the laser alignment.

9.5.2 Engaging the Sample

If the engage aborts because the tip is still too far away from the surface, return to **Stage/Focus Surface** and use the trackball to relocate the surface. After successful re-engaging, a well formed image appears on the display monitor.

9.5.3 Cantilever Will Not Tune

If the Cantilever Tune fails, check the following:

- Ensure the laser is properly aligned at the free end of the cantilever (the end furthest from the substrate).

- Ensure there is good physical coupling between the probe and the probe holder. Make sure the groove the probe is held in is free of debris, and that the probe substrate is in firm contact with the back wall of the groove and is pushed firmly against one side of the groove.
Chapter 10  Fluid Imaging

The imaging of samples under fluid is an ever-increasing realm for SPM technology. Imaging samples under fluid minimizes surface forces on delicate samples, allows observation of biological specimens in their natural, fluid environments, and allows real-time observations of samples undergoing electrochemical reactions (ECAFM). In order to conduct ECAFM observations with electrical potentials, an external potentiostat unit is necessary. Contact Veeco for more information.

This chapter details basic operation of the Dimension 3100 SPM in fluid, using both Contact Mode and TappingMode. Methods of preparing the sample for fluid operation are also included. Specifically, this chapter addresses the following:

- **Basic Principles**: Section 10.1
- **Acknowledgments**: Section 10.1.1
- **Fluid Operation Hardware**: Section 10.2
  - **Fluid Tip Holder**: Section 10.2.1
  - **Tip Suggestions**: Section 10.2.2
  - **Rubber Protective Skirt**: Section 10.2.3
- **Sample Mounting**: Section 10.3
  - **General Notes on Sample Binding**: Section 10.3.1
  - **Larger Samples**: Section 10.3.2
  - **Smaller Samples**: Section 10.3.3
- **Precautions**: Section 10.4
  - **Spillage Precautions**: Section 10.4.1
- **Operating Principles**: Section 10.5
  - **Clean Fluid Cell and Protective Skirt**: Section 10.5.1
  - **Select Mode of Operation**: Section 10.5.2
• Load the Probe: Section 10.5.3
• Install the Fluid Tip Holder: Section 10.5.4
• Install the Protective Skirt: Section 10.5.5
• Align Laser: Section 10.5.6
• “False” Reflections: Section 10.5.7
• Load Sample: Section 10.5.8
• Lower Probe into Fluid: Section 10.5.9
• Readjust Laser Alignment: Section 10.5.10
• Adjust Photodetector: Section 10.5.11
• Locate Tip: Section 10.5.12
• Focus Surface: Section 10.5.13
• Cantilever Tune (TappingMode Only): Section 10.5.14
• Show All Items: Section 10.5.15
• Set Initial Scan Parameters: Section 10.5.16
• Engage: Section 10.5.17
• Adjust Scan Parameters: Section 10.5.18
• Clean Cell and Protective Skirt: Section 10.5.19
• Troubleshooting: Section 10.6
  • Cantilever Tune Plot Looks Poor: Section 10.6.1
  • Laser Sum Signal Absent or Weak: Section 10.6.2
  • Poor Image Quality: Section 10.6.3
  • Unable to Locate Particulate Samples: Section 10.6.4
10.1 Basic Principles

Attractive forces due to surface tension effects are eliminated when imaging samples under fluid. This enables the sample surface to be imaged with minimal cantilever tip force—a decided advantage when imaging biological specimens and delicate materials. The procedure for observing samples under fluid is similar to that for observation in air; however, special hardware is utilized to contain the fluid. In addition, minor adjustments must be made to correct for refractive effects as the laser beam transits air-fluid boundaries.

This chapter assumes familiarity with standard operation of the Dimension 3100 AFM in air. If you are not familiar with air operation of the AFM in Contact Mode, please follow the procedures outlined in Chapter 8 before attempting to operate the AFM under fluid. If you are not familiar with air operation of TappingMode, refer to Chapter 9.

10.1.1 Acknowledgments

Veeco appreciates the following individuals’ assistance with the following sections: Monika Fritz, Manfred Radmacher, Magdalena Benzanilla, Helen G. Hansma, Jan H. Ho, Craig B. Prater.

10.2 Fluid Operation Hardware

10.2.1 Fluid Tip Holder

The Dimension 3100 can be equipped with an optional tip holder that permits operation under fluid (see Figure 10.2a). The fluid tip holder interchanges with the standard tip holder quickly and easily.

The fluid tip holder consists of a small glass assembly with a wire clip for holding an AFM cantilever substrate. The glass surfaces provide a flat, beveled interface so that the AFM laser beam may pass into the fluid without being distorted by an unstable fluid surface. The four sockets located on the top of the fluid tip holder are used to attach the tip holder to the four pins at the end of the scanner tube.

Use the fluid tip holder in an open environment where the holder is dipped into a user-supplied fluid container (or into a drop of fluid on larger samples). A method for mounting samples for fluid operation is illustrated in Figure 10.3a in Section 10.3.
10.2.2 Tip Suggestions

Soft cantilevers, particularly oxide sharpened tips, produce the best results for biological applications. These cantilevers are typically 100µm long, narrow-legged with oxide sharpened silicon-nitride tips. Models DNP-S or DNP-STT are good examples. Users should experiment to find which cantilevers work best for their sample. The application note “Choosing AFM Probes for Biological Applications” discusses the appropriate probes for different fluid imaging applications. Contact Veeco for a copy.

Note: For additional information on selecting a cantilever, please refer to the Veeco website (www.veeco.com).

Removing Organic Contamination

CAUTION: When cleaning the cantilever holder, take care to avoid scratching the glass surfaces in the center of the cantilever holder. Be careful to prevent dripping any liquid onto the Dimension 3100 system, especially onto the SPM head.

Contaminants on the cantilever tip may limit the AFM’s resolution. Use ultraviolet light to remove contaminants as follows:

1. Place the fluid cell with installed tip face-up on a clean surface.

2. Position a UV lamp very close (3-5mm) to the fluid cell and irradiate the unit for two minutes at full intensity.

Note: Washing probes in 1-5% SDS (sodium dodecyl sulfate) is also effective.
10.2.3 Rubber Protective Skirt

A rubber protective skirt (see Figure 10.2b) is also provided with the fluid tip holder. This protective skirt is used to protect the Dimension scanner from getting liquid on it. It is recommended that the protective skirt be used with all wet samples. Skirts wear over time and may need to be replaced.

![Figure 10.2b Rubber Protective Skirt](image)

10.3 Sample Mounting

10.3.1 General Notes on Sample Binding

Immobilize samples for AFM imaging on a rigid support. Macroscopic samples (biomaterials, crystals, polymer membranes, etc.) can be attached directly to a stainless steel sample disk with an adhesive. Biological samples like cells, proteins, DNA, etc. are usually bound to a flat substrate such as mica or glass. Many sample preparations have been developed and AFM applications articles are an excellent source of information or sample binding.

**Note:** For a list of articles describing biological applications of AFM, including sample preparation techniques, contact Veeco.

| CAUTION: | Do not attempt to operate the standard air tip holder in a fluid environment. The standard tip holder has exposed electrical signal lines that could short circuit if exposed to a conducting fluid. |
| ATTENTION: | En milieu liquide, ne pas utiliser le support de pointe standard prévu pour une utilisation à l’air. Le support de pointe standard présente des contacts électriques qui peuvent être endommagés (court-circuit) suite à une exposition à un liquide conducteur d’électricité. |
10.3.2 Larger Samples

For larger samples, it may be desirable to image a small region under a drop of fluid (see Figure 10.3a).

1. Put the drop of fluid onto the sample.

2. Lower the AFM fluid tip holder into the drop.

![Figure 10.3a](image)

10.3.3 Smaller Samples

Alternatively, it may be desirable to image smaller samples that are totally immersed in a liquid bath.

1. Place the sample in a plastic petri dish.

   **Note:** If you wish to construct a custom sample holder, please contact Veeco for more information.

2. Secure the sample to the bottom of the petri dish lid or other sample holder with epoxy or other non water-soluble adhesive.

   **Note:** For non-critical applications, Devcon 2-Ton Epoxy works well. For applications where contamination control is more critical, use a more inert, solvent-free epoxy like Master Bond EP21LV, EP21AR, or a hot melt adhesive.

3. Follow the manufacturer's directions for mixing and curing to obtain the best resistance to leaching and chemical attack. For lower resolution applications where it is desirable to image a sample quickly without waiting for an adhesive to cure, you can use double-sided tape as long as fluid never touches the tape.

   **Note:** Do not use cyanoacrylate glue (like Super Glue) for mounting samples in fluid.
10.4 Precautions

10.4.1 Spillage Precautions

Throughout all procedures outlined in the following sections, you will work with fluids on and around the Dimension 3100 SPM. When handling fluids, keep a quantity of filter paper and/or paper towels nearby for wicking away any spilled fluid. The Dimension head is designed to be immersed in no more than 3mm of fluid when used with a protective skirt.

**CAUTION:** Users occasionally experience problems with moisture wicking up through fluid cell seals. Users should avoid prolonged cell immersion in fluids. Always remove the cell from the fluid, detach it from the scanner, and dry thoroughly prior to storage. Any moisture present on the end of the scanner must be dried immediately to prevent shorting the piezo.

**ATTENTION:** A la suite de problemes occasionnels, certains utilisateurs ont experimentes des fuites du joint de la cellule liquide. Il est donc recommande d'eviter les immersions prolongees dans un liquide. Une fois l'experience termine, veuillez enlever la cellule de la solution, la retirer de la sonde de balayage piezo et la ranger apres sechage. Afin d'eviter un endommagement du piezo, l'extremite de la sonde de balayage piezo doit etre nettoyer et secher des que la moindre trace d'humidite et/ou de moisissure apparaissent.

**VORSICHT:** Da es zu Problemen mit Flüssigkeit kommen kann, die durch die Silikonabdichtung an der Meßzelle bis hinauf zum Scanner wandert, beachten Sie bitte das Folgende:Es wird empfohlen, ein längeres Verweilen des Meßkopfes (fluid-cell) in Flüssigkeit zu vermeiden. Nach Abschluß der Messungen entfernen Sie bitte immer die Meßzelle aus der Flüssigkeit, ziehen sie vom Scanner ab und trocknen sie vorsichtig und gründlich bevor sie gelagert wird. Jegliche Flüssigkeit am Ende des Scanners muß SOFORT entfernt werden, um einem Kurzschluß des Piezos vorzubeugen.
### Fluid Imaging Precautions

| CAUTION: | When imaging fluid samples, use extraordinary precautions against spillage. Fluids must **not** be spilled on or around the sample stage, electronics boxes, or other components containing electronic parts. |
| ATTENTION: | Lors d’un travail en milieu liquide, prendre toute précaution pour éviter des fuites. Les liquides ne doivent pas se répandre sur la platine porte échantillons, le boîtier électronique ou toute autre partie du microscope contenant de l’électronique. |
| VORSICHT: | Falls Sie Proben in Flüssigkeiten abbilden, lassen Sie äußerste Vorsicht walten, damit keine Flüssigkeit verspritzt wird. Flüssigkeiten dürfen nicht auf die oder nahe der Probenhalterung, der Elektronikbox oder anderen Komponenten, die elektronische Bauteile enthalten, verspritzt werden. |

| CAUTION: | Avoid spilling all corrosive fluids on exposed surfaces; otherwise, damage may result. In the case of a spill, immediately clean and dry all affected surfaces carefully. |
| ATTENTION: | Eviter toute fuite de liquide corrosif sur les surfaces exposées. Le non respect de cette recommandation peut entraîner des dommages. En cas de fuite, nettoyer et sécher immédiatement les surfaces touchées. |
| VORSICHT: | Vermeiden Sie bitte, korrosive Flüssigkeiten auf freiliegende Oberflächen zu verspritzen; andernfalls wären Beschädigungen die Folge! Falls Sie Flüssigkeit verspritzt haben, säubern und trocknen Sie alle betroffenen Flächen sorgfältig. |
10.5 Operating Principles

10.5.1 Clean Fluid Cell and Protective Skirt

To reduce contamination problems and to obtain high quality images, clean the fluid cell and protective skirt as follows:

1. When sample imaging is complete, carefully remove the protective skirt and fluid tip holder.

2. Place the fluid cell and protective skirt in warm, soapy water and place a few drops of liquid dish soap on them.

3. Gently rub the fluid cell and protective skirt with a cotton swab or finger.

4. Using distilled water, rinse the fluid cell and protective skirt completely.

5. Using filtered, compressed air or dry nitrogen, blow dry the fluid cell until all moisture evaporates to prevent the buildup of salts or other contaminants on the parts.

CAUTION: Avoid scratching the glass surface with abrasive material.

10.5.2 Select Mode of Operation

Select Microscope > Profile and choose the profile for either Contact Mode or Tapping Mode. Click Load.

10.5.3 Load the Probe

The probe is held in a small pocket on the bottom side of the tip holder by a gold-plated stainless steel wire. The cantilever installation fixture has three docking stations where different tip holders may be mounted. Use the docking station that has a small wire between two of the sockets. The steel wire is held against the cantilever substrate by a leaf spring mounted on the top of the tip holder.

1. To mount a probe in the holder, turn the holder over so that the leaf spring and four sockets are facing down and plug the holder onto the appropriate docking station of the cantilever installation fixture.

2. Grip the tip holder by the edges and gently push down on the holder.
3. With the gold wire raised, use tweezers to slide a probe under the wire and into the pocket.

4. Check that the cantilever substrate is set squarely against one side of the pocket and flush against the back.

5. Gently lift the tip holder off the docking station.

6. Check that the probe is held firmly by the wire.

### 10.5.4 Install the Fluid Tip Holder

1. Check that there is sufficient clearance between the bottom of the SPM head and the sample.

   **Note:** The cantilever tip position extends roughly 1 mm further towards the sample with the fluid cantilever holder over the standard air cantilever holder.

2. If the height of the SPM head needs adjustment, use one of the following methods: **Focus Surface**, **Motor > Step Motor**, or **Withdraw**.

3. Gently unplug any cantilever holders attached to the base of the scanner.

   **Note:** If necessary, lift the SPM head out of the dovetail to allow for easier access to the base of the scanner.

4. Pull the cantilever holder straight off to prevent bending any of the pins on the cantilever holder or scanner cap.

5. Fit the fluid cantilever holder onto the four pins of the scanner cap.

   **Note:** The four sockets on the cantilever holder will only align with the pins on the scanner cap when the cantilever tip points to the left of the microscope.

6. Set the head back into the dovetail and lock into place by releasing the knurled head clamp screw, located at the upper-right of the Z-stage, until the thread is just loosened.
10.5.5 Install the Protective Skirt

The protective skirt is a rubber seal used to protect the SPM scanner tube from liquids. Install it by sliding it over the fluid tip holder and onto the shoulder on the SPM tube. Make sure that the seal is tight on both the tip holder and the SPM tube. See Figure 10.5a below for an illustration of the SPM head and the fluid tip holder with the protective skirt installed.

Figure 10.5a Tip Holder Installed With Protective Skirt

10.5.6 Align Laser

Use the technique for aligning the laser onto the cantilever discussed in Chapter 7 of this manual.
10.5.7 “False” Reflections

The cantilever substrate rests on a smooth, angled, glass surface. The laser reflects off the angled glass surface resulting in a visible laser reflection on the laser viewing window on the microscope head, even when the laser is not aimed at the cantilever (see Figure 10.5b). This reflection from the glass surface does not affect the operation of the AFM, but it can be a source of confusion when aligning the laser on the cantilever. Ignore this fainter reflection and look instead for the much brighter reflection off the cantilever.

![Figure 10.5b](false reflection) False Reflections from Fluid Tip Holder

Once the fluid tip holder is plugged into the bottom of the AFM scanner, note the faint laser reflection visible on the glass in the tip holder (in the laser viewing window).

**Note:** The SUM signal on the display monitor will typically show less than 1V when the laser is not yet aligned on the cantilever. The SUM signal should rise above 1V when the laser is truly reflecting off the cantilever.

10.5.8 Load Sample

**Prepare the Sample for Imaging**

Set the sample on the microscope stage. For TappingMode in fluid, use a petri dish, or if the sample is hydrophobic, image the surface within a drop of fluid.

**Note:** Immersed samples may tend to dry out during imaging due to evaporation; therefore, keep a quantity of fluid nearby to periodically replenish lost fluid.
Remount the Dimension Head

With the sample prepared and positioned on the stage, *slowly* remount the Dimension head in its dovetailed, vertical mount.

| CAUTION: | If the fluid level is too high, the end of the scanner tube may be dunked too far into fluid. Do not allow this to happen. Permanent damage to the scanner tube may occur. |
| ATTENTION: | Si le niveau du liquide est trop important, l’extrémité des céramiques piézo-électriques peut tremper dans le liquide. Ceci ne doit jamais arriver. Ce cas de figure peut entraîner des dommages définitifs sur les céramiques piézo-électriques. |
| VORSICHT: | Falls der Flüssigkeitsspiegel zu hoch ist, könnte das Ende des Scannerröhrchens in die Flüssigkeit eintauchen—dies darf auf keinen Fall passieren. Es könnte sonst eine dauerhafte Schädigung des Scannerröhrchens entreten. |

Ideally, the Dimension head should come to rest in its mount at a level where the tip is just above the level of the fluid. If the head rests too low in its mount, use either of the following methods to raise the mount:

- Raise the mount further by using the **Motor > Step Motor > Tip Up** command.
- Remove the head from its mount and lower the sample into the fluid level. Remount the head.

**Note:** Because the tip is lowered through a fluid layer, the laser beam will refract slightly requiring minor adjustments. Refer to Section 10.5.10 for more information regarding aiming the laser through a fluid layer.

At this point, the fluid cell should be prepared for TappingMode imaging: the cantilever is aligned with the laser, the sample is prepared and the tip is immersed in fluid and positioned one millimeter above the sample surface. All that remains is to tune the cantilever.

**Verify that the Microscope is Dry**

Verify that all Dimension 3100 surfaces are free of spilled fluid. Wick away moisture and droplets with filter paper.
10.5.9 Lower Probe into Fluid

Lower the head, allowing the fluid tip holder to enter the liquid. The fluid should form a meniscus around the fluid tip holder (see Figure 10.3a).

**Note:** The laser sum signal must be greater than 0.5V to use the Z motor. It may be necessary to use the detector mirror adjustment screws to roughly center the reflected laser beam on the detector before using either the Focus Surface or Stepper Motor commands.

**Note:** To prevent air bubbles, you may first place a drop of fluid on the probe.

10.5.10 Readjust Laser Alignment

Lowering the tip holder into fluid causes the laser spot to move towards the fixed end of the cantilever by roughly 25µm. To compensate for this shift, proceed with the following:

1. Turn the right-rear laser aiming screw slightly counter-clockwise to move the laser spot back to the free end of the cantilever.

2. Check that a bright reflected laser spot is still present on the laser viewing window.

Occasionally, air bubbles will become trapped near the cantilever and these may interfere with the laser beam's optical path. If this occurs, it may be impossible to get a good reflection from the cantilever after putting the tip holder into fluid. In this case, do the following:

3. Remove the SPM head from the dovetail.

4. Lightly rinse the tip holder with liquid.

5. Replace the SPM head.

10.5.11 Adjust Photodetector

**Adjust Detector Offsets**

Turn the detector mirror adjustment screws to center the laser spot on the laser detector as described in Chapter 7.

Set several parameters:

- For **Contact Mode**: Vertical Deflection signal = roughly -1V, and **Setpoint** = 0V. (These are typical starting parameters).

- For **TappingMode**: Vertical Deflection signal = 0V.
**Note:** The difference between the vertical deflection before engaging and the setpoint is related to the amount of force that the cantilever probe tip applies to the sample.

**Note:** Verify that there is not too large a difference between the setpoint and the vertical deflection signal before engaging. Samples are typically softer in liquid than in air. It may be desirable to reduce the setpoint once engaged to obtain the minimum tracking force.

**Adjust Photodetector**

1. Adjust the photodetector so that the red dot moves toward the center of the laser alignment window using the two photodetector adjustment knobs located on the side of the Dimension head.

2. Set the **Vertical deflection** to 0.

3. Verify that the red dot is centered and elliptical in shape in the laser alignment window.

**10.5.12 Locate Tip**

1. Using the mouse, select **Locate Tip** from under the **Stage** pop-down menu or click the **Locate Tip** icon.

2. Center the tip on the cantilever under the cross hairs using the two adjustment screws located to the left of the optical objective on the microscope.

3. Focus on the tip end of the cantilever using the trackball while holding the bottom left button.

**Note:** See Chapter 7 for more detailed instructions for locating the tip.

**10.5.13 Focus Surface**

When focusing on the sample surface in air before adding fluid to the sample area, the following procedure is necessary:

1. Align laser

2. Locate tip

3. Focus surface

4. Add fluid

5. Readjust laser alignment
6. Adjust laser alignment in photodetector

Fluid changes the optical path length as the angle of refraction changes, therefore, you must offset the focus position in **Focus Surface** by 300 µm to a point below the surface when focusing in fluid.

**Note:** For example, if the surface is in focus with the Z motor positioned at -5000 µm, you must move the Z motor position down until it is at -5300 µm.

When focusing on the sample surface directly in **fluid**, the following procedure is necessary:

a. Align laser (in air)

b. Locate tip (in fluid)

c. Focus surface (hit engage several times)

**OR**

d. Focus surface (beyond surface by another 300 µm)

e. Realign laser

f. Realign laser in photodetector
Focus Surface Procedure

1. Use the Stage > Focus Surface command to bring the sample into focus on the video camera monitor, as described in Chapter 7.

2. Move the X-Y sample stage to bring an area of interest under the AFM cantilever tip.

| CAUTION: | Use extreme caution moving the X-Y stage if the sample holder has a lip that extends above the sample surface (i.e. petri dish). The SPM head can be destroyed if the sample stage is moved such that the tip holder crashes sideways into the lip of your sample holder. Also, check that the position of the lip of the sample holder will not interfere with the movement of the Z-stage. |
| ATTENTION: | Il est recommandé de déplacer avec une extrême vigilance la platine quand le support d’échantillon présente un rebord qui se trouve à une hauteur supérieure à mesurer (comme une boîte de Petri). La tête de mesure peut être endommagée si le support de pointe vient heurter le rebord du support d’échantillon lors d’un déplacement de la platine. De plus, il est impératif de vérifier que le rebord du support d’échantillon ne viendra pas perturber le mouvement vertical du moteur de la tête de mesure. |

10.5.14 Cantilever Tune (TappingMode Only)

This section describes the steps required to find the resonance peak of the cantilever and adjust the oscillation voltage so the cantilever vibrates at an appropriate amplitude. A range of oscillation frequencies are applied to the cantilever to determine the frequency which produces the largest response (the resonance frequency). In most instances, the resonance peak has a sharp Gaussian distribution but at times the peak can be ragged. The system tolerates some deviation in the shape of the peak.

Manual Cantilever Tune is the counterpart to the step used in standard (air) TappingMode to find the resonant frequency of the cantilever. In liquid, however, the cantilever resonance is largely
damped. Instead, this step is used to find an oscillating frequency specific to the fluid and cantilever holder where the cantilever can be driven into oscillation.

Enter the View > Sweep > Cantilever Tune menu to select a drive frequency. The optimal drive frequency can depend upon sample, fluid and fluid volume inside the fluid cell. Experiment to find the best drive frequency for specific imaging conditions. Two frequency ranges that are commonly used are 16-19kHz and 8-12kHz; higher frequencies have also been used. Start with a Sweep width of 20kHz. Users of TappingMode in air will notice that there is not a single well-defined resonance, but instead a large number of broad peaks. The peaks are resonances of the fluid cell and fluid, and do not usually depend so much on the cantilever dimensions.

A typical Cantilever Tune screen is shown in Figure 10.5c. It is necessary to select a frequency where there is some cantilever response, (i.e., near a peak), but experience suggests that it is best to avoid the tops and sides of extremely sharp peaks. The best frequencies appear to be on the side of a peak or in a shallow valley between peaks. Figure 10.5c shows a typical operating frequency that produces good fluid tapping images.

**Figure 10.5c** Typical Cantilever Tune Curve for Silicon Nitride Tip in Fluid

1. In the Feedback Controls panel, set Z Modulation to Enabled.
2. Select View > Sweep > Cantilever Tune, or click on the Cantilever Tune icon. The initial Cantilever Tune panel appears with the Frequency Sweep (a plot of cantilever response as a function of applied oscillation frequency) on the display monitor.
3. In the Cantilever Tune panel, set the Drive frequency parameter to 10kHz and the Sweep width parameter to 20kHz.
4. Set the Drive amplitude to 200mV.
5. Zero the Amplitude setpoint.
6. Set the Amplitude limit to 2.5V.
7. Center the peak on the frequency sweep plot shown on the display monitor using the **Zoom** In and **Offset** commands after identifying the maximum amplitude peak with the lowest frequency in the frequency response plot. This peak is usually in the 8-12kHz range.

**Note:** The **Offset** command sets the center frequency equal to the cursor position to shift the plot. The **Zoom In** command decreases the sweep width and shifts the center frequency value to stretch the plot.

8. Increase the **Drive Amplitude** until the peak appears.

9. Continue to **Zoom In** and center the peak until the peak coincides with the vertical center line within 10Hz. The value displayed for center frequency is now used as the resonant frequency of the cantilever.

**Note:** The system works well in TappingMode if the center frequency is at, or below, the peak in the resonance plot. The center frequency can decrease to the point where the oscillation amplitude reaches 90 percent of the maximum value. Operate at a frequency lower than the resonant frequency to avoid shifting the resonant frequency upon approach of the tip to the surface (see Figure 10.5e).

**Figure 10.5d** Cantilever Tune Control Panels for Main Controls

![Cantilever Tune Control Panels for Main Controls](image-url)
10. Adjust the **Drive amplitude** until obtaining an **RMS Amplitude** of 0.3 - 0.6V. This value has produced good results for protein samples like RNA polymerase and lysozyme.

**Note:** In general, larger RMS amplitudes (approximately 2V) work better for taller samples such as cells.

**Figure 10.5e** Cantilever Tune Frequency Sweep

11. Click **OK**. The parameters set in the **Cantilever Tune** control panel appear in the **Realtime** control panel.

12. Click on **CANCEL** to exit the **Cantilever Tune** command and leave the parameters unchanged.
10.5.15 Show All Items

Before changing any parameters, you should display all of the available parameters. If you cannot view a parameter in a panel, you might need to enable this parameter.

1. Click the “minus box” in the upper left corner of the panel, and click Show all items.

![Figure 10.5f Select Show All Items](image)

2. Ensure there is a “X” in the check box to the left of all parameters.

   **Note:** Those parameters without a X will not display in normal Realtime mode.

![Figure 10.5g Enable Parameters](image)

3. Click the “minus box” in the upper left corner of the panel, and click Show all items. The panel will once again appear in normal Realtime mode.
10.5.16 Set Initial Scan Parameters

Scan Controls Panel

In the Scan Controls panel, set the following initial scan parameters (see Figure 10.5h)

1. Set the Scan Rate to 2Hz.
2. Set the Scan Size to 1µm.
3. Set the Scan Angle to 0.
4. Set X and Y Offsets to 0.

Figure 10.5h  Suggested Scan Controls Settings during TappingMode

<table>
<thead>
<tr>
<th>Scan Controls</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Scan size</td>
<td>1.00 µm</td>
</tr>
<tr>
<td>Aspect ratio</td>
<td>1.1</td>
</tr>
<tr>
<td>X offset</td>
<td>0.000 nm</td>
</tr>
<tr>
<td>Y offset</td>
<td>0.000 nm</td>
</tr>
<tr>
<td>Scan angle</td>
<td>0.00°</td>
</tr>
<tr>
<td>Scan rate</td>
<td>2.00 Hz</td>
</tr>
<tr>
<td>Tip velocity</td>
<td>4.00 µm/Hz</td>
</tr>
<tr>
<td>Samples/line</td>
<td>256</td>
</tr>
<tr>
<td>Lines</td>
<td>256</td>
</tr>
<tr>
<td>Slow scan axis</td>
<td>Enabled</td>
</tr>
</tbody>
</table>

Feedback Controls Panel

1. For TappingMode, set the Integral gain to 0.5 and the Proportional gain to 0.7. For Contact Mode, set the Integral gain to 2.0 and the Proportional gain to 3.0.
2. Set the Look Ahead gain to zero.
3. For Contact Mode, in the Feedback Controls panel set the Deflection Setpoint to 0V. It is not necessary to enter a value for Amplitude Setpoint for TappingMode because this value is automatically determined during the engage process.
10.5.17 Engage


2. To move to another area of the sample, execute a Withdraw command to avoid damaging the tip and scanner.

3. Select Stage > Focus Surface and move the stage using the trackball.

   Note: After the tip is engaged, adjust the control panel values to provide the desired scan parameters.

10.5.18 Adjust Scan Parameters

Once engaged, the scan parameters should be adjusted to obtain the best image. Set the Slow scan axis to Disabled and select View > Scope Mode. Observe the agreement between the trace and retrace lines into, and adjust the Setpoint, Gains and Scan rate to bring the trace and retrace lines in to coincidence. This procedure will be similar to operation in air, with the following exceptions:

- Samples are generally softer in fluids. Adjusting the applied forces becomes more critical.
- Scan rates tend to be slower in fluid.

Adjusting Setpoint

Contact Mode

1. Adjust the Setpoint to as low a value as possible using the cursor keys until the cantilever pulls off the surface (and the Z-center voltage jumps to -220V).

2. Increase the Setpoint slightly until the cantilever begins to touch the surface again and an image appears. Or, use the Force Calibration command to select the Setpoint and estimate the contact force, as described in Chapter 17.

   Note: The cantilever will typically adhere to the sample surface much less in fluid; therefore, it is often possible to image at much smaller contact forces in liquid than in air.
**TappingMode**

Usually the best images are obtained at setpoints 5-10 percent less than the cantilever RMS amplitude before engaging. The setpoint may be optimized in one of two ways:

- **Use the Force Calibration Command:** The Force Calibration command plots the cantilever amplitude versus the scanner position. A typical Force Calibration is shown in Figure 10.5c. The curve should show a mostly flat region where the cantilever has not yet reached the surface and a sloped region where the amplitude is being reduced by the tapping interaction. Set up the Force Calibration as described for TappingMode in air (see Section 13.5). (Experienced users may use the Force Step command instead). To protect the tip and sample, take care that the cantilever amplitude is never reduced to zero. Adjust the setpoint until the green “setpoint line” on the graph is just barely below the flat region of the Force Calibration curve. This is the setpoint that applies the lowest force to the sample.

  **Note:** The slope of the Force Calibration curve shows the sensitivity of the fluid TappingMode measurement. In general higher sensitivities will give better image quality. If the sensitivity is very poor, consider changing to a different drive frequency or check the mounting of the sample and fluid cell.

- **Optimize the Image Quality:** The Setpoint can also be adjusted by simply monitoring the image quality.
  
  - Select a **Scan size** of 500nm.
  
  - Increase the **Setpoint** in small increments until the cantilever pulls off the surface and the **Z center voltage** is at -220V.
  
  - Reduce the **Setpoint** in small increments until an image appears. Continue reducing the **Setpoint** until the image is optimized. Usually the best images are obtained at setpoints just below where an image appears.

When operating in TappingMode, it may be necessary to check the cantilever tuning after the system is engaged. To check the cantilever tuning:

1. Select **View > Sweep > Cantilever Tune**.
2. Set the **Tip Offset** to 200nm and click **OK**.
3. Once in the cantilever tuning window, adjust drive frequency and drive amplitude if necessary.

### 10.5.19 Clean Cell and Protective Skirt

When you are finished scanning, remove and clean the fluid probe holder and protective skirt, following the procedure described in Section 10.5.1. In the Feedback Panel, set **Z Modulation** to **Disabled**.
10.6 Troubleshooting

10.6.1 Cantilever Tune Plot Looks Poor

Become familiar with the characteristics of the Cantilever Tune plot when you successfully obtain good images. You may use the Cantilever Tune plot as a diagnostic tool. If the plot looks substantially different from previous successful experiments, there may be a problem with the fluid cell or the cantilever may be loose in its holder. Ensure there is good physical coupling between the probe and the fluid cell, and that the laser is positioned correctly at the free end of the cantilever.

10.6.2 Laser Sum Signal Absent or Weak

Remove all air bubbles from the cantilever. Bubbles may attach themselves to the cantilever, causing the laser beam to diffract. Remove bubbles by gently squirting the tip and sample with a stream of fluid, taking care not to squirt or splash fluid into spaces above the protective skirt.

10.6.3 Poor Image Quality

Some types of samples may adhere to the cantilever and tip (e.g., certain proteins). If you suspect tip contamination, you must protect the tip against contamination using either of the following methods:

- If the tip adheres to a sample surface through diffusion (e.g., diffusion of protein onto mica), first diffuse the sample substance into the substrate, then flush away stray substance using a straight fluid media. Lower the tip into a fluid containing little or no stray substances that may adhere to the tip.

- If the sample is short-lived and must be imaged quickly, mask the tip against contamination by bringing the tip into gentle contact with an uncontaminated substrate surface. Set the Dimension 3100 in Contact Mode by switching the AFM mode parameter on the Other Controls panel to Contact. Engage the substrate surface using a zero scan size. While keeping the tip gently in contact with the substrate surface, add the sample substance to be imaged to the petri dish and allow the sample substance to settle onto the substrate. Once diffusion is reached, quickly lift the tip from the substrate surface. Switch to TappingMode and image the sample.
10.6.4 Unable to Locate Particulate Samples

Some particulate samples (i.e., proteins) may prove difficult to find directly beneath a cantilever if the cantilever remains stationary during a diffusion or settling period. This may be due to the fact that some types of particulates are more attracted to the cantilever than to the substrate intended to support them. The result is a “shadow” on the substrate directly beneath the cantilever where fewer sample individuals are located; they are stuck to the cantilever. If you suspect this problem, simply shift the imaging site to a location outboard of the tip and cantilever. You should find more individual samples there.
Chapter 11  Scanning Tunneling Microscopy (STM)

This chapter includes the following sections:

- **Introduction**: Section 11.1
  - Overview of STM: Section 11.1.1
- Basic STM Operation: Section 11.2
  - Imaging Samples: Section 11.2.1
- STM-Specific Information and Operations: Section 11.3
  - STM Hardware: Section 11.3.1
  - Fine Points of STM Operation: Section 11.3.2
  - STM Operating Modes: Section 11.3.3
  - STM-Specific Menu Parameters: Section 11.3.4
- Spectroscopy with the STM: Section 11.4
  - Operation of STS: Section 11.4.1
- Troubleshooting Operation of STM: Section 11.5
  - Head and Microscope-Related Problems: Section 11.5.1
  - Head Engages Immediately: Section 11.5.2
- Etching Tungsten Tips: Section 11.6
  - Procedure: Section 11.6.1
11.1 Introduction

STM relies on “tunneling current” between the probe and the sample to sense the topography of the sample. The STM probe, a sharp metal tip (in the best case, atomically sharp), is positioned a few atomic diameters above a conducting sample which is electrically biased with respect to the tip. At a distance under 1 nanometer (0.001µm), a tunneling current will flow from sample to tip. In operation, the bias voltages typically range from 10 to 1000mV while the tunneling currents vary from 0.2 to 10nA. The tunneling current changes exponentially with the tip-sample separation, typically decreasing by a factor of 2 as the separation is increased by 0.2nm. The exponential relationship between the tip separation and the tunneling current makes the tunneling current an excellent parameter for sensing the tip-to-sample separation. In essence, a reproduction of the sample surface is produced by scanning the tip over the sample surface and sensing the tunneling current.

11.1.1 Overview of STM

The STM option is generally employed under the following conditions:

- For samples having deeply relieved features, where AFM probes may not be able to penetrate, and/or where feature verticality is very close to 90 degrees.

- On polished samples, where it is necessary to image different layers having similar topography but different electrical conductivities.

- Under conditions where contact with the sample surface is prohibited.

STM relies on a precise scanning technique to produce very high-resolution, three-dimensional images of sample surfaces. The STM scans the tip over the sample surface in a raster pattern while sensing and outputting the tunneling current to the NanoScope control station. The digital signal processor (DSP) in the workstation controls the Z position of the piezo based on the tunneling current error signal. The STM operates in both the “constant height” and “constant current” data modes, depending on a parameter selection in the STM Control Panel. The DSP always adjusts the height of the tip based on the tunneling current error signal, but if the feedback gains are low, the piezo remains at a nearly “constant height” and tunneling current data is collected. With the gains high, the piezo height changes to keep the tunneling current nearly constant, and the change in piezo height is collected by the system. The exponential relationship between the tip separation and the tunneling current allows the tip height to be controlled very well. For example, if the tunneling current stays within 20 percent of the setpoint value (the current to be maintained by the feedback system), the variation in the tip-sample separation is less than 0.02nm.

The STM tip is held using a dedicated STM tip holder which plugs into the end of the Dimension head’s tube (see Figure 11.1a).
11.2 Basic STM Operation

11.2.1 Imaging Samples

This section explains how to use the NanoScope to image the 10µm, silicon standard supplied with the system.

1. Select the STM option — Click the left mouse button with the cursor on the Realtime icon in the menu bar to select the Realtime operating mode. Pull down the Microscope menu by clicking on the Microscope item in the menu bar, click on the Select command, then click on STM and OK to place the microscope into STM mode.

2. Insert a new tip in the tip-holding tube mounted on the STM tip holder. The tips come in a small, plastic snap-box filled with black foam. Grip the tip with tweezers near the sharp end, then insert the blunt end of the tip into the tip-holder. For the tip to be held in the tube, it is necessary to put a small bend in the tip before it is completely inserted. The tip should be inserted so that it protrudes about 2mm beyond the end of the head and should be fairly tight in the tip-holder. The business end of the tip must project beyond the bottom profile of the tip holder’s preamp chip; otherwise, the chip will bottom out on the sample surface before the tip engages.

3. Load the calibration standard (sample) onto the stage using a magnetic puck. Ensure that the standard is in electrical contact with the stage surface. This usually necessitates using an electrically conductive epoxy (silver-based) to affix the sample to the surface of the puck (e.g., Dynaloy 325).
4. Plug the loaded tip holder into the end of the Dimension head, then mount the head into the dovetail slot. Select Stage > Locate Tip to find the end of the STM probe—it will resemble a metallic bee stinger. Once the tip has been located, proceed with using the Stage > Focus Surface controls to position the sample beneath the probe.

**Note:** Using the microscope’s optical system, the tip will be difficult or impossible to view if it is not located over a very reflective surface. Usually, the stage surface is sufficiently reflective to accomplish this; however, most polished, silicon wafers will work just as well. If the sample is dark in appearance, it may be necessary to load it onto the stage AFTER the tip has been located using a reflective background.

5. Set the Scan Controls panel parameters to the values shown below:

| Scan Controls |
|---------|----------------|
| Scan size:  | 90.0 µm        |
| X offset:   | 0.00 nm        |
| Y offset:   | 0.00 nm        |
| Scan angle: | 0.00 deg       |
| Scan rate:  | 2.44 Hz        |
| Number of samples: | 256 |
| Slow scan axis: | Enabled |
| Z limit:    | 440 V          |

6. Engage the sample surface using the Motor > Engage option. The display monitor should render an image of the sample surface immediately. Depending on the condition of the tip, the image on the screen will be either clear or noisy. The status bar on the control monitor shows how many microns the tip has traveled. When the tip engages with the surface and tunneling occurs, the computer will beep and an Engaged message will appear in the status bar.

7. Click on a scan parameter and drag the mouse to change the parameter. Lower the Integral gain and Proportional gain (Feedback Controls panel) near zero and vary the Bias voltage to see how the image changes. Vary the Scan size to observe how the image can be magnified, then vary the X offset and Y offset to see how the image can be moved. Transfer to the Channel panels, and instead of displaying an image using Height data, select Current at the Data type field to observe image changes.

**Note:** Generally, the Data type field is set to Height whenever the Dimension is used in STM mode to image sample surfaces with large fields of view. The Current setting is usually selected for imaging atomic features—a more difficult feat for the Dimension-series microscopes due to their much larger stages and frames. Customers desiring to image atomic features should use Veeco’s dedicated STM microscope, which is equipped with a much smaller, more rigid frame. For more information, contact Veeco.
Click on the **Scope Mode** command in the **View** menu to see what the signal looks like for each trace across the sample. Return to the **Image Mode** by clicking on the **Image Mode** command.

**Note:** A poor tip, either because it has touched the sample, has contamination on the end, or because of its manufacturing, will render a poor image. In this case, there is little likelihood that the tip will recover, and the best procedure is to replace the tip. Pull down the **Motor** menu by clicking on **Motor** in the menu bar, then click on **Withdraw** to stop scanning, and retract the probe from the surface. After the tip is withdrawn, the “Secured” message will appear in the status bar of the control monitor. To simplify tip holder removal, position the stage so that it is no longer beneath the head; the tip holder may be pulled straight off without the need to remove the entire head. Be certain there is sufficient clearance between tip and sample after installing the new tip—a new tip will extend a different distance out of the tip holder than the old tip.

The nominal Z position of the piezo provides useful diagnostic information. The bar graph to the right of the image on the display monitor reflects the Z position of the piezo during the scan. Under most circumstances, the “Z center position” should be in the center of the graph, indicating that the Z voltage for the piezo is fluctuating around zero volts. If the sample is not level, or if there is drift in the mechanical system after the tip has engaged, the “Z center position” will fluctuate during the scan or drift off-scale.

**To Improve Image Quality...**

- Vary the **Scan size** and the **X offset** and **Y offset**. Move to a new location on the sample by changing the X offset and/or Y offset of the scan. The X and Y offset parameters define the center of the scan. Often, a better image can be obtained on a different portion of the sample. The X and Y offsets can be changed by altering the values in the control panel, or by using the **Offset** command in the menu bar on the display monitor.

- Oscillate the tip by briefly setting the **Integral gain** up to about 500. The oscillation will show up on the display as a grainy pattern of light and dark. Set the **Integral gain** back down after about a second and check if the signal is quieter than before. Setting the Integral gain high for a brief period is also useful for cleaning debris from the tip.

- Alternate the commands **Withdraw** and **Engage** a couple of times. This raises and lowers the tip and may get rid of contamination on the end of the tip.

- Use the **Step Motor** command to single-step the tip down a step or two. Be sure to minimize the **SPM step size** before stepping the motor down. Watch the **Z Center Position** scale on the display monitor to verify that the piezo has sufficient room to retract so the tip will not harm the surface of the sample. Stepping the tip down until the **Z Center Position** goes to the retracted end of the scale where the indicator turns red will usually destroy the tip.

- Vary the **Setpoint** current over the range 2 to 10nA. As a last resort, current may be increased up to 48nA for a very brief period of time.

- If none of the above procedures improves the quality of the signal, replace the tip and try again. If that doesn't work, call Veeco for technical assistance.
8. After a clean image has been obtained, it can be saved onto disk with the Capture command in the Capture menu (or click on the Capture icon). The Capture command saves the current scan image (or the next image if any changes have been made in the STM control panel) into the Capture directory. The Capture Filename command can be used to define a custom filename or the captured file will be named with the concatenation of a date/time stamp. In either case, a three-digit suffix which incrementally increases after each capture operation is appended to the filename. If the date/time stamp is used, a file captured at 3:32 p.m. on July 31 would be assigned the file name 07311532.001. A second file captured the same minute would be named 07311532.002.

9. Some simple filtering operations can improve the look of the captured image. Enter the Offline mode and select the image to work on by clicking on it in the file list. There are a number of image processing options available in the Modify menu. Click on Modify in the menu bar to display the menu. The simplest way to remove high frequency noise is with the lowpass filter.

Pull-down the Modify menu and click on the Lowpass command to apply the lowpass filter to the image and redraw it on the display monitor. Successive Re-execute clicks will continue to filter and redraw the image. The entire filtering operation can be undone with the Undo command, the filtered image can be saved, or the Quit command will return the system to the Modify menu. There is also the option of changing the display with the Color table, Color contrast, or Color offset parameters.

Note: The Z range parameter will have no effect if the Plot type parameter in the Top View menu is set to Equal area.

11.3 STM-Specific Information and Operations

The NanoScope STM is a digitally-controlled instrument capable of producing high resolution, three-dimensional images. The sample is held in position while a piezoelectric crystal in the form of a cylindrical tube scans the sharp metallic probe over the surface in a raster pattern. The digital signal processor (DSP) calculates the desired separation of the tip from the sample by sensing the tunneling current flowing between the sample and the tip. The bias voltage applied to the sample encourages the tunneling current to flow. The DSP completes the digital feedback loop by outputting the desired voltage to the piezoelectric tube. The NanoScope STM can be operated in two modes. In one case the feedback gains are set high, the tunneling tip closely tracks the sample surface, and the variation in the tip height required to maintain constant tunneling current is measured by the change in the voltage applied to the piezo tube. In the other case, the feedback gains are set low, the tip remains at a nearly constant height as it sweeps over the sample surface, and the tunneling current is imaged. This section provides greater insight into the operation of the STM.
11.3.1 STM Hardware

Some individual STM components are described below:

1. Tip holder—To keep the mass on the end of the tube low, a simple tip holder, designed to take 0.010" diameter tips, is used. The holder is a stainless steel tube with a 0.012" inner diameter mounted in ceramic. This design mounts the tip at the center of the piezo tube on a ceramic support element. This design preserves the symmetry of the scan, although it makes it difficult to see the tip-sample interface. This design is used on all large-range, “G” and “J”: scanners.

2. Tips—The probes for the NanoScope STM must be less than 0.012" in diameter to fit into the tip holder. The two most commonly used tips are made from either a platinum iridium (PtIr alloy or tungsten. The PtIr tips are mechanically formed and can be purchased directly from Veeco. At the end of this chapter, instructions are provided on how to etch tungsten tips from tungsten wire with an electrochemical process. In general, PtIr tips provide better atomic resolution than tungsten tips, but tungsten tips are more uniformly shaped. They may perform better on samples with steeply sloped features such as compact or optical disks.

3. Preamp—Mounted on the tip holder is a circuit which contains the preamplifier for the tunneling current and provides interconnections to the tube electrodes. A schematic for this preamp is at the end of this section.

The preamplifier is an FET input amplifier with an input bias current of 25 picoamps, small, compared to the nanoamps or fractions of nanoamps which are being measured. The preamp is configured such that the tunneling tip is connected through a 1 megohm resistor to ground. The tip is also connected to the input of the amplifier which is wired as a x100 non-inverting amplifier with a cutoff frequency of 15KHz. The transimpedance gain of the input resistor/preampl combination is 100mV/nA with an input range from 0 to 100nA. The noise of the preamp is essentially the Johnson noise in the 1 megohm resistor and the standard filtering is 2mV rms, equivalent to an input tunneling current of 0.02nA rms.

A disadvantage of this amplifier configuration is that there is a voltage drop across the 1 megohm resistor which raises the voltage of the tip above ground, reducing the effective bias voltage. The actual bias voltage is equal to:

\[ V_{sample} = V_{bias} - I_{tunneling} \times R_{input} \]

This effect is accounted for in the NanoScope software so the actual bias voltage between the tip and the sample agrees with the menu value.

Special low-noise preamps have been developed for spectroscopic functions. The preamps which are included on scan heads designated as either AI or Veeco, have no voltage drop due to the tunneling current.

Scanning heads with four maximum scan ranges are available for NanoScope. The “G” scanner-based, Dimension heads is designed for a nominal 90µm scan size.
11.3.2 Fine Points of STM Operation

Getting the best images on NanoScope requires a good interface between sample and tip, reasonable vibration isolation, and proper settings in the Computer Workstation menus. This section provides greater detail on the operation of the STM.

11.3.3 STM Operating Modes

The two operating modes available on the NanoScope STM are selected with the Data type option in the Channel panel (see Figure 11.3a). Height data reflects the change in tip position required to maintain a constant tunneling current. The DSP senses the tunneling current, calculates the difference from the desired tunneling current, and determines the voltage that must be applied to the piezo tube to keep the tunneling current constant. Due to the known characteristics of the piezoelectric material, the change in voltage applied to the piezo tube translates directly to a change in distance. This distance data is recorded throughout the scan and displayed on the screen as the “height” of the sample.

Figure 11.3a Typical STM Channel 1 Control Panel Parameters

Current data is a measure of the tunneling current at each point tested on the sample. The DSP measures the voltage drop across a resistor in series with the tip and calculates the tunneling current as the tip scans the surface of the sample. The tunneling current at each data point is recorded and displayed on the screen.

The two scan modes (height and current) require subtle changes in the menu parameters to operate effectively. The parameter changes also affect the application of the two modes. To operate effectively in collecting height data, the tip must closely track the sample surface. The gains must be maximized to force the piezo to respond quickly to the variations in the sample surface. The height mode is used for most applications. Conversely, the gains must be very low to keep the piezo from responding while collecting current data. After engaging, the tip scans the surface of the sample with very little variation in the piezo height. This constant height provides a reference from which to measure and record the fluctuations in the tunneling current. The current mode is most useful for imaging atoms with relatively small scan sizes.
11.3.4 STM-Specific Menu Parameters

In addition to the **Data type** discussed above, the STM control panels contain three items that are specific to the operation of the scanning tunneling microscope. The **Feedback type**, **Bias**, and **Setpoint** parameters pertain exclusively to the control of the STM.

The **Feedback type** parameters in the Other Controls panel determine the transformation performed on the tunneling current prior to the feedback calculations. The three settings select **Linear**, **Log**, or **Boost** operations. Remember that tip-to-sample separation is proportional to the log of the tunneling current. The **Linear** selection causes the error signal for the feedback loop to be the difference between the instantaneous tunneling current and the setpoint current. The **Log** and **Boost** selections calculate the error signal as the difference between the log of the instantaneous tunneling current and the log of the setpoint current. The **Boost** mode performs additional operations to optimize the feedback performance for high scan rates over rough surfaces.

The **Bias** parameter controls the magnitude and sign of the bias voltage applied between the tip and the sample. A bias voltage encourages the tunneling current to flow. Although settings of 20 to 100 mV are typical for conductive samples, the allowable setting ranges from -10 to 10 volts. Positive settings of the bias voltage induce negative tunneling currents (i.e. electrons flowing from the tip to the sample).

**Optimization of STM Scanning Parameters**

The process of selecting and optimizing the scan parameters can be streamlined. In most cases the scan parameters are dictated by the sample. The **Data type** is usually the first parameter set and the **Proportional** and **Integral gains** are directly related to the **Data type**. The **Scan size** depends on the sample and the features of interest. The maximum **Scan rate** is usually related to the **Scan size**. The **Bias** voltage and the tunneling current **Setpoint** depend on the sample. Usually, they are set at a standard value for engagement and fine-tuned along with the gains and filter to enhance the quality of the image.

As discussed above, a **Data type** of **Current** is the best for atomic-scale images. This mode is not practical for rough surfaces, because the tip will crash into the surface at low feedback gains. The **Height Data type** is usually better for all but atomic-scale scans. In general, height data images are best at higher feedback gains and slower scan rates.

Settings for feedback gains depend on many factors, but perhaps the most important is the **Data type**. If the Data type is set to **Current**, the **Integral** and **Proportional gains** should be set as close to zero as possible. The **LookAhead gain** adds information from the previous scan line into the feedback calculation so it is most useful for samples with long vertical features. The gains should be lowered for data captured using the linear **Feedback type**, especially with high **Setpoint** current levels. Large-scale images should be taken at increased gain, except for the **LookAhead gain**, which is best kept to low values. Experimentation may yield other values for your samples.

Often the best way to set the gains for the **Height Data type** is to view the Realtime scan in the **Scope Mode** with the **Y scan** disabled. This allows the feedback to be tuned while looking at a single scan line of data. First, increase the **Integral gain** until oscillations start to appear, and then, back off a little. Next, adjust the **Proportional** and **LookAhead gains**. High frequency fuzz will appear on the signal when the **Proportional gain** is set too high. Setting the **LookAhead gain** too
high will cause oscillations in the scope image and ripples on top view images. Setting the **LookAhead gain** even higher will cause the feedback loop to become unstable. The **Setpoint current** and the **Bias** voltage can also be adjusted using the Scope display.

Bias voltages below 20mV usually provide the best quality images on samples with surface conductivities equal to or better than graphite, but there are exceptions. Resistivity across the surface of a sample can be measured with an ohmmeter. For samples with high resistivity (greater than 1 megohm/cm), bias voltages of 100mV or even higher may work best. For scans larger than 0.5µm, it is sometimes better to increase the bias voltage by 50mV to 100mV over the value for smaller scans. A higher bias keeps the tip further from the surface, giving the feedback loop greater tolerance in tracking the surface at high speeds.

Increasing the **Setpoint current** can also be helpful for larger scans. This has the effect of raising the gain, but also brings the tip closer to the surface by a small amount. High setpoint currents of 6 nanoamps or more can also be useful in improving the signal-to-noise ratio for atomic images on some materials.

The **Feedback type** can be set to either **Log**, **Boost**, or **Linear** input transformations. Because the tip-to-sample separation is proportional to the log of the tunneling current, the transformation performed on the tunneling current prior to the feedback calculation can have dramatic effects on the performance of the feedback loop. Linear input is more protective of the tip, because the feedback error signal responds exponentially to tip-sample separation. When the tip-to-sample separation decreases, the error signal rises exponentially, quickly driving the tip away. However, the error signal is unsymmetrical. The same sample-to-tip separation change that caused the tip to move away so quickly will generate a small error signal when the tip is higher than it is supposed to be. This unsymmetrical response in the **Linear** mode will distort data. For this reason, the **Boost** and **Log** modes (with ln(I) used in the feedback calculation) are preferable for most samples, because they respond in a more symmetrical fashion to positive and negative sample slopes. The **Boost** mode is preferable for large scans with high vertical features such as compact disc stampers or integrated circuits. The proportional and integral gain can be reduced greatly when the **Boost** mode is used. The log input has the advantage of having a gain which is insensitive to the value of the **Setpoint current**.

Large scans cannot be taken at the same scan rate as small scans. When using the large scan heads with scans above a few microns, the **Scan rate** should be lowered below 10Hz. Best results can be obtained at scan rates of 1 Hz or less, although image-taking is slow. At these scan rates, the 128 x 128 and 256 x 256 data formats are most useful, quadrupling and doubling the frame rate over the 512 x 512 format for a given scan rate. To be sure that there is no image degradation due to too high of a scan rate, lower the rate and check for changes in the image. Check the **Scope Mode** view to ensure that the scan is not slew-rate limited in Z, as evidenced by an artificial “sawtooth” appearance in the scope trace.

The **Filter** parameter (if available) provides the option of filtering the tunneling current signal. A lowpass filter with a cut-off frequency of 25KHz can be applied to the analog tunneling signal in hardware. Typically, the filter is selected for atomic-scale images; otherwise, no filtering should be selected.
Tunneling Tips

Although the microscope will accept any 0.010” diameter tip, tips made of platinum iridium (PtIr) and tungsten are used most often. PtIr tips are supplied by Veeco while tungsten tips can be electrochemically etched from tungsten wire by following instructions at the end of this chapter. In general, most of the discussion in this manual involving tips and noise reduction applies to both types of tips, but there are some applications which are tip specific.

PtIr tips seem to give better atomic resolution than tungsten in air and liquids, probably due to the lower reactivity of platinum. The PtIr tips are not as uniformly shaped as the tungsten tips, so freshly etched tungsten tips may provide cleaner data when scanning steeply sloped surfaces such as compact or optical disks. For tunneling on surfaces immersed in conductive liquids, coated tips have been used. Glass coatings are removed from the very end of the tip by briefly applying a high-bias voltage.

The quality of the mechanically formed PtIr tips will vary. Some give beautiful images as soon as tunneling starts; others start poorly but improve over time; while others start noisy and stay noisy. Some tips have very flimsy points which give an image that is stretched out on one side; this indicates that the tip is unable to turn around quickly at the ends of the X scan. These tips should be replaced unless the artifacts can be eliminated by increasing the X-rounding using the Calibrate command in the Realtime > Microscope menu, or by capturing large scans and using the Offline > Modify Zoom to focus on the desired information.

Sample Surface

Samples to be imaged with a scanning tunneling microscope must conduct electricity to some degree. In many cases nonconductive samples can be coated with a thin layer of a conductive material to facilitate imaging. The sample surface must be conductive enough to allow a few nanoamps of current to flow from the bias voltage source to the area to be scanned. NanoScopes have been used to scan gold, silver, platinum, nickel, copper under oil, chrome plating, doped silicon under oil, conducting polymers, amorphous carbon, blue diamond, diamond-like carbon films, carbon fibers, graphite, iron-oxide compounds, semi-metals, doped semiconductors (molybdenum disulfide), cobalt-chromium compounds, stainless steel, liquid crystals, and other materials. Oxide layers more than a few atoms thick on the sample, tend to affect the scanning and wear down the tip as it is dragged through the oxide. The feedback loop will extend the tip until a tunneling current flows, even if it must push the tip through an oxide layer (if it can). If oxide presents a problem, keep the sample covered with oil or operate the microscope in a glove bag filled with nitrogen or argon. The standard NanoScope microscope heads were not designed to operate in UHV.

On samples which are noisy or tend to oxidize, tunneling under oil or scanning in a glove box filled with inert gas can improve the imaging. Silicon oil or paraffin oil (mineral oil) also work well with some samples. The only problem involved with the use of oil is the increased difficulty in the coarse positioning of the tip. The reflection of the tip comes off the liquid instead of the surface of the sample. It is difficult to tell when the tip is close to the sample surface. The best approach is to lower the tip until it just touches the surface of the oil, falsely engage the tip (use Ctrl-E quickly after the Motor > Engage command), then lower the tip the rest of the way with the stepper motor. It may take the motor about a minute or so, but it is better than smashing the tip on the surface of the sample.
Vibration Isolation

The microscope should be isolated from sources of vibration in the acoustic and subacoustic frequencies. This requirement can be relaxed somewhat for large-scale images, but atomic-scale work is extraordinarily sensitive to ordinary room vibrations.

As a final note, the best way to reduce coupling from vibrations is to eliminate as many sources of vibration as possible. Remember that vibrations can be transmitted to the microscope over the cable. To reduce this phenomenon, prevent tension in the cable and keep it away from fans and other noise sources. Also, keep the microscope away from sources of acoustic noise. Loud conversation can disrupt atomic scale images. Air currents can also disturb atomic images, so it is best to run the microscope with the cover on.

Piezoelectric Sensitivity and Derating

The sensitivity of the piezoelectric tube in nanometers per volt and the derating of the piezo sensitivity as the scan voltage is decreased are calibrated using the Autocalibration command in the Offline > Utility menu. Prior to using the Autocalibration command, the calibration images must be captured with the Capture Calibration command in the Realtime > Capture menu. Generally, a silicon calibration standard is used for the “G” scanner-based, Dimension head.

The sensitivity of the piezoelectric tube decreases as the applied range of the applied scan voltage is reduced. Over a small scan range, the sensitivity of the piezo is constant and a plot of scan size versus scan voltage is linear. However, for large scans, sensitivity variations are an important factor. For example, the G head shows sensitivity variation. A plot of the sensitivity of a long-range head as a function of scan voltage looks similar to the graph in Figure 11.3b. As shown, the Derating (the slope of the head's sensitivity plot) indicates how much the piezo sensitivity decreases as the scan voltage is reduced.

![Figure 11.3b Scan Derating Graph](image)

The NanoScope software accounts for the reduction in sensitivity as the scan voltage is decreased through the Derating parameters in the Microscope > Calibrate > Scanner dialog box. As described in the following paragraphs, the Head Autocalibrate command in the Offline > Utility menu can be used to calculate the sensitivity and derating parameters of STM heads.
Head Offset

The value of the head preamplifier offset can be measured and corrected with the Offset command in the Realtime > Microscope menu. The procedure is as follows:

- Withdraw the tip from the sample surface.
- Invoke the Offset command to observe the offset current of the preamplifier in nanoamps.

11.4 Spectroscopy with the STM

The NanoScope STM performs limited spectroscopic operations under the two scanning tunneling spectroscopy STS modes of operation. The variation of the tunneling current due to variations of the bias voltage or tip-to-sample separation can be tested and recorded at a single point with the View > STS Plot modes.

STS Plot Modes

In the STS Plot modes, the tip is positioned at a point on the surface, and a spectroscopic plot is acquired and displayed in a scope format. Between plots, the feedback is run to establish the tunneling current to the setpoint value. The different types of STS Plots that can be acquired are:

**STS i(v)** — The tunneling current as a function of the bias voltage is displayed. The tip height is held constant while the I-V plot is being acquired. In addition to I vs. V, F(d i,dv), F(d ln(i),dv), or F(d ln(i),d ln(v)) vs. V can be plotted.

**STS i(s)** — The tunneling current as a function of the tip height is displayed. The bias voltage is held constant while the I-S plot is being acquired. In addition to I vs. S, ln(I) vs. S can be plotted.

11.4.1 Operation of STS

In the following sections, the operation of the spectroscopic functions of the NanoScope STM will be discussed. Additional information can be obtained from the Command Reference Manual.

STS Plot

There are several items that you should be aware of when using the NanoScope to acquire spectroscopic plots with the STS Plot commands. The spectroscopic capabilities can provide information that can help to distinguish different species although exact species identification is difficult, especially in air. The spectroscopic plots should aid in comparative studies between samples or between different regions on a sample, but they will not reveal the precise make-up of that sample.
A comparison to STM imaging reveals two somewhat conflicting requirements. As a good starting point, the sample and tip should produce consistent STM images. The images should repeat well from frame to frame and be fairly free of noise or areas on the surface that appear unstable. For current-versus-voltage type plots, the spectroscopic plots may be nice and smooth and repeat well, but switching back to the STM imaging mode reveals images which are quite noisy. This can be attributed to the fact that the quality and uniformity of the tip is probably more critical for imaging than for making the rather simple spectroscopic plots. This is generally not true for the I vs. S plots. Some general recommendations for acquiring spectroscopic plots are:

1. Low settings for the **Integral gain** are preferred. Since the tip is not tracking any topography, the lower gains are acceptable and tend to make the plots more stable.

2. The maximum input range of ±100nA on the NanoScope with the standard preamps will restrict the current-versus-voltage plots.

3. The spectroscopic functions do not adjust for any loss of bias voltage due to IR losses caused by the input impedance of the preamplifier. This has different effects for the STS i(v) and STS i(s) functions which are discussed individually below:

**STS i(v)**

The spectroscopic plots do not correct for reductions in bias voltage caused by the preamplifier, which for current-versus-voltage is typically small, anyway. For example, a 1V scan on the bias voltage, producing a 50nA response in the tunneling current would have a 5 percent error at the extremes of the scan (50nA x 1 MΩ = 50mV or 5 percent of 1V).

Input impedance of the preamplifier leads to reduced bias voltages at increased tunneling currents. This effect can cause the I vs. S plot to be inaccurate. For example, a bias voltage of 20mV will restrict the upper limit of the tunneling current to 20nA since that level of current would effectively reduce the bias voltage to zero. Even before the tunneling current gets to 20nA, the reduced bias voltage will make the measured current appear lower than it should be for a given tip height.

### 11.5 Troubleshooting Operation of STM

This section addresses errors or malfunctions encountered during the operation of the STM.

#### 11.5.1 Head and Microscope-Related Problems

This section deals with problems related to the scan heads or the microscope. If a problem exists with a scan head, try a second one under the same conditions, if possible. Otherwise, the following list of symptoms and cures may be helpful:
11.5.2 Head Engages Immediately

If the STM engages immediately after initiating the Motor > Engage command, then one of the following probably occurred:

1. Tip On Surface—Make sure the tip is not touching the surface of the sample. Adjust the coarse-adjustment screws upward until the tip is far from the surface.

2. Controller Off—Verify that power to the controller is on and that the controller is connected to the computer workstation via the beige 25-pin cable.

3. Head has Offset—Follow the directions in section 9.3. to determine if your scan head requires its offset to be adjusted.

4. Head has Leakage—Follow the directions in section 9.3. to determine whether your scan head has leakage current between the Y electrode and tip holder.

Head Never Engages

If the scan head never engages, test for the following:

- Disconnected—Make sure the microscope is connected to the Controller.

- Bias Shorted—Measure the bias by using a voltmeter between the head and stage chuck. If this is not in agreement with the settings in the Bias voltage item in the STM Parameter control panel and appears to be grounded, then check to see if anything is providing a conduction path between the Base and the Base Support or any other ground.

Tip Crashes

If the tip always crashes into the surface with the Z center either changing erratically or stuck in the fully retracted position, try the following:

- Check the Polarity of the Z Piezo—Use the Calibrate command in the Realtime > Microscope menu to review the calibration parameters for the head in use. The Z polarity should be set to Forward.

- Check Sample Conductivity—There are two problems associated with sample conductivity. First, the bulk conductivity of the sample may make it difficult to image. If the resistance of the sample is greater than 1 Kohm/cm, higher bias voltages should be tried. If the resistance is greater than 1 Megohm, bias voltages of 100 mV or more should be used. Samples with resistances 1 Megohm or greater will be difficult to image even with high bias voltages.

Measuring the bulk conductivity of the sample with probes may not tell the whole story. Probes may easily penetrate oxide or contamination layers on the sample surface yielding reasonable
Scanning Tunneling Microscopy (STM)
Troubleshooting Operation of STM

resistance measurements. However, oxide and contamination layers on the sample surface can make imaging very difficult. Higher bias voltages are required for these types of samples.

**Problems During Realtime Operation**

This section deals with problems that are associated with the Realtime aspects of the NanoScope software although they often point to the scanning head or microscope.

**Image goes out of Range**

If the Z center position tends to go out of range at the edges, top and bottom or right and left of the scan, then try the following:

- **Level Sample to Head**—The Z center position is affected by sample tilt and the Dimension head may be less tolerant of sample tilt due to its small vertical range compared to the large, lateral scan range. Try leveling the head relative to the sample by noting the trend in Z center position and adjusting the head tilt accordingly. The **View > Scope Mode** with the *Show slope* option can also be very helpful in eliminating tilt along the scan direction.

- **Measure Coupling**—A broken wire to one of the electrodes can cause this problem and will usually result in a large, monotonic increase (or decrease) in Z center position from the bottom of the scan to the top.

**Z drift**

If the Z center voltage tends to drift out of range rather quickly after the head is engaged, it may be a result of the following:

1. **Thermal Drift**—Allow some time for the temperature to stabilize if the microscope and/or scan head has been stored in a cold place overnight. Drift can be minimized by keeping the STM in a thermally stable environment.

2. **Tip not Tight**—Make sure the tip is held tightly in the tip holder. Push and pull on the tip with the tweezers to see that it is not loose. Increase the bend in the tip if the tip seems loose.

3. **Sample Hold-Down**—Verify that the sample is flat against the chuck and cannot move vertically. This may become problematic if the sample has been affixed using uncured, conductive epoxy, and/or if foam adhesives are used.

**Realtime Image Hides Features**

If the Realtime image appears to be flat, but captured images reveal detail, then try rotating the sample 90° in the microscope. The Realtime image leveling software tends to hide features that are parallel to the X-scan direction.
Image is Streaky or Wavy

If high-resolution images appear streaky or wavy, it may be a result of the following:

- **Insufficient Vibration Isolation**— Atomic-scale scans are the most susceptible to vibration in the acoustic and subacoustic frequencies. Verify that the Dimension is acoustically isolated with a functioning isolation table and, if required, an acoustic cover. Make certain that vibration tables are properly pressurized and adjusted.

- **Bad Tip**— Many strange effects have been pondered and hunted down for hours only to find that changing the tip fixes the problem. Try a different tip to see if the problem persists.

- **Low-Scan Rates**— The brute force method for reducing the effects of drift and even low frequency vibration is to simply raise the scan rate. Collect small-scale images at 156 Hz with 256 x 256 sample points.

Image is Triangular over Step-like Features

- The performance of the STM over large scans with high vertical features is very dependent on the ability of the feedback loop to force the tip to track the sample surface. The digital feedback used in the NanoScope has been designed to maximize performance on a variety of samples. Try the following to improve the image quality over step-like features:

  - **Log or Boost Feedback**— The most dramatic increase in performance of the feedback over large scans is achieved using the **Log** or **Boost** feedback modes. These make the error signal symmetrical for conditions with the tip too far or too close to the surface. **Boost** mode further optimizes the feedback performance for large scans.

  - **Gain**— The settings of the **Integral** and **LookAhead gain** terms also tend to be critical for large scans. They should be high enough to produce a little fuzz on the image but not so high as to cause large oscillations.

  - **Scan Rate**— The **Scan rate** should be lowered for large scans, especially, if the sample surfaces are rough or contain large steps. Moving the tip quickly along the sample surface at high scan rates with large scan sizes will usually lead to a tip crash. Essentially, the **Scan rate** should be inversely proportional to the **Scan size**, since the tip must still be maintained roughly 1 nanometer above the surface.

  - **Setpoint Current**— Raising the **Setpoint current** will effectively raise the gain of the feedback loop which can be quite helpful for large scans. It will also bring the tip closer to the surface but only by a small amount \((i = e^{-k})\).
11.6 Etching Tungsten Tips

You can purchase tungsten tips from Veeco or make them yourself. This section describes the process of etching tungsten tips for use with the NanoScope.

Materials Required

- Variac auto transformer
- Optical microscope (20-100X)
- Sodium nitrite (NaNO2)
- Distilled water
- Ethyl alcohol
- WD-40 (anti-oxidant)
- Two 50ml beakers
- Tipholder
- Platinum wire
- Tungsten Wire, 0.010" Diameter
- Miscellaneous Wire/Clips

11.6.1 Procedure

1. Mix a 5 percent (by weight) solution of Sodium Nitrite in water.
2. Pour ≈ 40ml of the Sodium Nitrite solution into a beaker.
3. Pour ≈ 40ml of WD 40 into a beaker.
4. Construct an electrode out of the platinum wire and insert it into the beaker.
5. Adjust the variac for 30V, and with it Off, connect one output to the platinum electrode.
6. Cut 10 to 12 pieces of tungsten wire ≈ 1.25cm long. Before etching, check to make sure that at least one end of the wire has not split by inserting the ends into a tip holder. If an end has split, you will not be able to insert it into the tipholder. You can etch the end that has split, however, preserve the unspoiled end.
7. Place the tungsten tips into a holder. We like to use an IC socket (the low cost, edge-grip square contact type, not the machine-grip round contact type), with all the pins soldered together. The tips will then be held in place while inverting them over the solution. We also find it helpful to solder the IC socket to the back of a proto-board (perf-board). You can then invert the tips over a beaker with the proto-board sitting on the rim of the beaker.

8. Invert the tips over the Sodium Nitrite solution with ≈ 2mm of the tips’ surface submerged. More than 2mm will cause excessive foaming of the solution during etching, and less than 2mm will result in tips that are too blunt.

9. Connect the other output of the variac to the common of all the tips.

10. Turn on the variac and etch the tips. While the tips are etching, the solution will foam, and the tips will start to glow. As the tips etch towards the surface, the foaming will be reduced. Continue to etch the tip until it stops.

11. Re-submerge the tips ≈ 1mm into the solution for ≈ 15 seconds at 30V. Turn on the variac and re-etch the tips. There should be only slight bubbling from the tip and it should not glow.

   **Note:** It is possible to vary the tip shape at this point by lowering the voltage on the variac and increasing or decreasing the amount of time the tips are submerged.

   **Note:** Longer time gives blunter tips.

12. Dip the tips into ethyl alcohol to clean them. If you plan to keep the tips around for more than a day, then dip them into the WD 40 after cleaning. Dispose of unwanted tips in an appropriately labelled solvent-contaminated waste container.

13. Examine the tips under the optical microscope. Ones that are too long, too blunt, or split at the end will hardly ever be good tips and can be thrown out at this time. Of course, this is a subjective process. As your experience in etching grows, you will get better at throwing out the bad ones.

14. Repeat the etching procedure. Replace the etching solution when a fairly large amount of residue is present. Typically, you can etch 60 to 80 tips in a 40ml solution.
Chapter 12  Lateral Force Mode

This chapter includes the following sections:

- **Introduction:** Section 12.1
- **Basic LFM Operation:** Section 12.2
- **Advanced LFM Operation:** Section 12.3
  - **Scan Direction:** Section 12.3.1
  - **Tip selection:** Section 12.3.2
  - **Understanding the LFM Signal:** Section 12.3.3
  - **Understanding the Color Scale:** Section 12.3.4
  - **Using TMR Voltage to Measure Friction:** Section 12.3.5
  - **Enhancing the LFM Data by Subtracting Two Images:** Section 12.3.6
  - **Height Artifacts in the Signal:** Section 12.3.7

12.1 Introduction

The Dimension 3100 SPM is capable of measuring frictional forces on the surfaces of samples using a special measurement known as lateral force microscopy (LFM). The name derives from the fact that cantilevers scanning laterally (perpendicular to their lengths) are torqued more as they transit high-friction sites; low-friction sites tend to torque cantilevers less. The relative measure of lateral forces encountered along a surface yields a map of high- and low-friction sites.

After obtaining a good topographical image in Contact mode, it is relatively easy to use LFM to view and acquire lateral force data. It is important to obtain a good image in Contact mode before measuring LFM data. The NanoScope system will continue to run the feedback based on measuring the vertical deflection signal and feedback gains in the control panel while LFM data is acquired and displayed.
12.2 Basic LFM Operation

1. Set up and run the system in Contact mode as described in Chapter 6, assigning the Channel 1 image to Data Type: Height and the Channel 2 image to Data Type: Friction. Set the Scan angle to 90.00.

2. Optimize the scan parameters in AFM mode for Channel 1.

3. For Channel 2, set Line direction to Trace. This will place high lateral forces on the top of the color bar and low lateral forces on the bottom of the color bar. If the Line direction parameter is changed to Retrace, the plus-minus sign of the lateral force changes and low lateral force will be displayed on the top of the color bar. LFM data can now be collected and stored.

   Note: LFM is a qualitative measurement, not quantitative. NanoScope software does not provide a way to calibrate the torsional spring constant of a cantilever.

   Note: The trace and retrace LFM signals may not be the same magnitude. The tip will never be exactly perpendicular to the sample. In most cases, internal stress in the material of the cantilever will cause the cantilever to have a natural bias in some direction.
12.3 Advanced LFM Operation

12.3.1 Scan Direction

The cantilever is most susceptible to frictional effects when the scan direction runs perpendicular to the major axis of the cantilever as shown in Figure 12.3a. The Scan angle parameter in the Scan Controls panel must be set to 90° or 270° to produce this scan direction.

The contact mode setpoint voltage will slightly adjust the “gain” of the lateral force signal. By increasing the setpoint, the contact force applied will increase, and so will the frictional or torsional forces in an approximately linear fashion. If the frictional effects are far too large or too small, it will be necessary to resort to changing the cantilever probe used, but if the value is near the dynamic range desired, adjustment of the contact force will produce modest changes in the lateral force or frictional signal.
12.3.2 Tip selection

The analog-to-digital converter on the auxiliary input channel which is used for LFM data has a maximum input range of ±10V. This, and the anticipated interaction between tip and sample define the selection of the cantilever to be used for the measurement.

The 200µm cantilever with wide legs provides a good starting point for frictional measurements. It is flexible enough to provide reasonable signal levels on samples with moderate friction. If the signal exceeds ±10.00V with the 200µm wide-legged cantilever, one of the stiffer 100µm cantilevers should be used. If the signal level is too small, the narrow-legged 200µm cantilever will provide a larger signal.

12.3.3 Understanding the LFM Signal

To understand LFM, examine a sample’s trace and retrace in scope mode. Figure 12.3b below illustrates the movement of the tip as it encounters friction during a scan.

Figure 12.3b  Example of Frictional Forces on Tip During Scan (Front View)
12.3.4 Understanding the Color Scale

LFM data is typically monitored in the trace direction with the scan angle set to 90 degrees. The data then follows a convention where lighter colors mean higher friction. Darker colors mean less friction. The sign of the color is inverted if Retrace is monitored (see Figure 12.3c).

### Table 12.3a  Key for LFM Example Above

<table>
<thead>
<tr>
<th>Number</th>
<th>Trace or Retrace?</th>
<th>Tip Movement</th>
<th>Level of Friction</th>
<th>Photo Diode Voltage</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>trace</td>
<td>slightly right</td>
<td>slight</td>
<td>slightly positive</td>
</tr>
<tr>
<td>2</td>
<td></td>
<td>severely right</td>
<td>higher</td>
<td>increases positive</td>
</tr>
<tr>
<td>3</td>
<td></td>
<td>straightens</td>
<td>slight</td>
<td>returns to slightly positive</td>
</tr>
<tr>
<td>4</td>
<td></td>
<td>severely right</td>
<td>higher</td>
<td>increases positive</td>
</tr>
<tr>
<td>5</td>
<td></td>
<td>straightens</td>
<td>slight</td>
<td>returns to slightly positive</td>
</tr>
<tr>
<td>6</td>
<td>retrace</td>
<td>slightly left</td>
<td>slight</td>
<td>slightly negative</td>
</tr>
<tr>
<td>7</td>
<td></td>
<td>severely left</td>
<td>higher</td>
<td>increases negative</td>
</tr>
<tr>
<td>8</td>
<td></td>
<td>straightens</td>
<td>slight</td>
<td>returns to slightly negative</td>
</tr>
<tr>
<td>9</td>
<td></td>
<td>severely left</td>
<td>higher</td>
<td>increases negative</td>
</tr>
<tr>
<td>10</td>
<td></td>
<td>straightens</td>
<td>slight</td>
<td>returns to slightly negative</td>
</tr>
</tbody>
</table>

**Figure 12.3c**  Friction Data
12.3.5 Using TMR Voltage to Measure Friction

The signal called TMR (Trace minus Retrace) in the scope mode display measures the voltage difference between the Trace and the Retrace scan directions. In the case of LFM data, this directly corresponds to the amount of total tip twist that occurs as the tip scans back and forth across the sample.

It is common to study the frictional differences between two different samples. Monitoring the TMR voltage between two different samples will give you a comparative frictional measurement.

Figure 12.3d TMR Data

![TMR Data](image)

Be aware that friction force is also affected by the amount of tracking force. The force needs to be the same when comparing two samples. You should use the force calibration curve to verify the force after substituting samples. Also note that the laser spot position and changing the probe will also cause changes in the LFM measurement.

12.3.6 Enhancing the LFM Data by Subtracting Two Images

It is possible to enhance the magnitude of the LFM data by subtracting the trace from the retrace. This is done by collecting three data channels with one scan.

1. Set channel 1 to **Height**.

2. Set channel 2 to **Friction – Trace – Offline plane fit = none**

3. Set channel 3 to **Friction – Retrace – Offline plane fit = none**

4. Collect a scan at 90 degree scan angle.

5. Use the Image subtract feature in Offline mode to subtract Retrace from Trace. The resulting data will show double the LFM data and half the background noise caused by tracking error.

**Note:** The X-Y motion of an open loop scanner in trace and retrace does not overlap exactly. You can still use image subtraction, but some erroneous height data might be added to the LFM data in the final image. This is not an issue for closed loop scanners.
12.3.7 Height Artifacts in the Signal

LFM is subject to height artifacts due to coupling with surface topography. Delay in the feedback loop causes the tip to momentarily twist as it climbs up an edge. This will be visible in the friction data if it’s severe enough.

To distinguish real friction data from height artifacts, remember that friction causes the cantilever to twist in the opposite direction as it travels. Actual LFM information will always show up as a mirror image in the trace and retrace directions in the scope display. Height artifacts will be the same direction in the scope display (see Figure 12.3e).

**Figure 12.3e** Height Artifacts in LFM Data
Chapter 13  Force Imaging

Force plots measure tip-sample interactions and determine optimal setpoints. More recently, microscopists have plotted force measurements across entire surfaces to reveal new information about the sample. This area of scanning probe microscopy promises to open new chapters in materials science, biology and other investigative areas.

Specifically, this chapter details the following topics:

- **Force Plots–An Analogy:** Section 13.1
- **Force Calibration Mode:** Section 13.2
  - Example Force Plot: Section 13.2.1
- **Force Calibration Control Panels and Menus:** Section 13.3
  - Main Controls (Ramp Controls): Section 13.3.1
  - Main Controls Panel (Display): Section 13.3.2
  - Channel 1, 2, 3 Panels: Section 13.3.3
  - Feedback Controls Panel: Section 13.3.4
  - Scan Mode Panel (Advanced Mode Only): Section 13.3.5
  - Menu Bar Commands: Section 13.3.6
- **Force Calibration (Contact Mode AFM):** Section 13.4
  - Obtaining a Good Force Curve: Section 13.4.1
  - Helpful Suggestions: Section 13.4.2
  - Advanced Techniques: Section 13.4.3
  - Interpreting Force Curves: Section 13.4.4
13.1 Force Plots–An Analogy

A force plot is an observation of tip-sample interactions which yields information regarding the sample and tip. By way of analogy, suppose a materials researcher must determine how powerful two different types of magnets are. One magnet is made of iron, the other is a stronger, so-called “rare earth” magnet.

A simple way of measuring each magnet’s power would be to determine its pull upon a steel plate. For example, the researcher could hang each magnet from a simple spring scale, “zero” the scale, then lower the magnet toward a heavy steel plate. At regular distances from the plate, the amount of pull shown on the scale is recorded. At some unique height above the plate, each magnet is attracted strongly enough to attach itself to the plate. A plot of height, \( H \), versus magnetic pull gives a comparative index of each magnet’s power. Similarly, after attachment the researcher could pull each magnet away from the plate and measure the pulling force at regular intervals until the magnet breaks free. The pull-off point of each magnet gives an additional index of its holding power.\(^1\) A representation of this setup during a lowering cycle of one magnet is illustrated in Figure 13.1a.
The pulling force is measured at 1 cm height intervals while the scale and magnet lower and lift in a controlled cycle. Figure 13.1b depicts a plot of this experiment using two magnets. The plot depicts each magnet’s attraction as it approaches the plate, and its tenacity when pulled off the plate. Assuming both magnets are the same size, this reveals information about each magnet’s power. First, magnet #1 is weaker, attaching to the steel plate with 7N of pulling force at 6cm, and magnet #2 is stronger, attaching at 7cm with 10N.

1. For the sake of simplicity, forces are represented here using a common scale in kilogram units; however, force is properly measured in Newtons (1 kg = 9.8 N).
This oversimplified model depicts activity between SPM tips and various materials. In reality, SPM force plots reveal far more. For example, by combining force curves at regularly spaced intervals across the sample, you may generate a force map of the sample’s electric properties, elastic modulus, and chemical bonding strengths.

13.2 Force Calibration Mode

The Force Calibration command in the View > Force Mode > Calibration menu allows you to quickly check the interaction between the cantilever and the sample surface. In Force Calibration mode, the X and Y voltages applied to the piezo tube are held constant and a triangular waveform similar to the one depicted in Figure 13.2a is applied to the Z electrodes of the piezo tube.

![Figure 13.2a Force Calibration Z Waveform](image)

As a result of the applied voltage, the cantilever tip moves up and down relative to the stationary sample as shown in Figure 13.2b. The Z scan start parameter sets the offset of the piezo travel, while the Ramp size parameter defines the total travel distance of the piezo. Therefore, you can obtain the maximum travel distance by setting the Z scan start to \(+220\) V, with the Ramp size set to \(+440\) V.
As the piezo moves the tip up and down, the cantilever-deflection signal from the photodiode is monitored. The force curve, a plot of the cantilever deflection signal as a function of the voltage applied to the piezo tube, displays on the display monitor. The control panel detailing parameters for controlling the microscope in Force Calibration mode displays on the control monitor.

**Force Calibration** mode is frequently used to adjust and calculate contact forces between the cantilever and the sample. Other uses of **Force Calibration** mode include characterization of the forces on the cantilever tip, diagnosing AFM performance, and determination of the sensitivity of the cantilever deflection voltage in terms of voltage applied to the piezo. If used correctly, **Force Calibration** mode provides a variety of useful information.
Figure 13.2c  Tip-Sample Interaction During a Force Plot
13.2.1 Example Force Plot

A Contact Mode AFM force plot using a silicon nitride tip is the most simple SPM force plot. Because of the lower spring constant of silicon nitride tips, they are very sensitive to attractive and repulsive forces. A force plot in Contact Mode AFM is shown in Figure 13.2d.

Figure 13.2c compares portions of the force curve shown in Figure 13.2d to relative positions of the tip and sample at seven points. The force curve represents the deflection signal for each complete extension-retraction cycle of the piezo (Figure 13.2a). The Z scan rate parameter in the Main Controls panel defines the rate at which the piezo completes an extension-retraction cycle (and therefore the rate at which new curves are displayed).
The horizontal axis plots the tip movement relative to the sample. By extending the Z-axis piezo crystal, the tip descends toward the sample and the tip-sample distance decreases. The descent plots from right-to-left in yellow on the NanoScope display monitor. By retracting the Z-axis piezo crystal, the tip ascends away from the sample and the tip-sample distance increases. The ascent plots from left-to-right in white on the NanoScope display monitor.

Cantilever deflection plots on the vertical axis of the graph. When the cantilever deflects downward, it plots on the graph’s downward vertical; when the cantilever deflects upward, it plots on the graph’s upward vertical.
You can use force plots to adjust the setpoint so that minimal force is applied to the sample. Although attractive forces appear small, the tip is extremely sharp. Because only a few nanometers of the tip actually touch the sample, even minute forces add up quickly when distributed over an exceedingly small area. The tip can easily dent many materials under such conditions.

The graph detailed in Figure 13.2a reveals the following types of information:

**Tip-Sample Attraction**

As the tip approaches the sample, various attractive forces reach out and grab the tip. This is evident at point 2 (slight dip) in the graph above. The tip plunges toward the sample during its descent. This is also referred to as the “jump-to-contact” point and is usually due to electrostatic attraction or surface tension (capillary) forces.

Attraction is also evident between points 4 and 5 (sloped line) as the cantilever pulls away from the sample. If attractive forces are strong enough, the tip clings to the sample surface as it pulls clear. Eventually, the sample retracts and the tip rebounds sharply upward (white line between points 5 and 6). You can measure attractive forces of tip-sample interactions if you know the spring constant.

**Material Elasticity**

It is possible to extract information regarding the elasticity of the material by studying force curves. In the graph above, the tip is in constant contact with the sample between points 2 and 4. As the tip presses further into the sample material, the cantilever flexes. The amount of cantilever flexion for a given amount of downward tip movement indicates the material’s elasticity.

For example, if the material is extremely hard, pressing the tip downward results in a relatively large amount of cantilever flexion. On the other hand, if the material is soft, the cantilever will flex less during its descent. The shape and slope of the contacted portion of the force curve gives detailed information about surface elasticity. It is possible to obtain quantitative measurements of sample elasticity. (See Radmacher, *et al.* 1994. *Science*, Vol. 265:1577-1579).

Two imaging techniques measure and display elasticity at multiple points on a sample surface: **force modulation** and **force volume imaging**.
13.3 Force Calibration Control Panels and Menus

The Force Calibration Control window (see Figure 13.3a) manipulates the microscope in Force Calibration mode. The parameters control the rate, start position and amplitude of the triangle wave applied to the Z piezo. You can also adjust the Setpoint value of the cantilever deflection voltage used in the feedback loop during imaging. The Capture button stores the force curve for Offline viewing. Some parameters influence the operation of the microscope during imaging; most of the menu parameters affect only Force Calibration mode.

Figure 13.3a  Advanced Force Calibration Control Window (Contact Mode AFM)

There are 2 methods to enter Force Calibration Mode:

- **View > Force Mode > Calibrate** will open a simplified subset of the parameters and commands available.

- **View > Force Mode > Advanced** includes the full set of available parameters and commands.

Additionally:

- **View > Force Mode > Step** enters force mode with the parameter start mode = step and the piezo fully retracted.

- **View > Force Mode > Volume** enters Force Volume Mode.

Items in the Force Calibration Control Window are discussed individually below.
13.3.1 Main Controls (Ramp Controls)

Ramp Channel (Advanced Mode Only)

This parameter specifies the channel you will ramp. To collect force plots, this parameter should be set to $Z$. For IV curves, Bias is typically selected.

Ramp Size

As shown in Figure 13.2a, this parameter defines the amplitude of the triangular waveform applied to the $Z$ piezo. The units of this item are volts or nanometers, depending on the setting of the Units parameter. Regardless of the size of the scan, the entire scan is shown in the force curve; therefore, increasing the value of this parameter increases the horizontal axis scale on the force plot.

Z Scan Start

This parameter defines the maximum voltage applied to the $Z$ electrodes of the piezo during force calibration operation. The triangular waveform shown in Figure 13.2a displaces the piezo up and down in relation to the value of Z scan start. Increasing the value of the Z scan start parameter moves the cantilever closer to the sample by extending the piezo tube. The units of this item are volts or nanometers, depending on the setting of the Units parameter. The initial value of Z scan start is equal to the average $Z$-center voltage defined by the feedback just prior to entering the Force Calibration mode. Decreasing the value of this parameter shifts the force curve on the display to the left, while increasing the parameter shifts the curve to the right.

Scan Rate

This parameter defines the rate that force plots are collected (typically ~1Hz). The ramp size, forward velocity and reverse velocity determine the scan rate.

Forward Velocity (Advanced Mode Only)

This parameter defines the piezo speed to bring together the tip and sample.

Reverse Velocity (Advanced Mode Only)

This parameter defines the piezo speed to separate the tip and sample.

X Offset, Y Offset

These parameters define the X and Y positions where the force plot will be collected.
Number of Samples

This parameter defines the number of data points captured during each extend and retract operation of the Z piezo during Force Calibration. This parameter does not affect the number of samples used in Image Mode.

Average Count (Advanced Mode Only)

This parameter defines the number of Force Calibration scans taken to average in the display of the Force Calibration graph. Set to 1 unless the user needs to reduce noise. Otherwise, set between 1 and 1024. No curves are displayed until “Average Count” curves have been collected. Also, drift may cause systemic error in the resulting plot.

13.3.2 Main Controls Panel (Display)

Spring Constant

The parameter defines the spring constant of the cantilever. The spring constant will be saved with captured force plots.

Display Mode

This parameter defines the display as either the approach, the retract, or both.

Units

This item selects the units, either metric lengths or volts on the piezo, that define the parameters and the axes of the graph. Changing this item in Force Calibration mode also changes it in the Realtime imaging mode.

X Rotate

X Rotate allows you to move the tip in the X direction during ramping. This is useful because the cantilever is at an angle relative to the surface. X Rotate prevents the cantilever from plowing the surface laterally, typically along the X direction, while it indents in the sample surface (in the Z direction). Plowing occurs when the cantilever bends during indentation or with X movement caused by coupling of the Z and X axes of the piezo scanner. X Rotate moves the scanner in the opposite direction in which the cantilever points. Without X Rotate control, the tip moves in the direction of the cantilever during indentation. Normally, it is set to about 22.0 degrees. This parameter typically ranges between 12 and 25 degrees.
13.3.3 Channel 1, 2, 3 Panels

Data Type

This parameter allows you to select the type of data you want to display on the vertical axis.

Data Scale

This parameter sets the vertical scale in the force plot. Increasing this parameter expands the range of the display about the centerline causing more of the force curve to fall on the graph. Initially, set this parameter to its maximum value, then gradually reduce.

Data Center

This parameter shifts the displayed force plot in the vertical axis.

Note: For Data type = Deflection in Contact Mode or Data type = Amplitude in TappingMode, the data is also shifted by the setpoint (i.e., if the Data type = Deflection and Data Center = 0, then the setpoint is at the center of the vertical scale.

Deflection Sensitivity

This item relates the cantilever deflection signal in volts from the controller to the actual deflection of the cantilever (in nm). It equals the inverse of the slope of the deflection versus Z piezo position line when the tip is in contact with a very hard, stiff sample as shown in Figure 13.4d. The NanoScope system automatically calculates and enters the value from the graph once you use the mouse to draw a line parallel to the graph. You must properly determine the deflection sensitivity value before deflection data in nanometers can accurately display. For a proper force curve, the line has a negative slope with typical values of 10-100 nm/V; however, by convention, values appear as positive in the menu.

Amplitude Sensitivity (TappingMode)

Amplitude Sensitivity relates the vibrational amplitude of the cantilever (in nm) to the amplitude signal (in V) from the controller. To calculate the Amplitude Sensitivity, measure the slope of the RMS amplitude versus the Z piezo position when the tip is in contact with a very hard, stiff sample. The NanoScope software automatically calculates and enters the value from the graph after you use the mouse to draw a line to the graph. You must properly calibrate the Amplitude Sensitivity before amplitude data can be correctly displayed in nm.
13.3.4 Feedback Controls Panel

All of the parameters in the Feedback Controls panel also affect Image mode.

Deflection Setpoint (Contact Mode)

By changing the deflection setpoint, you can adjust the cantilever deflection voltage maintained by the feedback loop in Image mode. This parameter defines the center of the range of Cantilever Deflection Voltages that can be collected. If the Data Center = 0, then the setpoint is at the center line of the force plot shown on the display monitor. Changing the setpoint shifts the force calibration curve on the graph. For example, if the setpoint is set to -3.0V and the data center is 0, the cantilever deflection axis of the graph centers around -3.0V. Raising the setpoint to -2.0V shifts the force calibration curve down by one volt so the graph centers at -2.0V. Changing the value of this parameter in Force Calibration mode also changes the Image mode.

Amplitude Setpoint (TappingMode)

The RMS value of the cantilever deflection voltage maintained by the feedback loop in Image mode can be adjusted by changing Setpoint. In a TappingMode force plot mode, the setpoint defines the centerline of the vertical, “Amplitude” axis of the amplitude calibration plot shown on the display monitor (the Data Center must be 0 for that Channel). Changing the Setpoint shifts the amplitude curve on the graph. For example, if the setpoint is at 3.0V, the RMS amplitude axis of the graph will be centered around 3.0V; raising the setpoint to 4.0V will shift the amplitude curve down by one volt, so the graph will be centered at 4.0V. Changing the value of this parameter in the Amplitude Calibration mode also changes the setpoint parameter in Image mode.

Deflection/Amplitude Limit

This parameter changes the gain applied to the input signal. You can reduce the input signal by a factor of eight for a NanoScope IIIa (or set it to one of seven different levels for a NanoScope IV) to see more of the Force Calibration plot deflection or amplitude. This parameter also affects Image mode and the resolution of the system; therefore, change the value to 2.5V for a NanoScope IIIa (or 5V for a NanoScope IV) before returning to imaging.

Drive Frequency (TappingMode)

This parameter defines the frequency at which the cantilever is vibrated. This frequency should be close to the resonant frequency of the cantilever. Changing the value of this parameter in the Force Plot menu also changes the Drive frequency parameter in the Image mode.

Drive Amplitude (TappingMode AFM)

This parameter defines the amplitude of the voltage applied to the piezo system which drives the cantilever vibration. Changing the value of this parameter in Force Plot mode also changes the Drive amplitude parameter in the Image mode.
13.3.5 Scan Mode Panel (Advanced Mode Only)

Trigger Mode

The Scan Mode panel allows you to use various triggers when obtaining Force Plot and Force Volume plots. The idea of triggering simple: it limits the total amount of force exerted by the tip upon the sample. Depending upon which trigger you use and how it is set, you may operate the trigger independent of drift (Relative) or at some arbitrarily fixed point (Absolute).

**Figure 13.3b** Absolute and Relative Triggers

The plots in Figure 13.3b show the effect of drift on each of the two trigger types. The plot series shown on the right side of Figure 13.3b utilizes a Relative trigger and maintains force at a constant level defined by the Trig threshold parameter. The Relative trigger threshold is relative to the data at the right of the plot where the cantilever is typically undeflected. As illustrated, the total force is maintained, even as the system drifts.

The plot series on the left side of Figure 13.3b utilizes an Absolute trigger. Notice that as the system drifts (plot moves slowly downward), total force increases. Drift may be due to mechanical causes, or due to thermal effects on the cantilever. An Absolute trigger permits the total force to be set using Setpoint values.

Trigger Channel

This parameter defines the channel to watch to determine when to reverse the ramp.
Force Imaging
Force Calibration Control Panels and Menus

Trigger Threshold

This parameter as well as the Trigger Direction and Trigger Mode define the level at which trigger occurs.

Trigger Direction

The Trigger Directions are defined as follows:

- **Positive**: Trigger occurs on positive values only (Trigger Threshold must be positive)
- **Negative**: Trigger occurs on negative values only (Trigger Threshold must be negative)
- **Absolute**: Sign of Trigger Threshold is ignored (trigger may occur on positive or negative values).

Start Mode

The Start Mode parameters are defined as follows:

- **Calibrate** and **Step**: Normal ramping (no stepping) unless you use Probe > Approach Single or Approach Continuous.
- **Motor Step**: Uses the stepper motor to offset ramp instead of the piezo.

End Mode

The End Mode parameters specify the location of the tip when the mode is switched back to Image mode. **Retracted** is the typical setting.

**CAUTION:** Use caution when using the Extended Mode parameter; you could damage the tip.

Z Step Size

This parameter defines the size of Z step for Step or Motor Step modes. For Step, it the amount to move the piezo; for Motor Step it is the amount to move the motor.

Auto Start

When Enabled this parameter starts taking force curves upon entering Force Calibrate Mode.
Ramp Delay

This parameter sets the amount of time to wait with the piezo extended before retracting.

Reverse Delay

This parameter sets a delay to occur each time the piezo is retracted while continuously ramping.

Auto Offset

If the trigger is not achieved within a range twice the ramp size, then the retract will begin without reaching the trigger voltage. Enabling this parameter allows the software to automatically move the range to attempt to reach the trigger.

13.3.6 Menu Bar Commands

Capture

The Capture button stores the force plot for Offline viewing. Use other options in the Capture menu to change a capture filename and for “continuous capture” of all the force plots collected.

Probe Menu Commands

These commands allow for highly controlled tip movement designed to prevent damage to the tip. Each of these commands has an icon to access directly from the menu bar.

- **Run Continuous**: The tip is continuously lowered and raised by a distance equal to the Z scan size. This is the normal, default motion during Force Calibrate. “Raising” and “lowering” are relative to your system (e.g., On Dimension Series SPMs, the tip is raised and lowered to the surface; however, other SPMs raise and lower the sample beneath the tip).

- **Run Single**: Lowers and raises tip once by a distance equal to the Z scan size, then halts.

- **Stop**: Halts all tip movement.

Note: View additional menu subcommands by accessing the advanced Force Mode command.
Motor

The Motor menu allows you to withdraw or manually control the tip position using the stepper motor. Selecting Step Motor opens a dialog box containing the following buttons:

- **Tip Up**: This command moves the tip up by the SPM step size displayed inside the window.
- **Tip Down**: This command moves the tip down by the SPM step size displayed inside the window.

### 13.4 Force Calibration (Contact Mode AFM)

#### 13.4.1 Obtaining a Good Force Curve

**Figure 13.4a** Typical Force Calibration Curve

![Typical Force Calibration Curve](image)

To minimize or calculate the contact force between the tip and sample, obtain a good force curve which shows the typical features displayed in the example curve in Figure 13.4b. However, the force curve rarely looks “typical” right after invoking Force Calibration mode. This section...
discusses general approach adjustments to improve force curves obtained after engaging the microscope.

The basic approach to obtaining a good force curve entails adjusting the Z motion of the piezo relative to the sample (with the Z scan start and Ramp size parameters) and shifting the graph (with the Setpoint parameter) so the pull-off point of the tip displays on the graph. In general, use the following steps to obtain a good force curve:

1. **Engage** and verify the tip is tracking the surface. Then switch to **Force Calibration** mode.

2. Maximize the **Deflection Limit** parameter in the **Feedback Controls** panel.

3. In the **Channel 1** panel select **Deflection** as the **Data Type**.

4. Maximize the **Data Scale** parameter.

5. Adjust the **Ramp size** parameter to about 1µm.

6. If the tip does not reach the sample surface (for example, see **Figure 13.4a**, between points 2 and 3), slowly increase the **Z scan start** value.

7. As the **Z scan start** increases, the traces on the force curve move to the right.

8. Adjust the **Setpoint** parameter.

   **Note:** Adjusting the **Setpoint** value moves traces up and down on the graph. Decreasing the value moves the curve up while increasing the value moves the curve down. (Remember that the green horizontal centerline of the graph is equal to the **Setpoint** if the **Data Center** = 0, so that changing the **Setpoint** actually shifts the graph up and down.) Typically, changing the **Setpoint** value to -2 volts shows the desired features of the force curve. If it does not, decrease the **Setpoint** value further.

   **Note:** Sometimes the entire ramp will occur in the contact portion of the curve (see **Figure 13.4a**, between points 3 and 5). If this occurs, increase the **Ramp size** and/or decrease the **Z scan start**.
13.4.2 Helpful Suggestions

To minimize or calculate the contact force between the tip and sample, it is important to obtain a good force curve; however, there will be situations where you will not obtain a good force curve no matter how much you adjust the Ramp size, Z scan start and Setpoint. The following sections discuss a few such situations. Suggestions on working in Force Calibration mode are included.

False Engagement

Figure 13.4c illustrates a force curve resulting from a falsely engaged tip. The photodiode receives light reflected off the sample, causing an increase in the deflection signal until the signal equals the setpoint and the system “engages” (even though the tip is not on the surface). Interference in the reflected light causes the hump-shaped waveform.

The easiest way to correct a false engagement is to withdraw the tip, adjust the photodetector positioner to make the top/bottom differential voltage more negative, then re-engage the tip. This compensates for the slight slope in Figure 13.4c).

![False Engagement (G Scanner)](image)

Motor Control

Motor Control > Tip Up and Tip Down buttons provide coarse adjustment of Z center voltage. With these buttons the SPM head moves vertically. The feedback loop causes the Z piezo to adjust to compensate for the head movement. If you use Tip Up, the Z piezo extends. If you use Tip Down, the Z piezo retracts.

Note: The Step Motor function is generally used only when the scanning range of the Z piezo is exceeded or when it is necessary to position a force measurement in the center of the scanner range. Because the Z-axis leadscrew has some backlash, it may be necessary to rotate the leadscrew several turns by clicking on the Tip Up or Tip Down buttons before obtaining movement.
Adjust Photodiode

In an analogous manner, you can use the photodiode positioner as a coarse adjustment for Setpoint voltage. Changing the laser beam position on the photodiode by rotating the photodiode adjustment knobs shifts the force curve on the graph. Rotating the top photodiode adjustment knob clockwise shifts the curve up, just as decreasing the Setpoint parameter shifts the curve up. Conversely, rotating the top photodiode adjustment knob clockwise moves the curve down.

13.4.3 Advanced Techniques

Sensitivity Determination

The Deflection Sensitivity allows conversion from the raw photodiode signal (in Volts) to deflection of the cantilever (in nm), and is normally set from the Force Calibration mode. The sensitivity must be calibrated before accurate deflection data can be obtained. Sensitivity is equal to the inverse of the slope of the force curve while the cantilever is in contact with a hard sample surface. Complete the following steps to calculate the sensitivity:

1. Obtain a good force curve on the display monitor using a hard sample so that the sample does not deform.

2. Position the cursor on one end of the contact portion of the curve.

3. Click on the left mouse button to fix the line segment.

4. Drag the mouse to position the “rubber band line” parallel to the contact portion of the force curve (see Figure 13.4d).

5. The second click on the mouse causes the system to calculate the slope of the line segment and enter the -1/slope as the Sensitivity in the panel.

6. A click of the right mouse button will remove the line segment from the screen.
If Sensitivity is calibrated on a material much stiffer than the cantilever, it measures the inverse of the value of the AFM’s optical lever sensitivity; i.e., how many volts of deflection signal are produced by a given deflection of the cantilever tip. The sensitivity will change for different cantilever lengths and styles (shorter cantilevers give lower Sensitivities). Sensitivity will also change with the position of the laser on the cantilever and the quality of the laser beam reflection from the cantilever.

**Note:** It is important to calibrate the Sensitivity parameter on a hard substrate as described here BEFORE using the force curve’s vertical scale for quantitative measurements.

**Note:** Deflection Sensitivity can be expressed in terms of the photodiode voltage versus the distance traveled by the piezo, or the photodiode voltage versus the voltage applied to the piezo, depending on the setting of the Units parameter.

**Force Minimization**

**Force Calibration** mode allows minimization of the contact force of the cantilever on the sample surface. The force curve clearly illustrates the relationship between the Setpoint and the cantilever deflection voltage when the cantilever is off the sample surface. You can adjust the Setpoint to set the normal deflection of the cantilever and, therefore, the normal force applied by the cantilever during data collection.

You can run the microscope below the point of zero deflection of the cantilever to minimize the contact force of the cantilever on the sample. It is possible to get a negative deflection whenever the cantilever sticks to the surface. To engage, you must set Setpoint greater than the deflection voltage when the tip is not interacting with the surface. However, you can change the setpoint after engaging.

In **Force Calibration** mode, you can lower the setpoint to the zero cantilever-deflection point and beyond, while viewing the force curve. You can adjust the setpoint (most often made more negative) so that it lies between the flat segment of the force curve which corresponds to the zero deflection point, and the tip of the retraction scan where the cantilever pulls off the sample surface VCSmin (see Figure 13.4e). The contact force is at its minimum when VCSmin is on the centerline of the deflection-signal axis (Setpoint = VCSmin).

In practice, VCSmin must be a little below the centerline because VCSmin is the point where the cantilever pulls off the surface and operation at this deflection is unstable. Changing the Setpoint option in the Feedback Controls panel changes the setting of the Setpoint parameter in its Image Mode counterpart when you exit the Force Calibration Mode. After exiting, if the image looks good, you can decrease the force further by lowering the Setpoint in small increments until the cantilever pulls off the sample surface. Resetting the Setpoint to a value higher than the voltage when the tip is not interacting with the surface, recaptures the cantilever. (Slowly adjust to a more positive value until the tip is back on the surface.) Adjusting the Setpoint a few tenths of a volt above the point where the cantilever pulled off provides a low contact force.

If a high initial contact force adversely affects the sample, engage the cantilever with a very small scan size. Then, minimize the force while the tip is confined to a small area of the sample where it experiences the relatively high initial engagement force. Once the force is minimized, increase the
Ramp size or offset the scan to a different area of the sample. However, keep in mind that if the force is minimized in a smooth area of the sample, the cantilever may pull off when it translates to a rougher part of the sample.

Calculating Contact Force

The force curve clearly shows the relationship between the setpoint and the deflection of the cantilever. Because the setpoint defines the value of the deflection signal maintained by the feedback loop, the force curve can be used to calculate the contact force of the tip on the sample if the spring-constant, $k$, of the cantilever is known. The contact force is defined by the equation:

$$F = k \times d$$

where “$d$” is the deflection measured from the setpoint to $V_{CSmin}$ in nanometers. An example of how to compute the contact force from the Force Plot graph is shown in Figure 13.4e.

Recalling that contact force $F = kd$, we can calculate the contact force from the sample plot above. Let us assume, for example, that the spring constant of the cantilever is $k = \frac{0.6N}{m}$ and that deflection sensitivity $= \frac{70nm}{V}$. The plot above may be measured at the points where the retract portion of the curve intersects the setpoint to the pull-off (point). The distance is then multiplied times the deflection sensitivity to obtain $d$. In this example:

$$d = (4.5 \text{ div}) (1\text{V/ div}) (70\text{nm/V}) = 315\text{nm}$$

Therefore, the contact force is calculated as:

$$F = (0.6\text{N/m}) (315\text{nm})$$
$$= 189\text{nN}$$
When the **Data type** is set to **Height** with the feedback gains set high, the tip tracks the sample surface with nearly constant deflection of the cantilever. When the cantilever deflection is constant, the force is constant and the force calculation above determines the contact force between the tip and the surface over the entire scan area.

Force calculations are not as straightforward on images captured with the **Data type** set to **Deflection**. When collecting deflection data, the feedback gains are ideally set low so the sample stays at a nearly constant position relative to the cantilever holder. In this case, the cantilever deflection (and therefore the force applied to the sample) varies as features on the surface are encountered. The contact force can be calculated by adding the deflection data from the image to \( d \) before multiplying by the spring constant: \( F = k \text{ (deflection image data + } d \text{)} \). Note that the **Sensitivity** parameter must be accurate—that is, previously determined and entered—before the deflection data will be accurate.

A simple alternative to calculating force is to follow these five steps:

1. Set sensitivity using the mouse.
2. Change units to metric.
3. Count vertical units from Setpoint to VCS min.
4. Multiply by Deflection Scale (adjacent to plot).
5. Multiply by the spring-constant, \( k \).
13.4.4 Interpreting Force Curves

An examination of force curves can prove useful in determining adhesion, hardness, and elastic characteristics of samples. The examples in Figure 13.4f represent some of the general variations in force curves. For more information regarding force imaging, refer to Veeco’s application note *Probing Nano-Scale Forces with the Atomic Force Microscope.*

**Figure 13.4f** Force Curve Examples

- Large adhesion
- Small adhesion
- Stiff sample
- Soft sample
- Long-range repulsion
- Long-range attraction
- Plastic Deformation
13.5 Force Calibration (TappingMode)

**CAUTION:** Because TappingMode cantilevers are relatively stiff, **Force Mode** can potentially damage the tip and/or surface. Before using Force Calibration, read and understand the following section.

**Force Mode** allows the imaging of forces between the tip and surface, including chemical bonds, electrostatic forces, surface tension and magnetic forces. In TappingMode, you can observe forces by measuring changes in tip RMS amplitude, phase, or TM deflection. The user may collect force plots in one of two forms: **Force Plot** and **Force Volume**. The two forms are similar, with **Force Volume** generating a map of many individual force plots. To produce high-quality force plots, it is necessary to precisely control tip position relative to the surface.

### 13.5.1 Force Plots

When performing **Force Plot** in TappingMode, the piezo moves to the center of the current X-Y scan, then turns off the X-Y scan motion. Next, a triangular waveform is applied to the Z electrodes of the piezo tube resulting in the oscillating tip moving up and down relative to the sample. The same Z-axis piezo motion occurs in Contact Mode AFM force plots. However, in TappingMode, the force plot is a graph of the piezo’s extension versus oscillating tip amplitude, phase or TM deflection, instead of deflection or friction.

Uses of **Force Calibration** in TappingMode include characterizing forces on the cantilever tip, diagnosing SPM performance, calibrating the RMS amplitude or TM deflection, and configuring **Lift Mode**. For example, as the oscillating tip is brought closer to the surface, tip motion is dampened, which shows as an immediate drop in amplitude. When plotted, the graph resembles Figure 13.5a.
Figure 13.5a illustrates a two-channel TappingMode force plot. The vertical axes of the graphs represent the amplitude (top) and TM deflection signal (bottom) of the cantilever. The position of the Z piezo plots along the horizontal axis. Channel 1 (top) demonstrates how the cantilever amplitude decreases as the tip moves closer to the sample. The plot represents the amplitude for one complete extension-retraction cycle of the piezo. The scan rate parameter in the Main Controls panel defines the rate at which the piezo completes an extension-retraction cycle; therefore, the rate at which new curves display. At point 1, the tip encounters the sample surface. Upon encountering the surface, the tip oscillation amplitude decreases, dropping off as the tip moves closer to the sample surface. Between points 1 and 2, voltage to the Z piezo is increased, bringing the tip about 50 nm closer to the surface. Over the same interval, the cantilever amplitude diminishes about 2 volts due to dampening effects.

Collecting a force plot on a hard sample and dividing the change in amplitude by the change in Z piezo position gives the responsiveness of the electronics that measure the amplitude. The Amplitude Sensitivity value in the Main Controls menu is the inverse of the responsiveness. You can determine this value by using the mouse to draw a line parallel to the plot’s slope in the region between points 1 and 2 where the tip amplitude dampens. Tip damping occurs as a result of mechanical-acoustic coupling between the tip and sample. As the z piezo is extended further, oscillation eventually ceases and the amplitude drops to zero (point 2).

For TappingMode in air on a hard sample, each nanometer decrease in the cantilever position decreases the peak-to-peak vibration of the cantilever by two nanometers. Once the tip encounters...
the sample surface, the oscillation amplitude of the cantilever decreases as the piezo is extended. When the piezo turns around and begins to retract, the oscillation amplitude of the cantilever increases until the tip is free of the surface, leveling off at the free-air amplitude (point 5).

**Channel 2** (bottom) in Figure 13.5a plots average cantilever deflection (TM deflection) versus piezo extension. The deflection signal is low-pass filtered to eliminate the high-frequency TappingMode oscillation. Even as tip RMS amplitude dampens during its encounters with the sample surface, the average deflection is unchanged. This condition changes once the tip is so close to the sample that all oscillation ceases. Extending the piezo still further causes the average deflection to increase, applying an increasing force to the sample (point 2).

At point 3 in Figure 13.5a, the cantilever begins to deflect. The region between points 3 and 4 may be hazardous to the tip, because the tip is pressed firmly against the sample surface. Most single crystal silicon TappingMode tips rapidly become dull in this region, depending upon the hardness of the sample.

### 13.5.2 Obtaining a Force Plot (TappingMode)

| CAUTION: | Use **Force Calibration** with caution or when it is important to obtain experimental information shown in **Force Calibration**. When using stiff TappingMode cantilevers, it is easy to blunt the tip with excess contact force during **Force Calibration** measurements. |

When obtaining force plots in TappingMode, set up scan parameters so that the reduction of amplitude is minimal (approximately 25 percent of the free air amplitude). If the amplitude is reduced to zero, the tip and sample may sustain damage.

To generate a TappingMode force plot of a silicon calibration reference, complete the following steps:

1. Verify the cantilever holder is loaded with a TappingMode tip.
2. Mount the calibration reference on the SPM stage.
3. Set the **AFM mode** parameter to **Tapping**, engage, and obtain a TappingMode image.
   - **Note:** You are now in **Image mode**.
4. To switch to **Force Mode**, click on the **Realtime > View > Force Mode > Calibration** or **Advanced** option. At least two panels should be visible:
   - **Main Controls**
   - **Channel 1 Panel**
Note: Collectively, these panels control tip-sample interactions. If any panels do not appear, pull down the Panels menu to select them. The Probe menu offers a number of tip approach options detailed in the Command Reference Manual.

5. Set the Main Controls and Channel 1 panel parameters to the settings shown in Figure 13.5b.

Note: The Sensitivity value shown in Figure 13.5b may differ from yours.

Figure 13.5b  TappingMode Force Plot Parameter Settings (Force Calibrate)

6. Set the Data type parameter to Amplitude under the Channel 1 panel.

7. Adjust the Z scan start parameter to obtain a satisfactory force plot using the left-right arrow keys.
13.5.3 High Contact Force

Figure 13.5c shows a curve produced when the tip pushes too far into the sample. The flat portion on the left side of the amplitude curve in Figure 13.5c occurs because the tip is so close to the surface that it no longer vibrates. As the piezo extends the tip further, the amplitude of vibration does not change because the tip is always in contact with the sample surface. The contact force is very high due to the stiffness of the TappingMode cantilevers. The tip may shatter if deflection continues.

![Figure 13.5c Amplitude Force Plot with High Contact Force](image)

You can avoid this situation by using triggers (see Section 13.3.5) or by reducing the value of Z scan start until there is no flat portion on the left side of the curve. Rapidly increasing the value of Z scan start is dangerous because the total oscillation amplitude of the cantilever is small relative to the total Z travel of the long-range scanner.

13.5.4 Tip Selection

You may use virtually any TappingMode tip to obtain TappingMode force plots; however, the ultimate choice depends upon the delicacy of the sample and the magnitude of the forces to be gauged. Longer cantilevers have lower spring constants (i.e., they are more pliant) and therefore offer greater sensitivity for most samples. Shorter cantilevers afford better control when gauging strong attractive forces and are less prone to entrapment by surface tension forces. Sharper tips are more likely to plastically deform the sample, and are less sensitive to adhesive forces, than tips that are more blunt. Experiment to determine the tip that best meets your needs.
13.6 Force Modulation

13.6.1 Introduction

This section describes the operation of force modulation mode, which you can use to image local sample stiffness or elasticity. This method is useful for imaging composite materials or soft samples on hard substrates where you can obtain contrast between regions of different elasticity. This section assumes knowledge of operation of Contact Mode AFM in air (see Chapter 8). It is useful, but not essential, to have experience operating in TappingMode (see Chapter 9).

Force modulation measures local sample elasticity by oscillating a cantilever such that the tip indents slightly into a sample. The tip indents soft materials more easily than harder materials. The amount of cantilever deflection is inversely related to the amount of indentation. For example, a soft sample allows the tip to indent more deeply into the surface, resulting in a very small deflection of the cantilever. A hard sample allows less indentation, with the cantilever deflected by a larger amount. To measure the relative elasticity of the sample the system records the amplitude of the tip deflection versus position over the sample as depicted in Figure 13.6a.

Figure 13.6a  Contrast Generation in Force Modulation Mode

Force modulation requires the use of a special optional cantilever holder, shown in Figure 13.6b. This cantilever holder uses a piezoelectric bimorph to oscillate the cantilever against a sample surface. The force modulation cantilever holder is similar to the standard tapping cantilever holder; however, its piezo stack is much larger, allowing larger driving amplitudes.
13.6.2 Selecting a Force Modulation Tip

The key consideration when selecting a force modulation cantilever is its spring constant. Ideally, the cantilever must have a spring constant which compliments the pliancy of the two contrasting materials (or close to the pliancy of one, but not the other). This way, the tip indents into one material more than the other providing good force modulation image contrast. If the tip is so stiff that it indents equally into both materials, or so soft that it indents neither material, then you will not see contrast in the force modulation image. Instead, the image will consist primarily of edge and frictional artifacts. It may take experimentation to find a cantilever that matches the sample's requirements. For rubber and plastic samples Veeco recommends using 225µm long force modulation (Model # FESP) silicon cantilevers. For more delicate, samples, use 450µm long silicon cantilevers or silicon nitride cantilevers. For hard materials, use stiffer tips like the 125µm single crystal silicon TappingMode tips.

Veeco offers cantilevers with a wide range of spring constants (see Table 13.6a). Choosing a tip depends upon how stiff the sample is For samples of unknown hardness, start with a force modulation cantilever (Model FESP) and determine whether the tip is sufficiently stiff then adjust accordingly.
13.6.3 Operating Principle

Force modulation mode is very similar to Contact Mode AFM. The NanoScope system scans the cantilever over the sample surface while trying to keep the cantilever deflection constant. The deflection setpoint determines the average deflection during operation. In addition, the cantilever is oscillated up and down by a piezoelectric bimorph in the tipholder so that the tip indents slightly into the sample surface as it is scanned across the surface. The NanoScope system records the amplitude of the cantilever, motion, which indicates the relative indentation of the tip into the surface. For softer samples the tip penetrates further into the surface resulting in a smaller change in the angle of the cantilever. A small change in angle results in a small measured amplitude which displays as a bright area on the image. For harder samples the tip penetrates less into the surface resulting in a larger change in angle of the cantilever. A large change in angle causes a large measured amplitude which displays as a dark area on the image.

13.6.4 Force Modulation Procedure

This section gives instructions for operating in Force Modulation mode.

1. Choose the Force Modulation profile under Microscope > Profile.

2. Verify that the Microscope mode parameter in the Other Controls panel is set to Tapping and the SPM Feedback in the Feedback Controls panel is set to TM Deflect.

3. Load the special force modulation cantilever holder with a cantilever. The procedure for loading a cantilever is exactly the same as for operation with the standard air cantilever holder.

   Note: Refer to the section on Tip Selection earlier in this chapter to help you choose an appropriate cantilever.
4. Install the cantilever holder on the Dimension SPM head.

5. Align the laser on the cantilever.

Note: Methods for aligning the laser are discussed in Chapter 7.

6. Adjust the Setpoint. Begin with a Setpoint of 0V. Recall that higher setpoints cause the cantilever to push harder on the surface during scanning.

7. Turn the photodetector adjustment knobs to center the laser spot on the laser detector. Adjust the Vertical Deflection to approximately -0.5V for FESP or TESP cantilevers, -2V for NP cantilevers.

Note: The force the cantilever applies to the surface is related to the difference between the Vertical Deflection and the Setpoint and the spring constant of the cantilever used. If the sample is very delicate, set the Vertical Deflection value closer to the chosen Setpoint.

8. Find the Bimorph Resonant Frequency: The cantilever is oscillated by a small piezoelectric bimorph mounted in the cantilever holder. For Force Modulation, oscillate the bimorph at or near its resonant frequency. The bimorph resonance frequency is usually the largest peak in the 5-30kHz range. This ensures the cantilever moves with sufficient amplitude to produce elasticity contrast.

Note: You need to find the bimorph’s resonant frequency only once. (Resonant frequencies are unique to each force modulation cantilever holder.) Once you find the resonant frequency, write it down for future use. This Drive frequency may be used as a starting place each time you perform force modulation imaging; however, recheck the bimorph’s resonant frequency in free air using Cantilever Tune each time you install a new cantilever.

a. Use a FESP or TESP cantilever. NP probes have confusing low frequency resonances.

b. Select View > Sweep > Cantilever Tune or click on the Cantilever Tune icon.

c. The display monitor plots the Frequency Sweep, showing cantilever oscillation amplitude versus frequency. To set the parameters controlling the Frequency Sweep plot, use the parameters in the Sweep Controls panel and the commands on the top menu bar of the display monitor.
d. Set the **Drive frequency** to 15kHz and the **Sweep width** to 30kHz.

e. Set the **Drive amplitude** at 1V to start. You can readjust this value later.

**Note:** A series of peaks display on the **Frequency Sweep** plot. A typical **Frequency Sweep** plot is shown in Figure 13.6d.

**Figure 13.6d** Typical Frequency Sweep Plot

---

**Note:** The large drive amplitude is necessary because peaks are smaller than normally seen during TappingMode operation. This is due to the cantilever not at resonance; therefore, its motion is mostly vertical. Vertical motion is not amplified by the beam deflection detection technique which is sensitive primarily to changes in cantilever angle.
f. Adjust the **Sweep width**, **Data scale** and the **Drive amplitude** until you can clearly see peaks. Bimorph resonances typically occur between 8-20kHz.

g. Choose a peak, then click on the **Zoom In** command (top menu bar of display monitor) with the left mouse button. Two vertical lines appear on the **Frequency Sweep** plot.

h. Use the mouse to move the vertical lines until the selected peak is centered between the lines.

i. Increase or decrease the zoom range by clicking the left mouse button.

j. When the peak centers and the zoom width is adjusted, double-click the right mouse button to automatically adjust the **Drive Frequency** and **Sweep width**, and zoom in on the selected peak.

k. Use the **Offset** command on the display monitor to center the peak in the graph. Click on the **Offset** command with the left mouse button; a vertical, green line appears on the plot.

l. Move the line until centered on the desired peak (usually the frequency with the highest amplitude), then double-click the left button to lock it.

m. Click **Execute**. The computer automatically changes the **Drive Frequency** so that the peak is centered. You may need to click on this command more than once to properly center the peak.

**Note:** Once you choose the desired frequency, the **Frequency Sweep** plot should be recentered similarly to the plot shown in (see Figure 13.6e).

n. Adjust the **Drive amplitude** so the maximum response amplitude is about 1V. Recenter the peak if necessary.

**Figure 13.6e**  Correctly Tuned Force Modulation Frequency
Note: You may also change the Drive Frequency by clicking on the Drive Frequency parameter on the control monitor’s Feedback Controls panel, and entering a new value.

Note: Bimorph resonance should be between $5 \text{ kHz}$ and $30 \text{ kHz}$. If peaks are found at a much higher frequency, these are cantilever resonances, not bimorph resonances.

9. Record the Drive frequency. This is the resonant frequency of your force modulation bimorph.

10. Select Stage > Locate Tip or click the Locate Tip icon.

11. Select Stage > Focus Surface or click the Focus Surface icon.

12. Check the scan parameters Scan speed, Scan size and Integral gain to verify they are reasonable for Contact Mode AFM imaging. Also, it may be desirable to readjust the detector mirror adjustment screws if the Vertical Difference signal has drifted from the value originally set.

13. For the Channel 1 image, select Data Type > Height. Select Data Type > Amplitude for the Channel 2 image. The multi-image capability views both the topography data and the force modulation (elasticity) data at the same time.


   Note: The motor moves the SPM head down towards the sample and stops once the cantilever deflects to the chosen Setpoint. Under some conditions the system may “false engage” before the cantilever actually reaches the surface. Increase the Setpoint and engage again.

15. Adjust the Integral Gain, Proportional Gain, Setpoint, and Scan Speed to obtain a good topography (Height) image. For force modulation operation, set the Integral Gain and Proportional Gain to values of 1-10 and set the Setpoint as low as possible using the cursor keys (or by typing in new Setpoint values) until the cantilever pulls off the surface and the Z-center voltage jumps to -220V.

16. Record the Setpoint value where the cantilever pulls off the surface (the “pull-off value”).

17. Increase the Setpoint until the cantilever touches the surface, and an image appears. Then decrease the setpoint to a value just above the value where the pull-off occurred.

   Note: If you adjust the Setpoint very close to the pull-off value, imaging perform with the smallest and least damaging force. However, in this condition imaging may be more unstable, as the cantilever may pull off the surface unexpectedly. The setpoint value affects the force modulation contrast. Examine the contrast of the force modulation image.
18. Optimize Drive amplitude for Force Modulation imaging. The amount of contrast and the quality of both Height and Amplitude images depends on the Drive amplitude. In general, increasing the Drive amplitude provides greater contrast in the force modulation image.

**Note:** It is possible to set the Drive amplitude too high. If this occurs, the Drive amplitude no longer increases the contrast in the amplitude image. Instead, the overall contrast in the force modulation image remains roughly constant, but you will observe more artifacts in the image. For example, if the drive amplitude is too high, the force modulation image becomes contaminated by “edge effects” or “friction effects.” Operate at the lowest drive amplitude that gives sufficient contrast to examine the sample. Low drive amplitudes also help extend the life of the cantilever tip and reduce sample damage.

**Procedure for Optimizing Drive Amplitude**

1. Start with a small Drive amplitude value of 50mV.

2. Increase the Drive amplitude with the right arrow keys or type in new values. The contrast of the Amplitude (force modulation) image increases.

3. Continue increasing the Drive amplitude until sufficient contrast appears in the Amplitude image. If the Drive amplitude increases to the point where contrast is no longer improving, reduce the Drive amplitude slightly.

   **Note:** Force modulation contrast also depends on the Setpoint. In general, if using a larger Setpoint (larger tracking force) use a smaller Drive Amplitude to obtain good force modulation images without artifacts. If it is difficult to obtain a clear force modulation image that is free of artifacts, try reducing or increasing the Setpoint and then optimizing the Drive Amplitude.

4. Readjust gains (if necessary).

5. The value of the Drive amplitude may also affect the Contact Mode AFM image, causing the system to go into unwanted oscillations. If the Drive amplitude changes by a large amount, readjust the Integral gain and Proportional gain. Set the gains as high as possible to track the sample topography, but not so high that they cause oscillation due to the bimorph oscillation.

Sometimes an oscillation that appears in the data will be due to “aliasing” as described in the next section. If you cannot adjust gains to eliminate unwanted oscillations without compromising the height image’s quality, see Section 13.6.5.
13.6.5 Notes About Artifacts

It is possible to see artifacts in force modulation images that are not due to differences in elasticity. Some artifacts to look for are outlined below:

Aliasing

Under some conditions, unwanted oscillations appear in the data due to aliasing of the Drive Frequency with the image pixel rate. This problem can be eliminated by changing the Drive Frequency by small increments. Use the arrow keys to change the Drive Frequency up or down very slightly until the oscillation disappears. On some materials, shifting the Drive Frequency slightly (1-3Hz) below or above a resonant peak value may improve image contrast. Operators are encouraged to experiment.

Edge Effects

Sometimes force modulation images show changes in amplitude at the edge of topographic features like steps or bumps. These artifacts typically look like the derivative of the sample topography.

To see if a feature is an edge effect, try reversing the Scan direction from Trace to Retrace, for example. If the contrast reverses or the amplitude change now appears on the other side of the topographic feature, then the amplitude change is likely due to the topographic edge, not differences in elasticity. To minimize edge effects, reduce Drive amplitude, Setpoint or Scan speed. Set the Integral gain and Proportional gain as high as possible without causing unwanted oscillations.

Frictional Effects

Because the cantilever is held at an angle to the sample surface, the cantilever tip will slide laterally (“skate”) as the tip pushes into the sample (see Figure 13.6f). The amplitude of cantilever motion is affected by differences in friction between two different materials. For this reason, force modulation images may contain information about differences in local frictional forces. To reduce the influence of frictional effects, use a smaller Setpoint or Drive amplitude. Or, if you are using “Negative LiftMode” (see Section 13.7), use a more positive Lift Height.
Tip Shape

The amount of indentation into a surface for a given applied force depends on the shape of the cantilever tip. For the same Drive Amplitude a sharper tip indents deeper than a dull tip. Because it is possible for the tip to dull during imaging, replace the cantilever if the force modulation contrast deteriorates over time. Also, note that it will be difficult to obtain reproducible, quantitative elasticity measurements between different samples and different cantilevers because the tip shapes may be different. In general, the force modulation technique is a qualitative tool for identifying regions of harder and softer material on a sample, rather than a tool for quantitative analysis.

Not all samples lend themselves to standard force modulation imaging. Even samples with excellent elasticity contrast may not show up in force modulation if their absolute elasticity is out of instrumental range. “Negative LiftMode” may prove useful for imaging otherwise difficult materials (see Section 13.7.3).
13.7 Force Modulation with ‘Negative LiftMode’

A new form of force modulation imaging utilizing TappingMode and LiftMode operation known as “Negative LiftMode,” allows imaging of certain materials previously not visible with Contact Mode AFM force modulation. This method is especially suited for softer materials, yielding higher resolution. Best results using negative LiftMode are obtained on relatively smooth samples (<500nm vertical features); however, Veeco encourages experimenting with this technique on rougher surfaces as well. A general procedure for Force Modulation with “Negative LiftMode” is described in Section 13.7.3.

**Note:** Force modulation contrast is very sensitive to the spring constant of the tip, which varies according to the length and thickness of the cantilever. You may perform TappingMode easily with either force modulation or TappingMode cantilevers, but you may have difficulty with Contact Mode AFM silicon and silicon nitride cantilevers. (see Table 13.6a).

1. Verify the probe is withdrawn from the sample surface.
2. Switch modes under Microscope > Profile to TappingMode.
3. Verify in the Main Controls panel that SPM Feedback = Amplitude.

### 13.7.1 Set Interleave Controls

In the Interleave Controls panel (select Panels > Interleave to open it if it is not open), set the following

1. Click the Enable buttons next to the Drive frequency and Drive amplitude parameters; when enabled the buttons appear green.
2. Set the Drive amplitude on the Interleave Controls panel to 200-400mV.
3. Set the Drive Frequency on the Interleave Controls panel to the bimorph resonant frequency found in Section 13.6.4.
4. Set Lift start height and Lift scan height to 0.00nm.
5. For now, set the Interleave mode parameter to Disabled.
13.7.2 Obtain a TappingMode Image

While negative LiftMode force modulation data is imaged using Channel 2, height data is obtained using TappingMode on Channel 1. You must obtain a satisfactory TappingMode image to generate good data.

1. Verify that the Interleave mode parameter on the Interleave Controls panel is Disabled.

2. Verify that the AFM mode parameter in the Other Controls panel is set to Tapping.

3. Select Realtime > View > Sweep > Cantilever or the Cantilever Tune icon. Enter a main controls Start frequency value of 5kHz and End frequency value of 100kHz for FESP tips.

4. Set Target Amplitude to 1-2V, and click the Auto Tune button, or tune manually.

5. Click the Interleave Controls button to verify that the bimorph drive parameters are correct.

6. Exit the Cantilever Tune dialog box.

7. Verify that all Scan controls and Feedback Controls parameters are set for obtaining a TappingMode image.

8. Set the Channel 1 panel Data type parameter to Height.

9. Set the Line direction to Retrace and enter an appropriate Data Scale value for your sample.

10. Engage the tip on the surface and obtain a good TappingMode image.

13.7.3 Obtain a Negative LiftMode Force Modulation Image

1. Set the Data type parameter in the Channel 2 panel to Amplitude. Set the Line direction parameter to Retrace.

2. Switch the Interleave mode parameter in the Interleave Controls panel to Lift. Negative LiftMode imaging is now in effect.

3. Using the left arrow key, optimize the negative LiftMode image by slowly decreasing the Lift scan height parameter in the Interleave Controls panel from zero until you reach the surface. In most cases, you should not go below -60.0nm.

Note: This is sometimes best performed while in Realtime > View > Scope Mode. When the interleaved scan is enabled, the tip’s TappingMode height above the sample reduces by the Lift scan height amount. This places the oscillating tip in contact with the sample as surface features are profiled. The contrast between light and dark reveals areas of high and low elasticity, with the dark area indicating harder material and the lighter areas indicating softer material.
Note: If the Lift scan height is too large, the interleave may be tapping, and therefore not in the continuous contact required for force modulation.

4. Adjust the interleaved Drive amplitude and Lift scan height until the force modulation image is optimized. This may require some experimentation.

Note: If you see a lot of contrast in the amplitude image before reaching the surface, try reducing the Integral and Proportional gains in the Feedback Controls panel. Adjust gains slightly lower than when performing normal TappingMode imagery. Verify by setting a Lift scan height of 100nm, then adjusting the gains (and possibly Drive amplitude) until you see the minimum amount of contrast in the amplitude image. Once you minimize contrast, enter a Lift scan height of 0.0nm and approach the surface.

13.8 Force Volume

Force volume imaging with the atomic force microscope (AFM), available with NanoScope software versions 4.22 and higher, combines force measurement and topographic imaging capabilities. A force volume data set can be used to map in two or three dimensions the interaction forces between a sample and the AFM tip and correlate the force data with topographic information. Possible applications include elasticity, adhesion, electrostatic, magnetic, and binding studies. Advantages of force volume imaging include the ability to collect distributions of forces at various Z-positions and at thousands of XY positions during a single image scan, correlation of surface topography to interaction force, better quantization of the interaction force, and new methods of analysis. For detailed information regarding force volume imaging, contact Veeco for a copy of Support Note 240A, Force Volume.
This chapter provides general information regarding the Interleave procedure and commands, with emphasis on LiftMode. Specifically, this chapter details the following topics:

- Preface: Interleave Scanning & LiftMode: Section 14.1
- Interleave Mode Description: Section 14.2
- LiftMode Description: Section 14.3
- Operation of Interleave Scanning / LiftMode: Section 14.4
- Use of LiftMode with TappingMode: Section 14.5
  - Main Drive Amplitude and Frequency selection: Section 14.5.1
  - Setpoint Selection: Section 14.5.2
  - Interleave Drive Amplitude and Frequency Selection: Section 14.5.3
  - Amplitude Data Interpretation: Section 14.5.4
  - Cantilever Oscillation Amplitude: Section 14.5.5
### 14.1 Preface: Interleave Scanning & LiftMode

**Interleave** is an advanced feature of NanoScope software which allows the simultaneous acquisition of two data types. Enabling **Interleave** alters the scan pattern of the piezo. After each main scan line trace and retrace (in which topography is typically measured), a second (**Interleave**) trace and retrace is made with data acquired to produce an image concurrently with the main scan.

Typical applications of interleave scanning include MFM (magnetic force microscopy) and EFM (electric force microscopy) measurements; Chapter 15 provides detailed instructions for obtaining MFM images of a standard magnetic sample. Enabling **Interleave** with the mode set to **Lift** enacts **LiftMode**. During the interleave scan, the feedback is turned off and the tip is lifted to a user-selected height above the surface to perform far field measurements such as MFM and EFM. By recording the cantilever deflection or resonance shifts caused by the magnetic or electric forces on the tip, a magnetic force or electric force image is produced; see Chapter 15. **LiftMode** was developed to isolate purely MFM and EFM data from topographic data.

**Interleave** can also be used in **Interleave Mode**. In this mode, the feedback is kept on while additional topography, phase lateral force, or force modulation data is acquired.

The **Interleave** commands utilize a set of **Interleave Controls** which allow several scan controls (Drive amplitude, Setpoint, and various gains) to be set independently of those in the main scan controls.

This chapter provides a general discussion of the **Interleave** action and commands, with emphasis on **LiftMode**. Chapter 15 provides step-by-step instructions for using **Interleave** scanning and **LiftMode** for obtaining magnetic and electric force data. For purposes of learning to use **Interleave** scanning, this section may be useful even to those users whose end application is not magnetic force microscopy.
14.2 Interleave Mode Description

Enabling Interleave changes the scan pattern of the tip relative to the imaged area. With Interleave mode disabled, the tip scans back and forth in the fast scan direction while slowly moving in the orthogonal direction as shown on the left of Figure 14.2a. This is the standard scan pattern of the NanoScope.

**Figure 14.2a  X-Y Scan Pattern**

With Interleave mode enabled, the system first performs a standard trace and retrace with the Main Feedback Controls in effect. The tip moves at half the normal rate in the slow scan direction. As shown on the right of Figure 14.2a, an additional trace and retrace are then performed with the Interleave Feedback Controls enacted. The frame rate halves because twice as many scan lines are performed for the same scan rate.

Four modes are possible for Interleave scan: Interleave, Linear, Retrace Lift and Lift. With Interleave selected, the feedback remains on during the interleave pass with the values under Interleave Feedback Controls (Setpoint, Gains, etc.) in effect. In LiftMode, the feedback is instead turned off, and the tip lifted off the surface and scanned at a user-selected height. Topography data recorded during the main pass is used to keep the tip a constant distance from the surface during the Interleave trace and retrace. In Linear mode, the tip is lifted above the surface to the specified height using the median value of the main scan line as the reference for the lift height. If there are any features taller than the lift height you entered, the system will lift the tip over those features rather than crashing the tip. In Retrace Lift the tip is on the surface during the main scan, and lifts during the retrace scan line.
14.3 LiftMode Description

With the Interleave scan option set to Lift, the motion of the tip during the Interleave trace and retrace is as shown in Figure 14.3a.

The tip first moves to the Lift start height, then to the Lift scan height. A large Lift start height can be used to pull the tip from the surface and eliminate sticking. The Lift scan height is the final tip height. This value is added point-by-point to the height data obtained during the Main topography trace and retrace. Values can be positive or negative.

14.4 Operation of Interleave Scanning / LiftMode

These instructions apply to STM, contact AFM, or TappingMode AFM modes. It is assumed the user is familiar with TappingMode or contact AFM to obtain good images of surface topography. Use of interleave scanning requires the steps below; see Chapter 13 for specific examples using MFM.

1. Obtain a topography scan using the appropriate (usually Contact or TappingMode) method: When using LiftMode, it is important that the gains and setpoint under Feedback Controls be adjusted to give a faithful image of the surface. Because the height data is used in the lift pass to trace the topography, a poor measurement of surface height may give inaccurate measurement during the lift pass or cause the tip to strike the surface. Typically, the height data is displayed on Channel 1.

2. Adjust the Interleave Controls panel to desired settings: Choose the Interleave Mode (Interleave, Lift, Linear or Retrace Lift) appropriate for the measurements to be performed. Set the Interleave Controls as desired. When using TappingMode, the Drive amplitude, Drive frequency, Gains, and Setpoint can be set differently in the Interleave Controls panel than in the main Feedback Controls panel; see Section 14.5. However, it is often convenient to begin with the main and interleave values set equal; this can be done by toggling the bullets to the left of the appropriate Interleave parameters to an “off” (grayed) condition. The values can be changed once engaged. If using Lift, set the Lift start height and Lift scan height. If using Interleave Mode, set the Gains and Setpoint.
Note that certain constraints are imposed: scan sizes, offsets, angles, and rates and numbers of samples per scan line are the same for the main and interleave data, and the imaging context (contact, TappingMode, or force modulation) must also match.

3. Choose the Interleave Data Type: Depending on the type of microscope, Interleave mode allows the options of amplitude, phase, frequency, potential, input potential, or data types for doing far-field (MFM or EFM) imaging; see Chapter 15 for detailed examples. Auxiliary channels are also available for some applications.

Once the Interleave Data Type is chosen, Interleave mode is automatically enabled, triggering interleave scanning. Interleave data typically displays as the second (right) image. Note that the scan rate in the slow direction is halved.

4. Display the interleave data by switching Scan line (in the Channel panels) to Interleave.

   - Lift scan height: The lateral and vertical resolutions of the Lift data depend on the distance between tip and sample: the lower the tip, the higher the resolution. However, the Lift scan height must be high enough that the tip does not contact the sample during the Lift trace and retrace.

   - Tip Shape: As shown in Figure 14.3a, the tip separation in the LiftMode is defined in terms of the Z direction only. The Lift scan height is added to the height values taken from previous scan lines point-by-point. However, the tip may be closer to the sample than the Z separation indicates. On features with steep edges, the tip may get very close to the sample even though the Z separation is constant; see Figure 14.3a.

   - Scan Line Direction: The Line direction should be set to Retrace for both the main and interleaved scans. If it is set instead to Trace, a band may appear along the left side of the images due to the ramp between the surface and the Lift scan height.

14.5 Use of LiftMode with TappingMode

There are additional considerations when using LiftMode with TappingMode.

14.5.1 Main Drive Amplitude and Frequency selection

As usual, these parameters are set in Cantilever Tune before engaging. It is helpful to keep in mind the measurements to be done in LiftMode when setting these values. For example, if Amplitude data will be monitored during the Lift scan for magnetic force imaging, the Drive frequency should be set to the side of the resonance; see Chapter 15. (However, certain parameters can be set independently for the interleave scan; see below.)
14.5.2 Setpoint Selection

When the main and interleave Drive amplitudes and Drive frequencies are equal (bullets under Interleave Controls disabled), the cantilever oscillation amplitude increases to the free oscillation amplitude when the tip is lifted off the surface in LiftMode. If a small setpoint value forces the oscillation amplitude low while the feedback is running, the amplitude can grow considerably when the tip is lifted free of the sample surface. The change can also be large if the main Drive amplitude was increased or the main Drive frequency altered after the tip was engaged. (The vibration amplitude remains at the setpoint during the main scan even if these parameters are changed.) This could make the tip hit the surface in the lift scan for small Lift scan Heights.

14.5.3 Interleave Drive Amplitude and Frequency Selection

The cantilever drive amplitude can be set differently in the Lift scan as compared to the main scan by toggling the flag on the left of the corresponding Interleave Control to “on” (green) and adjusting the value. This allows the tuning of a measurement in the Lift scan lines without disturbing the topography data acquired during the Main scan lines. The Interleave Drive amplitude must be set low enough that the tip does not strike the surface during the Lift pass.

WARNING: Before enabling the Interleave Drive Amplitude, check that its value is not much larger than the main Drive Amplitude value to prevent possible damage to the tip.

AVERTISSEMENT: Lors d’un travail en mode intercalé (Interleave Mode), vérifier que la tension appliquée pour osciller le bras de levier lorsqu’il est en position haute n’est pas beaucoup plus importante que la tension appliquée lorsque ce même bras de levier est en position basse (Main Drive Amplitude). Le non respect de cette procédure peut entraîner la destruction de la pointe.

WARNUNG: Bevor Sie im Interleave-Mode die “Interleave Drive-Amplitude” einschalten, vergewissern Sie sich bitte, daß der dort eingetragene Wert nicht wesentlich größer ist, als der Wert der “Main Drive-Amplitude”, um evtl. Beschädigungen der Spitze vorzubeugen.

The Interleave Drive frequency can also be adjusted, which may be useful if acquiring amplitude data in LiftMode; see Chapter 15.

Note: The cantilever drive circuit features a filter capacitor to limit the rate at which the drive amplitude is changed between Main and Interleave scanning. If using scan rates above a few hertz, it may be advantageous to remove or disable the filter. For more information on how to disable the filter, contact Veeco technical support.
14.5.4 Amplitude Data Interpretation

When monitoring amplitude data in LiftMode, brighter regions correspond to smaller amplitude, and darker regions to larger amplitude.

14.5.5 Cantilever Oscillation Amplitude

The selection of the oscillation amplitude in LiftMode depends on the quantity to be measured. For force gradients which are small in magnitude but occur over relatively large distances (sometimes hundreds of nm, as with magnetic or electric forces), the oscillation amplitude can be large, which for some applications may be beneficial. The Lift scan height must be correspondingly large so that the tip does not strike the surface. However, the lateral resolution of far field (MFM or EFM) measurements decreases with distance from the surface. Typically, the resolution is limited to a value (in nm) roughly equal to the Lift scan height; see Chapter 15.

Small amplitudes must be used to sense force gradients, such as Van der Waals forces, which occur over short distances (typically a few nm). As much of the cantilever travel as possible should be within the range of the force gradient.
Chapter 15  Magnetic Force Microscopy

This chapter describes how to perform Magnetic Force Microscopy (MFM) using the Interleave and LiftMode procedures discussed in Chapter 14. Please review those sections prior to attempting MFM. Best results will be obtained with either the Digital Instruments Basic Extender Electronics Module or the Quadrex Extender Module. These hardware units allows phase detection and frequency modulation for optimal MFM imaging.

Specifically, this chapter discusses the following topics:

- Magnetic Force Microscopy: Section 15.1
  - Force Gradient Detection: Section 15.1.1
  - Amplitude Detection Techniques: Section 15.1.2
- Basic MFM Operation: Section 15.2
  - MFM Using LiftMode: Section 15.2.1
- Magnetic Force Microscopy Procedure: Section 15.2.2
- Advanced MFM Operation: Section 15.3
  - Lift Scan Height and Magnetic Imaging Resolution: Section 15.3.1
  - Fine Tuning Interleave Controls: Section 15.3.2
  - Drive Amplitude: Section 15.3.3
- Installation of the Electronics Modules: Section 15.4
  - Phase Extender Module: Section 15.4.1
  - Quadrex Extender: Section 15.4.2
  - NanoScope IV: Section 15.4.3
- Software Setup Configuration (Phase, Quadrex or NSIV): Section 15.5
15.1 Magnetic Force Microscopy

In MFM, a tapping cantilever equipped with a special tip first scans over the surface of the sample to obtain topographic information. Using LiftMode as shown in Figure 15.1a, the tip then raises just above the sample surface. The surface topography from the initial scan is added to the lift height to maintain constant separation during the lifted scan. The influence of magnetic force is measured using the principle of force gradient detection.

15.1.1 Force Gradient Detection

In the absence of magnetic forces, the cantilever has a resonant frequency $f_0$. This frequency is shifted by an amount $\Delta f$ proportional to vertical gradients in the magnetic forces on the tip. The shifts in resonant frequency tend to be very small, typically in the range 1-50 Hz for cantilevers having a resonant frequency $f_0 \sim 100$ kHz. These frequency shifts can be detected three ways: phase detection which measures the cantilever’s phase of oscillation relative to the piezo drive; amplitude detection which tracks variations in oscillation amplitude; and frequency modulation which directly tracks shifts in resonant frequency. Phase detection and frequency modulation produce results that are generally superior to amplitude detection.

Figure 15.1a  MFM LiftMode Principles

1. Cantilever traces surface topography on first trace.
2. Cantilever retraces surface topography on first retrace.
3. Cantilever ascends to Lift scan height.
4. Lifted cantilever profiles topography while responding to magnetic influences (second trace).
5. Lifted cantilever reporfiles topography while responding to magnetic influences (second retrace).
15.1.2 Amplitude Detection Techniques

All standard Dimension-series SPMs are capable of MFM imaging using amplitude detection techniques. By adding the Phase Extender or Quadrex Extender Electronics Modules to a NanoScope III or IIIa controller, or by using a NanoScope IV controller, the Dimension 3100 may be used for frequency modulation or phase detection with improved results (see Figure 15.1b and Figure 15.1c). Amplitude detection has largely been superseded by frequency modulation and phase detection. A more extensive discussion of force gradient detection and MFM imaging is given in the reprint *Magnetic Force Microscopy: Recent Advances and Applications*. Contact Veeco to obtain a copy.

**Figure 15.1b**   Extender Electronics Module for NanoScope III, IIIa Controllers

**Figure 15.1c**   Quadrex PhaseImaging Module for NanoScope IIIa Controllers
15.2 Basic MFM Operation

In the instructions below, steps specific to phase and amplitude imaging are described independently. Use the icons in the margin to locate steps specific to either frequency modulation and phase detection, or amplitude detection.

15.2.1 MFM Using LiftMode

LiftMode allows the imaging of relatively weak but long-range magnetic interactions while minimizing the influence of topography (see Figure 15.1a). Measurements are taken in two passes across each scan line; each pass consists of one trace and one retrace. In the first pass, topographical data is taken in TappingMode. The tip is then raised to the lift scan height and a second trace and retrace performed while maintaining a constant separation between the tip and local surface topography. Magnetic interactions are detected during this second pass. In LiftMode, topographical features are virtually absent from the MFM image (see Figure 15.2e).

This section provides instructions for using the LiftMode of Interleave Scanning to obtain MFM images. These guidelines will help you obtain an MFM image of a standard magnetic sample (metal-evaporated video tape). Standard tape samples are provided with purchase of MFM probes, and can be obtained free of charge from Veeco. Other samples can also be used; however, you will not have the benefit of comparing your results with the images shown here. Obtaining a good image of the tape sample will familiarize you with Interleave and MFM techniques and provide a check that the system is correctly tuned to image magnetic samples. Many of the principles discussed here also apply to Electric Force Microscopy (EFM).

As mentioned above, the NanoScope controllers use force gradient detection for MFM imaging. Within this general technique, there are three possible schemes, known as frequency modulation, phase detection, and amplitude detection. Phase detection and frequency modulation are available for all TappingMode-capable microscopes in the form of the Basic Extender Electronics Module (Basic) and Quadrex Extender Electronics Module (Quadrex). Microscopes without an Extender addition cannot utilize phase detection; for more information, contact Veeco. The NanoScope IV design integrates the Quadrex. Phase detection and frequency modulation detection are superior methods for magnetic force imaging, offering greater ease of use, better signal-to-noise ratios, and reduced artifact content as compared to amplitude detection. Extender electronics are strongly recommended for extensive MFM imaging.

For MFM procedures, magnetic-coated tips are required. Various kinds of MFM probes are available for specific applications; contact Veeco for more information. For specific information regarding TappingMode and Interleave Scanning please refer to Chapter 9 and Chapter 14 respectively.

The procedure below suggests parameter values that should work well for most applications. Further adjustment, in some cases, will improve the quality of MFM scans. Some experimentation may be needed to optimize the imaging of specific samples. See the suggestions at the end of this section.
15.2.2 Magnetic Force Microscopy Procedure

1. Magnetize a NanoProbe magnetic probe with a strong permanent magnet before installing the tip holder on the AFM head.

   **Note:** Tips are usually magnetized with the field aligned along the tip axis (perpendicular to the sample surface). The MFM then senses force gradients due to the perpendicular component of the sample’s stray field. Tip magnetizers can be purchased from Veeco.

2. Mount a NanoProbe magnetic probe on the scanner or tip holder.

3. Set up the AFM for TappingMode operation (see Chapter 9).

4. In all **Channel** panels, set the **Highpass** and **Lowpass** filters to **Off**.

5. Set the **Rounding** parameter in the **Microscope > Calibrate > Scanner** window to zero (0).

6. Tune the cantilever drive frequency.

   **Note:** The procedure to tune the cantilever drive amplitude depends on whether you are using phase detection or amplitude detection. Both cases rely on automatic **Cantilever tune** just as when preparing for TappingMode (see Chapter 9). MFM cantilevers have resonant frequencies between 50 and 100 kHz. If using the **AutoTune** feature, these values can be used as bounds for the frequency sweep. With the Extender option, two curves appear in the **Cantilever Tune** box: the **amplitude** curve in white, and the **phase** curve in yellow (see Figure 15.2a). Microscopes without the Extender Electronics Module display only the amplitude curve.

**Setting a Drive Frequency for Phase Detection**

The Drive frequency should be set to the center of the cantilever resonance, as shown in Figure 15.2a. This occurs automatically if using AutoTune.

**Figure 15.2a** Cantilever Tune for Phase Detection and Frequency Modulation
To correctly track the cantilever phase, the **Phase offset** parameter must be adjusted. This automatically occurs in **AutoTune**; alternatively, **Zero Phase** can be selected from the **Channel 2** panel. The phase curve should appear as in Figure 15.2a, decreasing with increasing frequency and crossing the center line (corresponding to a 90° phase lag) at the peak frequency. The phase curve then measures the phase lag between the drive voltage and the cantilever response. Again, vertical gradients in the magnetic force cause a shift $\Delta f_0$ in the resonance frequency. In this case, resonance shifts give rise to phase shifts $\Delta \phi$ which then give an image of the magnetic force gradients (see Figure 15.2b).

**Note:** The Extender electronics give a measure of the phase lag of the cantilever oscillation relative to the piezo drive. This measurement is monotonic versus frequency as is the true phase lag in degrees. The Extender measurement has slightly different nonlinear characteristics vs. frequency. The measurement technique allows optimal signal-to-noise ratios; however, absolute values of phase data should be taken as approximate. Users requiring quantitative measures of force gradient are advised to use frequency modulation (see Frequency Modulation: Page 263).

**Figure 15.2b**  Shift In Phase at Fixed Drive Frequency

![Figure 15.2b](image)

**Setting a Drive Frequency for Amplitude Detection**

1. Use the **AutoTune** feature to find the resonance peak.

2. Select the **Offset** function under the **Cantilever Tune** pop-down menu to manually move the drive frequency to the side of the resonance (see Figure 15.2b).

3. Set the **Drive Frequency** to the steepest part of the resonance curve for maximum sensitivity.

**Note:** As the tip oscillates above the sample, a gradient in the magnetic force will shift the resonance frequency $f_0$ (see Figure 15.2c). Tracking the variations in oscillation amplitude while in LiftMode yields an image of the magnetic force gradients.
4. Select an appropriate Target Amplitude (approximately 2V) using Auto Tune to adjust the Drive Amplitude so that the RMS voltage response of the photodetector is approximately 2V before tuning. Or, exit Cantilever Tune and manually adjust the Drive Amplitude parameter under Feedback Controls.

Note: Somewhat larger values may be beneficial if using amplitude detection.

5. Quit Cantilever Tune and return to Image Mode.

6. Under Interleave Controls set the Lift start height to 0nm, and Lift scan height to 100nm.

Note: The lift height can be optimized later.

7. Set the remaining Interleave parameters (Setpoint, Drive Amplitude, Drive frequency, Gains) to the Main Controls values by setting the flags left of the Interleave Control column to Off.
8. Under **Scan Controls**, set the **Scan size** to 5µm and **Scan rate** to 1–2Hz.

9. Set the **Channel 1 Data type** to **Height**, the **Data scale** to 75nm and the **Line direction** to **Retrace**.

10. Engage the AFM and make the necessary adjustments to obtain a good topographical image while displaying height data.

**CAUTION:** Use the highest possible **Setpoint** to ensure that the tip is contacting the surface only lightly. The image should be similar to the topographic image shown on the left of **Figure 15.2e**. The surface is fairly flat with lubrication nodules of various sizes. A good image of the nodules indicates that the tip is sharp.

**Figure 15.2e** Topographic (left) and Magnetic Force Gradient Image (right)

**Note:** The MFM data displays in Channel 2; however, the parameter settings are different depending on whether Phase Detection or Amplitude Detection is being used.
Phase Detection

Set the Channel 2 image Data type to Phase; Z range to 3 degrees; and Line direction to Retrace.

Note: It is important that the Scan direction be set to Retrace for both the main and interleave scans. If instead it is set to Trace, a band may appear along the left side of the images due to the time taken for the tip to move between the surface and the lift scan height.

Amplitude Detection

1. Set the Channel 2 image Data type to Amplitude, Z range to 1nm, and Line direction to Retrace.

2. Change Interleave mode to Enable to invoke LiftMode.

3. Set the Channel 2 Scan line to Interleave to display the interleaved data.

Note: This can only be done after Interleave mode is Enabled. A magnetic force gradient image similar to that shown on the right of Figure 15.2e should appear as the Channel 2 image. The alternating dark and light stripes represent the recorded magnetic information, signifying a varying resonant frequency and magnetic force gradient on the tip.

Note: Keep the Setpoint as large as possible while consistent with a good image. Wider scans (> 25µm) will reveal separate tracks in which the magnetic stripes are at different angles.

Frequency Modulation

With the Extender Electronics Module, it may be desirable to use frequency modulation. This activates a feedback loop which modulates the Drive Frequency to keep the cantilever phase lag at 90 degrees relative to the drive, corresponding to resonance. The frequency Data Type displays the resulting shift in Drive Frequency in Hz, and gives the most direct, quantitative image of force gradients.

To enable frequency modulation, follow the procedure above for obtaining an MFM image with phase detection with the following modifications:

1. In the Interleave Controls panel, set the Input Feedback to Frequency. Turn on this parameter by selecting the gray button next to Frequency. When selected, the gray button becomes green, indicating the control is on.

2. Switch the Channel 2 image Data type to Frequency. Try a Data scale (frequency shift) of approximately 10 Hz.

3. Select Other Controls, then adjust the frequency modulation gains:
### 15.3 Advanced MFM Operation

#### 15.3.1 Lift Scan Height and Magnetic Imaging Resolution

The most important parameter affecting imaging resolution is **Lift scan height**. The range of 10–200nm is most useful. In general, MFM resolution is roughly equal to the lift height. Smaller **Lift scan heights** give better resolution; magnetic features smaller than the **Lift scan height** may not be resolved. The tip also experiences stronger fields close to the surface, giving improved signal-to-noise ratios.

For example, the image of metal-evaporated tape in Figure 15.2e has a resolution limited by the 100 nm **Lift scan height**. To improve the resolution, try reducing the **Lift scan height** to ~25nm. Ensure that the tip does not strike the surface on the low point of its swing in the Lift image. Tip strikes appear as black or white spots, or even noisy, high-contrast streaks crossing the image. If the tip begins to strike the surface, reduce the **Interleave Drive Amplitude**. (In general, MFM tips are not damaged by intermittent tip strikes in **LiftMode**, except in extreme cases of very large amplitude and small lift heights.) An example of an image of the metal-evaporated tape taken with a **Lift scan height** of 30nm is shown in Figure 15.3a. Note the fine magnetic structure that is not visible in Figure 15.2e. When imaging a sample for the first time, begin with moderate **Lift scan heights** (50nm or greater), then adjust downward. On relatively smooth samples (e.g., hard disks), lift heights down to 0nm can be used, as long as the drive amplitude is adjusted accordingly. (Lift scan heights of 0nm still correspond to a non-zero mean tip-sample distance. See the section on **Setpoint** below.) It is usually not beneficial to use **Lift scan heights** much smaller than the surface roughness. Users are encouraged to experiment for the best images on their samples.

The ultimate lateral resolution of MFM is near 20nm. Resolution is affected by properties of the tip, including mechanical sharpness and magnetic structure. When in good condition, magnetically-coated tips routinely give 50nm resolution, and many achieve 30nm or better.
15.3.2 Fine Tuning Interleave Controls

Certain scanning parameters found under Interleave Controls can be set to values in the Interleave (Lift) scan that differ from the values in the main scan. These parameters are enabled by clicking on the circular flag to the immediate left of the desired Interleave control, toggling its state from Off (gray bullet) to On (green bullet). When the flag is set to Off, the main scan control parameter setting takes precedence. When the flag is set to On the displayed Interleave scan value is active, overriding the main scan value.

15.3.3 Drive Amplitude

For MFM, of particular use is the Interleave Drive Amplitude. This parameter can affect a magnetic force image in a variety of ways.

- Increasing the Drive Amplitude can improve the signal-to-noise ratio when using phase detection or frequency modulation. This is because intrinsic, low-level noise interferes less when measuring the phase of a larger cantilever oscillation amplitude and hence stronger photodetector output. As an illustration, try setting the Interleave Drive Amplitude to 0; the resulting phase image will be pure noise because one cannot measure the phase of a non-oscillating cantilever.

- In LiftMode, the Interleave Drive Amplitude can often be set to a value larger than in the main scan, thus giving optimal signal-to-noise. In some cases this is beneficial as long as the Drive Amplitude is not increased to the extent that the tip strikes the surface on the low point of its swing. The signatures of tip-sample contact are white and black spots in the image, or, in extreme cases, noisy, high-contrast streaks across the whole image.
image. It is usually safe to increase the Drive Amplitude until the first signs of tip strike are noticed, then reduce the amplitude slightly.

- Before enabling the Interleave Drive Amplitude, check that its value is not much larger than the main Drive Amplitude value. This prevents the cantilever oscillation from jumping to a very large amplitude when the parameter is enabled, possibly damaging the tip. The Drive Amplitude can be adjusted even when the parameter is disabled (i.e., when the flag is set to Off [gray bullet]).

| CAUTION: | Before enabling the Interleave Drive Amplitude, check that its value is not much larger than the main Drive Amplitude value to prevent possible damage to the tip. |
| ATTENTION: | Lors d’un travail en mode intercalé (Interleave Mode) vérifier que la valeur de tension appliquée à l’oscillateur piezo-électrique est inférieure à celle appliquée à l’oscillateur en mode imagerie (Main Drive Amplitude). Le non respect de cette procédure peut entraîner la destruction de la pointe. |
| VORSICHT: | Um mögliche Beschädigung der Meßspitze zu vermeiden, vergewissern Sie sich, daß der Wert der Interleave Drive Amplitude nicht wesentlich größer ist, als der Main Drive Amplitude, ehe Sie den Interleave Mode aktivieren. |

- When using Amplitude Detection, variations in Drive Amplitude affect sensitivity and image contrast as well as signal-to-noise ratio. This is because changes in the oscillation amplitude change the slope of the amplitude vs. frequency curve, and hence the effective sensitivity; see Figure 15.3b. With phase detection and frequency modulation, changes in amplitude produce no change in contrast, and results are thus more reproducible than with amplitude detection.

**Note:** On some microscope models, there is a lowpass filter in the scanning electronics that prevents fast switching of the Drive Amplitude between main and Interleave scanning. This can interfere with very fast rates (> a few Hz). The filter can be disabled easily; contact Veeco technical support for more information.
Setpoint

For the most reproducible results, it is best to use a consistent setpoint. In LiftMode, the total tip-sample distance $h_{tot}$ is the sum of the average tip-sample distance in TappingMode $h_T$, and the lift scan height $h_{lift}$ (see Figure 15.3b). In TappingMode, the average tip-sample distance $h_T$ is equal to the oscillation amplitude, which is determined by the setpoint and the amplitude sensitivity of the tip. MESPs typically have an amplitude sensitivity of approximately 25nm/V.

Large variations in setpoint can change the total tip-sample distance in LiftMode, sometimes with visible results in the magnetic image. For this reason, reproducible results are most easily obtained by using consistent setpoints. Note that a lift scan height of 0nm still gives a mean tip-sample distance of $h_T$ in LiftMode.

Figure 15.3b  Tip Height and Oscillation Amplitudes (TappingMode & LiftMode)

The relationship between setpoint voltage and oscillation amplitude is known as the sensitivity. Its value can be determined with Force Calibration (see Chapter 13). For 225µm MFM cantilevers, the sensitivity is typically in the range 20-25nm/V. The exact value depends on the position of the laser spot on the cantilever, the cantilever geometry, and the particular instrument. A 1V Setpoint typically corresponds to $h_T$ ~14-18nm.
15.4 Installation of the Electronics Modules

15.4.1 Phase Extender Module

The Extender is installed using 37-to-37 pin ribbon cables between: 1) the NanoScope III or IIIA SPM controller and the Extender Electronics Module; as well as 2) from the FM / Extender to the microscope. A hardware change is also required; the main electronics backplane board at the rear of the microscope must be swapped out (this may be done by either the customer or a factory representative). For more information, contact Veeco.

The phase box is equipped with a slider switch for switching internal electronics between Dimension-series and MultiMode SPM signals. This switch may be accessed through a hole on the underside of the box as shown below:

**Figure 15.4a Phase Box**

![Phase Box Diagram](image)

For Dimension-series SPMs, always set the switch to **Dimension**. Use a pencil to access the switch through the hole.

| CAUTION: | Do not insert a conducting object (e.g., screwdriver) into the Phase Extender box while it is energized. |
| ATTENTION: | Ne pas insérer d’ objet conducteur (par exemple: un tournevis) dans le boîtier d’extension de phase (Phase Extender Box) quand celui-ci est sous tension. |
| VORSICHT: | Stecken Sie keine leitfähigen Teile (zum Beispiel Schraubenzieher) in die Phase Extender Box, während diese eingeschaltet ist. |
Important Points

1. Extender-compatible microscope electronics are required to permit operation of the phase detection extender option. Standard electronics on these microscopes require hardware upgrades. Consult Veeco for details.

2. Turn off the power to the NanoScope controller whenever connecting or disconnecting the Extender.

15.4.2 Quadrex Extender

The Quadrex Extender connects to a NanoScope IIIa in the same way as the Phase Extender described above, and has similar hardware requirements. Quadrex operation requires NanoScope software version 5.12 or higher.

15.4.3 NanoScope IV

NanoScope IV has the Quadrex electronics integrated in to the design and requires no modification or additions for MFM.

15.5 Software Setup Configuration (Phase, Quadrex or NSIV)

1. Select \texttt{di > Microscope Select} to display the \texttt{Microscope Select} dialog box (see Figure 15.5a).

2. Click the \texttt{Edit} button to open the \texttt{Equipment} dialog box.

3. Select the appropriate \texttt{Controller}.

4. Select the appropriate \texttt{Extender}.
Note: This step is not necessary for NanoScope IV.

5. Click the **Ok** button when complete.

### 15.6 Troubleshooting

#### 15.6.1 MFM Image Verification

The procedure described above should produce a good magnetic force gradient image of the videotape sample. If there is a problem, check that the Interleave Mode is set to Lift, that Interleave is Enabled and that the Scan Line is set to Interleave. Check also that the Interleave values of Drive Amplitude and Drive Frequency are initially set equal to the main Scan Controls values.

#### 15.6.2 Saturation in Amplitude Detection

If using amplitude detection, the magnetic force image can saturate (appear completely featureless) if the Interleave Drive Amplitude is significantly different than the Drive Amplitude in the main scan. Adjust the Interleave Setpoint to restore the image.

Note: The Interleave Setpoint has no physical effect in LiftMode since there is no surface feedback during the lift pass.

#### 15.6.3 Optical Interference

When using Amplitude Detection, optical interference may sometimes appear in the Lift (magnetic force gradient) image when imaging highly reflective samples. Optical interference appears as evenly spaced, sometimes wavy lines with ~1–2µm spacing superimposed on the lift image. This occurs when ambient laser light (i.e., light passing around or through the cantilever, then reflecting off the sample) interferes with laser light reflecting from the cantilever. Interference can be alleviated by moving the beam spot up the cantilever away from the tip; one-third of the cantilever length works well. The adjustment can be refined by carefully moving the beam spot laterally a small distance on the cantilever while scanning until interference fringes are minimized. Be careful not to move the beam off the cantilever or feedback may be lost.

Note: Optical interference is essentially eliminated by using phase detection or frequency modulation.
Chapter 16  Electric Techniques

This chapter describes how to perform two electric techniques: Electric Force Microscopy (EFM) and Surface Potential. EFM is similar to Magnetic Force Microscopy (MFM) and shares many of the same procedural techniques. Both modes utilize the Interleave and LiftMode procedures discussed in previous chapters. Please read those chapters before attempting electric force measurements.

Specifically, this chapter includes:

- **Electric Techniques Overview**: Section 16.1
  - Electric Force Microscopy Overview: Section 16.1.1
  - Surface Potential Imaging Overview: Section 16.1.2

- **Electric Force Microscopy**: Section 16.2
  - Electric Force Microscopy Theory: Section 16.2.1
  - Electric Force Microscopy Preparation: Section 16.2.2
  - Electric Force Microscopy Procedures: Section 16.2.3
  - Phase Detection: Section 16.2.4
  - Frequency Modulation: Section 16.2.5
  - Amplitude Detection: Section 16.2.6

- **EFM Troubleshooting/Pointers**: Section 16.3
  - Use Low Setpoint When Tapping in Electric Field: Section 16.3.1
  - Verify Electric Field at Surface: Section 16.3.2
  - Fine Tune Lift Scan Height: Section 16.3.3
  - Fine Tune Interleave Drive Amplitude: Section 16.3.4
  - Optimize Tune in Vicinity of Surface: Section 16.3.5
• Optimize Tune in Interleave: Section 16.3.6
• If Voltage is Needed, Use Analog 2 When Possible: Section 16.3.7
• Try Uncoated Si Tip: Section 16.3.8
• Surface Potential Detection—Theory: Section 16.4
• Surface Potential Detection—Preparation: Section 16.5
  • Applying Voltage to the Sample Directly: Section 16.5.1
• Surface Potential Imaging—Procedure: Section 16.6
  • Troubleshooting the Surface Potential Feedback Loop: Section 16.6.1
16.1 Electric Techniques Overview

There are two types of electric techniques used with the Dimension 3100: Electric Force Microscopy (EFM) and Surface Potential Detection.

Electric techniques are similar to magnetic force microscopy (MFM) and share many of the same procedural techniques. Electric techniques and MFM both use the Interleave and LiftMode procedures. The two-pass LiftMode measurement allows the imaging of relatively weak but long-range magnetic and electrostatic interactions while minimizing the influence of topography (see Figure 16.1a). LiftMode records measurements in two passes, each consisting of one trace and one retrace, across each scanline. First, LiftMode records topographical data in TappingMode on one trace and retrace. Then, the tip raises to the lift scan height, and performs a second trace and retrace while maintaining a constant separation between the tip and local surface topography.

16.1.1 Electric Force Microscopy Overview

Electric Force Microscopy measures variations in the electric field gradient above a sample. The sample may be conducting, nonconducting, or mixed. Since the surface topography (e.g. sharp points on the surface concentrate the field gradient) shapes the electric field gradient, large differences in topography make it difficult to distinguish electric field variations due to topography or due to a true variation in the field source. The best samples for EFM are samples with fairly smooth topography. The field source includes trapped charges, applied voltage, etc. Samples with insulating layers (passivation) on top of conducting regions are also good candidates for EFM.

All standard Dimension Series SPMs are capable of EFM imaging using amplitude detection techniques. By adding an Extender electronics module, you can use the Dimension system for frequency modulation or phase detection with improved results (see Figure 16.1b). Frequency modulation and phase detection has largely superseded amplitude detection. The Extender electronics module is required for surface potential imaging, and is strongly recommended for electric force microscopy.
If applying a voltage to the tip is desired, then the special electric cantilever holder is required (model MMEFCH).

16.1.2 Surface Potential Imaging Overview

Surface potential imaging measures the effective surface voltage of the sample by adjusting the voltage on the tip so that it feels a minimum electric force from the sample. (In this state, the voltage on the tip and sample is the same.) Samples for surface potential measurements should have an equivalent surface voltage of less than ±10V, and operation is easiest for voltage ranges of ±5V. The noise level of this technique is typically 10mV. Samples may consist of conducting and nonconducting regions, but the conducting regions should not be passivated. Samples with regions of different materials will also show contrast due to contact potential differences. Quantitative voltage measurements can be made of the relative voltages within a single image. This method requires the Extender Electronics Module and version 3.1 or later of the NanoScope software.
16.2 Electric Force Microscopy

16.2.1 Electric Force Microscopy Theory

Electric Force Microscopy is analogous to standard MFM, except that gradients being sensed are due to electrostatic forces. In this method, the cantilever is vibrated by a small piezoelectric element near its resonant frequency. The cantilever’s resonant frequency changes in response to any additional force gradient. Attractive forces make the cantilever effectively “softer,” reducing the cantilever resonant frequency. Conversely, repulsive forces make the cantilever effectively “stiffer,” increasing the resonant frequency. A comparison of these force additives is shown in Figure 16.2a.

Figure 16.2a Comparison of Attractive and Repulsive Forces

Changes in cantilever resonant frequency are detected in one of the following ways:

- Phase detection (with Extender Electronics Module only)
- Frequency modulation (with Extender Electronics Module only)
- Amplitude detection (not recommended due to artifacts)

All of the above methods rely on the change in resonant frequency of the cantilever due to vertical force gradients from the sample. Figure 16.2b shows a diagram of how the Extender electronics module provides signal enhancement and feedback allowing gradient detection. The best candidates for electric field gradient imaging are samples that have large contrasts in the electric force gradient due to material differences or regions at substantially different potentials. For other samples having rough surface topography or small voltage variations, this technique may be undesirable because topographic features appear in the LiftMode image.
In many cases, you must apply a voltage to the tip or sample to achieve a high-quality image. Various methods for applying voltages to the tip and sample are included in the sections that follow. Samples with permanent electric fields may not require voltage application.

### 16.2.2 Electric Force Microscopy Preparation

This section explains how to apply a voltage to the tip or sample to generate electric fields. If the sample has a permanent electric field which does not require the external application of voltage, the steps below are not required and you can proceed to Section 16.2.3.

#### Setting Jumper Configurations

To apply voltage to the tip or sample, you may need to make minor changes to the jumpers on the microscope’s backplane and the toggle switches on the Extender Electronics Module (if equipped). Original jumper configurations and jumper changes are dependent on the microscope and the desired measurements. The section **Jumper Configurations Without Extender Electronics: Section** provides jumper configuration instructions for basic microscope models operating with and without the Extender Electronics Module.

The backplane board used with Dimension Series SPMs is shown below in Figure 16.2c. There is a header supplied with jumpers at the center of the board. For non-EFM applications and Surface Potential operation, leave or return jumpers to their original positions.
Instructions for Reconfiguring Jumpers

Carefully examine the jumper configuration figures in the following pages and identify which jumper configuration is correct for your application. If the configuration you choose differs from the configuration as shipped from the factory, follow the instructions below. Refer to Figure 16.2e and Figure 16.2j for examples of factory jumper configurations.

1. Turn off the NanoScope controller and unplug the power cable from the microscope’s electronic box.
2. Remove the back panel on the microscope’s electronic box.
3. Locate header and jumpers per Figure 16.2c on the main electronics backplane.

   **Note:** Jumper systems without the Extender Electronics Module should appear as shown in Figure 16.2e; whereas jumper systems with the Extender Electronics option should appear as in Figure 16.2j.

4. Reconfigure jumpers on the backplane header using the appropriate jumper configuration.
5. After correctly configuring the backplane jumpers, replace the cover on the electronics box.
6. Plug the power cable back into the microscope.
7. Turn on the NanoScope controller.
Setting Analog 2 in the Software

If you have chosen a configuration where Analog 2 applies to the tip or sample, you must enable Analog in the software. The Analog 2 parameter appears in both the Feedback Controls and Interleave Controls panels.

Note: For Version 4.23 and lower, Analog 2 appears only in the Feedback Controls panel.

Instructions for Enabling Analog 2 in Software

1. Select Di > Microscope Select > Edit > Advanced, and set Analog 2 to User defined.
2. Click OK to exit both dialog boxes.

Note: For software versions 4.23 and lower, select Microscope > Calibrate > Detector to display the Detectors Parameters window. Switch the Allow in attenuation field to Disallow.

Instructions for Disabling Analog 2 in Software

1. Select Di > Microscope Select > Edit > Advanced, and set Analog 2 to Atten switch.
2. Click OK to exit both dialog boxes.

Note: Remember to set Allow in attenuation to Allow when finished. For all other configurations it should be left on Allow.
Setting the Extender Electronics Box

1. For systems with an Extender Electronics Box, locate the two toggle switches on the backside of the Extender Electronics Box (see Figure 16.2d).

2. Verify that they are toggled as shown in Table 16.2a.

Figure 16.2d  Toggle Switches on Extender Electronics Module

Table 16.2a  Extender Electronics Module Toggle Switch Settings

<table>
<thead>
<tr>
<th>Mode</th>
<th>Tip or Sample Voltage</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>FM/Phase</strong></td>
<td><strong>Surface Potential</strong></td>
</tr>
<tr>
<td>EFM with Analog 2 biasing tip or sample</td>
<td>x</td>
</tr>
<tr>
<td>EFM in all other configurations</td>
<td>x</td>
</tr>
<tr>
<td>Standard Operation</td>
<td>x</td>
</tr>
</tbody>
</table>
Jumper Configurations Without Extender Electronics

As shipped from the factory, the jumper configuration on a Dimension Series system without the Extender Electronics Module appears as shown in Figure 16.2e below. This configuration connects both tip and sample to ground.

Figure 16.2e  Normal Jumper Configuration
**Analog 2 Voltage Applied to the Tip (No Extender Electronics)**

The jumper configuration in Figure 16.2f connects the Analog 2 signal from the NanoScope III controller (± 12 VDC range) to the tip. Remember to enable the Analog 2 voltage line as described in Section 16.2.2.

**Figure 16.2f** Jumper Configuration for Application of Analog 2 Voltage to Tip
Analog 2 Voltage Applied to the Sample (No Extender Electronics)

The jumper configuration in Figure 16.2g connects the Analog 2 signal from the NanoScope III controller (± 12 VDC range) to the sample chuck. Remember to enable the Analog 2 voltage line as described in Section 16.2.2.

Figure 16.2g  Jumper Configuration (Application of Analog 2 Voltage to Sample)
External Voltage Source Applied to the Tip (No Extender Electronics)

In some cases, it may be advantageous to use voltages greater than 12 V, or to use a pulsed power supply. If an external source of voltage is to be applied to the tip, configure jumpers as shown in Figure 16.2h.

**Figure 16.2h**  Jumper Configuration for Applying External Voltage to Tip

Place a current-limiting resistor (e.g., 10–100MΩ) in series with the external voltage supply as shown to protect the tip and sample from damage. You may also use current-limited power supplies. Connect voltage leads to pins on the header using soldered, push-on connectors. Do not solder leads directly to the header pins, as the heat may cause damage and/or make jumpering the pins difficult.
External Voltage Source Applied to Sample (No Extender Electronics)

In some cases, it may be advantageous to use voltages greater than 12 V, or to use a pulsed power supply. If an external source of voltage is to be applied to the sample, configure jumpers as shown in Figure 16.2i.

Figure 16.2i  Jumper Configuration for Applying External Voltage to Sample

A current-limiting resistor (e.g., 10–100 MΩ) should be placed in series with the external voltage supply as shown to protect the tip and sample from damage. Current-limited power supplies may also be used. Voltage leads should be connected to pins on the header using soldered, push-on connectors. Do not solder leads directly to the header pins, as the heat may cause damage and/or make jumpering the pins difficult.
Jumper Configurations With Extender Electronics

**CAUTION:** Turn off the NanoScope controller and unplug the power cable from the microscope electronic box before attempting to adjust jumper configurations.

As shipped from the factory, systems with the Extender Electronics option should have an original backplane jumper configuration as shown in **Figure 16.2j**. This configuration connects both the tip and sample to the ground.

**Figure 16.2j** Normal Jumper Configuration with Extender Electronics Module
Analog 2 Voltage Applied to the Tip (With Extender Electronics)

Notice that the jumper configuration in Figure 16.2k connects the Analog 2 signal from the NanoScope III controller (± 12 V range) to the tip, and is exactly the same as the jumper configuration shown in Figure 16.2j, the standard configuration as shipped from the factory. Remember to enable the Analog 2 voltage line as described in Section 16.2.2.

**Figure 16.2k** Jumper Configuration for Application of Voltage to Tip
**Analog 2 Voltage Applied to Sample (With Extender Electronics)**

The jumper configuration in Figure 16.21 connects the Analog 2 signal from the NanoScope III controller (± 12 V range) to the sample. Remember to enable the Analog 2 voltage line as described in Section 16.2.2.

**Figure 16.21**  Jumper Configuration for Application of Voltage to Sample

![Figure 16.21](image-url)
External Voltage Source Applied to Tip (With Extender Electronics)

In some cases, it may be advantageous to use voltages greater than 12V, or to use a pulsed power supply. If an external source of voltage is to be applied to the tip, configure jumpers as shown in Figure 16.2m.

Figure 16.2m  Jumper Configuration for Applying External Voltage to Tip

Place a current-limiting resistor (e.g., 10–100 MΩ) in series with the external voltage supply as shown to protect the tip and sample from damage. You can also use current-limited power supplies. Connect voltage leads to pins on the header using soldered, push-on connectors. Do not solder leads directly to the header pins as the heat may cause damage or make jumpering the pins difficult.
External Voltage Source Applied to Sample (With Extender Electronics)

In some cases, it may be advantageous to utilize voltages greater than 12 V, or to utilize a pulsed power supply. If an external source of voltage is to be applied to the sample, configure jumpers as shown in Figure 16.2n.

**Figure 16.2n** Jumper Configuration for Applying External Voltage to Sample

Place a current-limiting resistor (e.g., 10-100 MΩ) in series with the external voltage supply as shown to protect the tip and sample from damage. You can also use current-limited power supplies. Connect voltage leads to pins on the header using soldered, push-on connectors. Do not solder leads directly to the header pins, as the heat may cause damage and make jumpering the pins difficult.
16.2.3 Electric Force Microscopy Procedures

**Note:** Amplitude detection is the only procedure described here that can be performed without the Extender Electronics Module; however, this method is no longer recommended (see Section 16.2.6).

1. Verify the following electric force microscopy preparation is complete:
   a. Jumper Configurations
   b. Extender Electronics Module Settings (see Figure 16.1b and Table 16.2a).
   c. Analog 2 settings in software (see Page 278).

2. Electrically connect the sample by mounting it to a standard sample disk or stage using conducting epoxy or silver paint.

3. Verify the connection is good (a poor connection introduces noise).
   **Note:** If an external power supply connects directly to leads on the sample itself, it is important to electrically isolate the sample from the stage. A piece of Kapton tape covering the bottom of a sample puck works well.

4. Mount a metal-coated NanoProbe cantilever into the electric field cantilever holder.
   **Note:** MFM-style cantilevers (225 µm long, with resonant frequencies around 70 kHz, models MESF and SCM-PIT) usually work well. It is also possible to deposit custom coatings on model FESP silicon TappingMode cantilevers. Make sure that any deposited metal you use adheres strongly to the silicon cantilever.

5. Set up the AFM as usual for TappingMode operation.


7. Follow the procedure below for the type of electric force imaging desired, Phase Detection, Frequency Modulation or Amplitude Detection (see sections 16.2.4 through 16.2.6).
16.2.4 Phase Detection

Phase Detection is only available when the Extender Electronics Module has been correctly configured into the system.

1. In the **Auto Tune Controls** window, set **Start frequency** and **End frequency** to appropriate values for your cantilever (e.g., for 225µm MFM cantilevers, set **Start frequency** to 40kHz and **End frequency** to 100 kHz).

2. Select **Auto Tune**.

   **Note:** Two curves appear on the Cantilever Tune graph (see Figure 16.2o): the **amplitude** curve in white (the solid line in Figure 16.2o), and the **phase** curve in yellow (the dashed line).

![Figure 16.2o Phase Detection Cantilever Tune](image)

   **Note:** The phase should decrease with increasing frequency and cross the center line (0° point) at the peak frequency. The phase curve then correctly reflects the phase lag between the drive and the cantilever response. Gradients in the electric force cause a shift $\Delta F_0$ in the resonance frequency. Resonance shifts also give rise to phase shifts $\Delta \phi$ used to generate an image of the electric force gradients; see Figure 16.2p.

![Figure 16.2p Shift In Phase at Fixed Drive Frequency](image)
3. Quit Auto Tune.

4. Select Back to Image Mode.

5. Engage the AFM and make the necessary adjustments to obtain a good topography (Height) image on Channel 1.

6. In the Interleave Controls panel set the Lift start height to 0nm, and Lift scan height to 100 nm. (The lift height can later be optimized).

7. Set the remaining Interleave parameters (Setpoint, Drive amplitude, Drive frequency, Gains) to the main Feedback Controls values.

   **Note:** This can be done by setting the flags to the left of each parameter to “off” (grayed bullets).

8. Set the Channel 2 Data type to Phase and choose Retrace for the scan Line direction on both Channel 1 and 2 images.

9. In the Interleave Controls panel set Interleave mode to Lift.

   **Note:** For NanoScope software versions 4.23 and lower set Interleave scan to Lift and switch Interleave mode to Enable in the Interleave Controls panel.

10. Set the Channel 2 Scan line to Interleave to display interleave data. This screen should now display the cantilever phase change due to electrical force gradients from the sample in the right image and topography in the left image.

   **Note:** If Analog 2 is being used to apply voltage to the tip or sample, it is recommended to apply it only during the Interleave line if feasible. Set Analog 2 to the desired voltage in the Interleave Controls panel. In the Feedback Controls panel set Analog 2 to 0V.

   **Note:** For NanoScope software versions 4.23 and lower: There is no separate Analog 2 setting available in the Interleave Control panel, so Analog 2 must be set in the Feedback Controls panel. For more details, refer to EFM Troubleshooting/Pointers: Section 16.3.

11. Optimize the Lift scan height. For high-resolution, make the Lift scan height as small as possible without crashing the tip into the surface.
16.2.5 Frequency Modulation

For more quantitative results, use frequency modulation (FM). This technique provides a direct measure of change in resonant frequency sensed by the cantilever.

1. Follow all the steps required to perform phase detection EFM.

2. In the Interleave Controls panel, set the Input feedback to Frequency.

3. Switch the Data Type for Channel 2 to Frequency.

   Note: It may be necessary to optimize the FM gains in the Other Controls panel to properly track the shifts in resonant frequency (starting values: FM igain = 40 and FM pgain = 60).

   Note: For NanoScope software versions 4.23 and lower, there is no Input feedback setting; just switch the Data Type for Channel 2 to Frequency.

16.2.6 Amplitude Detection

Amplitude detection is inferior to the phase and frequency detection methods described previously and is not the recommended technique for systems with an Extender Electronics Module.

Amplitude detection is the only technique available for systems without the Extender Electronics Module. This section describes the differences in set up for amplitude detection. Changes in the cantilever amplitude provide an indirect measure of shifts in the cantilever resonance frequency as shown in Figure 16.2q.

![Figure 16.2q Shift In Amplitude at Fixed Drive Frequency](image)

1. Set the Drive frequency to the left side of the cantilever resonance curve, as shown in Figure 16.2r.
2. For maximum sensitivity, set the **Drive frequency** to the steepest part of the resonance curve.

**Note:** As the tip oscillates above the sample, a gradient in the electric force shifts the resonance frequency $F_0$ (see Figure 16.2q). Tracking the variations in oscillation amplitude while in LiftMode yields an image of the electric force gradients. You may use either side of the resonance, though we have obtained slightly better results on the low side, as shown in Figure 16.2q.

When using Amplitude Detection, optical interference may sometimes appear in the lift (electric force) image when imaging highly reflective samples. Optical interference appears as evenly spaced, sometimes wavy lines with about 1–2 µm spacing superimposed on the lift image. This occurs when ambient laser light (i.e., light passing around or through the cantilever, then reflecting off the sample) interferes with laser light reflecting from the cantilever. Interference can be alleviated by moving the beam spot up a little along the cantilever away from the tip; about one-third of the cantilever length from the tip usually works well. On the Dimension head, the adjustment can be refined by carefully moving the beam spot laterally on the cantilever while scanning until interference fringes are minimized.

**Note:** Optical interference is essentially eliminated by using phase detection or Frequency Modulation, available only with the Extender Electronics Module.
16.3 EFM Troubleshooting/Pointers

16.3.1 Use Low Setpoint When Tapping in Electric Field

If a voltage is applied during the main TappingMode line (as well as the interleave line) either through Analog 2 or an external source, be careful to ensure proper operation. It is possible to enter a mode in which the tip is never actually touching the surface, even though the amplitude setpoint is being met. As the feedback moves the tip closer to the sample surface, the resonant frequency of the tip is shifting (see Figure 16.2q). The closer the tip is to the surface, the larger the force gradient and the more the resonant frequency shifts. It is possible for the resonant frequency to shift enough so that the amplitude setpoint is met without the tip touching the surface. The tip can be a significant distance away from the sample. The height image has comparatively poor resolution as does the corresponding electric field gradient image. A significantly lower amplitude setpoint is needed to really tap the surface in the presence of a strong electric field.

16.3.2 Verify Electric Field at Surface

If applying Analog 2 voltage to tip or sample to generate an E-field, set the phase channel Realtime planefit to None. While in Scope Mode, vary the interleave Analog 2 value and verify that phase signal shifts accordingly.

16.3.3 Fine Tune Lift Scan Height

Set the lift height to be as small as possible without hitting the surface, because lateral resolution of EFM improves with decreased tip/sample separation. The minimum lift height depends on the roughness of the sample, the difference between the amplitude setpoint and free air amplitude, and the quality of the height image. Hitting the surface usually produces phase data with extremely high contrast (either black or white pixels).

16.3.4 Fine Tune Interleave Drive Amplitude

Decrease the drive amplitude in the interleave line to further minimize the lift height. Be aware that the S/N ratio also decreases with decreasing drive, so there are diminishing returns after a point.

16.3.5 Optimize Tune in Vicinity of Surface

Select View > Sweep > Cantilever Tune to open tune panel while engaged. A tip offset of 30nm usually works well for smooth surfaces (if the tune has a noisy straight area in the middle instead of a smooth peak, the tip is hitting the surface and a larger tip offset is needed typically for rough surfaces). Adjust drive frequency to center of peak or just to the left. If phase data is to be collected during the main line, zero the phase at the drive frequency.
16.3.6 Optimize Tune in Interleave

Find optimal lift height. Use View > Sweep > Cantilever Tune to open the tune window while engaged. Choose a Tip Offset equal to the Lift Height. Make any changes to the Drive frequency and Drive phase to adjust the main tune (tip #3). In the Sweep Controls panel, select the Interleave Controls button. Activate (green button) the Drive frequency and Phase, and Analog 2. With Analog 2 set to operating voltage, set the frequency to the center of the peak and zero the phase.

16.3.7 If Voltage is Needed, Use Analog 2 When Possible

It is often very difficult to get a high quality TappingMode image with an electric field present. Analog 2 has an important advantage over an external power supply – it can be used to create an E field only in interleave and be set to 0V in the main line (> v4.31). Its range is limited to +/- 12V.

16.3.8 Try Uncoated Si Tip

EFM has been successful with a variety of tips, including standard Si tips with no metal coating (fesp, tesp, ltesp). The Si is highly n-doped and is often conductive enough for EFM measurements. Metal coatings make the tip less sharp, decreasing lateral resolution. The standard tips also seem to give cleaner images over longer periods of time. There is likely a reduction in sensitivity to small E fields with the decreased conductivity.

16.4 Surface Potential Detection—Theory

**Note:** Surface potential detection EFM is only possible using the one of the extender modules or the NanoScope IV controller. This section does not apply to microscopes which are not equipped with the Basic or Quadrex Modules, or the NanoScope IV controller.

- The Basic Extender Module allows measurement of local sample surface potential. This is similar to techniques called Scanning Maxwell Stress Microscopy and Kelvin Probe Microscopy. Surface potential detection is a two-pass system where the surface topography is obtained in the first pass and the surface potential is measured on the second pass. The two measurements are interleaved, that is, they are each measured one line at a time with both images displayed on the screen simultaneously.

A block diagram of the surface potential measurement system is shown in Figure 16.4a. On the first pass, the sample topography is measured by standard TappingMode. In TappingMode the cantilever is physically vibrated near its resonant frequency by a small piezoelectric element. On the second pass, the piezo that normally vibrates the cantilever is turned off. Instead, to measure the surface potential, an oscillating voltage $V_{ac}\cos \omega t$ is applied directly to the cantilever tip. This creates an
oscillating electrostatic force at the frequency $\omega$ on the cantilever. The oscillating force has the following amplitude:

$$ F = \frac{dC}{dz} V_{dc} V_{ac} $$

where $\frac{dC}{dz}$ is the vertical derivative of the tip/sample capacitance.

$V_{dc} = V_{tip} - V_{sample}$, the dc voltage difference between the tip and the sample,

and $V_{ac}$ is the amplitude of the oscillating voltage applied to the cantilever tip.

Figure 16.4a  Simplified Block Diagram of Basic Extender Module in Surface Potential Mode

The key here is that the force on the cantilever depends on the product of the ac drive voltage and the dc voltage difference between the tip and the sample. And, when the tip and sample are at the same dc voltage ($V_{dc}=0$), the cantilever will feel no oscillating force. The Basic Extender Module uses this fact to determine the effective surface potential on the sample, $V_{sample}$. The Extender determines the local surface potential by adjusting the dc voltage on the tip, $V_{tip}$, until the oscillation amplitude becomes zero. At this point the tip voltage will be the same as the unknown surface potential. The voltage applied to the cantilever tip $V_{tip}$ is recorded by the NanoScope III to construct a voltage map of the surface.
16.5 Surface Potential Detection—Preparation

It is often desirable to apply a voltage to one or more areas of a sample. This may be done in two ways: by connecting a voltage to the sample mounting chuck, or by making direct contact to the sample. In both cases, jumper configurations in the back panel of the microscope must be changed to match the environment desired.

**Note:** In addition to any reconfigured jumpers, remember to connect the common or negative terminal of an external power supply to the Dimension ground or the AFM chassis.

1. Power down the NanoScope controller and turn off all peripherals. Unplug the NanoScope power cable from the microscope’s electronic box.

2. Remove the back panel on the microscope’s electronic box.

3. Locate header and jumpers per Figure 16.2c on the main electronics backplane.

   **Note:** Jumper systems without the Extender Electronics Module should appear as shown in Figure 16.2e; whereas jumper systems with the Extender Electronics option should appear as in Figure 16.2j.

4. Reconfigure jumpers on the backplane header using the appropriate jumper configuration.

5. After correctly configuring the backplane jumpers, replace the cover on the electronics box.

6. Plug the power cable back into the microscope.

7. Turn on the NanoScope controller.

8. Depending upon whether voltage is to be applied to the sample directly or indirectly, reconfigure jumpers if indicated.

### 16.5.1 Applying Voltage to the Sample Directly

When voltage is applied directly to the sample, there is no need to reconfigure the jumpers. They should remain jumpered as shipped from the factory (Figure 16.5a), and the sample should be electrically insulated from the chuck.

Connect the external voltage source directly to the sample by attaching fine gauge wire to appropriate contacts (e.g., on integrated circuits connect electrical leads directly to pads). For normal operation, the sample chuck is held at ground. For Application Module-ready systems, the bias is normally applied to the chuck. Be certain to carefully any electrical connections from the sample chuck.
Figure 16.5a  Normal Jumper Configuration with Extender Electronics Module

ChuckGround/Bias
Chuck
Analog 2 or Gnd/OSC + DC signal
Unused
STM Signal
Auxiliary 2 Output
Ground
Ground

Indicates Jumpers

Analog 2 Voltage Applied to the Tip (With Extender Electronics)

Notice that the jumper configuration in Figure 16.2k connects the Analog 2 signal from the NanoScope III controller (± 12V range) to the tip, and is exactly the same as the jumper configuration shown in Figure 16.2j, the standard configuration as shipped from the factory. Remember to enable the Analog 2 voltage line as described in Section 16.2.2.

Figure 16.5b  Jumper Configuration for Application of Voltage to Tip

ChuckGround/Bias
Sample Chuck
Analog 2 or Gnd/OSC + DC signal
unused
STM Signal
Auxiliary 2 Output
Ground
Ground

Indicates Jumpers
Analog 2 Voltage Applied to Sample (With Extender Electronics)

The jumper configuration in Figure 16.21 connects the Analog 2 signal from the NanoScope III controller (± 12V range) to the sample. Remember to enable the Analog 2 voltage line as described in Section 16.2.2.

A current-limiting resistor (e.g., 10–100MΩ) should be placed in series with the external voltage supply to protect the tip and sample from damage. Current-limited power supplies may also be used. Voltage leads should be connected to pins on the header using soldered, push-on connectors. **Do not solder leads directly** to the header pins. Heat may cause damage and/or make jumpering the pins difficult.

The sample should be electrically connected directly to the chuck or a standard sample puck using conductive epoxy or silver paint as shown below:
16.6 Surface Potential Imaging—Procedure

1. Locate the two toggle switches on the backside of the Basic Extender box (Figure 16.6a), then verify that they are toggled as shown in Figure 16.6a.

![Figure 16.6a Toggle Switches on Back of Basic Extender Module](image)

Table 16.6a Basic Extender Module toggle switch settings for surface potential imaging.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Tip or Sample Voltage</th>
</tr>
</thead>
<tbody>
<tr>
<td>FM/Phase</td>
<td>Surface Potential</td>
</tr>
<tr>
<td>GND/Surface Potential</td>
<td>Analog 2</td>
</tr>
<tr>
<td>TappingMode Contact AFM</td>
<td>✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓</td>
</tr>
<tr>
<td>MFM</td>
<td>✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓</td>
</tr>
<tr>
<td>Surface Potential</td>
<td>✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓</td>
</tr>
<tr>
<td>Apply voltage to tip or sample (Use for electric field gradient imaging; tunneling AFM)</td>
<td>✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓</td>
</tr>
</tbody>
</table>

**Note:** The toggle switch combination of **Surface Potential** = ON and **Analog2** = ON is not recommended and can produce erratic and undefined results.

2. Mount a sample onto the sample holder. Make any external electrical connections that are necessary for the sample.

3. Mount a metal-coated NanoProbe cantilever into the standard cantilever holder. MFM-style cantilevers (225µm long, with resonant frequencies around 70kHz) usually work well. It is also possible to deposit custom coatings on model FESP silicon TappingMode cantilevers.
Verify that all deposited metal adheres strongly to the silicon cantilever. SCM-PIT and DSCM-PT also work well for surface potential.

4. Set up the AFM as usual for TappingMode operation.

5. Use Cantilever Tune: AutoTune to locate the cantilever’s resonant peak. Remember, however, that the Extender box has been reconfigured so that the phase detection circuitry now acts as a lock-in amplifier. Any procedures that are normally used to view or adjust the phase signal will now affect the lock-in signal instead (see Figure 16.4a).

In this case, two curves should appear in the Cantilever Tune box: the amplitude curve in white and the lock-in curve in yellow. In the event you find more than one resonance, select a resonance that is sharp and clearly defined, but not necessarily the largest. It is also helpful to select a resonant peak where the lock-in signal also changes very sharply across the peak. Multiple peaks can often be eliminated by making sure the cantilever holder is clean and the cantilever is tightly secured.

6. Engage the AFM and make the necessary adjustments for a good TappingMode image while displaying height data.

7. Select the Interleave Controls command. This brings up a new set of scan parameters that are used for the interleaved scan where surface potential is measured. Different values from those on the main scan may be entered for any of the interleaved scan parameter. To fix any of the parameters so they are the same on the main and interleave scans, click on the green bullets to the left of particular parameter. The green bullet changes to “off” (gray) and the parameter value changes to the main Feedback Controls value. Set the interleave Drive frequency to the main feedback value. Enter an interleaved Setpoint of 0V. Set Interleave scan to Lift.

8. Enter an Interleave Controls Drive amplitude. This is the ac voltage that is applied to the AFM tip. Higher Drive amplitude produces a larger electrostatic force on the cantilever and this makes for more sensitive potential measurements. Conversely, the maximum total voltage (ac + dc) that may be applied to the tip is ±10V. So a large Drive amplitude reduces the range of the DC voltage that can be applied to the cantilever. If the sample surface potentials to be measured are very large, it is necessary to choose a small Drive amplitude, while small surface potentials can be imaged more successfully with large Drive amplitudes. To start choose a Drive amplitude of 2V.

9. Set the Channel 2 image Data type to Potential. Set the scan Line direction for the main and interleave scans to Retrace. Remember to choose the Retrace direction because the lift step occurs on the trace scan and data collection occurs on the retrace.

10. Choose a Lift start height of 0nm and a Lift scan height of 50nm. The Lift scan height can be readjusted later. Set the drive phase to -90°. This compensates for mechanical lay in the cantilever as it responds to the oscillating electric field.

11. Switch Interleave mode to Enable to start LiftMode. Now, when the microscope completes a topographic scan line (trace and retrace) the system turns off the TappingMode piezo and switches the oscillator signal to the cantilever. The cantilever is driven electrostatically according to the interleave Drive amplitude that has been selected. Also, when Potential is selected as the Data type for the Channel 2 image, a feedback circuit is enabled in the Extender box which adjusts the dc voltage on the tip to maintain the cantilever oscillation.
amplitude at zero. To do this, the feedback circuit uses the lock-in signal of the cantilever oscillation and tries to keep this value at zero volts. As detailed in the Section 16.4 above, when the cantilever oscillation amplitude has returned to zero, the dc voltage on the tip and sample are the same. The NanoScope records the dc voltage applied to the tip and this signal is displayed in the Potential data type.

12. Adjust the Input gains. The feedback loop that is used by the Basic Extender for surface potential measurements is the same as the one used in Frequency Modulation (FM) for magnetic and electric force gradient detection, as described previously. The feedback loop should be tuned in a similar manner to the FM setup. Select Other Controls and adjust the FM gains. Setting both Input igain and Input pgain to 15.0 is a good starting point. As with the topography gains, the scan can be optimized by increasing the gains to maximize feedback response, but not so high that oscillation sets in. The gains often need to be much lower for potential measurements than for standard FM measurements. More information on tuning the feedback loop is given in Section 16.6.1 below.

Note: In older versions of software, Input igain = FM-igain and Input pgain = FM-pgain)

13. Optimize the lift heights. Set the Lift scan height at the smallest value possible that does not make the Potential feedback loop unstable or cause the tip to crash into the sample surface. When the tip crashes into the surface during the Potential measurement, dark or light streaks appear in the Potential image. In this case, increase the Lift scan height until these streaks are minimized.

14. Optimize the drive phase. When using cantilevers other than MESPs, OSCM-PTs and SCM-PITs, the lag in the response of the cantilever to the electric force can be compensated for by looking at the phase cantilever with the potential feedback loop enabled, but with the Input igain and Input pgain set to zero. By looking at the phase in this state, you can see the input to the potential feedback loop.

- To proceed with the drive phase adjustment, with the Input Feedback set to Potential, set the Input igain and Input pgain to zero. Set one of the Data Channels to Phase, and set Realtime Planefit to None. Select View > Scope Mode, and look at the position of the phase data relative to zero. Begin adjusting the Drive Phase under the Interleave Controls panel while observing the change in the phase signal. Find the point where the phase is minimized. For MESPs, SCM-PTs and OSCM-PTs, this value should be near 0°. For TESPts, this value is normally around -45°. Once the minimum has been found, subtract 90° from this value. This is the optimal value of drive phase shift to compensate for lag in the cantilever to the electrical drive. Set the Input igain and Input pgain to their previous values. Change the Data Type back to Potential, and proceed to collect surface potential data as needed.

15. For large sample voltages or qualitative work, select Data type = Phase instead of Potential. When the Extender box has been configured for surface potential measurements, the “phase” signal is actually the cantilever amplitude signal, as measured by a lock-in amplifier. If the feedback loop is not enabled by selecting the Data type = Potential, the lock-in cantilever amplitude depends on the voltage difference between the tip and sample in a roughly linear fashion. (The lock-in amplifier produces a voltage that is proportional to the cantilever amplitude.) Qualitative surface potential images can be collected using this lock-in signal. Also, if the sample has a surface potential that exceeds ±10V (greater than the range of the
“Potential” signal), it is possible to use the lock-in signal to provide qualitative images that reflect the sample surface potential. To view the lock-in signal with the reconfigured Extender box, select the Data type = Phase.

16.6.1 Troubleshooting the Surface Potential Feedback Loop

The surface potential signal feedback loop can be unstable. This instability can cause the potential signal to oscillate or become stuck at either +10V or -10V. Here are some tips to see if the feedback loop is working properly with no oscillation:

- Go into Scope Mode and look at the Potential signal. If oscillation noise is evident in the signal, reduce the FM gains. If oscillations persist even at very low FM gains, try increasing the Lift scan height and/or reducing the Drive amplitude until oscillation stops. If the tip crashes into the surface the Lock-in signal becomes unstable and can cause the feedback loop to malfunction. Increasing the Lift height and reducing the Drive amplitude can prevent this problem. Once oscillation stops, the FM gains may be increased for improved performance.

In Scope Mode, if the Potential signal is perfectly flat and shows no noise even with a small Z-range, the feedback loop is probably stuck at ±10V. (You can verify this by changing the value of Realtime planefit to None in the Channel 1 panel.) Reduce the Scan rate and watch the display monitor which indicates the cantilever amplitude. On the topographic trace, the voltage displayed should be the setpoint selected for the Main scan. On the Potential trace, this voltage drops close to zero if the cantilever oscillation is being successfully reduced. If the value on the display monitor instead goes to a large nonzero value, the feedback loop is probably not working properly. In this case, try reducing the Drive amplitude and increasing the Lift scan height. It may also be helpful to momentarily turn the Interleave mode to Disabled, then back to Enabled. Also try reducing any external voltage that is being applied to the sample to stabilize the feedback loop, then turn the voltage back up.
Chapter 17  Calibration

This chapter provides detailed instructions for the fine calibration of Digital Instruments Dimension SPMs. Specifically this chapter includes the following topics:

- SPM Calibration Overview: Section 17.1
  - Theory Behind Calibration: Section 17.1.1
  - Calibration References: Section 17.1.2
- Calibration Setup: Section 17.2
  - Check Scanner Parameter Values: Section 17.2.1
  - Align Calibration Reference: Section 17.2.2
  - Set Realtime Parameters: Section 17.2.3
  - Set Up Contact AFM: Section 17.2.4
- Check Sample Orthogonality: Section 17.3
  - Measure Orthogonality: Section 17.3.1
  - Adjust Sample Orthogonality: Section 17.3.2
- Linearity Correction: Section 17.4
  - Adjust Mag0 and Arg: Section 17.4.1
  - Adjust Fast mag1: Section 17.4.2
  - Adjust Slow mag1: Section 17.4.3
- X-Y Calibration using Capture Calibration and Autocalibration: Section 17.5
  - Capture Calibration: Section 17.5.1
  - Autocalibration: Section 17.6
- **Fine-tuning for X-Y Calibration:** Section 17.7
  - Prepare System for Fine-tuning: Section 17.7.1
  - Measure Horizontally at 440V Scan Size: Section 17.7.2
  - Measure Vertically at 440V Scan Size: Section 17.7.3
  - Measure Horizontally at 150 V Scan Size: Section 17.7.4
  - Measure Vertically at 150V Scan Size: Section 17.7.5
  - Change Scan angle and Repeat Calibration Routines: Section 17.7.6

- **Calibrating Z:** Section 17.8
  - Engage: Section 17.8.1
  - Capture and Correct an Image: Section 17.8.2
  - Measure Vertical Features: Section 17.8.3
  - Correct Z Sensitivity: Section 17.8.4
  - Recheck Z-axis Measuring Accuracy: Section 17.8.5
  - Calculate Retracted and Extended Offset Deratings: Section 17.8.6
17.1 SPM Calibration Overview

Veeco employs a software-guided calibration procedure for all microscopes. The procedural details of how calibration is executed using NanoScope software are beyond the scope of this document and include proprietary methods exclusive to Veeco. A brief overview of the theory is available in Section 17.1.1. The calibration is summarized in four basic steps outlined below.

- **Orthogonality Adjustments**: The orthogonality adjustment compensates for a possible non-square scan pattern.

- **Scanner Linearization**: Adjust parameters for correcting the capacitive nature of the piezo material and force the X-Y motion of the tip to move at a constant velocity.

- **X, Y Calibration**: Designate the software conversion values using one or both of the following methods.
  - **Capture Calibration and Autocalibration**: A built-in software routine automatically controls the scanner while capturing a series of data files. The data files are then used to “teach” the software the actual distance that the scanner moved. This process creates a customized set of conversion values that will be used to convert the known signals to a metric scale.
  - **Fine Tuning**: Manually test and adjust X-Y sensitivity and derating values to within 1% accuracy. The conversion values that scale the scanner motion are confirmed, or are adjusted if necessary to within 1%. These same values should be adjusted by the customer as the scanner ages due to use. A scanner will typically lose 10-20% of its scan range over the first year of typical use. The scanner will then become stable as long as it is not damaged.

- **Calibrate Z**: Calibrate the Z scan tube to within 2%. A separate calibration “look-up” table stores the conversion values for converting the control voltages applied to the Z tube. These values are determined by scanning over a sample with a known depth.

Veeco recommends that you adhere to the following Calibration schedule (see Table 17.1a). After initial installation, perform the **Fine-Tuning X-Y Calibration** (see Section 17.7) per the following time schedule. If you find that the calibration measurements are more than 10% off at any point during Fine-Tuning Calibration, stop and perform the **Full X-Y Calibration Routine** (see Section 17.2). For most applications it is sufficient to perform the Z calibration with the same frequency. For critical height measurements we recommend monthly Z calibration.
Table 17.1a  Calibration Schedule

<table>
<thead>
<tr>
<th>Calibration Routine</th>
<th>Time Frame</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fine-Tuning Calibration</td>
<td>First Year</td>
<td>Every 3 months</td>
</tr>
<tr>
<td>(or Full X-Y Calibration if required)</td>
<td>Subsequent Years</td>
<td>Every 6 months</td>
</tr>
<tr>
<td>Z Calibration</td>
<td>First Year</td>
<td>Every 3 months</td>
</tr>
<tr>
<td>(for General Applications)</td>
<td>Subsequent Years</td>
<td>Every 6 months</td>
</tr>
<tr>
<td>Critical Height Measurements</td>
<td>All Years</td>
<td>Monthly</td>
</tr>
</tbody>
</table>

Note: Small Scan Size Calibration: If using scan sizes of 5µm or smaller, Veeco recommends calibrating the scanner for small scan sizes. Contact Veeco for further instructions.

17.1.1 Theory Behind Calibration

Scanners typically consist of a hollow tube made of piezoelectric material such as PZT (lead zirconium titanate). Piezo materials contract and elongate when voltage is applied, according to whether the voltage is negative or positive, and depending upon the orientation of the material’s polarized grain structure. Scanners are used to precisely manipulate sample-tip movement in order to scan the sample surface. In Dimension SPMs, the sample is stationary while the scanner moves the tip.

Not all scanners react exactly the same to a voltage. Because of slight variations in the orientation and size of the piezoelectric granular structure (polarity), material thickness, etc., each scanner has a unique “personality.” This personality is conveniently measured in terms of sensitivity, a ratio of piezo voltage-to-piezo movement. Sensitivity is not a linear relationship, however. Because piezo scanners exhibit more sensitivity (i.e., more movement per volt) at higher voltages than they do at lower voltages, the sensitivity curve is just that—curved. This non-linear relationship is determined for each scanner crystal and follows it for the life of the scanner. As the scanner ages, its sensitivity will decrease somewhat, necessitating periodic recalibration.

The diagram below depicts scanner crystal voltage versus photodiode voltage (see Figure 17.1a). In this instance, detector sensitivity is given as volt per volt, a parameter provided in the Force Calibration screen.
The Microscope > Calibrate > Scanner function displays the Scanner Calibration dialog box, allowing users to enter the sensitivity of their scanner’s X-Y axes. Sensitivity is measured in terms of lateral displacement for a given voltage (nm/volt). In addition, the NanoScope software employs various derating and coupling parameters to model scanners’ nonlinear characteristics. By precisely determining points along the scanner’s sensitivity curve, then applying a rigorous mathematical model, full-range measuring capabilities can be achieved with better than 1 percent accuracy. Consider the sensitivity curve represented in Figure 17.1b.
This curve typifies scanner sensitivity across the full range of movement. The vertical axis denotes voltage applied to the scanner. The horizontal axis denotes scanner movement. At higher voltages, the scanner’s sensitivity increases (i.e., more movement per voltage applied). At zero volts, the scanner is “motionless.” Plotting each point along the curve describes a second-order, exponential relationship which provides a rough approximation of scanner sensitivity.

However, because piezo materials exhibit hysteresis, their response to increasing voltage is not the same as their response to decreasing voltage. That is, piezo materials exhibit “memory,” which causes the scanner to behave differently as voltages recede toward zero. The graph below represents this relationship (see Figure 17.1c).

To produce the sharp, linear movements (triangular waveform) required for accurate back-and-forth scanning, it is necessary to shape the applied voltage as shown on the top graph in Figure 17.1d. Moreover, the applied voltage must compensate for scan rate and scan size. As scan rate slows, the applied voltage must compensate for increased memory effects in the piezo material. As scan size is decreased, the piezo exhibits more linearity. These effects are further complicated by X-Y-Z coupling effects (the tendency for one axis to affect movement in other axes).
Through rigorous quality control of its scanner piezos, Veeco has achieved excellent modeling of scanner characteristics. Two calibration points are typically used for fine-tuning: at 150 and 440 volts. A third point is assumed at 0 nm/volts. These three points yield a second-order sensitivity curve to ensure accurate measurements throughout a broad range of scanner movements.

Because scanner sensitivities vary according to how much voltage is applied to them, the reference must be thoroughly scanned at a variety of sizes and angles. The user dictates, via the software, the distance between known features on the reference’s surface and a parameter is recorded to compensate the scanner’s movements. The X, Y and Z axes may be calibrated in any sequential order; however, the linearization adjustments must be performed before any calibrations are attempted (see Section Note:). Otherwise, calibrations will be undone by the linearity adjustments.

**Note:** Check the SPM’s measuring accuracy periodically to ensure that images are dimensionally represented within acceptable limits of error. If measuring accuracy is critical, or if environmental factors (e.g., humidity, temperature) impact the SPM significantly, this may require a quick check at the start of each imaging session. Establish a three-month service schedule for maintenance and calibration.
17.1.2 Calibration References

As described above, each scanner exhibits its own unique sensitivities; therefore, it is necessary to precisely measure these sensitivities, then establish software parameters for controlling the scanner. This task is accomplished with the use of a calibration reference (see Figure 17.1e).

A calibration reference consists of a silicon substrate having a regular series of pits, each 200nm deep, which is plated with platinum. Pits are spaced apart on 10µm centers. Other similar surfaces are available with different dimensions. Atomic-scale calibrations are generally carried out with mica or graphite, which exhibit very regular atomic lattices. Calibration references serve as the primary tool by which SPMs are calibrated. They serve as measuring sticks with which to gauge scanner displacement for a given voltage.

The SPM should be capable of measuring a calibration reference with an accuracy of 2 percent or better while scanning at the maximum scan size setting. Using fine calibration techniques, it is possible to calibrate the SPM with even greater accuracy.

17.2 Calibration Setup

17.2.1 Check Scanner Parameter Values

1. If the system's original scanner parameters are deleted, copy the scanner parameters from the software CD shipped with every system. Individually purchased scanners are shipped with a head/scanner disk containing backup files or a hard copy of the scanner parameters.

2. In the event that files are not found, fax or call Veeco for scanner calibration records.
17.2.2 Align Calibration Reference

1. Load the silicon calibration reference into the SPM.

2. Align the reference with the microscope scanner so that the tip scans parallel to the reference’s features with the Scan angle set at 0 degrees (see Figure 17.2a).

![Figure 17.2a 0 Degrees Scan Angle](image)

3. Align the reference within approximately 2° of perpendicularity to the scan axes.

17.2.3 Set Realtime Parameters

1. Set parameters in the control panels to the following values:

<table>
<thead>
<tr>
<th>Panel</th>
<th>Parameter</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scan Controls</td>
<td>Scan Size</td>
<td>440 V</td>
</tr>
<tr>
<td></td>
<td>X offset</td>
<td>0.00 nm</td>
</tr>
<tr>
<td></td>
<td>Y offset</td>
<td>0.00 nm</td>
</tr>
<tr>
<td></td>
<td>Scan angle</td>
<td>0.00 deg</td>
</tr>
<tr>
<td></td>
<td>Scan rate</td>
<td>2.44 Hz</td>
</tr>
<tr>
<td></td>
<td>Number of samples</td>
<td>256</td>
</tr>
<tr>
<td></td>
<td>Slow scan axis</td>
<td>Enabled</td>
</tr>
<tr>
<td></td>
<td>Z limit</td>
<td>440 V</td>
</tr>
<tr>
<td>Other Controls</td>
<td>Units</td>
<td>Volts</td>
</tr>
<tr>
<td>Channel 1</td>
<td>Data type</td>
<td>Height</td>
</tr>
<tr>
<td></td>
<td>Z range</td>
<td>~ 20 Va</td>
</tr>
</tbody>
</table>

a. Adjust the Z range parameter to obtain the best contrast.
17.2.4 Set Up Contact AFM

1. Set the AFM mode to Contact.
   
   **Note:** The microscope can be calibrated using STM; however, this example utilizes contact AFM.

2. Set the Scan angle to 0 degrees.

3. Adjust Realtime parameters to obtain a good-quality, maximum Scan size image (440V). Set the Scan rate to 2.44 Hz and the Number of samples parameter to 256.

4. With the sample engaged, check the scanning line relative to the reference’s features; the scan should be orthogonal to the pits on the reference.

5. If the reference requires rotation, Withdraw and rotate the sample to improve orthogonality between sample and scan line.

6. Repeat until features are oriented orthogonally with the scan frame.

17.3 Check Sample Orthogonality

Check the sample scan for orthogonality along both the X- and Y-axes. If the scan is aligned along one axis of the scan but not another, it may be necessary to adjust the microscope’s Orthogonality parameter in the Scanner Calibration panel.

17.3.1 Measure Orthogonality

1. To measure a captured image’s orthogonality, view it using the Offline > View > Top View function.

2. On the display monitor, select the Angle command and use the mouse to draw a cursor between the edges (or centers) of widely spaced pits (see Figure 17.3a).

   **Figure 17.3a** Non-Orthogonal and Corrected, Orthogonal Image
Note: In Figure 17.3a, pits align with the vertical (slow) axis but skew with the horizontal (fast) axis. The angle should be measured with the vertex near the center of the image and the vertices in the upper-right or lower-left quadrant. The angle displays on the white status bar at the bottom of the display monitor.

3. Use the mouse to drag the cursor until it is oriented correctly then read the angle off the status bar. If the angle differs by more than a half degree, a correction is required; otherwise, move on to the next step.

17.3.2 Adjust Sample Orthogonality

1. Click **Realtime > Microscope > Calibrate > Scanner** to access the **Scanner Calibration** panel. The **Orthogonality** parameter is displayed on the bottom-right corner of the panel.

2. Enter the difference between 90º and the angle measured in the **Top View** image.

   Note: For example, if the angle measured in the **Top View** image was 92.5º, enter a value of -2.5º in the **Orthogonality** parameter.

3. Click **OK** to exit the **Scanner Calibration** panel

4. Capture another image and re-measure the angle.

5. Repeat correction of **Orthogonality** until the scanned image shows less than 0.5º of error.

   Note: After a major change to the orthogonality parameter, you may need to physically realign the calibration standard to the image frame.
17.4 Linearity Correction

For applications which demand good linearity, the following procedure can be used to optimize the linearity correction parameters for individual scanners. As discussed previously, linearity correction is especially important for long-range scanners.

17.4.1 Adjust Mag0 and Arg

1. Select Microscope > Calibrate > Scanner to display the Scanner Calibration dialog box.

2. Set the mag0 and arg values while noting the scan beginning and ending.

   Note: When Line direction is set to Trace, the beginning of the fast scan is on the left, as indicated by the arrow base. Because the display monitor screen itself is not linear, use the Realtime Zoom box to check mag0 and arg.

   Note: When viewing up or down scans, check the image against itself, not the residual image from the previous scan. Be careful to compare only the part of the scan drawn since the last parameter change.

Adjust Fast Mag0

1. After engaging, click on Microscope > Calibrate > Scanner to open the Scanner Calibration window. As parameters values are changed, the effects will be seen on the display monitor.

2. Move the mouse cursor to the display monitor and select Zoom Out to produce a box whose size and position can be changed by alternate clicks on the left mouse button.

3. Adjust the box until it is about one-third the size of the scan.

4. Click once on the right mouse button to set the box, free the cursor, and move to Execute.

   Note: Clicking twice will execute a Zoom, which you do not want to do.

5. Select Fast mag0, the first scanner parameter to modify.

6. Move the zoom box to the start of the fast scan (on the left if the Line direction is set to Trace).

7. Move and size the zoom box until the beginning third of the scan's features are exactly aligned with the zoom box.

   Note: The beginning third of the scan is the standard for judging almost all of the linearity values. Ignore the set of features near the edges of the scan since these may be distorted slightly.

8. Move the zoom box to the end third of the scan.
9. Align one side of the zoom box with desired features and observe how the other side aligns with the features under it.

10. Compare the beginning third of the scan to the features in the end third of the scan. If the features are too large to fit an equal number inside the zoom box, decrease the Fast mag0 value. If the features are too small, increase the Fast mag0 value. Change Fast mag0 by about 0.1 to 0.3 units at a time.

11. The entire scan axis is affected each time a parameter changes, so after every change, resize the zoom box at the beginning third of the scan and compare again with the end third.

**Figure 17.4a** Fast Scan Linearization: Mag0

Adjusting Fast arg

1. Once the beginning third of the scan is equal to the end third, check to see if the center needs adjusting.

2. If the center features are too large for the box, decrease the Fast arg value. If the center features are too small, increase the Fast arg value. Change args by 0.2 to 0.5 units at a time.

3. Changes affect the entire scan, so continue to resize the zoom box after each change.

4. After an adjustment in Fast arg is made, Fast mag0 may need readjusting. Repeat Fast mag0 adjustment procedure until the rulings are evenly spaced across the Fast-axis.

**Figure 17.4b** X Scan Linearization

Center Compressed

Center Expanded
5. After setting Fast mag0 and Fast arg, insert the values for Slow mag0 and Slow arg. These values serve as close starting points before adjusting the slow linearities.

### Adjusting Slow Mag0

1. Follow the same instructions as for Fast mag0.

2. After a parameter change, wait until a new third of a scan begins before setting new parameters and resizing the zoom box.

   **Note:** Setting the slow linearities requires a lot of time.

3. Move the resized box to the end of the scan and prepare to measure the end promptly.

   **Note:** You may type in a new parameter value before the scan starts again.

   **Note:** Be careful not to confuse scan top and bottom with beginning and ending, as the scan direction alternates.

4. Adjust the zoom box to fit the beginning third of the scan and check against the end third.

5. If the features of the end third are too large for the box, decrease the parameter. If the features are too small, increase the parameter.

   **Note:** Compare only parts of the current scan, not the previous scan.

---

**Figure 17.4c  Y Scan Linearization**

- **Center Compressed**
- **Center Expanded**
Adjusting Slow arg

1. Follow the same instructions for **Fast arg**.

2. Adjust the zoom box to fit the beginning and ending of the scan, then check the center.

3. If the features in the center are too large, reduce the **Slow arg** value. If the features in the center are too small, increase the **Slow arg** value.

4. After adjusting **Slow arg** values, check if **Slow mag0** requires readjusting.

5. Repeat the procedure for adjusting **Slow mag0** until the rulings are evenly spaced along the slow axis.

**17.4.2 Adjust Fast mag1**

**Initial Adjustment**

1. For initial adjustment, click **OK** to close the **Scanner Calibration** window.

   **Note:** Selecting **Cancel** resets parameters to default values when the box is opened.

2. Change the **Scan size** to **150V**.

3. Select **View > Scope Mode**.

4. On the display monitor, select **Dual Trace**. If the two scope traces do not overlap, **Fast mag1** needs adjusting.

5. On the **Scan Controls** panel, select **Slow scan axis**. When tall features appear on the scope trace, press the keyboard right or left arrow key to switch the **Slow scan axis** to **Disabled**.

6. Select **Microscope > Calibrate > Scanner** to open the **Scanner Calibration** box.

7. Select **Fast mag1**.

8. Use the left and right arrow keys to change the value until the two traces align.

   **Note:** The yellow retrace line will shift in the same direction as the arrow.

9. When done, click **OK** to close the **Scanner Calibration** window.

10. Set **Slow scan axis** back to **Enabled**.

11. Select **View > Image Mode**.
Fine Adjustment

Initial adjustment is usually adequate; however, if more precision is desired, use the following fine adjustment techniques to adjust Fast mag1.

1. Use the same procedure for adjusting Fast mag0.

2. As before, set the Zoom box for the beginning of the scan and then check the ending. Because the scan is small, use a Zoom box up to one-half as large as the scan.

3. If the end of the scan is larger than the beginning, reduce the Fast mag1 value. If the end is too small, increase the value of Fast mag1.

17.4.3 Adjust Slow mag1

1. With the Scan size set to 150V, select Microscope > Calibrate > Scanner.

2. Select Slow mag1 and input the value from Fast mag1.

   Note: For medium-sized scanners (C to F), further adjustments should not be necessary. The Slow mag1 value is usually 100-120 percent of the Fast mag1 value.

3. If more precision is desired, adjust Slow mag1 using the same procedure for adjusting Slow mag0.

4. Set the Zoom box for the beginning of the scan and then check against the ending. Because the scan is small, use a Zoom box up to one-half as large as the scan.

5. If the end of the scan is larger than the beginning, decrease the Slow mag1 value. If the end is too small, increase the value of Slow mag1.

6. Wait one complete frame with the new value before readjusting the Slow mag1 value.

7. Check the final result by capturing an image and checking it with the Offline > Modify > Zoom window. The scanner is now ready for calibration of the X and Y parameters.
17.5 X-Y Calibration using Capture Calibration and Autocalibration

17.5.1 Capture Calibration

Scanners are calibrated by setting parameters in the NanoScope software using the Capture Calibration command. The basic calibration procedure using version 5.XX software and a 10-micron calibration reference (see Figure 17.1e) is described below.

1. With the Scan rate set to 2.44 Hz and Number of samples parameter to 256, a full Capture Calibration requires approximately 70 minutes.

   Note: Increasing the Number of samples or decreasing the Scan rate significantly increases the required time.

2. Using the mouse, click on Realtime > Capture > Calibration. The Capture Calibration dialog box lists twelve parameters used in the calibration procedure (see Figure 17.5a).

   Figure 17.5a  Capture Calibration Prompt

3. If this is a first-time calibration, or if the microscope’s calibration has not been checked within the last three months, verify that all parameters are selected.

4. Click on CAPTURE to initiate the automatic calibration routine.

   Note: The microscope begins an automatic series of scans on the reference which require approximately one hour to complete. During each scan, the scanner moves the piezo using carefully calculated movements. Many of these movements are unusual, giving rise to a variety of images which do not resemble the normal reference. For example, pits may resemble trenches and features may be presented at various angles.

5. As each routine is executed, adjust the scan slightly to optimize the calibration image using the Capture Control dialog box displayed on the control monitor throughout the calibration routines (see Figure 17.5b).
X-Y Calibration using Capture Calibration and Autocalibration

Figure 17.5b  Capture Control Prompt

Note: The capture status will begin at skip 2. The program skips the current scan plus one more before capturing an image for later calibration. This allows hysteresis and drift to settle out when the scan changes direction and size between images.

6. If the scan has not settled out by the time the capture status changes to On, click on Skip to increment the capture to skip 1, skip 2 or skip 3.

Note: Do not click on Abort unless you want to stop the entire Capture Calibration program.

7. If portions of features are missing, or if the image is blank, click repeatedly on Adjust Y Offset > Up or Down to adjust the scan until more of the features are imaged. Features should extend across as much of the displayed image as possible (see Figure 17.5c).

8. Once the image is optimized, allow the software to capture the entire image without disturbing it. The software automatically indexes to the next image. Once all calibration images are obtained, the software prompts the user that it is finished.

Figure 17.5c  Improved Calibration Image

Note: After the first four images with the diagonal stripe pattern are captured, you can leave the system unattended while the program continues to completion. Some of the following images appear stretched in one dimension; however, this is normal.
9. Go to the Capture directory where all Capture Calibration files are saved.

10. Select Offline > File > Browse or click on Browse to review all Capture Calibration files.

11. Verify that all calibration images contain features spanning the full width and height of the image frame (see the right image in Figure 17.5c).

12. Recapture all images unsuitable for calibration. Record the file name extensions for all unusable files (e.g., .cxy, .dyy), then delete the files.


14. Verify that the file name prefix is identical to that of the usable files. Remove the “x” from all file name extensions (except for the unusable file names recorded in Step 12).

15. Finally, click on Capture to recapture the selected files.

17.6 Autocalibration

After the Capture Calibration routine is completed, the user measures surface features contained within each image and enters their dimensions into the software. The software compares its estimates with the actual (user-entered) dimensions to make final corrections. This portion of calibration is carried out using the Offline > Utility > Autocalibration command.

To utilize the Offline > Utility > Autocalibration command, do the following:

1. Select one of the desired captured calibration images in the Capture directory.

2. Select the Offline > Utility > Autocalibration command. The control monitor will display the X-Y Piezo Calibration dialog box (see Figure 17.6a).

**Figure 17.6a** X-Y Piezo Calibration Prompt

3. Verify that the file name prefix assigned to the captured files from the Capture Calibration routine is correct.
4. For normal calibration, verify that all parameters are selected in the dialog box, then click on **Calibrate** to execute the routine.

**Note:** The software sequentially presents various calibration images on the display monitor while prompting the user to draw either a vertical line or a horizontal line. The control monitor simultaneously displays various dialog boxes (one for each image), requesting the user to enter a distance.

5. Use the mouse to draw a line on the image. Draw the line to span as many features as possible, preferably connecting similar edges (see Figure 17.6b).

**Figure 17.6b** Vertical Calibration Line

In this example illustrated in Figure 17.6b, a line is drawn from the bottom edge of one feature to the bottom edge of another feature four rows away—a distance of 40µm. The control monitor simultaneously displays a dialog box for entering the distance indicated by the white line (see Figure 17.6c). The distance displayed in the box (in this example, 35.95µm) is the software’s estimate of the length of the line drawn on the image based on current calibration values. If the line length is different from the value shown, change the value to reflect the correct line length. (In this example, the user would enter a value of 40.)

**Figure 17.6c** Calibration Line Distance Prompt

6. Enter the distance covered by the white line drawn on the image. If a 10-micron reference is employed, like portions of features are spaced 10µm apart (e.g., between bottom edges, left sides, etc.).

**Note:** Measure features without regard to how they appear in calibration images. Features may be represented with stretched, distorted, or angled appearances.
due to the unusual movements employed during **Capture Calibration** scanning. Regardless, features are separated by the same (e.g., 10µm) spacings.

7. Continue drawing lines and entering measured distances until all **Capture Calibration** images are measured. When the software is finished, it prompts the user that it is done.

If **Capture Calibration** and **Autocalibration** routines are completed correctly, the SPM is calibrated within 1-2 percent accuracy over most of the scanner’s measuring range. To obtain still better accuracy, the SPM can be fine-tuned to obtain maximum measuring accuracy. This is accomplished through the use of calibration parameters discussed in Section 17.7.
17.7 Fine-tuning for X-Y Calibration

Fine-tuning is usually performed at two Scan size settings: 150V and 440V. Both horizontal and vertical measurements of sample features are made, then compared with actual distances. Based upon this comparison, computer parameters are fine-tuned. To fine-tune your SPM for maximum X-Y measuring accuracy, review the procedure below.

17.7.1 Prepare System for Fine-tuning

1. Set the Scan size parameter on the Scan Controls panel to the maximum value (440V).

2. Verify that the Scan angle is set at 0.00 degrees.

3. Mount a calibration reference in the SPM and begin imaging. This may consist of a generic (e.g., 10-micron, silicon) reference, or a sample having features of known dimensions (e.g., grating, etc.).

4. Optimize the image quality.

   **Note:** Your calibration and fine-tuning procedures are no better than the procedures and references used. **Choose both carefully.**

17.7.2 Measure Horizontally at 440V Scan Size

1. Set the Scan size parameter on the Scan Controls panel to the maximum value (440V).

2. Verify that the Scan angle is set to 0.00 degrees.

3. Engage the surface.

4. Select two widely-spaced features on the sample image of known separation. Use the mouse to draw a horizontal line between them (see Figure 17.7a). (For example, on a 10µm silicon reference, draw the line from the left side of one pit to the left side of another pit as far away as possible.) The screen will display the measured distance between pits next to the line.
Figure 17.7a  Calibration Horizontal Reference

5. Verify that the microscope’s measured distance agrees with the known horizontal distance. If there is significant disagreement between the two, fine tuning is required; go to the next step. If the displayed distance agrees with the known distance, skip to Section 17.7.4.

6. Based upon the results in the above step, divide the known distance by the distance displayed next to the line drawn a few steps earlier.

\[
\frac{\text{Known distance between features}}{\text{SPM-calculated distance between features}}
\]

7. Select the **Realtime > Microscope > Calibrate > Scanner** option. The **Scanner Calibration** dialog box displays (see Figure 17.7b).

Figure 17.7b  Scanner Calibration Panel

---

Draw a horizontal line.
8. Multiply the quotient obtained above by the \textbf{X fast sens} value shown on the \textbf{Scanner Calibration} panel.

9. Enter the new value. The new value adjusts the scanner’s fast axis to more closely match calculated distances with actual feature distances. The new sensitivity setting takes effect as soon as it is entered.

10. To save it to the computer’s hard disk, click on \textbf{OK}. This closes the \textbf{Scanner Calibration} panel.

\textbf{17.7.3 Measure Vertically at 440V Scan Size}

1. Return to the image of the calibration reference.

2. Clear the horizontal line drawn earlier and click the right mouse button, or click on \textbf{CLEAR}.

3. Wait for at least three full scans to allow the piezo to stabilize then select two widely spaced features and draw a vertical line connecting like portions of features (top edge-to-top edge, etc.). The SPM displays the calculated distance between features.

4. Verify that the microscope’s calculated distance agrees with the known vertical distance. If there is significant disagreement between the two, fine tuning is required; go to the next step. If the displayed distance agrees with the known distance, skip to Section 17.7.4.

5. Using the results from the above step, divide the known distance by the distance displayed next to the line drawn a few steps earlier.

\begin{align*}
\text{Known distance between features} & \quad \div \quad \text{SPM-calculated distance between features}
\end{align*}

6. Select the \textbf{Realtime > Microscope > Calibrate > Scanner} function to display the \textbf{Scanner Calibration} dialog box.

7. Select the \textbf{Y slow sens} parameter.

8. Multiply the quotient obtained earlier by the \textbf{Y slow sens} value shown on the \textbf{Scanner Calibration} panel.

9. Enter the new value to adjust the scanner’s slow axis to more closely match calculated distances with actual feature distances.

10. To save the new parameter value, click \textbf{OK}.
17.7.4 Measure Horizontally at 150 V Scan Size

1. Verify that the **Scan angle** is set to 0.00 degrees, and that **Units** (Other Controls panel) is set to **Volts**.

2. Set the **Scan size** parameter on the Scan Controls panel to one-third the maximum (150V).

3. Select two widely-spaced features on the sample image of known separation, then use the mouse to draw a horizontal line between them.

   **Note:** For example, on a 10µm, silicon reference, draw the line from the left side of one pit to the left side of another pit as far away as possible. The microscope displays the measured distance next to the line.

4. Verify that the microscope’s measured distance agrees with the known horizontal distance.

5. If there is significant disagreement between the two, fine-tuning is required; go to the next step. If the displayed distance agrees with the known distance, skip to Section 17.7.5.

6. Perform fine-tuning adjustments using either trial and error or calculate the precise correction (see Calculation Method).

**Trial and Error Method**

1. Select the **Realtime > Microscope > Calibrate > Scanner** function to display the **Scanner Calibration** dialog box.

2. Select the **X fast derate** parameter or **Y slow derate** for Y-axis adjustment.

3. If the measured distance is less than the actual distance, decrease the **X fast derate** parameter slightly or **Y slow derate** for Y-axis adjustment and re-measure image features.

4. Adjust deratings up or down until measurements accord with known feature distances.

**Calculation Method**

1. Select **Realtime > Microscope > Calibrate > Scanner** to display the **Scanner Calibration** dialog box.

2. Record the **X fast derate** or **Y slow derate** value.

3. Perform the following calculation where \( s \) is the **X fast sens** or **Y slow sens** value; \( a \) is the actual distance; \( d \) is the **X fast derate** or **Y slow derate** value you recorded in the above step; \( m \) is the measured distance; and, \( v \) is the **Scan size** in volts:

\[
\frac{s - \left( \frac{a}{m} \cdot [s - d(440 - v)] \right)}{440 - v}
\]
4. Return to the **Scanner Calibration** dialog box.

5. Select the **X fast derate** or **Y slow derate** parameter.

6. Enter the new **X fast derate** or **Y slow derate** value calculated in Step 3. This adjusts the scanner’s fast axis to more closely match calculated distances with actual feature distances.

7. To set the new parameter value, click **OK**.

### 17.7.5 Measure Vertically at 150V Scan Size

1. Select two widely-spaced features on the sample image of known separation.

2. Use the mouse to draw a vertical line between them.

   **Note:** For example, on a 10µm, silicon reference, draw the line from the top edge of one pit to the top edge of another pit as far away as possible. The microscope displays the measured distance next to the line.

3. Verify that the microscope’s measured distance agrees with the known vertical distance. If there is significant disagreement between the two, execute the fine tuning procedure; go to the next step. If the displayed distance agrees with the known distance, no further calibration is required.

4. Adjust the **Yslow derate** value by using one of two methods: 1) the **Trial and Error Method** or 2) the **Calculation Method** described in **Measure Horizontally at 150 V Scan Size**:
   Section 17.7.4 above.

### 17.7.6 Change Scan angle and Repeat Calibration Routines

- Change the **Scan angle** on the **Scan Controls** panel to 90°.

- Repeat steps above for the following parameters: **Y fast sens**, **X slow sens**, **Y fast der**, and **X slow der** to ensure the scanner is calibrated properly along the X- and Y-axis for scanning at 90°.
17.8 Calibrating Z

In terms of obtaining accurate Z-axis measurements, it is generally not difficult to obtain accurate X-Y calibration references; however, it is much more difficult to obtain accurate Z-axis results. Z-axis calibration is very sample-dependent. It is difficult to control Z piezo dynamics because the Z-axis does not move at a constant rate as the X- and Y-axes do during scanning. Furthermore, offsets affect the piezo over a period of minutes. The silicon calibration references distributed by Veeco have 200nm vertical features accurate to within ± 3 percent. The calibration reference is referred to throughout the examples provided in this section. If you require greater accuracy, you must select an appropriate calibration standard, and a metrology head employed with a Veeco Dimension Series microscope.

**Note:** Refer to the label on your calibration reference sample to verify the measurement employed is 200nm. Older systems may have samples with a different Z value.

17.8.1 Engage

1. Set up the microscope for **TappingMode** imaging.

2. Select **Engage** under the **Motor** pop-down menu or click on the **Engage** icon.

3. Find a square pit and center the pit in the image using a **Scan size** of approximately 10µm.

4. Change the aspect ratio to 4:1, and verify that the image includes the pit along with portions of the surrounding flat area (see Figure 17.8a).

**Figure 17.8a  Z Calibration Image**

5. Verify that the **Z Center Position** value shown next to the image display is close to 0 volts (±5 volts).
6. If the Z Center Position value is not close to zero, use the Realtime > Motor > Tip Up and Tip Down buttons to adjust.

### 17.8.2 Capture and Correct an Image

1. Capture an image by selecting Capture in the Realtime menu, or click on the CAPTURE icon. When the image is captured, go to the Offline screen.

2. Remove all tilt and scan line errata from the image by selecting Offline > Modify > Flatten Manual.

3. Set the Flatten order parameter in the dialog box to 1.

4. Go to the display screen and draw a stopband over the pit as shown in Figure 17.8b.

**Figure 17.8b** Draw a Stopband

5. Click Execute to complete the flattening procedure.

6. Quit the dialog box.
17.8.3 Measure Vertical Features

With the image corrected, its vertical features may now be measured. This is performed using **Depth** analysis to utilize more data points.

1. Select the **Offline** > **Analyze** > **Depth** command.

![Figure 17.8c  Depth Analysis Screen](image)

2. Go to the display screen and draw a cursor box surrounding the entire image (see **Figure 17.8d**).

![Figure 17.8d  Draw a Cursor Box](image)

3. Click **Execute** in the display monitor’s top menu bar.

**Note:** Height data within the drawn cursor box displays on the monitor, showing two, prominent peaks. These peaks correspond to two elevations on the surface: the bottom of the pit and the top surface. There should be a line cursor on each peak.
4. If the two peaks do not appear in the display, increase the **Histogram filter cut off** in the **Configure** dialog box to **2-10nm**.

5. Open the **Configure** dialog box by clicking the **Configure** button in the **Depth** dialog box (see Figure 17.8e).

**Figure 17.8e**  Z Calibration Configure Dialog Box

6. In the **Data result** dialog box located under the image on the display screen, check the **Peak to Peak** value and record it for future reference.

7. Click **Quit** to exit the **Depth** dialog box.

**Figure 17.8f**  Z Calibration Depth Dialog Box
17.8.4 Correct Z Sensitivity

If the depth of the pit on the 10µm silicon calibration reference deviates significantly from 200 nm, correct the Z sensitivity parameter in the Z Calibration dialog box.

1. Transfer to the Z Calibration dialog box by selecting Realtime > Microscope > Calibrate > Z.

2. Divide the actual depth of features (200nm for the 10µm calibration reference) by the measured depth (indicated in Depth analysis by the Peak to Peak value):

   \[
   \frac{200\text{nm}}{\text{Peak to Peak value}}
   \]

3. Multiply this quotient by the Z sensitivity value in the Z Calibration dialog box, and replace the former Z sensitivity value with the new result.

4. Click on OK to enter the new Z sensitivity value.

   Note: The numerator value above (200nm) is for Veeco 10µm silicon reference. For other calibration references, set the numerator equal to the depth of features measured by Depth analysis. Ideally, calibration references should have features with heights comparable to those being imaged and measured on samples.

17.8.5 Recheck Z-axis Measuring Accuracy

After executing the steps above, recheck the Z-axis measuring accuracy of the SPM by repeating the steps outlined above until you obtain accuracy of 1 to 2%.

17.8.6 Calculate Retracted and Extended Offset Deratings

Piezoelectric materials exhibit greater sensitivity at higher voltages. In the steps outlined above, the Z-axis calibrates while scanning near the middle of its voltage range (i.e., Z Center Position ~ 0 V). In this section, you will calibrate the Z-axis piezo while extended and retracted to offset the increased sensitivity.

1. Select Engage under the Motor pop-down menu or click on the Engage icon.

2. Use the Realtime > Motor > Tip Up button until the Z Center Position reads 100V (±5V).

   Note: By using the motor to move the tip up, the feedback loop forces the Z-axis piezo to extend to continue its tracking of the surface.

3. Refer to the steps above (Section 17.8.1 - Section 17.8.3) to determine the measured depth of the calibration standard with a 100V Z Center Position.
4. Record the measured depth. If the depth measured by the extended piezo is off by more than two percent, continue to Step 5 - Step 8.

**Note:** The measured depth should read 200nm on a Veeco 10µm silicon calibration reference.

5. Select **Realtime > Microscope > Calibrate > Z** to display the **Z Calibration** panel

6. Click on the **Extended offset der** parameter.

7. Perform the following calculation:

\[
\frac{(1 + \text{current offset der})}{\text{meas. depth}} \times \frac{200\text{nm}}{175\text{nm}} - 1
\]

For example, if the current offset equals 4% and the measured depth equals 175nm, then:

\[
(1 + .04) \frac{200\text{nm}}{175\text{nm}} - 1 = 0.19
\]

8. Enter the new percent value from above (example was 19%) for the **Extended offset der** parameter in the **Z Calibration** panel.

9. The procedure for calculating and setting the **Retracted offset derating** is exactly the same as for the **Extended offset der**; however, the piezo must be **retracted** by 100V. To calculate the **Retracted offset der**:

   a. Use the **Tip Down** button in the **Motor Control** panel to retract the piezo.

   b. Retract the **Z Center Position** to -100V.

   c. Repeat Step 3 - Step 8 above.
Chapter 18  Maintenance, Troubleshooting and Warranty

This chapter includes the following sections:

- Maintenance: Section 18.1
- Cleaning: Section 18.1.1
- Calibration: Section 18.1.2
- Changing the Illuminator Light Bulb: Section 18.1.3
- Fuse Characteristics and Replacement: Section 18.1.4
- Air Tables: Section 18.1.5
- Air Pressure: Section 18.1.6
- Air Table Feet: Section 18.1.7
- Optics Zoom System: Section 18.1.8
- Troubleshooting: Section 18.2
- Alarms and Error Messages: Section 18.2.1
- Common Problems: Section 18.2.2
- Warranty: Section 18.3
18.1 Maintenance

Generally, the Dimension 3100 system requires very little maintenance. A simple schedule of cleaning and calibration check is usually sufficient.

Every three months:

1. Wipe down the major components of the instrument.
2. Clean the SPM stage.
3. Check the air table for proper level and isolation.
4. Check piezo calibration.

18.1.1 Cleaning

Major Components

The D3100 is essentially an assortment of electronic boxes. You should use the same care with this equipment as with other laboratory instruments. Wipe the exterior of the system with clean paper towels or a cloth dampened with water or alcohol. Dispose of wipes in an appropriately labelled solvent-contaminated waste container.

SPM Stage

The surfaces of the granite base, sample chuck and chuck manifold should be wiped down with a lint-free cloth dampened with acetone. To properly perform this:

1. Remove the scanner from the Z stage and place it in a safe place.
2. Remove the sample chuck by lifting it off of the chuck manifold.
3. Disconnect the manifold from the X stage assembly by removing the three Phillips head screws that pass through the X flexure.

CAUTION: Do not remove the vacuum hoses on the side of the manifold! The upper hose has a wire inside that will be damaged if the hoses are pulled off.

4. Lift the manifold off of the granite base.
5. Wipe the top of the granite stage base.
6. Wipe the top and bottom of the manifold.
7. Reconnect the manifold to the X stage assembly.
8. Wipe the underside of the sample chuck.
9. Place the chuck back on the manifold.
10. Dispose of wipes in an appropriately labelled solvent-contaminated waste container.

**SPM Optics**

The video objective on the left side of the stage should be periodically cleaned with a mild glass cleaner or solvent such as acetone or alcohol.

**Dimension Scanner**

**Laser and Photodiode Adjustment Screws**

Dust and other contamination can cause the lubrication on the screws to thicken over time, thereby causing the screws to become difficult to turn.

   **Note:** We recommend you clean one screw at a time to avoid mixing up the screws.

   1. Remove a screw from the scanner by turning it counterclockwise.
   2. Wrap a pipe cleaner around the threads on the screw.
   3. Dip the screw in acetone. Unscrew the screw in the pipe cleaner. The bristles on the pipe cleaner are small enough to dig out the accumulated grease in the threads.
   4. Clean the threaded insert in the scanner with a Q-tip dipped in acetone.
   5. Lubricate the screw and the leading edge of the threaded insert with a small amount of silicon vacuum grease.
   6. Thread the screw back into the scanner head.
   7. Repeat the cleaning procedure with the other three adjustment screws.
18.1.2 Calibration

A description of the complete scanner calibration is located in a separate chapter. In general the scanner’s calibration should be checked every three months. The main change in calibration will be the loss of piezo sensitivity in the first year of use. This is an expected behavior. Loss of 10-15% of the initial scan size is common.

Inspections and Procedures

Noise Test Procedure

Although a noise test is performed prior to shipment and during a new installation, this test is useful to periodically test the instrument’s performance in your lab. Increases in the noise level of the instrument are typically due to some sort of environmental change such as the introduction of new equipment in proximity of the D3100 stage. The D3100 system itself is historically not prone to degrade over time, although changes to the environment are a common source of noise.

Because the Dimension 3100 is sensitive to vibration, it is often a convenient tool for checking the performance of the vibration isolation system. The following test can be performed under ambient conditions or while an external noise source is applied to the floor.

1. Install a new cantilever and engage in TappingMode on a Si wafer (500nm to 1µm scan size). You can also image the substrate of a silicon probe. The probe can be mounted to a small sample AFM puck with double-sided tape and held to the stage magnetically. The only limit to this sample is that the vacuum seal between the chuck and the sample won’t be tested.

2. Set the Z limit to 55V (~1µm). Set the Samples/line to 512.

3. Set the gains as low as possible, while still maintaining a good image with visible surface roughness. Do not lower the Integral and Proportional gain below 0.2; the LookAhead gain should be 0.

4. Change the Scan size to 1nm and capture an image. The Scan rate is not important for this Scan size. You can set the Scan rate to 10Hz to save time. If you have low frequency noise, you may want to set the Scan rate to 2Hz so that you can see at least a few periods (longer time base).

5. Perform a first order Flatten Auto. Then, run the roughness measurement. The RMS value should be typically 0.5Å.

An easy way to analyze noise is to use the Section Analysis function. If you draw a line that is perfectly horizontal, the one dimensional Fourier plot will show you what frequencies are contributing to your noise. Remember that when the Scan size is this small, you no longer have an image but rather a temporal graph of the Z displacement.
18.1.3 Changing the Illuminator Light Bulb

You can change the illuminator light bulb when it burns out. The illuminator light bulb is the only user-serviceable part inside the Dimension control box. Dimension 3100 systems ship with a spare light bulb mounted within the Dimension control box back panel. Order a new illuminator bulb from Veeco when the spare bulb burns out. Please note availability and shipping time may vary.

Figure 18.1a Change the Illuminator Bulb

1. Turn the Dimension control box off and unplug it from the power source.

2. Locate the bulb mount panel on the back of the control box. Allow the system to cool before attempting to open the bulb mount panel.

3. Un螺丝 the two holding screws.

4. Slide the bulb mounting panel out.

5. Pull spare bulb out and replace into light socket.

6. Slide bulb mount panel out.

7. Unplug bulb cable and lifting bulb up and out of the bulb holder.

8. Remove used bulb by unpluging bulb cable and lifting bulb up and out of the bulb holder.

1. Locate bulb mount panel on back of Dimension controller.

2. Remove 2 holding screws from bulb mount panel.

3. Slide bulb mount panel out.

4. Remove used bulb by unplugging bulb cable and lifting bulb up and out of the bulb holder.
5. Remove the used bulb by unplugging the bulb cable and lifting the bulb up and out of the bulb holder.

6. Pull the spare bulb (back bulb) out of the mount and place it into the holder. Do not touch the inside of the bulb.

7. Plug in the light bulb cable.

8. Slide the bulb mount panel back and replace the holding screws.

9. Order another spare bulb from Veeco.

CAUTION: When you receive the new spare bulb, remove the power from the Dimension Controller and wait for the bulb to cool down before opening the bulb mount panel to place the new spare bulb in its holder.
18.1.4 Fuse Characteristics and Replacement

- **NanoScope Controller**: 6 fuses; 3 identical fuses in use and 3 spare fuses. The fuse characteristics are silk-screened on the back of the NanoScope controller (see Table 18.1a).

<table>
<thead>
<tr>
<th>Line Voltage</th>
<th>Fuse Selection</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>F1</td>
</tr>
<tr>
<td>100V</td>
<td>2.0A</td>
</tr>
<tr>
<td>120V</td>
<td>2.0A</td>
</tr>
<tr>
<td>220V</td>
<td>1.0A</td>
</tr>
<tr>
<td>240V</td>
<td>1.0</td>
</tr>
</tbody>
</table>

All Fuses: 250V, Time-lag, 5mm x 20mm

- **Illuminator Circuit board**: 2 fuses; one fuse is non-replaceable (281-000-024), while the other fuse is replaceable and is shipped with a spare (see Table 18.1b).

<table>
<thead>
<tr>
<th>Illuminator Board</th>
<th>Part Number</th>
<th>Current</th>
<th>Dimensions</th>
<th>Max Voltage</th>
<th>Time Delay</th>
<th>Other</th>
</tr>
</thead>
<tbody>
<tr>
<td>100V</td>
<td>281-000-026</td>
<td>1.25A</td>
<td>5 x 20mm</td>
<td>250V</td>
<td>Yes</td>
<td>IEC</td>
</tr>
<tr>
<td>120V</td>
<td>281-000-032</td>
<td>1.00A</td>
<td>5 x 20mm</td>
<td>250V</td>
<td>Yes</td>
<td>IEC</td>
</tr>
<tr>
<td>240V</td>
<td>281-000-031</td>
<td>0.5A</td>
<td>5 x 20mm</td>
<td>250V</td>
<td>Yes</td>
<td>IEC</td>
</tr>
</tbody>
</table>

- **Vacuum Pump Board**: 2 fuses; each has a spare (see Table 18.1b).

<table>
<thead>
<tr>
<th>Vacuum Pump Board</th>
<th>Part Number</th>
<th>Current</th>
<th>Dimensions</th>
<th>Max Voltage</th>
<th>Time Delay</th>
<th>Other</th>
</tr>
</thead>
<tbody>
<tr>
<td>100V</td>
<td>281-000-030</td>
<td>0.25A</td>
<td>5 x 20mm</td>
<td>250V</td>
<td>Yes</td>
<td>IEC</td>
</tr>
<tr>
<td>120V</td>
<td>281-000-029</td>
<td>0.2A</td>
<td>5 x 20mm</td>
<td>250V</td>
<td>Yes</td>
<td>IEC</td>
</tr>
<tr>
<td>240V</td>
<td>281-000-028</td>
<td>0.125A</td>
<td>5 x 20mm</td>
<td>250V</td>
<td>Yes</td>
<td>IEC</td>
</tr>
</tbody>
</table>

**Fuse Replacement Procedure**

1. Remove all power from the system.
2. Remove the lid of the appropriate control box (4 screws).
3. Using a screwdriver, press the slot in the fuse holder and rotate the fuse a 1/4 turn counterclockwise.

4. Gently pull the fuse away from the board.

5. Carefully remove the replacement fuse and insert it in the fuse holder.

6. Using a screwdriver, press the slot in the fuse holder and rotate the fuse a 1/4 turn clockwise until the fuse is secure.

7. Order another spare fuse from Veeco. Be sure to turn off all system power before placing the spare fuse back in the holder location.

18.1.5 Air Tables

Veeco sells two different air tables with the D3100 system: VT-102 and VT-103. Both air tables are manufactured by TMC™ corporation and are referred to in this section.

Having a properly installed air table is necessary for a properly operating AFM system. It is very common to see periodic noise in the AFM data due to an under-inflated or improperly balanced air table. It is important to check the air table when you move the instrument.

18.1.6 Air Pressure

The incoming air pressure should be 60-80PSI. The air table has a built in regulator that is preset for optimum performance.

Note: Incoming pressure higher than 80PSI has not been proven to be harmful. It is just not recommended.

18.1.7 Air Table Feet

The frame of the air table has four legs with feet that support the D3100 stage. The feet should be lowered so that the air table is raised off of the wheels. Periodically check to make sure that the weight of the air table is evenly distributed on all four legs. To do this, simply use the supplied spanner wrench to slightly turn each of the feet in sequence. If the foot you are testing turns easily, there is no weight pressing down on it. Readjust the feet so that each foot is supporting an equal amount of weight.
18.1.8 Optics Zoom System

The clutch in the zoom system can begin to slip after several years of use. The symptom of a slipping clutch is an erratic change in the video magnification under use. A minor adjustment to the tension of the clutch can restore proper operation. To tighten the zoom system clutch follow the steps below.

1. Remove the black metal cover above the camera optics located on the left side of the stage frame.

2. Locate the zoom motor positioned vertically on the side of the optics tube. Use the zoom function in the locate tip software routine to see and hear the motor as it turns.

3. Watch the ring gear at the bottom of the zoom motor as it turns. If the video image is not zooming smoothly then the clutch is not applying enough pressure to continuously move the gear.

4. Locate the hex fitting on the brass collar just above the zoom gear.

5. Insert a hex wrench on the fitting to hold the collar from turning.

6. Tighten the clutch by tightening the nut below the ring gear.

    **CAUTION:** Do not tighten the nut more than 1/8-1/4 turn. This is typically enough additional tension to fix the problem.

7. Verify that the zoom optics work correctly and that the clutch still slips at the end of the motors travel.
18.2 Troubleshooting

The Dimension 3100 system is very reliable and generally will not need adjustment once properly calibrated, nor is it likely to develop a problem due to use. In most cases any problems that occur can be linked to some external event.

Some typical examples of such events are:

- Lighting storms that cause power transients can damage circuit boards.
- Fluid spills on electrical components can cause damage.
- Improper installation of the air table when relocating the instrument to a new room can cause noise in the data.
- Improper signal cable installation when relocating the instrument can cause problems.
- After relocating the instrument to a new room, the data may exhibit noise. The room itself may have excessive floor vibration or acoustic noise.
- Installing a new board other than what is needed to operate the instrument via the computer can cause the software to not load correctly or a hardware conflict within the computer system.

18.2.1 Alarms and Error Messages

Alarms

The D3100 stage controller will produce a high-pitched noise if it is tilted more than 45 degrees. There are mechanical pumps that need to be kept level in order to properly work.

The D3100 stage controller alarm will also sound if the internal temperature exceeds 40°C. The illuminator inside the controller can cause the inside temperature to rise beyond this point if the ventilation to the controller is restricted. The air inlet screen on the front of the controller may become clogged in a dusty environment.

Software Error Messages

- “Illuminator port timed out” – The serial port connected to the D3100 stage controller is not connected or is not communicating properly.
- “Stage not initialized” – The serial port connected to the D3100 stage is not connected or is not communicating properly.
- “Stage controller error” – The serial port connected to the D3100 stage is not communicating properly.
• “Illuminator Error, Manual override is on” – The manual control on the front of the D3100 stage controller is being used. Turn the illuminator manual control knob counterclockwise until a click sound is heard, indicating that it is switched off.

• “Bad data read from illuminator was O.S.B. 80” – The D3100 stage controller power is off. The power supply inside the D3100 stage controller is not working.

• “Warning focus position not updated” – You tried to move X-Y stage with no AFM SUM signal.

• “Safety check failed SUM too low” – 2 Explanations:
  - You tried to engage with no AFM SUM signal.
  - You tried to move X-Y stage with no SUM signal.

• “The focus axis is at its limit” – The focusing objective is either fully extended or fully retracted. This message will appear during the locate tip routine.

• “Warning: Sample clearance reduced! Unable to move past limit” – The focusing objective reached the extended limit when moving to the locate tip position. This can happen during STM use due to the lower tip location. The end of the STM probe should protrude no more than 1 mm below the end of the tip holder tube. This message can also occur if the sample clearance is set to a very large value. The standard sample clearance distance is 1000µm.

• “Motor axis is at limit” – The SPM (Z stage) is fully retracted. This can happen after the stage is initialized. Ignore the message and lower the Z stage by using the Focus Surface controls.

• “The tip location has been changed to an unsafe distance. If you proceed with this change you will need to re-teach the tip replacement position.” – This warning appears during the Locate Tip routine if the focusing objective has moved more than 300µm from the previous tip focus position. This is common when switching between silicon and silicon nitride cantilevers due the thickness difference of their substrates. The message will also appear when switching between AFM and STM probes. The intent of this message is a safety check to warn you that you have moved the objective unusually long distance. Select OK if you’ve changed to a different style of probe.
18.2.2 Common Problems

Bent stage flexures – The X or Y stage flexure can be accidentally bent if an object like a tool or tweezers is left on the granite base and the X-Y stage is driven into it. Stage flexures can also become bent due to improper shipping. The X-Y flexures are removed before a new system is shipped for this reason. A bent stage flexure will cause noise in the image due to a vacuum leak between the granite stage base and the chuck manifold. Bent flexures will also cause not repeatable movement in the X-Y stage motion.

Optics Zoom system does not work smoothly – The clutch that couples the zoom motor to the drive gear is slipping. Refer to Optics Zoom System: Section 18.1.8 of this chapter for instructions on adjusting the clutch.

No Laser light from scanner – Possible Explanations:

- The software is not running.
- The microscope mode is set to STM in software.
- The scanner is tilted more than 45 degrees.
- A microscope other than a D3100 is selected in software.

No stage illumination – Possible Explanations:

- Manual override is on.
- Blown illuminator bulb. Refer to Section 18.1.3 for instructions on changing the illuminator bulb.
- Blown fuse on illuminator circuit board. A spare fuse is provided next to the fuse holder.

No chuck vacuum – Possible Explanations:

- The fuse that powers the vacuum pump is blown. Verify that F1 on the main circuit board in the stage controller is good. Replace with the spare fuse if it’s blown.
- The vacuum pump is bad.
- The air and vacuum hoses are not connected.
- One of the four screws on the chuck is missing. The center screw and the four small Phillips screws plug various holes that direct the vacuum to the chuck.

Fluid spills – Fluid spills will cause numerous problems. The most common problem is that the piezo electric element in the Dimension scanner can become permanently damaged. Avoid fluid contact with the end of the scanner at all times.

Cables – The wires inside the cable connector on the Dimension scanner can be broken from the 21-pin plug. Disconnecting or connecting the scanner by pulling on the cable can cause this.
The scanner plug is very durable and typically does not fail due to use. Never connect or disconnect the dimension scanner cable from the stage by pulling on the cable. Always connect and disconnect the scanner by holding on to the plug.

18.3 Warranty

All new catalog-listed standard equipment sold and/or manufactured under Veeco labels is warranted by Veeco to be free of defects in material and workmanship if properly operated and maintained. This one-year warranty covers the cost of necessary parts and labor (including, where applicable as determined by Veeco, field service labor and field service engineer transportation) during the warranty period.

Warranty period takes effect upon date of shipment. Except as detailed below, these warranties extend to parts which are components of standard catalog items and manufactured by persons other than Veeco. The manufacturer warranty covers purchased equipment incorporated into any item supplied by Veeco.

Expendable items, including but not limited to styli, lamps, and fuses, are specifically excluded from the aforementioned warranties and are not warranted. All used equipment is sold on an “as is, where is” basis without warranty, express or implied.

Equipment made or modified to purchaser specifications on special order shall carry the above warranties with respect to material and workmanship, but shall be specifically excluded from any other warranties, express or implied, including those related to performance specifications. Special components shall only carry the original manufacturer warranties.

Warranty Claims

Veeco’s obligation under these warranties is limited to repairing or replacing at Veeco’s option defective non-expendable parts. Veeco’s obligation shall not extend to defects that do not impair service. No claim will be allowed for any defect unless Veeco has received notice of the defect within thirty days following its discovery by purchaser.

Claims for Shipment Damage

No claim will be allowed for equipment damaged in shipment sold under standard terms of F.O.B. Factory. Within thirty days of purchaser's receipt of equipment, Veeco must receive notice of any defect which purchaser could have discovered by prompt inspection of equipment. In any event, Veeco shall have the option of inspection at purchaser's premises or at Veeco’s plant before allowing or rejecting the claim.

Documentation Feedback

Veeco is dedicated to the ongoing improvement of our products and technical documentation. If you have any comments regarding this manual or any other Veeco documentation, please e-mail us at: SBOTechPubs@veeco.com.
Warranty Eligibility

To be eligible for the above warranties, purchaser must perform preventative maintenance in accordance with the schedule set forth in the manual provided. Veeco assumes no liability under the above warranties for equipment or system failures resulting from improper operation, improper preventative maintenance, abuse or modifications of the equipment or system from the original configuration.

Note: This warranty is in lieu of all other warranties, expressed or implied and constitutes fulfillment of all of Veeco’s liabilities to the purchaser. Veeco does not warrant that the system can be used for any particular purpose other than that covered by the applicable specifications. Veeco assumes no liability in any event, for consequential damages, for anticipated or lost profits, incidental damages or loss of time or other losses incurred by the purchaser or any third party in connection with systems covered by this warranty or otherwise.

Service

Field service is available nationwide. Service and installations are performed by factory trained Veeco service personnel. Contact the Veeco Metrology sales/service office for prompt service.

Veeco Instruments Inc.
112 Robin Hill Road
Santa Barbara CA 93117
Attn.: Service Center

Phone: (805) 967-2700
Fax: (805) 967-7717
Symbols
12 . 248
A
Air
  Dimension 3100 controller 7
Aliasing 241
Amplitude 146
Atomic Force Microscope (AFM)
  operator precautions 23
  sample precautions 26
Average count 214
B
Beamsplitter
  Dimension SPM head 11
Bias 178
Bias Voltage 176, 183, 184
Bimorph Resonant Frequency 236
C
Calibration 305–336
  standard 312
Cantilever
  fluid cell cantilever holder 13–14
  standard cantilever holder 13–14
Cantilever Holder
  description 13–14
  fluid cell 13–14
  specifications 14
  standard 13–14
Cantilever Tune 135–138
Capture 180
Capture Calibration 212, 321–323
Center Frequency 136
Checklists
  power-up (installation and service only) 31
  power-up (normal usage) 32
pre power-up (installation and service only)
  28–30
  software power-up 35
Chucks
  vacuum 115
Circuitry
  Dimension 3100 microscope 8
Color contrast 180
Color offset 180
Color table 180
Computer
  system overview 3, 4
Configurations
  IS3K-2 2
  VT-102 2
  VT-103-3K 2
Contact AFM
  in fluids 149–158
Contact Force 129, 232
Contact Information 350
Contact Technical Publications 349
Control Station
  computer 4
  Dimension 3100 controller 6
  input and display devices 3
  keyboard 3
  monitors 3
  mouse 3
  NanoScope IIIa controller 5
  system overview 3–7
  trackball 3
Crash tip 118
D
Data type 127, 129, 146, 147, 263
  force modulation 239
Data type 178
  LFM 196
  STM 182, 183
Index

Deflection **127**
Differential Signals **11**
Dimension 3100 Controller
  air pump **7**
  illumination **7**
  power supply **7**
  system overview **2, 6**
  thermal hazard **6**
  vacuum pump **7**
Dimension 3100 Microscope Electronics Box **7—8**
  larger SPM mother board **8**
  main SPM circuit board **8**
  two stepper-motor drive board **8**
  vacuum power switch **8**
Drive amplitude **148, 216, 238, 240, 241**
Drive frequency **136, 145, 166, 216, 238, 263**
  with MFM **259—262**
E
ECAFM **149**
Edge Effects **241**
EFM **248–253, 273–296**
Electric Force Microscopy See EFM **248**
Electrical Hazard
  symbol **19**
Electrochemical AFM **149**
Engage **125, 141, 171**
  force modulation **239**
  TappingMode **141, 171**
Engagement
  STM **178**
Equipment Damage
  symbol **19**
Equipment Safety Applications **27**
Ergonomics
  overview **26**
F
Feedback Gains
  initial settings **128**
Feedback type **183, 184**
Fluid Cell
  description **13, 151**
Fluids
  imaging in **149–158**
Focus Surface **148**
Force Cal
  adjustment **224**
  Force Cal **220–232**
Force Calibration **129, 130, 206–232, 308**
  Capture **219**
  Drive amplitude **216**
  Drive Frequency **216**
  Force Curve
    adjustment **220–226**
  Force Modulation **233–242**
    edge effects **240**
    operating procedure **235–241**
    principles of **235**
  Frequency Modulation
    with MFM **263**
  Frequency Sweep **135, 166**
    with MFM **261, 291–292**
  Frictional Measurements See Lateral Force Microscopy **195–201**
  Fuse Characteristics and Replacement **343**
G
Graph range **215, 221**
H
Hazards
  Dimension 3100 controller **6**
  labels **35–36**
  symbols **19**
Head
  beamsplitter **11**
  description **9–43**
  detector mirror **11**
  illustration **105**
  laser diode adjustment knobs **10**
  laser diode stage **10**
  laser spot detector screen **11**
  packing for shipment **56**
  photodetector **11**
  preamp board **10**
  scanner piezo tube **11**
Height **127, 146, 147**
Highpass **259**
Highpass Filter **129**
I
Icons
  attention **19**
  electrical hazard **19**
  laser hazard **19**
  lifting hazard **19**
  mechanical crushing hazard **19**
  NanoScope **34**
  realtime **34**
Index

<table>
<thead>
<tr>
<th>Safety</th>
<th>19</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thermal Hazard</td>
<td>19</td>
</tr>
</tbody>
</table>

**Illumination**

- Dimension 3100 controller | 7

**Input and Display Devices**

- Computer            | 4
- Keyboard            | 3
- Monitors            | 3
- Mouse               | 3
- Trackball           | 3

**Input attenuation** | 136, 166, 216

**Installation**

- Power-up            | 27–31
- Power-up checklist  | 31
- Pre power-up checklist | 28–30

**Integral gain** | 128, 144, 146, 241, 264

**Integral gain** | 178

**STM** | 179

**Interleave Controls** | 248–253, 265, 266

  - **Lift scan height** | 251
  - Principles of | 249

**L**

- **Labels**
  - Laser warning | 36

- **Laser**
  - Adjustable detector mirror | 11
  - Beamsplitter | 11
  - Detector screen | 11
  - Diode stage | 10
  - Photodetector | 11
  - Safety hazard | 19
  - Symbol | 19

- **Laser Aiming**
  - With fluid cells | 162

- **Laser Diode Adjustment Knobs**
  - Dimension SPM head | 10

- **Laser Diode Stage**
  - Dimension SPM head | 10

- **Laser Hazard**
  - Laser warning label | 36
  - Symbol | 19

- **Laser Spot Detector Screen**
  - Dimension SPM head | 11

- **Lateral Force Microscopy** | 195–201

- **Left Image** | 124

- **LFM**
  - Principles of | 195
  - Scan angle | 197

- **Lift scan height** | 261

  - **Lift scan height** | 250, 251

- **Lift start height** | 261

  - **Lift start height** | 250

- **Lifting Hazard**
  - Symbol | 19

- **LiftMode** | 248–253

  - Principles of | 250

  - With MFM | 258

- **Line direction** | 262, 316

- **Line direction** | 196, 251

- **Log On** | 33

  - **Look Ahead gain** | 183

- **Look ahead gain** | 128, 146

- **Lowpass** | 259

  - **Lowpass** | 180

  - **Lowpass Filter** | 129

**M**

- **Magnetic Force Microscopy** | 255–270

  - **Magnetic Force Microscopy** See MFM | 248

- **Maintenance** | 338–342

- **Mechanical Crushing Hazard**
  - Operator precautions | 24

  - Symbol | 19

- **MFM** | 248–253, 273–296

  - Operating procedure | 259–264

  - Principles of | 258

  - Resolution | 264

- **Microscope**
  - Dimension SPM head | 9–12
  
  - Electronics | 7–8
  
  - Preamp board | 10
  
  - Precautions | 23

  - Safety precautions | 23–25

  - Stage system | 9

  - Vacuum power switch | 8

  - Video zoom | 14

- **Mirrors**
  - Adjustable detector mirror | 11

- **Modify** | 180

- **Motor**
  - Withdraw | 142

- **Mouse** | 100

**N**

- **NanoScope**
  - Icon | 34

- **NanoScope IIIa Controller**
<table>
<thead>
<tr>
<th>Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>system overview 5</td>
</tr>
<tr>
<td>Number of samples 214</td>
</tr>
<tr>
<td>O</td>
</tr>
<tr>
<td>Objective</td>
</tr>
<tr>
<td>optics and motors overview 9</td>
</tr>
<tr>
<td>video zoom 14</td>
</tr>
<tr>
<td>Offset 136, 167</td>
</tr>
<tr>
<td>Operator Safety</td>
</tr>
<tr>
<td>diode laser 22, 23</td>
</tr>
<tr>
<td>general safety warnings 20–26</td>
</tr>
<tr>
<td>microscope precautions 23</td>
</tr>
<tr>
<td>non-ionizing radiation 23</td>
</tr>
<tr>
<td>pneumatics 21, 22</td>
</tr>
<tr>
<td>qualified personnel 20</td>
</tr>
<tr>
<td>sample safeguards 26</td>
</tr>
<tr>
<td>voltage 21</td>
</tr>
<tr>
<td>wiring 21, 22</td>
</tr>
<tr>
<td>Optics</td>
</tr>
<tr>
<td>objective 9</td>
</tr>
<tr>
<td>overview 9</td>
</tr>
<tr>
<td>system overview 2</td>
</tr>
<tr>
<td>zoom 14</td>
</tr>
<tr>
<td>P</td>
</tr>
<tr>
<td>Parameters</td>
</tr>
<tr>
<td>show 122, 139, 169</td>
</tr>
<tr>
<td>Password 33</td>
</tr>
<tr>
<td>Personal Injury</td>
</tr>
<tr>
<td>symbol 19</td>
</tr>
<tr>
<td>Photodetector</td>
</tr>
<tr>
<td>description 11</td>
</tr>
<tr>
<td>differential signals 11</td>
</tr>
<tr>
<td>Dimension SPM head 11</td>
</tr>
<tr>
<td>sum signal 11</td>
</tr>
<tr>
<td>Piezo</td>
</tr>
<tr>
<td>scanner 11</td>
</tr>
<tr>
<td>Plot type 180</td>
</tr>
<tr>
<td>Power</td>
</tr>
<tr>
<td>Dimension 3100 controller 7</td>
</tr>
<tr>
<td>power-up (installation and service only) 27–31</td>
</tr>
<tr>
<td>power-up (normal usage) 31–32</td>
</tr>
<tr>
<td>software power-up 32–35</td>
</tr>
<tr>
<td>Preamp Board</td>
</tr>
<tr>
<td>Dimension SPM head 10</td>
</tr>
<tr>
<td>Probe menu</td>
</tr>
<tr>
<td>Run Continuous 219</td>
</tr>
<tr>
<td>Run Single 219</td>
</tr>
<tr>
<td>Stop 219</td>
</tr>
<tr>
<td>Probe Tips 90–97</td>
</tr>
<tr>
<td>EFM 258</td>
</tr>
<tr>
<td>force modulation 234–235, 242</td>
</tr>
<tr>
<td>geometry 90–92, 96–97, 251</td>
</tr>
<tr>
<td>LFM 198</td>
</tr>
<tr>
<td>MFM 258</td>
</tr>
<tr>
<td>removal from substrates 93</td>
</tr>
<tr>
<td>selection 125–126</td>
</tr>
<tr>
<td>silicon 88–93</td>
</tr>
<tr>
<td>silicon nitride 93–97</td>
</tr>
<tr>
<td>STM 177, 181</td>
</tr>
<tr>
<td>tuning 135–138, 165–168</td>
</tr>
<tr>
<td>Property Damage</td>
</tr>
<tr>
<td>symbol 19</td>
</tr>
<tr>
<td>Proportional gain 128, 146, 241, 264</td>
</tr>
<tr>
<td>Proportional gain 178</td>
</tr>
<tr>
<td>R</td>
</tr>
<tr>
<td>Radiation</td>
</tr>
<tr>
<td>operator safety 23</td>
</tr>
<tr>
<td>Realtime</td>
</tr>
<tr>
<td>icon 34</td>
</tr>
<tr>
<td>Retrace 144</td>
</tr>
<tr>
<td>Right Image 124</td>
</tr>
<tr>
<td>RMS Amplitude 112</td>
</tr>
<tr>
<td>Rounding 259</td>
</tr>
<tr>
<td>Run Continuous, Probe menu 219</td>
</tr>
<tr>
<td>Run Single, Probe menu 219</td>
</tr>
<tr>
<td>S</td>
</tr>
<tr>
<td>Safety 100</td>
</tr>
<tr>
<td>labels 35–36</td>
</tr>
<tr>
<td>mechanical crushing hazard 24</td>
</tr>
<tr>
<td>microscope precautions 23</td>
</tr>
<tr>
<td>power-up (installation and service only) 27–31</td>
</tr>
<tr>
<td>power-up (normal usage) 31–32</td>
</tr>
<tr>
<td>precautions 20–26</td>
</tr>
<tr>
<td>sample safeguards 26</td>
</tr>
<tr>
<td>software power-up 32–35</td>
</tr>
<tr>
<td>symbols 19</td>
</tr>
<tr>
<td>Safety Hazards</td>
</tr>
<tr>
<td>attention 19</td>
</tr>
<tr>
<td>electrical 19</td>
</tr>
<tr>
<td>general operator safety 20–26</td>
</tr>
<tr>
<td>laser 19</td>
</tr>
<tr>
<td>lifting 19</td>
</tr>
<tr>
<td>mechanical crushing 19</td>
</tr>
<tr>
<td>thermal 19</td>
</tr>
<tr>
<td>Safety Precautions 20–26</td>
</tr>
<tr>
<td>Sample</td>
</tr>
</tbody>
</table>
precautions 26
Samples
biological 149–174
chucks 70
handling 15
minimizing surface forces 224
preparation 70, 114–115, 153–154
size 15
specifications 15
Scan angle 196, 197
Scan direction 263
Scan rate 129, 144
Scan size 129, 262
Scan size 178
STM 179, 183
Scan speed 241
Scanner
description 9
linearity 316–320
piezoelectric crystals 12
Scanner Calibration 316
Scanner Piezo Tube
Dimension SPM head 11
specifications 12
Sensitivity 215
Service
power-up 27–31
power-up checklist 31
pre power-up checklist 28–30
Setpoint 129, 144, 147, 216, 241
adjustment 221
defined 129
FM 239, 240
Setpoint
STM 179
Show All Items 122, 139, 169
Software
log on 33
NanoScope icon 34
password 33
power-up 32–35
power-up checklist 35
realtime 34
stage initialization 35
user name 33
Specifications
cantilever holder 14
samples 15
scanner 12
scanner piezo tube 12
Spring Constant
specifications 125
Stage Menu Commands
focus surface 165
initialize 35, 83
load new sample 72, 142
locate tip 73, 113
move to (X,Y) 76
programmed move 79–83
set reference 77–78
SPM parameters 85
Stages
axis orientation 71
control electronics 341
laser diode stage 10
servo motors 9
specifications 9
system overview 2
X-Y stage 9
Z stage 9
STM
applications 176
hardware 181
principles of 176, 180–181
Stop, Probe menu 219
Sum Signal 11
Sweep graph range 238
Sweep width 136, 238
Symbols
attention 19
electrical hazard 19
laser hazard 19
lifting hazard 19
mechanical crushing hazard 19
safety 19
thermal hazard 19
System Overview 2–3
computer 3
configurations 2
Dimension 3100 controller 2
motorized positioning stage 2
optical microscope 2
video image capture capability 3
T
TappingMode 131–232
Thermal Hazard
symbol 19
Tip crash 118
Tip Down 220, 222
Tip Holder 10
fluid 151
installation fixture 104
preparation 103–106
STM 176–177, 181
Tip Up 220
To 222
Trace 144
Trackball 100
Troubleshooting
cantilever tune plot looks bad 173
laser sum signal absent or weak 173
poor image quality 173
unable to locate particulate samples 174
U
Units 213, 214
User Name 33
V
Vacuum
Dimension 3100 controller 7
microscope vacuum power switch 8
Van der Waals Forces 253
Veeco Contact Information 350
Vibration
isolation table 57
Video Imaging
system overview 3
video zoom microscope 14
View
All Parameters 122, 139, 169
Image Mode 179
Scope Mode 179, 183
Voltage
general operator safety 21
W
Warranty 349
X
X offset 178
X-Y stage 9
Y
Y offset 178
Z
Z scan rate 229
Z scan size 206, 221, 232